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[bookmark: _Toc439542894]Inleiding
In dit verslag zullen wij de Eagle Cad beschrijven. De Eagle Cad ook wel CafSoft Eagle genoemd is een programma die gemaakt is om heel makkelijk PCB designs te creëren met de computer die vervolgens in werkelijkheid uitgeprint of gefabriceerd kan worden naar de wens. Printed Circuit Boards(PCB’s)  zijn borden die electronische componenten mechanisch ondersteunen en electronisch aan elkaar verbinden. PCB’s worden al vanaf de jaren 1900 gebruikt. De eerste PCB was ontworpen door Charles Ducas en het idee van PCB design was een revolutionair manier om complexe, grote en dure bedrading te elimineren. Tegenwoordig worden dagelijks miljoenen PCB’s gefabriceerd die op modern wijze komen te onstaan. In dit verslag zullen wij PCB design met vanaf illustratie met Eagle Cadsoft tot ontwerp duidelijk in het kort beschrijven. De hoofdstukken indeling zal er als volgt uitzien: 
1. Hoofdstuk 1 	
a. Paragraaf  1.1 Algemene informatie over Eagle Cadsoft.	
b. Paragraaf  1.2 Geschiedenis van Eagle.
c. Paragraaf 1.3 Hier zullen beginnen aan de twee voorkomende manieren namelijk: 	
i. Paragraaf 1.3.1 De THD.
ii. Paragraaf 1.3.2 De SMD.
d. Paragraaf 1.4 De twee technolgieën beschijven:
i. Paragraaf 1.4.1 De Through Hole Technology(THT).
ii. Paragraaf 1.4.2 De Surface Mount Technology(SMD).
e. Paragraaf 1.5 De lay-out.
f. Paragraaf 1.6 De layers.
2. Hoofdsuk 2
a. Paragraaf 2.1 Design Manieren
i. Paragraaf 2.1.1 Etsen
b. Paragraaf 2.2 Freesmachine
c. Paragraaf 2.3 Laserprinter
3. Hoofdstuk 3 
a. Paragraaf 3.1 CAM
b. Paragraaf 3.2 CAD






[bookmark: _Toc439542895]1 Eagle informatie en overzicht van design technologies
[bookmark: _Toc439542896]1.1 Algemene informatie over Eagle Cadsoft
De naam Eagle staat voor Easy Applicable Graphical Layout Editor in het engels en Einfach Anzuwendender Grafischer Layout Editor in het Duits. Eagle is een Computer Aided Design(CAD) en Computer Aided Manufactory(CAM) programma waarmee electronische schakelingen getekend kunnen worden met PCB design. Het programma Eagle is ontworpen door het bedrijf CadSoft Computer GmbH en is een flexibele en makkelijke Electronic Design Automation(EDA) programma om mee om te gaan. Het programma bestaat uit een tal van functies als Schematic Capture Editor, Printed Circuit Board(PCB) layout editor, Auto-router, Computer Aided Manufactory(CAM) en Bill of Materials(BOM). Eagle komt voor in vijf versies namelijk:
· Professional
· Standard
· Hobbyist
· Light
· Freeware
[image: ]Dit onderstaand tabel geeft de specificaties van de versies aan.

Eagle Cadsoft wordt ook door populaire DIY(Do It Yourself) electronics websites zoals Sparkfun  en Adafruit gebruikt. Sparkfun, Adafruit, Farnell, Element 14 en nog paar andere organisaties leveren Eagle libraries. De libraries zijn de lijsten met voorkomende componenten die gebruikt kunnen worden in het programma Eagle Cadsoft.

[bookmark: _Toc439542897]1.2 Geschiedenis van Eagle
Eagle was ontworpen in het jaar 1988 als programma voor Microsoft DOS en werd later bijgewerkt voor OS/2 en windows versies. Door enkele jaren heen werd Eagle Cadsoft mogelijk gemaakt voor Windows, MAC OSX en Linux. Eagle wordt tegenwoordig door vele Ingenieurs wereldwijd gebruikt voor PCB designing. Eagle was omgekocht door Premiër Farnell in het jaar 2008.

[bookmark: _Toc439542898]1.3 De twee uitvoering van componenten
[bookmark: _Toc439542899]1.3.1 De THD 
THD staat voor Through Hole  Device. THD is een van de uitvoeringen van componenten die veel gebruikt worden. Deze componten worden uitgevoerd met soldeerbare voetjes die makkelijk gesoldeerd en gedesoldeerd kunnen worden. Bij deze soort uitvoering van de componenten wordt de Through Hole Technology toegepast waarbij de componenten voetjes in geboorde gaten in de printbord worden geplaatst en gesoldeerd. Deze soort van uitvoering komt heel duur aan omdat de componenten een bij een met de hand aan het bord worden vastgemaakt. De THD componenten zijn altijd groter qua formaat vergeleken met de Surfac Mount Device(SMD) componenten. De fabricatie van de THD componenten zijn door de grotere uitvoerbare formaten duurder. De THD componenten worden meestal groot gefabriceerd omdat ze uiteindelijk door de hand vast gemaakt moeten worden. Deze uitvoering met THD componenten op het printbord komt eerder voor bij kleinschalige uitvoeringen. Bij grootschalige uitvoeringen worden SMD’s gebruikt omdat deze goedkoper uitkomen.
De Eagle Cadsoft heeft een ruime keuze in de libraries voor THD componenten. De Eagle maakt het mogelijk deze componenten te gebruiken bij de PCB design. 

[bookmark: _Toc439542900]1.3.2 De SMD
SMD staat voor Surface Mount Device. SMD is de tweede uitvoering van componenten die tegenwoordig het meest worden uitgevoerd. Deze componenten worden niet voorziend van lange en grote soldeervoetjes zoals bij de THD maar integendeel worden de voetjes zo klein mogelijk gefabriceerd dat ze net vast te maken zijn met een speciale soldeertechnologie. Bij het vastmaken van de SMD componenten wordt de Surface Mount Technology toegepast. Bij deze technologie worden de componenten machineel op de borden gesoldeerd omdat het ook niet mogelijk meer is om de componenten vanwege de kleine formaten met de hand vast te maken. Door machinale verwerking wordt heel veel menselijk arbeid bespaard. Ook word er heel veel grondstof bespaard waardoor er meer componenten uit minder materiaal vervaardigd kan worden. De bovengenoemde besparingen zorgen voor de lagere kosten die gemaakt worden bij Surface Mount Technology. Bij het defect raken van SMD componten kan electronicus gebruik maken van de zogenaamde Heat Gun om enkele SMD te desolderen en solderen. Bij SMT technologie wordt er nauwelijks aan het bord gekomen omdat deze meestal van het soort plug en play zijn.
De Eagle libraries hebben ook heel veel soorten SMD’s in voorkomen. Zo is het ook mogelijk om tijdens de PCB design met Eagle Cadsoft te kiezen tussen SMD’s en THD’s.



[bookmark: _Toc439542901]1.4 De twee voorkomende fabriceertechnolgieën 
Er zijn twee voorkomende technologieën van ontwerp op gebied van PCB design. De twee technologieen zijn :
1. De Through Hole Technology(THT)
2. De Surface Mount Technology(SMT)
De twee ontwerp technologieën worden hierna verder in de paragraven 1.4.1 en 1.4.2 beschreven.
[bookmark: _Toc439542902]1.4.1 De THT
De THT is een ontwerp technologie van THT borden. THT technologie is een technologie waarbij componenten voetjes in geboorde gaatjes aan een blote pcb worden vastgemaakt. Bij deze technologie wordt er gebruik gemaakt van componenten met soldeervoetjes (lead wires in het engels). Deze technologie heeft een beperkte flexibiliteit qua formaat, kosten, gewicht en toepassing. De grootte van een enkelvoudige component kan varieren van 1 millimeter to enkele centimeters. In het verleden tot het jaar 1980 was dit de enige manier om schakeling te ontwerpen. THT word toegepast in producten waarbij meer betrouwbaarheid, deugdelijkheid en bedrijfszekerheid word geeist aangezien de THT minder gevoelig zijn tegen schokkingen en hoge temperaturen. THT technologie is gebruikelijk bij test en prototype ontwikkeling waarbij handmatige bewerking nodig zijn. Deze technologie heeft zijn bestaan tot nu toe behouden omdat niet alle componenten door SMT technolgie te vervaardigen is en ook omdat bepaalde THD componenten goedkoper uitkomen dan SMD componenten.

[bookmark: _Toc439542903]1.4.2 De SMT
SMT is een ander ontwerp technolgie die wordt toegepast bij het vervaardigen van SMT printborden. Voor 1980 was THT de enige pcb ontwerp technologie. Na 1980 kwam de SMT technologie die heel voordeliger en goedkoper uitvoerbaar was en nogsteeds is. Tegenwoordig wordt bijna alle electronische hardware met de SMT technologie vervaardigd. SMT is essentieel geworden bij pcb design en manufacturing en heeft de kwaliteit en prestatie verbeterd. SMT wordt steeds gemoderniseerd en steeds meer gebruikt. SMT is een kapitaalintesieve en arbeidsextensieve technologie. Hierbij wordt menselijke arbeid vervangen door dure CNC machines en andere soorten freesmachines voor het vervaardigen van pcb borden.




[bookmark: _Toc439542904]2 Drie maieren van print design
[bookmark: _Toc439542905]2.1 design manieren 
Er zijn vele manieren voor het ontwerp van printborden. In dit verslag gaan wij drie simpele en veel toegepaste methodes beschrijven. De drie methodes zijn:
· Pcb ontwerp door middel van Etsen 
· Pcb ontwerp door middel Freesmachine 
· Pcb ontwerp door middel Laserprinter 
[bookmark: _Toc439542906]2.1.1  etsen 
Etsen is de eerste en oudste manier bij pcb design. Etsen werd toegepast toen er nog geen mogelijkheid voor automatisering bestond. Deze manier werd gebruikt door hobbyisten. Tegenwoordigword het nog steeds gebruikt maar heel weinig. Etsen is een oppervlaktebehandeling waarbij een oppervlak (zoals een metaal) met een – meestal vloeibaar middel behandeld wordt. Hierbij treedt een chemische reactie op waarbij het (koperen)oppervlak gedeeltelijk oplost. In het geval van een metaal en een zuur gaat het om een redoxreactie. In feite zou men het een vorm van gecontroleerde, gewenste corrosie kunnen noemen.
Enkele toepassingen van etsen
· Binnen het metaalkundig onderzoek wordt het etsen gebruikt om bepaalde details van een microstructuur te laten corroderen, zodat ze zichtbaar worden op een oppervlak en ze met de lichtmicroscoop bekeken kunnen worden. Het gebruikte etsmiddel is afhankelijk van het materiaal dat geëtst wordt, en de precieze details die er bekeken moeten worden.
· Glas kan worden geëtst met waterstoffluoride of ammoniumfluoride om er afbeeldingen op aan te brengen. Met een mal wordt een patroon aangebracht. Het glas wordt in een zuur gedompeld. Het fluorwaterstof reageert met het glas. De uitvinding werd in 1787 gedaan door Jean-Pierre Marcassus de Puymaurin in Toulouse. 
· Elektronische schakelingen worden vaak gemaakt door een dunne laag koper op een isolerende ondergrond zodanig te etsen (met ammoniumpersulfaat, ferrichloride of een mengsel van zoutzuur en waterstofperoxide) dat er verbindingen(gedrukte bedrading) overblijven tussen de verschillende elektronische onderdelen.
· Binnen de wereld van de kunst wordt het etsen gebruikt als diepdruktechniek waarbij er getekend wordt op een met vernis afgedekte koperen of zinken plaat. De tekening wordt vervolgens ingebeten in zuur en op vochtig papier afgedrukt. 

Etsmiddelen 
Om bepaalde bestanddelen van een metaaloppervlak reliëf te geven of met specifieke kleuren op te doen lichten gebruikt men chemische middelen, waardoor het beeld onder een microscoop beter zichtbaar of herkenbaar wordt. Enige voorzichtigheid hierbij is wel raadzaam (kleding- en oog/huid-bescherming) omdat het vaak om vrij agressieve chemicaliën gaat, zoals zoutzuur voor het aantonen van poreuze plaatsen, scheurtjes, vezelrichtingverloop in gewoon staal. 
Onderstaande tabel geeft een overzicht van een aantal veel gebruikte etsmiddelen bij metaalkundig onderzoek:  
	Legering
	Etsmiddel
	Samenstelling
	Opmerking

	Staal (algemeen)
	2% nital
	
	

	Staal (perliet)
	4% picrinezuur in alcohol
	
	de laagjescementiet zijn hiermee beter te zien

	Staal (cementiet)
	alkalischnatriumpicraat
	
	

	Staal (gehard)
	Kourbatoff
	
	

	Staal (austeniet)
	Kalling of Vilella
	Villela: 3 delenglycerine, 2 delen zoutzuur en 1 deelsalpeterzuur
	Kalling omcarbiden te zien, Vilella voorkorrelgrenzen

	Koper en -legeringen (algemeen)
	ammoniumpersulfaat of ammoniak
	
	

	Koper-nikkel en α-β-messing
	ijzer(III)chloride in alcohol
	
	Snelle etser voor moeilijk aantastbare legeringen

	Aluminium (macro-niveau)
	eerst vloeizuur (HF), daarna koningswater
	
	HF tot gasontwikkeling begint, diepetsen met koningswater

	Aluminium (micro-niveau)
	Keller & Wilcox
	
	Snelle etser

	Aluminiumlegering
	NaOH in water
	
	Etstemperatuur 50°

	Tin en -legeringen
	HCl in alcohol
	
	

	Zink en -legeringen
	HCl in alcohol
	
	

	Nikkel en –legeringen
	Ammoniumpersulfaat
	
	



[bookmark: _Toc439542907]2.1.2 freesmachine
Een freesmachine of freesbank is een machine die met een snel ronddraaiend stuk gereedschap, de frees, een vorm of profiel kan frezen uit een stuk materiaal.
Een freesmachine is een machine voorzien van een frees waarmee verschillende materialen zoals staal, aluminium, kunststof, hout en andere materialen verspaand kunnen worden. Het is mogelijk om met een freesbank ingewikkelde vormen in materialen te maken zoals, sleuven, gaten, kottergaten, eilanden, kamers, enz.. Bij een freesbank, in tegenstelling tot bijvoorbeeld een draaibank, draait het gereedschap in plaats van het werkstuk.
De machines zijn in 3 groepen te verdelen, horizontale, verticale en universele freesbanken. Het verschil tussen horizontaal en verticaal is de richting van de spil-as waarin het gereedschap wordt gespannen. De universele freesbank bevat een verdraaibare kop van de spil-as waarmee de spil-as in zowel horizontale als verticale richting kan worden geplaatst. Ook is het mogelijk om onder verschillende hoeken te werken. Er ook freesbanken waarbij de opspantafel de mogelijkheid van draaien heeft. Als dit gebeurt in stappen van een aantal graden praten we over indextafels (indexeren). Als er een verdraaiing van 0.001 graad mogelijk is dan heten ze NC-gestuurde tafels. Speciale universele freesbanken zijn de vijfassige waarbij zowel de spil als de tafel kunnen draaien. Als dit gelijktijdig NC gestuurd gebeurt dan praten we over vijfassigsimultaanfrezen (toegepast op vlakken met bijvoorbeeld dubbele krommingen).
Een freesbank bestaat uit een spil-as waarmee het gereedschap aangedreven wordt en een opspangedeelte voor het werkstuk dat eenbed heet. Op dit bed is met behulp van T-sleuven het werkstuk rechtstreeks of met een machineklem op te spannen.
Het bed kan verplaatst worden met spindels waarop een nonius is gemonteerd. Een nonius is een ronde schijf waarop een schaalverdeling is gegraveerd. Door tijdens het draaien van de spindel het aantal omwentelingen met de schaalverdeling te vermenigvuldigen wordt de afstand die verplaatst wordt uitgerekend. Tegenwoordig vindt meestal digitale uitlezing plaats waarmee de directe absolute maten kunnen worden afgelezen.
Er zijn 3 richtingen, assen, die belangrijk zijn voor de verplaatsing van het bed, De X-as, Y-as en de Z-as. Voor de freesbank staand is de;
X-as, de beweging van links naar rechts en terug.
Y-as, de beweging van voor naar achteren en terug.
Z-as, de beweging op en neer.
Een freesbank kan "conventioneel" (met handbediening) zijn, of computergestuurd (CNC: Computer Numerical Control).

Soorten freesmachines
Conventionele freesbank
Conventionele freesbanken zijn banken die geheel met de hand bediend moeten worden. Er is weliswaar wel een voeding aanwezig waarmee de assen automatisch aan of uitgezet kunnen worden, maar de afstand die afgelegd moet worden, wordt door de bewerker gedaan met behulp van het aan of uitzetten van de voedingsknop. De conventionele banken worden wat minder gebruikt omdat er daar voor in de plaats veel CNC-banken zijn gekomen. Deze CNC banken worden vaak genoemd onder de vakterm 'bewerkingscentrum'. Hiermee zijn zeer complexe werkstukken te realiseren.
Andere soorten freesmachines:
· kettingfreesmachine
· handbovenfreesmachine
· bokfreesmachine
· bovenfreesmachine
· trappenfrees
· inkroosmachine
Bijzondere freesmachines:
· freesmachine met verstelbare tafel
· freesmachine met schuin stelbare freesas
· freesmachines met speciale uitrusting voor het maken van pennen (aangebouwde rollentafel)
· lamellenfrees (voor het frezen van de specifieke 'lamello'-verbinding)
· stobbenfrees (voor het frezen van een boomstomp en wortels)



Diversen
De opening in de freestafel moet zo klein mogelijk gehouden worden bij het bovenaan frezen om maximaal steun te geven aan het werkstuk. Dit is vooral belangrijk bij werkstukken met een kleine houtsectie.
De geleiderschoenen moeten zo dicht mogelijk bij het snijgereedschap aansluiten; dit geeft grotere veiligheid wegens maximale steun aan het werkstuk (vooral belangrijk bij kleinere houtsecties) en de aanvoergeleiderschoen werkt eveneens als spaanbreker zodat afsplintering voorkomen wordt.
Bij het frezen van grote profielen wordt een dichte aansluiting van de geleiderschoenen verkregen door een houten (multiplex) schoen opgelegd, zodat de gehele profieldiepte in de opgelegde schoen kan opgenomen worden.
Kleine stukken kunnen veilig geprofileerd worden:
· een liniaal als geleider in de geleideropening
· een aangepast duwhout
· een verticale drukker
· een handgreep te plaatsen op het duwhout
· een klemtoestel, met klemming door een excentrische schijf: hoe harder het toestel op de tafel gedrukt wordt, hoe groter de klemming op het werkstuk wordt.
Bij handdoorvoer van kleine stukken gebruikt men steeds: duwhout, handgreep, verticale drukker, liniaal als geleider in de geleideropening, klemtoestel.
Bij het uitvoeren van invalwerk moet men rekening houden met voor lijsten en sponningen steeds zo veel mogelijk onderaan werken en steeds zorgen voor een goede aanslag. Bij groefprofielen steeds sterke aandacht voor goede aanslag op tafel om terugslag te vermijden

[bookmark: _Toc439542908]2.1.3 laserprinter
Een laserprinter drukt tekst en afbeeldingen af door toner (zwart of gekleurd poeder) aan het papier te hechten. Oorspronkelijk maakten printers hierbij gebruik van laserlicht (vandaar de naam), maar in het spraakgebruik worden ook led-printers 'laserprinters' genoemd. De laserprinter werd in 1969 uitgevonden bij Xerox door onderzoeker Gary Starkweather.

Techniek
De techniek (xerografie) voor monochrome laserprinters gaat in het kort als volgt. Er is een ronde koker (de 'drum'), die met lichtgevoelig materiaal is bedekt. Vroeger was datseleen, maar tegenwoordig gebruikt men silicium, dat lichtgevoeliger is. Die drum wordt eerst met statische elektriciteit een negatieve lading gegeven. 
Dit gebeurt door een elektrisch geladen draad (hoogspanning!) dichtbij de drum (corona), maar tegenwoordig ook met een geladen rol die de lading overdraagt op de drum. Vervolgens wordt op die drum een afbeelding geprojecteerd met licht. Dit kan laserlicht zijn dat via een roterende polygonale spiegel wordt geprojecteerd. Tegenwoordig wordt dit soms ook gedaan door belichting met een regel ledjes over de breedte van de drum. Waar de drum wordt belicht verliest de drum zijn elektrische lading door het foto-elektrisch effect. Op de drum is nu in de vorm van wel/geen elektrische lading de af te drukken afbeelding al aanwezig. Hierna wordt de drum blootgesteld aan toner poeder (plastic met zwart of gekleurd pigment). Dit is ook negatief geladen en wordt afgestoten door de niet-belichte delen van de drum, en hecht alleen op de wel belichte delen. Vervolgens rolt de drum over papier waar de toner op het papier wordt overgedragen. Soms extra geholpen door het papier iets elektrisch te laden. Tot slot wordt de toner op het papier gefixeerd in de fuser door middel van verwarming (tot wel 200 graden) en een drukrol. Het verwarmen kan op verschillende manieren gebeuren. Veel gebruikt is een holle rol met binnenin een verwarmingselement. Een massieve kleine rol komt ook voor (vaak in langzamere printers, dan kan bij lagere temperatuur toch voldoende fixatie plaatsvinden). In professionele omgevingen waar hoge volumes geprint worden kan ook ineens gefixeerd worden met een flitslamp.
Om de toner gelijkmatig te krijgen worden er soms ijzerdeeltjes aan toegevoegd. Vervolgens wordt er een magneet boven de toner geplaatst, zodat rondom de magneet er een mooie hoeveelheid toner klaarstaat, om door de drum aangetrokken te worden.
De techniek bij een kleurenprinter gebruikt soortgelijke technieken maar de toner wordt op verschillende manieren aangebracht op het papier. Het papier kan herhaaldelijk langs dezelfde drum geleid worden (met steeds een andere kleur). Ook kan een band (transfer-belt) gebruikt worden.

Onderhoud
In tegenstelling tot printers die met een printkop inktdruppeltjes op het papier spuiten (inkjet printers) zijn er bij een laserprinter geen spuitmondjes die verstopt kunnen raken. Ook is er geen heen en weer bewegende printkop, die voor onnauwkeurigheden kan zorgen. Bij een laserprinter zijn er wel hoge elektrische spanningen, die stof kunnen aantrekken. Daardoor kan de kwaliteit achteruitgaan.
Als de toner gemorst wordt, neem dit dan altijd op met een doek die eventueel vochtig is gemaakt met koud water. Bij warm water smelten de kunststof tonerdeeltjes en is de toner bijna niet meer te verwijderen. Toner is zo fijn dat bij gebruik van een stofzuiger zonder HEPA-filter, de deeltjes gewoon weer de ruimte worden ingeblazen.



Lazerpinter in vergelijking met injektprinter
Het vooroordeel is dat een laserprinter duurder is in aanschaf, maar goedkoper in het gebruik. Tegenwoordig is dit zeker geen harde wetmatigheid meer. Er moet eigenlijk per geval bekeken worden naar de aanschaf- en gebruikskosten om een totaalplaatje te maken. Dit verschilt fors per merk en type. Bij sommige merken vervang je toner en drum ineens (duurdere tonercartridge maar geen aparte drum te vervangen). Bij andere merken is de toner veel goedkoper maar moet na enkele tienduizenden afdrukken de drum vervangen worden. Bij sommige inkjetprinters vervang je inktreservoir en printkop ineens, bij andere niet. Ook is er verschil of je ineens een hele driekleureninkttank moet vervangen of dat de inkt per kleur vervangen kan worden.
Tegenwoordig kan ook bij weinig gebruik een inkjet behoorlijk duur uitpakken. Omdat de resolutie steeds hoger wordt, en de spuitgaatjes steeds kleiner, is het risico op verstopping veel groter. Er wordt tegenwoordig veel inkt verspild aan reinigingsprogramma's, die de printer zelfstandig uitvoert. Er zijn ervaringen waarbij bij 20 zwart printjes in minder dan een half jaar, toch alle inkt, zowel zwart als kleur, op was door het automatische reinigingsprogramma.
De meeste toners hebben een hogere printcapaciteit dan inktcartridges. De aanschafprijs lijkt dan hoog - zeker als je er voor een kleurenlaserprinter ineens 4 moet kopen - maar de prijs per pagina is meestal lager.
Overige verschillen zoals die vroeger golden, zoals geluidsproductie, formaat, aanschafprijs en opstarttijd, zijn voor een groot deel achterhaald.
De voor- en nadelen van de laserprinter en de inktjetprinter:
Voordelen inkjetprinter
· Is tegenwoordig bijna altijd in staat zowel zwart als kleur te printen.
· Bij gelijke functionaliteit goedkoper in aanschaf.
· Print fotokwaliteit
· Energiezuiniger doordat geen fuser hoeft te worden opgewarmd.

Nadelen inkjetprinter
· Inktpatronen en/of inktkoppen kunnen verdrogen, of worden opgemaakt aan reinigingsprogramma's.
· Inkt op papier is niet watervast, kan dus vlekken. (sommige fabrikanten gebruiken wel watervaste zwarte inkt)
· Hebben vaak specifieke drivers nodig. Die vaak voor een volgende versie van het besturingssysteem niet meer worden gemaakt. Nieuwe windowsversie betekent dan nieuwe printer kopen. Dit speelt vooral bij de goedkopere instapmodellen.
· Bij hogere bedrukkingsgraad wordt het papier nat.
· Inkt drukt iets meer door, minder geschikt voor dubbelzijdig printen omdat je de afdruk van de andere kant kan zien.

Voordelen Laserprinter
· Hogere printsnelheid ten opzichte van een inkjetprinter
· De afdrukken zijn watervast.
· De afdrukken zijn droog.
· Toner verdroogt niet, maar kan onder extreme omstandigheden wel klonteren.
· Grotere kans dat de printer bruikbaar blijft bij een volgende versie van een besturingssysteem. Bijvoorbeeld door ondersteunen van generieke printertalen als PCL6 en PCL5.

Nadelen Laserprinter
· Vanuit standby moet de printer opwarmen voor de eerste print. Er zijn echter consumentenprinters die dit in tien seconden doen.[1]
· Printer verbruikt meer elektriciteit.
· Minder (tot nauwelijks) geschikt voor het afdrukken van foto's (hierin zit wel veel verschil tussen de diverse merken en typen).













[bookmark: _Toc439542909]3 CAM en CAD
[bookmark: _Toc439542910]3.1 CAM
Computer-Aided Manufacturing (meestal afgekort tot CAM) is gericht op de toepassing van de computer bij de fabricage van onderdelen en producten. CAM wordt, net als CAD gerealiseerd door op maat gemaakte softwarepakketten.
Algemeen geldt dat een CAM-pakket in staat is om verschillende soorten CAD-bestanden, zoals DWG-, DXF-, STEP- of SLDPRT-bestanden, in te laden. Daarnaast kan men zelf het CAM-pakket gebruiken om productcontouren te tekenen. Wanneer dit gebeurd is, worden de bewerkingen aan het product/contour toegekend. CAM-pakketten zijn vaak erg uitgebreid en zijn meestal voorzien van handige bewerkingstrategieën. Het bepalen van de opspanningen en het kiezen van de gereedschappen verloopt op dezelfde grafisch interactieve wijze als bij het ontwerpen. De programmeur wijst de vormelementen van het product aan op het beeldscherm. Het inschrijven van maten op de tekening is dan ook overbodig. De berekende gereedschapsbaan wordt meteen op het beeldscherm getoond.
De directe voordelen van CAM manifesteren zich in:
3. Een aanmerkelijke verkorting van de werkvoorbereidingstijd;
4. Een drastische vermindering van fouten in de programmering van de productiewerktuigen;
5. Een efficiëntere inzet van de productiemiddelen in de werkplaats alsmede een betere kwaliteitsbeheersing.

[bookmark: _Toc439542911]3.2 CAD
CAD is een letterwoord dat staat voor Computer-Aided Drafting. Nadien is dit geëvolueerd naar Computer-Aided Design. Vrij vertaald in het Nederlands betekent dit "met behulp van de computer tekenen en/of ontwerpen", of, korter, "computergesteund ontwerpen". CAD wordt toegepast in diverse vakgebieden waaronder de architectuur (ook wel 'Computer Aided Architectural Design CAAD), bouwkunde, landmeten, civieletechniek, stedenbouw, technisch beheer, werktuigbouwkunde, elektrotechniek en elektronica,staalbouw, wegenaanleg, topografie, industrieel ontwerp, en archeologie. Er wordt onderscheid gemaakt tussen 2D-, 2½D- en 3D-systemen. De 2D-systemen worden gebruikt om technische tekeningen te maken, de 2½D-systemen zijn een uitbreiding met diepte voor CNC-gestuurde machines (CAM) en de 3D-systemen werken metdraad-, oppervlakte-, volume- of solid-modellen. Met deze laatst genoemde kunnen dan bij sommige implementaties ook weer min of meer volledige 2D-tekeningen gegenereerd worden. De meeste CAD-systemen werken (of zijn compatibel) met het DWG-formaat (DraWinG). In de bouwkunde, civiele techniek en installatietechniek is de volgende stap in CAD-tekensystemen, na het 3D-systeem, het BIM: Building Information Model of Bouwwerk Informatie Model. Aan 3D-objecten wordt ook andere gegevens gekoppeld. Het onafhankelijk uitwisselingsformaat van een BIM is IFC.




[bookmark: _Toc439542912]4 Eagle Project
Als opdracht moesten wij een project met EAGLE uitvoeren. Hierbij ging het dat wij een schema(schematic) van de schakeling moesten en daarmee een pcb print layout(board) moesten maken. Deze tekening moesten wij ontwerpen met de design rules van EAGLE. Verder in dit hoofstuk zullen wij onze project uitwerken. 
[bookmark: _Toc439542913]4.1 Eagle schematic
[image: ]De Schematic die wij hebben getekend hebben wij gekozen vanuit het internet. Het gaat om een Panic Alarm Circuit. Deze schakeling kan een handje helpen bij het aantrekken van aandacht van de buren bij een inbraak s’avonds. Met een klap genereert de alarm schakeling en een luide politie alarm. Een schematic (schema) is het begin van elke electronische project en pcb design. Bij het tekenen van de schema moesten wij een library downloaden waarin de IC um3561 voorkomt. Al de resterende componenten kwamen al voor in de Eagle libraries. Figuur 1


Bij het tekenen hebben wij gebruik gemaakt enkele tools in EAGLE. De meeste tools komen voor in de toolbar in EAGLE die zich aan de uiterst links bevindt bij de standaard configuraties van EAGLE. De tools die wij allemaals hebben gebruikt zijn:
· De add tool
Deze tool wordt gebruikt om voorkomende componenten uit de library te plaatsen en bepaalde andere dingen als tekenschema(frames).
· Move tool
De move tool wordt gebruikt om componenten te schuiven naar de gewenste stand.

· Copy tool 
Dit wordt gebruikt om componenten te copieëren. Door gebruik te maken van deze tool bespaar je tijd bij het plaatsen van een aantal van dezelfde componenten.
· Mirror tool
Deze tool wordt gebruikt om componenten te spiegelen.
· Rotate tool 
Met deze tool is het mogelijk de componenten te roteren. 
· Group tool 
Met deze tool is het mogelijk componenten te groeperen en in keer een bepaalde handeling zoals verwijderen, copieëren, schuiven, spiegelen enzovoorts te plegen.
· Change tool 
Met deze tool kunnen bepaalde instellingen gewijzigd of geschakeld worden.
· Paste tool 
Met de paste tool wordt het gekopieerde bijgevoegd.
· Remove tool 
Met deze tool worden geselecteerde componenten verwijderd.
· Pinswap tool 
Met deze tool kunnen de verbindingen aan de componenten voetjes verwisseld worden.
· Name tool
Met deze tool kan de naam van de component bijgezet worden.
· Value tool 
Met de value tool kan de waarde van de component zichtbaar worden gemaakt.
· Smash tool 
Met de smash tool kan de zowel de naam,waarde als de component van elkaar gescheiden worden.
· Split tool
Met de split tool is het mogelijk een verbinding te splijten.
· De invoke tool
Met de invoke tool worden voedingspinnen van ic’s die meestal onzichtbaar zijn zichtbaar gemaakt.
· Wire tool 
Met de wire tool kunnen lijnen getekend worden voor bijvoorbeeld een tekenhoofd.
· Text tool 
Deze tool wordt gebruikt om tekst te plaatsen op het schema.
· Bus tool 
Met de bus tool kunnen draden(wires) gebundeld worden.
· Net tool 
Met de net tool worden draden geplaatst die componenten onderling verbinden.
· Junction tool 
Deze tool wordt gebruikt om twee of meer overlappende draden te verbinden.
· Label tool 
Met de label tool wordt de naam van een net of bus aangemaakt.
· Electrical rule check(ERC) tool 
Met de ERC tool kan de schakeling automatisch gecontroleerd worden op electrische verbindingsfouten.
· Net classes tool
Met deze tool kunnen de draden hun klassen toegewezen worden. Met klasse wordt de soort(vcc, ground enz.) bedoeld.
· Layers tool
Met de layers tool kunnen gewenste layers aan en uit geschakeld worden.
 
[bookmark: _Toc439542914]4.2 Eagle board
De Panic Alarm circuit kan op een pcb bord geprint worden. Met de schema van de Panic Alarm circuit kan een board file gemaakt worden. Deze board file zal aangeven hoe de bord na het uitprinten zal uitzien. De board file kan naar wens gemaakt worden. Door componenten te plaatsen naar eigen keus en de Eagle rules te bewerken kan eigen bord gemaakt worden. Deze bord kan naar wil uitgeprint worden met een CNC freesmachine. De bord van Panic Alarm circuit zullen we verder in dit paragraaf uitwerken.
[image: ]
Figuur 2
De figuur hierboven geeft de uitzicht van de board file aan. De board file in deze figuur bestaat uit alle layers.
[image: ]
Figuur 3
Figuur 3 geeft de componenten, de gaten, en de vias  op het bord aan. Ook zijn namen van de componenten aangegeven en de bijbehorende waarden.
[image: ]
Figuur 4
Bovenstaand figuur geeft de bottom layer aan met banen en de gaten voor de THD componenten.
[image: ]
Figuur 5
De figuur hierboven geeft de gespiegelde bottom layout aan.
[image: ]
Figuur 6
De figuur hierboven geeft de toplayer aan met de gaten voor de THD’s.


[bookmark: _Toc439542915]5 Eagle Rules
Het programma Eagle waarmee het mogelijk is printborden visueel te maken heeft regels(Rules). Bij deze programma kennen wij de twee welbekende Design Rule Check(DRC) en de Electrical Rule Check(ERC). Beide rules worden verder in de paragraven beschreven.
[bookmark: _Toc439542916]5.1 Design Rule Check
Design Rule Check is een hulpmiddel in EAGLE om de pcb printlayout te controleren naar enkele bekende voorgeprogrammeerde fouten. Design Rules zijn regels die niet overschreden mogen worden bij de printlayout. Indien de regels overschreden zijn kan het mogelijk zijn dat de bord niet geprint kan worden of geprint zal worden met ongewenste fouten. Deze fouten kunnen na het geprint te zijn van de borden niet meer gecorrigeerd worden waardoor het bord onbruikbaar kan worden. Enkele rules zijn:
1. De Design Rule Check let bijvoorbeeld op gaten die veel groter zijn dan de voetjes van de component die daar ter plekke zou komen.
2. Design Rule check let ook extra gaten die niet gebruikt worden en zal de melding geven om ze weg te halen.
3. Design Rule Check  daarnaast ook op of grote gaten banen overlappen. Indien dat wel zo is geeft het een melding.
4. Design Rule Check controleert ook of een vias en een gat elkaar overlappen, dat mag ook niet zal de programma een melding geven.
[bookmark: _Toc439542917]5.2 Electrical Rule Check
 Het programma Eagle heeft naar de DRC ook een ERC. De ERC controleert op bekende voorgeprogrammeerde electrische fouten. Electrical Rules mogen als Design Rules ook niet overschreden worden. Indien de regels van ERC overschreden worden is het mogelijk dat de schakeling niet zal werken. Deze fouten zijn ook niet te herstellen om het printbord alsnog te laten werken. De ERC heeft een aantal regels. Enkele zijn:
1. Een Electrical Rule kan zijn kortsluiting. Bij een kortsluiting wordt er een melding weergegeven.
2. Een ander regel is dat banen niet dunner mogen zijn dan de gat waar het naar toe leidt.
3. Een ander regel is weer dat banen elkaar niet mogen overlappen. Een overlapping wordt als fout gerekend met als gevolg een melding.
4. [bookmark: _GoBack]Twee voedingsbanen met niet dezelfde polarisatie mogen niet door een vias aan elkaar verbonden zijn. Dit is ook een kortsluiting en mag niet voorkomen.
5. De electrische banen mogen niet te dichtbij de randen zijn anders geeft het programma ook een foutmelding.
6. Banen onderling mogen niet te dichtbij van elkaar zijn anders geeft het programma een foutmelding.
De regels moeten goed in acht worden genomen voor een goede en succesvolle pcb design. Deze regels zorgen voor betere prestaties en een langere levensduur van het bord en circuit.




























[bookmark: _Toc439542918]Conclusie
Cadsoft Eagle is een uitgebreidde en professionele programma op het gebied van pcb design. Bij pcb design zijn er twee technologies met elk hun eigen componenten. Met de programma kan beide technologieën op een pcb bord worden ontworpen. Het is belangrijk om de Design Rules en Electrical Rules goed in acht te nemen. Door de regels in acht nemen kan men professionele pcb borden ontwerpen.
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De library file die voor eagle die we moesten bijplaatsen.
· 
De bottom printlayout.
· 
De mirrored bottom printlayout.
· 
De top printlayout.
· 
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· 
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· 
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Eagle voor beginners.
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Version Schematic sheetslayersPCB size use note cost

Professional 999 164x4 m any $ 1640, € 1385

Standard 99 6160x100 mmany $ 820, € 690

Hobbyist 99 6160x100 mmfor individual, non commercial use only $ 169, € 140

Light 1 2100x80 mm any $ 69, € 62

Freeware 1 2100x80 mm non-profit applications Support only via email or forum $ 0, € 0
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 <b>WIMA Capacitors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <B>MKS2</B>, 5 x 3 mm, grid 2.54 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Resistors, Capacitors, Inductors</b><p>
Based on the previous libraries:
<ul>
<li>r.lbr
<li>cap.lbr 
<li>cap-fe.lbr
<li>captant.lbr
<li>polcap.lbr
<li>ipc-smd.lbr
</ul>
All SMD packages are defined according to the IPC specifications and  CECC<p>
<author>Created by librarian@cadsoft.de</author><p>
<p>
for Electrolyt Capacitors see also :<p>
www.bccomponents.com <p>
www.panasonic.com<p>
www.kemet.com<p>
http://www.secc.co.jp/pdf/os_e/2004/e_os_all.pdf <b>(SANYO)</b>
<p>
for trimmer refence see : <u>www.electrospec-inc.com/cross_references/trimpotcrossref.asp</u><p>

<table border=0 cellspacing=0 cellpadding=0 width="100%" cellpaddding=0>
<tr valign="top">

<! <td width="10">&nbsp;</td>
<td width="90%">

<b><font color="#0000FF" size="4">TRIM-POT CROSS REFERENCE</font></b>
<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=2>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=3 FACE=ARIAL><B>RECTANGULAR MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BOURNS</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BI&nbsp;TECH</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">DALE-VISHAY</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PHILIPS/MEPCO</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MURATA</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PANASONIC</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">SPECTROL</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MILSPEC</FONT>
      </B>
    </TD><TD>&nbsp;</TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3 >
      3005P<BR>
      3006P<BR>
      3006W<BR>
      3006Y<BR>
      3009P<BR>
      3009W<BR>
      3009Y<BR>
      3057J<BR>
      3057L<BR>
      3057P<BR>
      3057Y<BR>
      3059J<BR>
      3059L<BR>
      3059P<BR>
      3059Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      89P<BR>
      89W<BR>
      89X<BR>
      89PH<BR>
      76P<BR>
      89XH<BR>
      78SLT<BR>
      78L&nbsp;ALT<BR>
      56P&nbsp;ALT<BR>
      78P&nbsp;ALT<BR>
      T8S<BR>
      78L<BR>
      56P<BR>
      78P<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      T18/784<BR>
      783<BR>
      781<BR>
      -<BR>
      -<BR>
      -<BR>
      2199<BR>
      1697/1897<BR>
      1680/1880<BR>
      2187<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      8035EKP/CT20/RJ-20P<BR>
      -<BR>
      RJ-20X<BR>
      -<BR>
      -<BR>
      -<BR>
      1211L<BR>
      8012EKQ&nbsp;ALT<BR>
      8012EKR&nbsp;ALT<BR>
      1211P<BR>
      8012EKJ<BR>
      8012EKL<BR>
      8012EKQ<BR>
      8012EKR<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      2101P<BR>
      2101W<BR>
      2101Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      2102L<BR>
      2102S<BR>
      2102Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVMCOG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      43P<BR>
      43W<BR>
      43Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      40L<BR>
      40P<BR>
      40Y<BR>
      70Y-T602<BR>
      70L<BR>
      70P<BR>
      70Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      -<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SQUARE MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
   <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3250L<BR>
      3250P<BR>
      3250W<BR>
      3250X<BR>
      3252P<BR>
      3252W<BR>
      3252X<BR>
      3260P<BR>
      3260W<BR>
      3260X<BR>
      3262P<BR>
      3262W<BR>
      3262X<BR>
      3266P<BR>
      3266W<BR>
      3266X<BR>
      3290H<BR>
      3290P<BR>
      3290W<BR>
      3292P<BR>
      3292W<BR>
      3292X<BR>
      3296P<BR>
      3296W<BR>
      3296X<BR>
      3296Y<BR>
      3296Z<BR>
      3299P<BR>
      3299W<BR>
      3299X<BR>
      3299Y<BR>
      3299Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      -<BR>
      64W&nbsp;ALT<BR>
      -<BR>
      64P&nbsp;ALT<BR>
      64W&nbsp;ALT<BR>
      64X&nbsp;ALT<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66P<BR>
      66W<BR>
      66X<BR>
      67P<BR>
      67W<BR>
      67X<BR>
      67Y<BR>
      67Z<BR>
      68P<BR>
      68W<BR>
      68X<BR>
      67Y&nbsp;ALT<BR>
      67Z&nbsp;ALT<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      5050<BR>
      5091<BR>
      5080<BR>
      5087<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      T63YB<BR>
      T63XB<BR>
      -<BR>
      -<BR>
      -<BR>
      5887<BR>
      5891<BR>
      5880<BR>
      -<BR>
      -<BR>
      -<BR>
      T93Z<BR>
      T93YA<BR>
      T93XA<BR>
      T93YB<BR>
      T93XB<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      8026EKP<BR>
      8026EKW<BR>
      8026EKM<BR>
      8026EKP<BR>
      8026EKB<BR>
      8026EKM<BR>
      1309X<BR>
      1309P<BR>
      1309W<BR>
      8024EKP<BR>
      8024EKW<BR>
      8024EKN<BR>
      RJ-9P/CT9P<BR>
      RJ-9W<BR>
      RJ-9X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3105P/3106P<BR>
      3105W/3106W<BR>
      3105X/3106X<BR>
      3105Y/3106Y<BR>
      3105Z/3105Z<BR>
      3102P<BR>
      3102W<BR>
      3102X<BR>
      3102Y<BR>
      3102Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMCBG<BR>
      EVMCCG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      55-1-X<BR>
      55-4-X<BR>
      55-3-X<BR>
      55-2-X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      50-2-X<BR>
      50-4-X<BR>
      50-3-X<BR>
      -<BR>
      -<BR>
      -<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      64Y<BR>
      64Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3323P<BR>
      3323S<BR>
      3323W<BR>
      3329H<BR>
      3329P<BR>
      3329W<BR>
      3339H<BR>
      3339P<BR>
      3339W<BR>
      3352E<BR>
      3352H<BR>
      3352K<BR>
      3352P<BR>
      3352T<BR>
      3352V<BR>
      3352W<BR>
      3362H<BR>
      3362M<BR>
      3362P<BR>
      3362R<BR>
      3362S<BR>
      3362U<BR>
      3362W<BR>
      3362X<BR>
      3386B<BR>
      3386C<BR>
      3386F<BR>
      3386H<BR>
      3386K<BR>
      3386M<BR>
      3386P<BR>
      3386S<BR>
      3386W<BR>
      3386X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      25P<BR>
      25S<BR>
      25RX<BR>
      82P<BR>
      82M<BR>
      82PA<BR>
      -<BR>
      -<BR>
      -<BR>
      91E<BR>
      91X<BR>
      91T<BR>
      91B<BR>
      91A<BR>
      91V<BR>
      91W<BR>
      25W<BR>
      25V<BR>
      25P<BR>
      -<BR>
      25S<BR>
      25U<BR>
      25RX<BR>
      25X<BR>
      72XW<BR>
      72XL<BR>
      72PM<BR>
      72RX<BR>
      -<BR>
      72PX<BR>
      72P<BR>
      72RXW<BR>
      72RXL<BR>
      72X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      T7YB<BR>
      T7YA<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      TXD<BR>
      TYA<BR>
      TYP<BR>
      -<BR>
      TYD<BR>
      TX<BR>
      -<BR>
      150SX<BR>
      100SX<BR>
      102T<BR>
      101S<BR>
      190T<BR>
      150TX<BR>
      101<BR>
      -<BR>
      -<BR>
      101SX<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ET6P<BR>
      ET6S<BR>
      ET6X<BR>
      RJ-6W/8014EMW<BR>
      RJ-6P/8014EMP<BR>
      RJ-6X/8014EMX<BR>
      TM7W<BR>
      TM7P<BR>
      TM7X<BR>
      -<BR>
      8017SMS<BR>
      -<BR>
      8017SMB<BR>
      8017SMA<BR>
      -<BR>
      -<BR>
      CT-6W<BR>
      CT-6H<BR>
      CT-6P<BR>
      CT-6R<BR>
      -<BR>
      CT-6V<BR>
      CT-6X<BR>
      -<BR>
      -<BR>
      8038EKV<BR>
      -<BR>
      8038EKX<BR>
      -<BR>
      -<BR>
      8038EKP<BR>
      8038EKZ<BR>
      8038EKW<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      3321H<BR>
      3321P<BR>
      3321N<BR>
      1102H<BR>
      1102P<BR>
      1102T<BR>
      RVA0911V304A<BR>
      -<BR>
      RVA0911H413A<BR>
      RVG0707V100A<BR>
      RVA0607V(H)306A<BR>
      RVA1214H213A<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3104B<BR>
      3104C<BR>
      3104F<BR>
      3104H<BR>
      -<BR>
      3104M<BR>
      3104P<BR>
      3104S<BR>
      3104W<BR>
      3104X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      EVMQ0G<BR>
      EVMQIG<BR>
      EVMQ3G<BR>
      EVMS0G<BR>
      EVMQ0G<BR>
      EVMG0G<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMK4GA00B<BR>
      EVM30GA00B<BR>
      EVMK0GA00B<BR>
      EVM38GA00B<BR>
      EVMB6<BR>
      EVLQ0<BR>
      -<BR>
      EVMMSG<BR>
      EVMMBG<BR>
      EVMMAG<BR>
      -<BR>
      -<BR>
      EVMMCS<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMM1<BR>
      -<BR>
      -<BR>
      EVMM0<BR>
      -<BR>
      -<BR>
      EVMM3<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      62-3-1<BR>
      62-1-2<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67R<BR>
      -<BR>
      67P<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67X<BR>
      63V<BR>
      63S<BR>
      63M<BR>
      -<BR>
      -<BR>
      63H<BR>
      63P<BR>
      -<BR>
      -<BR>
      63X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>&nbsp;<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=3>
  <TR>
    <TD COLSPAN=7>
      <FONT color="#0000FF" SIZE=4 FACE=ARIAL><B>SMD TRIM-POT CROSS REFERENCE</B></FONT>
      <P>
      <FONT SIZE=4 FACE=ARIAL><B>MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3224G<BR>
      3224J<BR>
      3224W<BR>
      3269P<BR>
      3269W<BR>
      3269X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      44G<BR>
      44J<BR>
      44W<BR>
      84P<BR>
      84W<BR>
      84X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST63Z<BR>
      ST63Y<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST5P<BR>
      ST5W<BR>
      ST5X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3314G<BR>
      3314J<BR>
      3364A/B<BR>
      3364C/D<BR>
      3364W/X<BR>
      3313G<BR>
      3313J<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      23B<BR>
      23A<BR>
      21X<BR>
      21W<BR>
      -<BR>
      22B<BR>
      22A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST5YL/ST53YL<BR>
      ST5YJ/5T53YJ<BR>
      ST-23A<BR>
      ST-22B<BR>
      ST-22<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST-4B<BR>
      ST-4A<BR>
      -<BR>
      -<BR>
      -<BR>
      ST-3B<BR>
      ST-3A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVM-6YS<BR>
      EVM-1E<BR>
      EVM-1G<BR>
      EVM-1D<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      G4B<BR>
      G4A<BR>
      TR04-3S1<BR>
      TRG04-2S1<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      DVR-43A<BR>
      CVR-42C<BR>
      CVR-42A/C<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>
<FONT SIZE=4 FACE=ARIAL><B>ALT =&nbsp;ALTERNATE</B></FONT>
<P>

&nbsp;
<P>
</td>
</tr>
</table>
 
 
 <b>Aluminum electrolytic capacitors</b> reflow soldering<p>
SMD (Chip) Standard 085 CS<p>
http://www.bccomponents.com/
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 



 
 <b>Diodes</b><p>
Based on the following sources:
<ul>
<li>Motorola : www.onsemi.com
<li>Fairchild : www.fairchildsemi.com
<li>Philips : www.semiconductors.com
<li>Vishay : www.vishay.de
</ul>
<author>Created by librarian@cadsoft.de</author>
 
 
 <B>DIODE</B><p>
diameter 3 mm, horizontal, grid 12.7 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 



 
 <b>Microphon</b> from<p>
JLI Electronics - www.jlielectronics.com<br>
Panansonic - http://industrial.panasonic.com<br>
<p>
<author>librarian@cadsoft.de</author>
 
 
 <b>Mocrophone 4 x 1.5mm</b><p>
Source: Projects Unlimited Inc. Microphone_TOM-1545P-R_40092-1.pdf
 
 
 
 >NAME
 >VALUE



 
 <b>Linear Devices</b><p>
Operational amplifiers,  comparators, voltage regulators, ADCs, DACs, etc.<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>Small Outline Package 8</b><br>
NS Package M08A
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 



 
 UMC UM3561 (DIP-8)
<br>
<a href="http://jayakody2000lk.wordpress.com">jayakody2000lk.wordpress.com</a>
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>LEDs</b><p>
<author>Created by librarian@cadsoft.de</author><br>
Extended by Federico Battaglin <author>&lt;federico.rd@fdpinternational.com&gt;</author> with DUOLED
 
 
 <B>LED</B><p>
3 mm, round
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>NPN Transistors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>TO-92</b><p>
 grid 5.08 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Piher Potentiometers</b><p>
PC-16/16 mm carbon types<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>POTENTIOMETER</b><p>
single carbon potentiometer, 16 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Resistors, Capacitors, Inductors</b><p>
Based on the previous libraries:
<ul>
<li>r.lbr
<li>cap.lbr 
<li>cap-fe.lbr
<li>captant.lbr
<li>polcap.lbr
<li>ipc-smd.lbr
</ul>
All SMD packages are defined according to the IPC specifications and  CECC<p>
<author>Created by librarian@cadsoft.de</author><p>
<p>
for Electrolyt Capacitors see also :<p>
www.bccomponents.com <p>
www.panasonic.com<p>
www.kemet.com<p>
<p>
for trimmer refence see : <u>www.electrospec-inc.com/cross_references/trimpotcrossref.asp</u><p>

<map name="nav_main">
<area shape="rect" coords="0,1,140,23" href="../military_specs.asp" title="">
<area shape="rect" coords="0,24,140,51" href="../about.asp" title="">
<area shape="rect" coords="1,52,140,77" href="../rfq.asp" title="">
<area shape="rect" coords="0,78,139,103" href="../products.asp" title="">
<area shape="rect" coords="1,102,138,128" href="../excess_inventory.asp" title="">
<area shape="rect" coords="1,129,138,150" href="../edge.asp" title="">
<area shape="rect" coords="1,151,139,178" href="../industry_links.asp" title="">
<area shape="rect" coords="0,179,139,201" href="../comments.asp" title="">
<area shape="rect" coords="1,203,138,231" href="../directory.asp" title="">
<area shape="default" nohref>
</map>

<html>

<title></title>

 <LINK REL="StyleSheet" TYPE="text/css" HREF="style-sheet.css">

<body bgcolor="#ffffff" text="#000000" marginwidth="0" marginheight="0" topmargin="0" leftmargin="0">
<table border=0 cellspacing=0 cellpadding=0 width="100%" cellpaddding=0 height="55%">
<tr valign="top">

</td>
<! <td width="10">&nbsp;</td>
<td width="90%">

<b><font color="#0000FF" size="4">TRIM-POT CROSS REFERENCE</font></b>
<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=2>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=3 FACE=ARIAL><B>RECTANGULAR MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BOURNS</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BI&nbsp;TECH</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">DALE-VISHAY</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PHILIPS/MEPCO</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MURATA</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PANASONIC</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">SPECTROL</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MILSPEC</FONT>
      </B>
    </TD><TD>&nbsp;</TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3 >
      3005P<BR>
      3006P<BR>
      3006W<BR>
      3006Y<BR>
      3009P<BR>
      3009W<BR>
      3009Y<BR>
      3057J<BR>
      3057L<BR>
      3057P<BR>
      3057Y<BR>
      3059J<BR>
      3059L<BR>
      3059P<BR>
      3059Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      89P<BR>
      89W<BR>
      89X<BR>
      89PH<BR>
      76P<BR>
      89XH<BR>
      78SLT<BR>
      78L&nbsp;ALT<BR>
      56P&nbsp;ALT<BR>
      78P&nbsp;ALT<BR>
      T8S<BR>
      78L<BR>
      56P<BR>
      78P<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      T18/784<BR>
      783<BR>
      781<BR>
      -<BR>
      -<BR>
      -<BR>
      2199<BR>
      1697/1897<BR>
      1680/1880<BR>
      2187<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      8035EKP/CT20/RJ-20P<BR>
      -<BR>
      RJ-20X<BR>
      -<BR>
      -<BR>
      -<BR>
      1211L<BR>
      8012EKQ&nbsp;ALT<BR>
      8012EKR&nbsp;ALT<BR>
      1211P<BR>
      8012EKJ<BR>
      8012EKL<BR>
      8012EKQ<BR>
      8012EKR<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      2101P<BR>
      2101W<BR>
      2101Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      2102L<BR>
      2102S<BR>
      2102Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVMCOG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      43P<BR>
      43W<BR>
      43Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      40L<BR>
      40P<BR>
      40Y<BR>
      70Y-T602<BR>
      70L<BR>
      70P<BR>
      70Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      -<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SQUARE MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
   <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3250L<BR>
      3250P<BR>
      3250W<BR>
      3250X<BR>
      3252P<BR>
      3252W<BR>
      3252X<BR>
      3260P<BR>
      3260W<BR>
      3260X<BR>
      3262P<BR>
      3262W<BR>
      3262X<BR>
      3266P<BR>
      3266W<BR>
      3266X<BR>
      3290H<BR>
      3290P<BR>
      3290W<BR>
      3292P<BR>
      3292W<BR>
      3292X<BR>
      3296P<BR>
      3296W<BR>
      3296X<BR>
      3296Y<BR>
      3296Z<BR>
      3299P<BR>
      3299W<BR>
      3299X<BR>
      3299Y<BR>
      3299Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      -<BR>
      64W&nbsp;ALT<BR>
      -<BR>
      64P&nbsp;ALT<BR>
      64W&nbsp;ALT<BR>
      64X&nbsp;ALT<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66P<BR>
      66W<BR>
      66X<BR>
      67P<BR>
      67W<BR>
      67X<BR>
      67Y<BR>
      67Z<BR>
      68P<BR>
      68W<BR>
      68X<BR>
      67Y&nbsp;ALT<BR>
      67Z&nbsp;ALT<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      5050<BR>
      5091<BR>
      5080<BR>
      5087<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      T63YB<BR>
      T63XB<BR>
      -<BR>
      -<BR>
      -<BR>
      5887<BR>
      5891<BR>
      5880<BR>
      -<BR>
      -<BR>
      -<BR>
      T93Z<BR>
      T93YA<BR>
      T93XA<BR>
      T93YB<BR>
      T93XB<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      8026EKP<BR>
      8026EKW<BR>
      8026EKM<BR>
      8026EKP<BR>
      8026EKB<BR>
      8026EKM<BR>
      1309X<BR>
      1309P<BR>
      1309W<BR>
      8024EKP<BR>
      8024EKW<BR>
      8024EKN<BR>
      RJ-9P/CT9P<BR>
      RJ-9W<BR>
      RJ-9X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3105P/3106P<BR>
      3105W/3106W<BR>
      3105X/3106X<BR>
      3105Y/3106Y<BR>
      3105Z/3105Z<BR>
      3102P<BR>
      3102W<BR>
      3102X<BR>
      3102Y<BR>
      3102Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMCBG<BR>
      EVMCCG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      55-1-X<BR>
      55-4-X<BR>
      55-3-X<BR>
      55-2-X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      50-2-X<BR>
      50-4-X<BR>
      50-3-X<BR>
      -<BR>
      -<BR>
      -<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      64Y<BR>
      64Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3323P<BR>
      3323S<BR>
      3323W<BR>
      3329H<BR>
      3329P<BR>
      3329W<BR>
      3339H<BR>
      3339P<BR>
      3339W<BR>
      3352E<BR>
      3352H<BR>
      3352K<BR>
      3352P<BR>
      3352T<BR>
      3352V<BR>
      3352W<BR>
      3362H<BR>
      3362M<BR>
      3362P<BR>
      3362R<BR>
      3362S<BR>
      3362U<BR>
      3362W<BR>
      3362X<BR>
      3386B<BR>
      3386C<BR>
      3386F<BR>
      3386H<BR>
      3386K<BR>
      3386M<BR>
      3386P<BR>
      3386S<BR>
      3386W<BR>
      3386X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      25P<BR>
      25S<BR>
      25RX<BR>
      82P<BR>
      82M<BR>
      82PA<BR>
      -<BR>
      -<BR>
      -<BR>
      91E<BR>
      91X<BR>
      91T<BR>
      91B<BR>
      91A<BR>
      91V<BR>
      91W<BR>
      25W<BR>
      25V<BR>
      25P<BR>
      -<BR>
      25S<BR>
      25U<BR>
      25RX<BR>
      25X<BR>
      72XW<BR>
      72XL<BR>
      72PM<BR>
      72RX<BR>
      -<BR>
      72PX<BR>
      72P<BR>
      72RXW<BR>
      72RXL<BR>
      72X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      T7YB<BR>
      T7YA<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      TXD<BR>
      TYA<BR>
      TYP<BR>
      -<BR>
      TYD<BR>
      TX<BR>
      -<BR>
      150SX<BR>
      100SX<BR>
      102T<BR>
      101S<BR>
      190T<BR>
      150TX<BR>
      101<BR>
      -<BR>
      -<BR>
      101SX<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ET6P<BR>
      ET6S<BR>
      ET6X<BR>
      RJ-6W/8014EMW<BR>
      RJ-6P/8014EMP<BR>
      RJ-6X/8014EMX<BR>
      TM7W<BR>
      TM7P<BR>
      TM7X<BR>
      -<BR>
      8017SMS<BR>
      -<BR>
      8017SMB<BR>
      8017SMA<BR>
      -<BR>
      -<BR>
      CT-6W<BR>
      CT-6H<BR>
      CT-6P<BR>
      CT-6R<BR>
      -<BR>
      CT-6V<BR>
      CT-6X<BR>
      -<BR>
      -<BR>
      8038EKV<BR>
      -<BR>
      8038EKX<BR>
      -<BR>
      -<BR>
      8038EKP<BR>
      8038EKZ<BR>
      8038EKW<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      3321H<BR>
      3321P<BR>
      3321N<BR>
      1102H<BR>
      1102P<BR>
      1102T<BR>
      RVA0911V304A<BR>
      -<BR>
      RVA0911H413A<BR>
      RVG0707V100A<BR>
      RVA0607V(H)306A<BR>
      RVA1214H213A<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3104B<BR>
      3104C<BR>
      3104F<BR>
      3104H<BR>
      -<BR>
      3104M<BR>
      3104P<BR>
      3104S<BR>
      3104W<BR>
      3104X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      EVMQ0G<BR>
      EVMQIG<BR>
      EVMQ3G<BR>
      EVMS0G<BR>
      EVMQ0G<BR>
      EVMG0G<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMK4GA00B<BR>
      EVM30GA00B<BR>
      EVMK0GA00B<BR>
      EVM38GA00B<BR>
      EVMB6<BR>
      EVLQ0<BR>
      -<BR>
      EVMMSG<BR>
      EVMMBG<BR>
      EVMMAG<BR>
      -<BR>
      -<BR>
      EVMMCS<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMM1<BR>
      -<BR>
      -<BR>
      EVMM0<BR>
      -<BR>
      -<BR>
      EVMM3<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      62-3-1<BR>
      62-1-2<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67R<BR>
      -<BR>
      67P<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67X<BR>
      63V<BR>
      63S<BR>
      63M<BR>
      -<BR>
      -<BR>
      63H<BR>
      63P<BR>
      -<BR>
      -<BR>
      63X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>&nbsp;<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=3>
  <TR>
    <TD COLSPAN=7>
      <FONT color="#0000FF" SIZE=4 FACE=ARIAL><B>SMD TRIM-POT CROSS REFERENCE</B></FONT>
      <P>
      <FONT SIZE=4 FACE=ARIAL><B>MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3224G<BR>
      3224J<BR>
      3224W<BR>
      3269P<BR>
      3269W<BR>
      3269X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      44G<BR>
      44J<BR>
      44W<BR>
      84P<BR>
      84W<BR>
      84X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST63Z<BR>
      ST63Y<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST5P<BR>
      ST5W<BR>
      ST5X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3314G<BR>
      3314J<BR>
      3364A/B<BR>
      3364C/D<BR>
      3364W/X<BR>
      3313G<BR>
      3313J<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      23B<BR>
      23A<BR>
      21X<BR>
      21W<BR>
      -<BR>
      22B<BR>
      22A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST5YL/ST53YL<BR>
      ST5YJ/5T53YJ<BR>
      ST-23A<BR>
      ST-22B<BR>
      ST-22<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST-4B<BR>
      ST-4A<BR>
      -<BR>
      -<BR>
      -<BR>
      ST-3B<BR>
      ST-3A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVM-6YS<BR>
      EVM-1E<BR>
      EVM-1G<BR>
      EVM-1D<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      G4B<BR>
      G4A<BR>
      TR04-3S1<BR>
      TRG04-2S1<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      DVR-43A<BR>
      CVR-42C<BR>
      CVR-42A/C<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>
<FONT SIZE=4 FACE=ARIAL><B>ALT =&nbsp;ALTERNATE</B></FONT>
<P>

&nbsp;
<P>
</td>
</tr>
</table>
</BODY></HTML>
 
 
 <b>CECC Size RC2211</b> Reflow Soldering<p>
source Beyschlag
 
 
 
 
 
 
 >NAME
 >VALUE



 
 
 
 <b>Speaker 13 x 13mm</b>, 8 Ohm, 0.7W<p>
Source: pui audio inc. SMS-1308MS-2-R.pdf
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 

 
 
 
 




 
 <b>Transistors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>SOT-23</b>
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 



 
 LT-Spice library generated with :<br>
import-ltspice.ulp<br>
from: E:/Programme/LTC/LTspiceIV/lib/sym/Misc/*.asy<br>
at 12.06.2012 10:26:07
<p>
2N5458.DEV<br>
2N7002.DEV<br>
BATTERY.DEV<br>
CELL.DEV<br>
DIAC.DEV<br>
DIP8.DEV<br>
DIP10.DEV<br>
DIP14.DEV<br>
DIP16.DEV<br>
DIP20.DEV<br>
EPOLY.DEV<br>
EUROPEANCAP.DEV<br>
EUROPEANPOLCAP.DEV<br>
EUROPEANRESISTOR.DEV<br>
FIXEDIND.DEV<br>
JUMPER.DEV<br>
NE555.DEV<br>
NEONBULB.DEV<br>
NIGBT.DEV<br>
PENTODE.DEV<br>
PIGBT.DEV<br>
SCR.DEV<br>
TETRODE.DEV<br>
TOWTOM2.DEV<br>
TRIAC.DEV<br>
TRIODE.DEV<br>
URC.DEV<br>
URC2.DEV<br>
XTAL.DEV<br>
XVARISTOR.DEV<br>
 
 
 <b>Small Outline IC</b>
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 



 
 <b>FRIWO Supply Connectors (TEXAS)</b><p>
http://www.friwo.com/<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 PCB SUPPLY CONNECTOR<p>
FRIWO (TEXAS)
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 




 

 

 
 

 


 
 <b>EAGLE Design Rules</b>
<p>
Die Standard-Design-Rules sind so gewählt, dass sie für 
die meisten Anwendungen passen. Sollte ihre Platine 
besondere Anforderungen haben, treffen Sie die erforderlichen
Einstellungen hier und speichern die Design Rules unter 
einem neuen Namen ab.
 <b>EAGLE Design Rules</b>
<p>
The default Design Rules have been set to cover
a wide range of applications. Your particular design
may have different requirements, so please make the
necessary adjustments and save your customized
design rules under a new name.
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 <b>WIMA Capacitors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <B>MKS2</B>, 5 x 3 mm, grid 2.54 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Resistors, Capacitors, Inductors</b><p>
Based on the previous libraries:
<ul>
<li>r.lbr
<li>cap.lbr 
<li>cap-fe.lbr
<li>captant.lbr
<li>polcap.lbr
<li>ipc-smd.lbr
</ul>
All SMD packages are defined according to the IPC specifications and  CECC<p>
<author>Created by librarian@cadsoft.de</author><p>
<p>
for Electrolyt Capacitors see also :<p>
www.bccomponents.com <p>
www.panasonic.com<p>
www.kemet.com<p>
http://www.secc.co.jp/pdf/os_e/2004/e_os_all.pdf <b>(SANYO)</b>
<p>
for trimmer refence see : <u>www.electrospec-inc.com/cross_references/trimpotcrossref.asp</u><p>

<table border=0 cellspacing=0 cellpadding=0 width="100%" cellpaddding=0>
<tr valign="top">

<! <td width="10">&nbsp;</td>
<td width="90%">

<b><font color="#0000FF" size="4">TRIM-POT CROSS REFERENCE</font></b>
<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=2>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=3 FACE=ARIAL><B>RECTANGULAR MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BOURNS</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BI&nbsp;TECH</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">DALE-VISHAY</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PHILIPS/MEPCO</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MURATA</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PANASONIC</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">SPECTROL</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MILSPEC</FONT>
      </B>
    </TD><TD>&nbsp;</TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3 >
      3005P<BR>
      3006P<BR>
      3006W<BR>
      3006Y<BR>
      3009P<BR>
      3009W<BR>
      3009Y<BR>
      3057J<BR>
      3057L<BR>
      3057P<BR>
      3057Y<BR>
      3059J<BR>
      3059L<BR>
      3059P<BR>
      3059Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      89P<BR>
      89W<BR>
      89X<BR>
      89PH<BR>
      76P<BR>
      89XH<BR>
      78SLT<BR>
      78L&nbsp;ALT<BR>
      56P&nbsp;ALT<BR>
      78P&nbsp;ALT<BR>
      T8S<BR>
      78L<BR>
      56P<BR>
      78P<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      T18/784<BR>
      783<BR>
      781<BR>
      -<BR>
      -<BR>
      -<BR>
      2199<BR>
      1697/1897<BR>
      1680/1880<BR>
      2187<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      8035EKP/CT20/RJ-20P<BR>
      -<BR>
      RJ-20X<BR>
      -<BR>
      -<BR>
      -<BR>
      1211L<BR>
      8012EKQ&nbsp;ALT<BR>
      8012EKR&nbsp;ALT<BR>
      1211P<BR>
      8012EKJ<BR>
      8012EKL<BR>
      8012EKQ<BR>
      8012EKR<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      2101P<BR>
      2101W<BR>
      2101Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      2102L<BR>
      2102S<BR>
      2102Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVMCOG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      43P<BR>
      43W<BR>
      43Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      40L<BR>
      40P<BR>
      40Y<BR>
      70Y-T602<BR>
      70L<BR>
      70P<BR>
      70Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      -<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SQUARE MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
   <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3250L<BR>
      3250P<BR>
      3250W<BR>
      3250X<BR>
      3252P<BR>
      3252W<BR>
      3252X<BR>
      3260P<BR>
      3260W<BR>
      3260X<BR>
      3262P<BR>
      3262W<BR>
      3262X<BR>
      3266P<BR>
      3266W<BR>
      3266X<BR>
      3290H<BR>
      3290P<BR>
      3290W<BR>
      3292P<BR>
      3292W<BR>
      3292X<BR>
      3296P<BR>
      3296W<BR>
      3296X<BR>
      3296Y<BR>
      3296Z<BR>
      3299P<BR>
      3299W<BR>
      3299X<BR>
      3299Y<BR>
      3299Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      -<BR>
      64W&nbsp;ALT<BR>
      -<BR>
      64P&nbsp;ALT<BR>
      64W&nbsp;ALT<BR>
      64X&nbsp;ALT<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66P<BR>
      66W<BR>
      66X<BR>
      67P<BR>
      67W<BR>
      67X<BR>
      67Y<BR>
      67Z<BR>
      68P<BR>
      68W<BR>
      68X<BR>
      67Y&nbsp;ALT<BR>
      67Z&nbsp;ALT<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      5050<BR>
      5091<BR>
      5080<BR>
      5087<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      T63YB<BR>
      T63XB<BR>
      -<BR>
      -<BR>
      -<BR>
      5887<BR>
      5891<BR>
      5880<BR>
      -<BR>
      -<BR>
      -<BR>
      T93Z<BR>
      T93YA<BR>
      T93XA<BR>
      T93YB<BR>
      T93XB<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      8026EKP<BR>
      8026EKW<BR>
      8026EKM<BR>
      8026EKP<BR>
      8026EKB<BR>
      8026EKM<BR>
      1309X<BR>
      1309P<BR>
      1309W<BR>
      8024EKP<BR>
      8024EKW<BR>
      8024EKN<BR>
      RJ-9P/CT9P<BR>
      RJ-9W<BR>
      RJ-9X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3105P/3106P<BR>
      3105W/3106W<BR>
      3105X/3106X<BR>
      3105Y/3106Y<BR>
      3105Z/3105Z<BR>
      3102P<BR>
      3102W<BR>
      3102X<BR>
      3102Y<BR>
      3102Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMCBG<BR>
      EVMCCG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      55-1-X<BR>
      55-4-X<BR>
      55-3-X<BR>
      55-2-X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      50-2-X<BR>
      50-4-X<BR>
      50-3-X<BR>
      -<BR>
      -<BR>
      -<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      64Y<BR>
      64Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3323P<BR>
      3323S<BR>
      3323W<BR>
      3329H<BR>
      3329P<BR>
      3329W<BR>
      3339H<BR>
      3339P<BR>
      3339W<BR>
      3352E<BR>
      3352H<BR>
      3352K<BR>
      3352P<BR>
      3352T<BR>
      3352V<BR>
      3352W<BR>
      3362H<BR>
      3362M<BR>
      3362P<BR>
      3362R<BR>
      3362S<BR>
      3362U<BR>
      3362W<BR>
      3362X<BR>
      3386B<BR>
      3386C<BR>
      3386F<BR>
      3386H<BR>
      3386K<BR>
      3386M<BR>
      3386P<BR>
      3386S<BR>
      3386W<BR>
      3386X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      25P<BR>
      25S<BR>
      25RX<BR>
      82P<BR>
      82M<BR>
      82PA<BR>
      -<BR>
      -<BR>
      -<BR>
      91E<BR>
      91X<BR>
      91T<BR>
      91B<BR>
      91A<BR>
      91V<BR>
      91W<BR>
      25W<BR>
      25V<BR>
      25P<BR>
      -<BR>
      25S<BR>
      25U<BR>
      25RX<BR>
      25X<BR>
      72XW<BR>
      72XL<BR>
      72PM<BR>
      72RX<BR>
      -<BR>
      72PX<BR>
      72P<BR>
      72RXW<BR>
      72RXL<BR>
      72X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      T7YB<BR>
      T7YA<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      TXD<BR>
      TYA<BR>
      TYP<BR>
      -<BR>
      TYD<BR>
      TX<BR>
      -<BR>
      150SX<BR>
      100SX<BR>
      102T<BR>
      101S<BR>
      190T<BR>
      150TX<BR>
      101<BR>
      -<BR>
      -<BR>
      101SX<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ET6P<BR>
      ET6S<BR>
      ET6X<BR>
      RJ-6W/8014EMW<BR>
      RJ-6P/8014EMP<BR>
      RJ-6X/8014EMX<BR>
      TM7W<BR>
      TM7P<BR>
      TM7X<BR>
      -<BR>
      8017SMS<BR>
      -<BR>
      8017SMB<BR>
      8017SMA<BR>
      -<BR>
      -<BR>
      CT-6W<BR>
      CT-6H<BR>
      CT-6P<BR>
      CT-6R<BR>
      -<BR>
      CT-6V<BR>
      CT-6X<BR>
      -<BR>
      -<BR>
      8038EKV<BR>
      -<BR>
      8038EKX<BR>
      -<BR>
      -<BR>
      8038EKP<BR>
      8038EKZ<BR>
      8038EKW<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      3321H<BR>
      3321P<BR>
      3321N<BR>
      1102H<BR>
      1102P<BR>
      1102T<BR>
      RVA0911V304A<BR>
      -<BR>
      RVA0911H413A<BR>
      RVG0707V100A<BR>
      RVA0607V(H)306A<BR>
      RVA1214H213A<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3104B<BR>
      3104C<BR>
      3104F<BR>
      3104H<BR>
      -<BR>
      3104M<BR>
      3104P<BR>
      3104S<BR>
      3104W<BR>
      3104X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      EVMQ0G<BR>
      EVMQIG<BR>
      EVMQ3G<BR>
      EVMS0G<BR>
      EVMQ0G<BR>
      EVMG0G<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMK4GA00B<BR>
      EVM30GA00B<BR>
      EVMK0GA00B<BR>
      EVM38GA00B<BR>
      EVMB6<BR>
      EVLQ0<BR>
      -<BR>
      EVMMSG<BR>
      EVMMBG<BR>
      EVMMAG<BR>
      -<BR>
      -<BR>
      EVMMCS<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMM1<BR>
      -<BR>
      -<BR>
      EVMM0<BR>
      -<BR>
      -<BR>
      EVMM3<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      62-3-1<BR>
      62-1-2<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67R<BR>
      -<BR>
      67P<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67X<BR>
      63V<BR>
      63S<BR>
      63M<BR>
      -<BR>
      -<BR>
      63H<BR>
      63P<BR>
      -<BR>
      -<BR>
      63X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>&nbsp;<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=3>
  <TR>
    <TD COLSPAN=7>
      <FONT color="#0000FF" SIZE=4 FACE=ARIAL><B>SMD TRIM-POT CROSS REFERENCE</B></FONT>
      <P>
      <FONT SIZE=4 FACE=ARIAL><B>MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3224G<BR>
      3224J<BR>
      3224W<BR>
      3269P<BR>
      3269W<BR>
      3269X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      44G<BR>
      44J<BR>
      44W<BR>
      84P<BR>
      84W<BR>
      84X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST63Z<BR>
      ST63Y<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST5P<BR>
      ST5W<BR>
      ST5X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3314G<BR>
      3314J<BR>
      3364A/B<BR>
      3364C/D<BR>
      3364W/X<BR>
      3313G<BR>
      3313J<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      23B<BR>
      23A<BR>
      21X<BR>
      21W<BR>
      -<BR>
      22B<BR>
      22A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST5YL/ST53YL<BR>
      ST5YJ/5T53YJ<BR>
      ST-23A<BR>
      ST-22B<BR>
      ST-22<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST-4B<BR>
      ST-4A<BR>
      -<BR>
      -<BR>
      -<BR>
      ST-3B<BR>
      ST-3A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVM-6YS<BR>
      EVM-1E<BR>
      EVM-1G<BR>
      EVM-1D<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      G4B<BR>
      G4A<BR>
      TR04-3S1<BR>
      TRG04-2S1<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      DVR-43A<BR>
      CVR-42C<BR>
      CVR-42A/C<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>
<FONT SIZE=4 FACE=ARIAL><B>ALT =&nbsp;ALTERNATE</B></FONT>
<P>

&nbsp;
<P>
</td>
</tr>
</table>
 
 
 <b>Aluminum electrolytic capacitors</b> reflow soldering<p>
SMD (Chip) Standard 085 CS<p>
http://www.bccomponents.com/
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 



 
 <b>Diodes</b><p>
Based on the following sources:
<ul>
<li>Motorola : www.onsemi.com
<li>Fairchild : www.fairchildsemi.com
<li>Philips : www.semiconductors.com
<li>Vishay : www.vishay.de
</ul>
<author>Created by librarian@cadsoft.de</author>
 
 
 <B>DIODE</B><p>
diameter 3 mm, horizontal, grid 12.7 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 



 
 <b>Microphon</b> from<p>
JLI Electronics - www.jlielectronics.com<br>
Panansonic - http://industrial.panasonic.com<br>
<p>
<author>librarian@cadsoft.de</author>
 
 
 <b>Mocrophone 4 x 1.5mm</b><p>
Source: Projects Unlimited Inc. Microphone_TOM-1545P-R_40092-1.pdf
 
 
 
 >NAME
 >VALUE



 
 <b>Linear Devices</b><p>
Operational amplifiers,  comparators, voltage regulators, ADCs, DACs, etc.<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>Small Outline Package 8</b><br>
NS Package M08A
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 



 
 UMC UM3561 (DIP-8)
<br>
<a href="http://jayakody2000lk.wordpress.com">jayakody2000lk.wordpress.com</a>
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>LEDs</b><p>
<author>Created by librarian@cadsoft.de</author><br>
Extended by Federico Battaglin <author>&lt;federico.rd@fdpinternational.com&gt;</author> with DUOLED
 
 
 <B>LED</B><p>
3 mm, round
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>NPN Transistors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>TO-92</b><p>
 grid 5.08 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Piher Potentiometers</b><p>
PC-16/16 mm carbon types<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>POTENTIOMETER</b><p>
single carbon potentiometer, 16 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Resistors, Capacitors, Inductors</b><p>
Based on the previous libraries:
<ul>
<li>r.lbr
<li>cap.lbr 
<li>cap-fe.lbr
<li>captant.lbr
<li>polcap.lbr
<li>ipc-smd.lbr
</ul>
All SMD packages are defined according to the IPC specifications and  CECC<p>
<author>Created by librarian@cadsoft.de</author><p>
<p>
for Electrolyt Capacitors see also :<p>
www.bccomponents.com <p>
www.panasonic.com<p>
www.kemet.com<p>
<p>
for trimmer refence see : <u>www.electrospec-inc.com/cross_references/trimpotcrossref.asp</u><p>

<map name="nav_main">
<area shape="rect" coords="0,1,140,23" href="../military_specs.asp" title="">
<area shape="rect" coords="0,24,140,51" href="../about.asp" title="">
<area shape="rect" coords="1,52,140,77" href="../rfq.asp" title="">
<area shape="rect" coords="0,78,139,103" href="../products.asp" title="">
<area shape="rect" coords="1,102,138,128" href="../excess_inventory.asp" title="">
<area shape="rect" coords="1,129,138,150" href="../edge.asp" title="">
<area shape="rect" coords="1,151,139,178" href="../industry_links.asp" title="">
<area shape="rect" coords="0,179,139,201" href="../comments.asp" title="">
<area shape="rect" coords="1,203,138,231" href="../directory.asp" title="">
<area shape="default" nohref>
</map>

<html>

<title></title>

 <LINK REL="StyleSheet" TYPE="text/css" HREF="style-sheet.css">

<body bgcolor="#ffffff" text="#000000" marginwidth="0" marginheight="0" topmargin="0" leftmargin="0">
<table border=0 cellspacing=0 cellpadding=0 width="100%" cellpaddding=0 height="55%">
<tr valign="top">

</td>
<! <td width="10">&nbsp;</td>
<td width="90%">

<b><font color="#0000FF" size="4">TRIM-POT CROSS REFERENCE</font></b>
<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=2>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=3 FACE=ARIAL><B>RECTANGULAR MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BOURNS</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BI&nbsp;TECH</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">DALE-VISHAY</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PHILIPS/MEPCO</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MURATA</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PANASONIC</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">SPECTROL</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MILSPEC</FONT>
      </B>
    </TD><TD>&nbsp;</TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3 >
      3005P<BR>
      3006P<BR>
      3006W<BR>
      3006Y<BR>
      3009P<BR>
      3009W<BR>
      3009Y<BR>
      3057J<BR>
      3057L<BR>
      3057P<BR>
      3057Y<BR>
      3059J<BR>
      3059L<BR>
      3059P<BR>
      3059Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      89P<BR>
      89W<BR>
      89X<BR>
      89PH<BR>
      76P<BR>
      89XH<BR>
      78SLT<BR>
      78L&nbsp;ALT<BR>
      56P&nbsp;ALT<BR>
      78P&nbsp;ALT<BR>
      T8S<BR>
      78L<BR>
      56P<BR>
      78P<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      T18/784<BR>
      783<BR>
      781<BR>
      -<BR>
      -<BR>
      -<BR>
      2199<BR>
      1697/1897<BR>
      1680/1880<BR>
      2187<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      8035EKP/CT20/RJ-20P<BR>
      -<BR>
      RJ-20X<BR>
      -<BR>
      -<BR>
      -<BR>
      1211L<BR>
      8012EKQ&nbsp;ALT<BR>
      8012EKR&nbsp;ALT<BR>
      1211P<BR>
      8012EKJ<BR>
      8012EKL<BR>
      8012EKQ<BR>
      8012EKR<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      2101P<BR>
      2101W<BR>
      2101Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      2102L<BR>
      2102S<BR>
      2102Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVMCOG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      43P<BR>
      43W<BR>
      43Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      40L<BR>
      40P<BR>
      40Y<BR>
      70Y-T602<BR>
      70L<BR>
      70P<BR>
      70Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      -<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SQUARE MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
   <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3250L<BR>
      3250P<BR>
      3250W<BR>
      3250X<BR>
      3252P<BR>
      3252W<BR>
      3252X<BR>
      3260P<BR>
      3260W<BR>
      3260X<BR>
      3262P<BR>
      3262W<BR>
      3262X<BR>
      3266P<BR>
      3266W<BR>
      3266X<BR>
      3290H<BR>
      3290P<BR>
      3290W<BR>
      3292P<BR>
      3292W<BR>
      3292X<BR>
      3296P<BR>
      3296W<BR>
      3296X<BR>
      3296Y<BR>
      3296Z<BR>
      3299P<BR>
      3299W<BR>
      3299X<BR>
      3299Y<BR>
      3299Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      -<BR>
      64W&nbsp;ALT<BR>
      -<BR>
      64P&nbsp;ALT<BR>
      64W&nbsp;ALT<BR>
      64X&nbsp;ALT<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66P<BR>
      66W<BR>
      66X<BR>
      67P<BR>
      67W<BR>
      67X<BR>
      67Y<BR>
      67Z<BR>
      68P<BR>
      68W<BR>
      68X<BR>
      67Y&nbsp;ALT<BR>
      67Z&nbsp;ALT<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      5050<BR>
      5091<BR>
      5080<BR>
      5087<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      T63YB<BR>
      T63XB<BR>
      -<BR>
      -<BR>
      -<BR>
      5887<BR>
      5891<BR>
      5880<BR>
      -<BR>
      -<BR>
      -<BR>
      T93Z<BR>
      T93YA<BR>
      T93XA<BR>
      T93YB<BR>
      T93XB<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      8026EKP<BR>
      8026EKW<BR>
      8026EKM<BR>
      8026EKP<BR>
      8026EKB<BR>
      8026EKM<BR>
      1309X<BR>
      1309P<BR>
      1309W<BR>
      8024EKP<BR>
      8024EKW<BR>
      8024EKN<BR>
      RJ-9P/CT9P<BR>
      RJ-9W<BR>
      RJ-9X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3105P/3106P<BR>
      3105W/3106W<BR>
      3105X/3106X<BR>
      3105Y/3106Y<BR>
      3105Z/3105Z<BR>
      3102P<BR>
      3102W<BR>
      3102X<BR>
      3102Y<BR>
      3102Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMCBG<BR>
      EVMCCG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      55-1-X<BR>
      55-4-X<BR>
      55-3-X<BR>
      55-2-X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      50-2-X<BR>
      50-4-X<BR>
      50-3-X<BR>
      -<BR>
      -<BR>
      -<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      64Y<BR>
      64Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3323P<BR>
      3323S<BR>
      3323W<BR>
      3329H<BR>
      3329P<BR>
      3329W<BR>
      3339H<BR>
      3339P<BR>
      3339W<BR>
      3352E<BR>
      3352H<BR>
      3352K<BR>
      3352P<BR>
      3352T<BR>
      3352V<BR>
      3352W<BR>
      3362H<BR>
      3362M<BR>
      3362P<BR>
      3362R<BR>
      3362S<BR>
      3362U<BR>
      3362W<BR>
      3362X<BR>
      3386B<BR>
      3386C<BR>
      3386F<BR>
      3386H<BR>
      3386K<BR>
      3386M<BR>
      3386P<BR>
      3386S<BR>
      3386W<BR>
      3386X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      25P<BR>
      25S<BR>
      25RX<BR>
      82P<BR>
      82M<BR>
      82PA<BR>
      -<BR>
      -<BR>
      -<BR>
      91E<BR>
      91X<BR>
      91T<BR>
      91B<BR>
      91A<BR>
      91V<BR>
      91W<BR>
      25W<BR>
      25V<BR>
      25P<BR>
      -<BR>
      25S<BR>
      25U<BR>
      25RX<BR>
      25X<BR>
      72XW<BR>
      72XL<BR>
      72PM<BR>
      72RX<BR>
      -<BR>
      72PX<BR>
      72P<BR>
      72RXW<BR>
      72RXL<BR>
      72X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      T7YB<BR>
      T7YA<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      TXD<BR>
      TYA<BR>
      TYP<BR>
      -<BR>
      TYD<BR>
      TX<BR>
      -<BR>
      150SX<BR>
      100SX<BR>
      102T<BR>
      101S<BR>
      190T<BR>
      150TX<BR>
      101<BR>
      -<BR>
      -<BR>
      101SX<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ET6P<BR>
      ET6S<BR>
      ET6X<BR>
      RJ-6W/8014EMW<BR>
      RJ-6P/8014EMP<BR>
      RJ-6X/8014EMX<BR>
      TM7W<BR>
      TM7P<BR>
      TM7X<BR>
      -<BR>
      8017SMS<BR>
      -<BR>
      8017SMB<BR>
      8017SMA<BR>
      -<BR>
      -<BR>
      CT-6W<BR>
      CT-6H<BR>
      CT-6P<BR>
      CT-6R<BR>
      -<BR>
      CT-6V<BR>
      CT-6X<BR>
      -<BR>
      -<BR>
      8038EKV<BR>
      -<BR>
      8038EKX<BR>
      -<BR>
      -<BR>
      8038EKP<BR>
      8038EKZ<BR>
      8038EKW<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      3321H<BR>
      3321P<BR>
      3321N<BR>
      1102H<BR>
      1102P<BR>
      1102T<BR>
      RVA0911V304A<BR>
      -<BR>
      RVA0911H413A<BR>
      RVG0707V100A<BR>
      RVA0607V(H)306A<BR>
      RVA1214H213A<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3104B<BR>
      3104C<BR>
      3104F<BR>
      3104H<BR>
      -<BR>
      3104M<BR>
      3104P<BR>
      3104S<BR>
      3104W<BR>
      3104X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      EVMQ0G<BR>
      EVMQIG<BR>
      EVMQ3G<BR>
      EVMS0G<BR>
      EVMQ0G<BR>
      EVMG0G<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMK4GA00B<BR>
      EVM30GA00B<BR>
      EVMK0GA00B<BR>
      EVM38GA00B<BR>
      EVMB6<BR>
      EVLQ0<BR>
      -<BR>
      EVMMSG<BR>
      EVMMBG<BR>
      EVMMAG<BR>
      -<BR>
      -<BR>
      EVMMCS<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMM1<BR>
      -<BR>
      -<BR>
      EVMM0<BR>
      -<BR>
      -<BR>
      EVMM3<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      62-3-1<BR>
      62-1-2<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67R<BR>
      -<BR>
      67P<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67X<BR>
      63V<BR>
      63S<BR>
      63M<BR>
      -<BR>
      -<BR>
      63H<BR>
      63P<BR>
      -<BR>
      -<BR>
      63X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>&nbsp;<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=3>
  <TR>
    <TD COLSPAN=7>
      <FONT color="#0000FF" SIZE=4 FACE=ARIAL><B>SMD TRIM-POT CROSS REFERENCE</B></FONT>
      <P>
      <FONT SIZE=4 FACE=ARIAL><B>MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3224G<BR>
      3224J<BR>
      3224W<BR>
      3269P<BR>
      3269W<BR>
      3269X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      44G<BR>
      44J<BR>
      44W<BR>
      84P<BR>
      84W<BR>
      84X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST63Z<BR>
      ST63Y<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST5P<BR>
      ST5W<BR>
      ST5X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3314G<BR>
      3314J<BR>
      3364A/B<BR>
      3364C/D<BR>
      3364W/X<BR>
      3313G<BR>
      3313J<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      23B<BR>
      23A<BR>
      21X<BR>
      21W<BR>
      -<BR>
      22B<BR>
      22A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST5YL/ST53YL<BR>
      ST5YJ/5T53YJ<BR>
      ST-23A<BR>
      ST-22B<BR>
      ST-22<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST-4B<BR>
      ST-4A<BR>
      -<BR>
      -<BR>
      -<BR>
      ST-3B<BR>
      ST-3A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVM-6YS<BR>
      EVM-1E<BR>
      EVM-1G<BR>
      EVM-1D<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      G4B<BR>
      G4A<BR>
      TR04-3S1<BR>
      TRG04-2S1<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      DVR-43A<BR>
      CVR-42C<BR>
      CVR-42A/C<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>
<FONT SIZE=4 FACE=ARIAL><B>ALT =&nbsp;ALTERNATE</B></FONT>
<P>

&nbsp;
<P>
</td>
</tr>
</table>
</BODY></HTML>
 
 
 <b>CECC Size RC2211</b> Reflow Soldering<p>
source Beyschlag
 
 
 
 
 
 
 >NAME
 >VALUE



 
 
 
 <b>Speaker 13 x 13mm</b>, 8 Ohm, 0.7W<p>
Source: pui audio inc. SMS-1308MS-2-R.pdf
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 

 
 
 
 




 
 <b>Transistors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>SOT-23</b>
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 



 
 LT-Spice library generated with :<br>
import-ltspice.ulp<br>
from: E:/Programme/LTC/LTspiceIV/lib/sym/Misc/*.asy<br>
at 12.06.2012 10:26:07
<p>
2N5458.DEV<br>
2N7002.DEV<br>
BATTERY.DEV<br>
CELL.DEV<br>
DIAC.DEV<br>
DIP8.DEV<br>
DIP10.DEV<br>
DIP14.DEV<br>
DIP16.DEV<br>
DIP20.DEV<br>
EPOLY.DEV<br>
EUROPEANCAP.DEV<br>
EUROPEANPOLCAP.DEV<br>
EUROPEANRESISTOR.DEV<br>
FIXEDIND.DEV<br>
JUMPER.DEV<br>
NE555.DEV<br>
NEONBULB.DEV<br>
NIGBT.DEV<br>
PENTODE.DEV<br>
PIGBT.DEV<br>
SCR.DEV<br>
TETRODE.DEV<br>
TOWTOM2.DEV<br>
TRIAC.DEV<br>
TRIODE.DEV<br>
URC.DEV<br>
URC2.DEV<br>
XTAL.DEV<br>
XVARISTOR.DEV<br>
 
 
 <b>Small Outline IC</b>
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 



 
 <b>FRIWO Supply Connectors (TEXAS)</b><p>
http://www.friwo.com/<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 PCB SUPPLY CONNECTOR<p>
FRIWO (TEXAS)
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 




 

 

 
 

 


 
 <b>EAGLE Design Rules</b>
<p>
Die Standard-Design-Rules sind so gewählt, dass sie für 
die meisten Anwendungen passen. Sollte ihre Platine 
besondere Anforderungen haben, treffen Sie die erforderlichen
Einstellungen hier und speichern die Design Rules unter 
einem neuen Namen ab.
 <b>EAGLE Design Rules</b>
<p>
The default Design Rules have been set to cover
a wide range of applications. Your particular design
may have different requirements, so please make the
necessary adjustments and save your customized
design rules under a new name.
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 <b>WIMA Capacitors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <B>MKS2</B>, 5 x 3 mm, grid 2.54 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Resistors, Capacitors, Inductors</b><p>
Based on the previous libraries:
<ul>
<li>r.lbr
<li>cap.lbr 
<li>cap-fe.lbr
<li>captant.lbr
<li>polcap.lbr
<li>ipc-smd.lbr
</ul>
All SMD packages are defined according to the IPC specifications and  CECC<p>
<author>Created by librarian@cadsoft.de</author><p>
<p>
for Electrolyt Capacitors see also :<p>
www.bccomponents.com <p>
www.panasonic.com<p>
www.kemet.com<p>
http://www.secc.co.jp/pdf/os_e/2004/e_os_all.pdf <b>(SANYO)</b>
<p>
for trimmer refence see : <u>www.electrospec-inc.com/cross_references/trimpotcrossref.asp</u><p>

<table border=0 cellspacing=0 cellpadding=0 width="100%" cellpaddding=0>
<tr valign="top">

<! <td width="10">&nbsp;</td>
<td width="90%">

<b><font color="#0000FF" size="4">TRIM-POT CROSS REFERENCE</font></b>
<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=2>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=3 FACE=ARIAL><B>RECTANGULAR MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BOURNS</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">BI&nbsp;TECH</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">DALE-VISHAY</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PHILIPS/MEPCO</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MURATA</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">PANASONIC</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">SPECTROL</FONT>
      </B>
    </TD>
    <TD ALIGN=CENTER>
      <B>
      <FONT SIZE=3 FACE=ARIAL color="#FF0000">MILSPEC</FONT>
      </B>
    </TD><TD>&nbsp;</TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3 >
      3005P<BR>
      3006P<BR>
      3006W<BR>
      3006Y<BR>
      3009P<BR>
      3009W<BR>
      3009Y<BR>
      3057J<BR>
      3057L<BR>
      3057P<BR>
      3057Y<BR>
      3059J<BR>
      3059L<BR>
      3059P<BR>
      3059Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      89P<BR>
      89W<BR>
      89X<BR>
      89PH<BR>
      76P<BR>
      89XH<BR>
      78SLT<BR>
      78L&nbsp;ALT<BR>
      56P&nbsp;ALT<BR>
      78P&nbsp;ALT<BR>
      T8S<BR>
      78L<BR>
      56P<BR>
      78P<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      T18/784<BR>
      783<BR>
      781<BR>
      -<BR>
      -<BR>
      -<BR>
      2199<BR>
      1697/1897<BR>
      1680/1880<BR>
      2187<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      8035EKP/CT20/RJ-20P<BR>
      -<BR>
      RJ-20X<BR>
      -<BR>
      -<BR>
      -<BR>
      1211L<BR>
      8012EKQ&nbsp;ALT<BR>
      8012EKR&nbsp;ALT<BR>
      1211P<BR>
      8012EKJ<BR>
      8012EKL<BR>
      8012EKQ<BR>
      8012EKR<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      2101P<BR>
      2101W<BR>
      2101Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      2102L<BR>
      2102S<BR>
      2102Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVMCOG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      43P<BR>
      43W<BR>
      43Y<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      40L<BR>
      40P<BR>
      40Y<BR>
      70Y-T602<BR>
      70L<BR>
      70P<BR>
      70Y<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      RT/RTR12<BR>
      -<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR>
      RJ/RJR12<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SQUARE MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
   <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3250L<BR>
      3250P<BR>
      3250W<BR>
      3250X<BR>
      3252P<BR>
      3252W<BR>
      3252X<BR>
      3260P<BR>
      3260W<BR>
      3260X<BR>
      3262P<BR>
      3262W<BR>
      3262X<BR>
      3266P<BR>
      3266W<BR>
      3266X<BR>
      3290H<BR>
      3290P<BR>
      3290W<BR>
      3292P<BR>
      3292W<BR>
      3292X<BR>
      3296P<BR>
      3296W<BR>
      3296X<BR>
      3296Y<BR>
      3296Z<BR>
      3299P<BR>
      3299W<BR>
      3299X<BR>
      3299Y<BR>
      3299Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66X&nbsp;ALT<BR>
      -<BR>
      64W&nbsp;ALT<BR>
      -<BR>
      64P&nbsp;ALT<BR>
      64W&nbsp;ALT<BR>
      64X&nbsp;ALT<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      66X&nbsp;ALT<BR>
      66P&nbsp;ALT<BR>
      66W&nbsp;ALT<BR>
      66P<BR>
      66W<BR>
      66X<BR>
      67P<BR>
      67W<BR>
      67X<BR>
      67Y<BR>
      67Z<BR>
      68P<BR>
      68W<BR>
      68X<BR>
      67Y&nbsp;ALT<BR>
      67Z&nbsp;ALT<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      5050<BR>
      5091<BR>
      5080<BR>
      5087<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      T63YB<BR>
      T63XB<BR>
      -<BR>
      -<BR>
      -<BR>
      5887<BR>
      5891<BR>
      5880<BR>
      -<BR>
      -<BR>
      -<BR>
      T93Z<BR>
      T93YA<BR>
      T93XA<BR>
      T93YB<BR>
      T93XB<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      8026EKP<BR>
      8026EKW<BR>
      8026EKM<BR>
      8026EKP<BR>
      8026EKB<BR>
      8026EKM<BR>
      1309X<BR>
      1309P<BR>
      1309W<BR>
      8024EKP<BR>
      8024EKW<BR>
      8024EKN<BR>
      RJ-9P/CT9P<BR>
      RJ-9W<BR>
      RJ-9X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      3103P<BR>
      3103Y<BR>
      3103Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3105P/3106P<BR>
      3105W/3106W<BR>
      3105X/3106X<BR>
      3105Y/3106Y<BR>
      3105Z/3105Z<BR>
      3102P<BR>
      3102W<BR>
      3102X<BR>
      3102Y<BR>
      3102Z<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMCBG<BR>
      EVMCCG<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      55-1-X<BR>
      55-4-X<BR>
      55-3-X<BR>
      55-2-X<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      50-2-X<BR>
      50-4-X<BR>
      50-3-X<BR>
      -<BR>
      -<BR>
      -<BR>
      64P<BR>
      64W<BR>
      64X<BR>
      64Y<BR>
      64Z<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RT/RTR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RJ/RJR22<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RT/RTR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RJ/RJR26<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RT/RTR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      RJ/RJR24<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=8>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BOURN</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MURATA</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>SPECTROL</B></FONT>
    </TD>
    <TD ALIGN=CENTER>
      <FONT SIZE=3 FACE=ARIAL><B>MILSPEC</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3323P<BR>
      3323S<BR>
      3323W<BR>
      3329H<BR>
      3329P<BR>
      3329W<BR>
      3339H<BR>
      3339P<BR>
      3339W<BR>
      3352E<BR>
      3352H<BR>
      3352K<BR>
      3352P<BR>
      3352T<BR>
      3352V<BR>
      3352W<BR>
      3362H<BR>
      3362M<BR>
      3362P<BR>
      3362R<BR>
      3362S<BR>
      3362U<BR>
      3362W<BR>
      3362X<BR>
      3386B<BR>
      3386C<BR>
      3386F<BR>
      3386H<BR>
      3386K<BR>
      3386M<BR>
      3386P<BR>
      3386S<BR>
      3386W<BR>
      3386X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      25P<BR>
      25S<BR>
      25RX<BR>
      82P<BR>
      82M<BR>
      82PA<BR>
      -<BR>
      -<BR>
      -<BR>
      91E<BR>
      91X<BR>
      91T<BR>
      91B<BR>
      91A<BR>
      91V<BR>
      91W<BR>
      25W<BR>
      25V<BR>
      25P<BR>
      -<BR>
      25S<BR>
      25U<BR>
      25RX<BR>
      25X<BR>
      72XW<BR>
      72XL<BR>
      72PM<BR>
      72RX<BR>
      -<BR>
      72PX<BR>
      72P<BR>
      72RXW<BR>
      72RXL<BR>
      72X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      T7YB<BR>
      T7YA<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      TXD<BR>
      TYA<BR>
      TYP<BR>
      -<BR>
      TYD<BR>
      TX<BR>
      -<BR>
      150SX<BR>
      100SX<BR>
      102T<BR>
      101S<BR>
      190T<BR>
      150TX<BR>
      101<BR>
      -<BR>
      -<BR>
      101SX<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ET6P<BR>
      ET6S<BR>
      ET6X<BR>
      RJ-6W/8014EMW<BR>
      RJ-6P/8014EMP<BR>
      RJ-6X/8014EMX<BR>
      TM7W<BR>
      TM7P<BR>
      TM7X<BR>
      -<BR>
      8017SMS<BR>
      -<BR>
      8017SMB<BR>
      8017SMA<BR>
      -<BR>
      -<BR>
      CT-6W<BR>
      CT-6H<BR>
      CT-6P<BR>
      CT-6R<BR>
      -<BR>
      CT-6V<BR>
      CT-6X<BR>
      -<BR>
      -<BR>
      8038EKV<BR>
      -<BR>
      8038EKX<BR>
      -<BR>
      -<BR>
      8038EKP<BR>
      8038EKZ<BR>
      8038EKW<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      3321H<BR>
      3321P<BR>
      3321N<BR>
      1102H<BR>
      1102P<BR>
      1102T<BR>
      RVA0911V304A<BR>
      -<BR>
      RVA0911H413A<BR>
      RVG0707V100A<BR>
      RVA0607V(H)306A<BR>
      RVA1214H213A<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      3104B<BR>
      3104C<BR>
      3104F<BR>
      3104H<BR>
      -<BR>
      3104M<BR>
      3104P<BR>
      3104S<BR>
      3104W<BR>
      3104X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      EVMQ0G<BR>
      EVMQIG<BR>
      EVMQ3G<BR>
      EVMS0G<BR>
      EVMQ0G<BR>
      EVMG0G<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMK4GA00B<BR>
      EVM30GA00B<BR>
      EVMK0GA00B<BR>
      EVM38GA00B<BR>
      EVMB6<BR>
      EVLQ0<BR>
      -<BR>
      EVMMSG<BR>
      EVMMBG<BR>
      EVMMAG<BR>
      -<BR>
      -<BR>
      EVMMCS<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      EVMM1<BR>
      -<BR>
      -<BR>
      EVMM0<BR>
      -<BR>
      -<BR>
      EVMM3<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      62-3-1<BR>
      62-1-2<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67R<BR>
      -<BR>
      67P<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      67X<BR>
      63V<BR>
      63S<BR>
      63M<BR>
      -<BR>
      -<BR>
      63H<BR>
      63P<BR>
      -<BR>
      -<BR>
      63X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      RJ/RJR50<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>&nbsp;<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=3>
  <TR>
    <TD COLSPAN=7>
      <FONT color="#0000FF" SIZE=4 FACE=ARIAL><B>SMD TRIM-POT CROSS REFERENCE</B></FONT>
      <P>
      <FONT SIZE=4 FACE=ARIAL><B>MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3224G<BR>
      3224J<BR>
      3224W<BR>
      3269P<BR>
      3269W<BR>
      3269X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      44G<BR>
      44J<BR>
      44W<BR>
      84P<BR>
      84W<BR>
      84X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST63Z<BR>
      ST63Y<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST5P<BR>
      ST5W<BR>
      ST5X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3314G<BR>
      3314J<BR>
      3364A/B<BR>
      3364C/D<BR>
      3364W/X<BR>
      3313G<BR>
      3313J<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      23B<BR>
      23A<BR>
      21X<BR>
      21W<BR>
      -<BR>
      22B<BR>
      22A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST5YL/ST53YL<BR>
      ST5YJ/5T53YJ<BR>
      ST-23A<BR>
      ST-22B<BR>
      ST-22<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST-4B<BR>
      ST-4A<BR>
      -<BR>
      -<BR>
      -<BR>
      ST-3B<BR>
      ST-3A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVM-6YS<BR>
      EVM-1E<BR>
      EVM-1G<BR>
      EVM-1D<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      G4B<BR>
      G4A<BR>
      TR04-3S1<BR>
      TRG04-2S1<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      DVR-43A<BR>
      CVR-42C<BR>
      CVR-42A/C<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>
<FONT SIZE=4 FACE=ARIAL><B>ALT =&nbsp;ALTERNATE</B></FONT>
<P>

&nbsp;
<P>
</td>
</tr>
</table>
 
 
 <b>Aluminum electrolytic capacitors</b> reflow soldering<p>
SMD (Chip) Standard 085 CS<p>
http://www.bccomponents.com/
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 



 
 <b>Diodes</b><p>
Based on the following sources:
<ul>
<li>Motorola : www.onsemi.com
<li>Fairchild : www.fairchildsemi.com
<li>Philips : www.semiconductors.com
<li>Vishay : www.vishay.de
</ul>
<author>Created by librarian@cadsoft.de</author>
 
 
 <B>DIODE</B><p>
diameter 3 mm, horizontal, grid 12.7 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 



 
 <b>Microphon</b> from<p>
JLI Electronics - www.jlielectronics.com<br>
Panansonic - http://industrial.panasonic.com<br>
<p>
<author>librarian@cadsoft.de</author>
 
 
 <b>Mocrophone 4 x 1.5mm</b><p>
Source: Projects Unlimited Inc. Microphone_TOM-1545P-R_40092-1.pdf
 
 
 
 >NAME
 >VALUE



 
 <b>Linear Devices</b><p>
Operational amplifiers,  comparators, voltage regulators, ADCs, DACs, etc.<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>Small Outline Package 8</b><br>
NS Package M08A
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 



 
 UMC UM3561 (DIP-8)
<br>
<a href="http://jayakody2000lk.wordpress.com">jayakody2000lk.wordpress.com</a>
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>LEDs</b><p>
<author>Created by librarian@cadsoft.de</author><br>
Extended by Federico Battaglin <author>&lt;federico.rd@fdpinternational.com&gt;</author> with DUOLED
 
 
 <B>LED</B><p>
3 mm, round
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>NPN Transistors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>TO-92</b><p>
 grid 5.08 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Piher Potentiometers</b><p>
PC-16/16 mm carbon types<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>POTENTIOMETER</b><p>
single carbon potentiometer, 16 mm
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE



 
 <b>Resistors, Capacitors, Inductors</b><p>
Based on the previous libraries:
<ul>
<li>r.lbr
<li>cap.lbr 
<li>cap-fe.lbr
<li>captant.lbr
<li>polcap.lbr
<li>ipc-smd.lbr
</ul>
All SMD packages are defined according to the IPC specifications and  CECC<p>
<author>Created by librarian@cadsoft.de</author><p>
<p>
for Electrolyt Capacitors see also :<p>
www.bccomponents.com <p>
www.panasonic.com<p>
www.kemet.com<p>
<p>
for trimmer refence see : <u>www.electrospec-inc.com/cross_references/trimpotcrossref.asp</u><p>
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      RJ/RJR50<BR>
      RJ/RJR50<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>&nbsp;<P>
<TABLE BORDER=0 CELLSPACING=1 CELLPADDING=3>
  <TR>
    <TD COLSPAN=7>
      <FONT color="#0000FF" SIZE=4 FACE=ARIAL><B>SMD TRIM-POT CROSS REFERENCE</B></FONT>
      <P>
      <FONT SIZE=4 FACE=ARIAL><B>MULTI-TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3224G<BR>
      3224J<BR>
      3224W<BR>
      3269P<BR>
      3269W<BR>
      3269X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      44G<BR>
      44J<BR>
      44W<BR>
      84P<BR>
      84W<BR>
      84X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST63Z<BR>
      ST63Y<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      ST5P<BR>
      ST5W<BR>
      ST5X<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>&nbsp;
    </TD>
  </TR>
  <TR>
    <TD COLSPAN=7>
      <FONT SIZE=4 FACE=ARIAL><B>SINGLE TURN</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BOURNS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>BI&nbsp;TECH</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>DALE-VISHAY</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PHILIPS/MEPCO</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>PANASONIC</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>TOCOS</B></FONT>
    </TD>
    <TD>
      <FONT SIZE=3 FACE=ARIAL><B>AUX/KYOCERA</B></FONT>
    </TD>
  </TR>
  <TR>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      3314G<BR>
      3314J<BR>
      3364A/B<BR>
      3364C/D<BR>
      3364W/X<BR>
      3313G<BR>
      3313J<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      23B<BR>
      23A<BR>
      21X<BR>
      21W<BR>
      -<BR>
      22B<BR>
      22A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST5YL/ST53YL<BR>
      ST5YJ/5T53YJ<BR>
      ST-23A<BR>
      ST-22B<BR>
      ST-22<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      ST-4B<BR>
      ST-4A<BR>
      -<BR>
      -<BR>
      -<BR>
      ST-3B<BR>
      ST-3A<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      EVM-6YS<BR>
      EVM-1E<BR>
      EVM-1G<BR>
      EVM-1D<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      G4B<BR>
      G4A<BR>
      TR04-3S1<BR>
      TRG04-2S1<BR>
      -<BR>
      -<BR>
      -<BR></FONT>
    </TD>
    <TD BGCOLOR="#cccccc" ALIGN=CENTER><FONT FACE=ARIAL SIZE=3>
      -<BR>
      -<BR>
      DVR-43A<BR>
      CVR-42C<BR>
      CVR-42A/C<BR>
      -<BR>
      -<BR></FONT>
    </TD>
  </TR>
</TABLE>
<P>
<FONT SIZE=4 FACE=ARIAL><B>ALT =&nbsp;ALTERNATE</B></FONT>
<P>

&nbsp;
<P>
</td>
</tr>
</table>
</BODY></HTML>
 
 
 <b>CECC Size RC2211</b> Reflow Soldering<p>
source Beyschlag
 
 
 
 
 
 
 >NAME
 >VALUE



 
 
 
 <b>Speaker 13 x 13mm</b>, 8 Ohm, 0.7W<p>
Source: pui audio inc. SMS-1308MS-2-R.pdf
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 

 
 
 
 




 
 <b>Transistors</b><p>
<author>Created by librarian@cadsoft.de</author>
 
 
 <b>SOT-23</b>
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 



 
 LT-Spice library generated with :<br>
import-ltspice.ulp<br>
from: E:/Programme/LTC/LTspiceIV/lib/sym/Misc/*.asy<br>
at 12.06.2012 10:26:07
<p>
2N5458.DEV<br>
2N7002.DEV<br>
BATTERY.DEV<br>
CELL.DEV<br>
DIAC.DEV<br>
DIP8.DEV<br>
DIP10.DEV<br>
DIP14.DEV<br>
DIP16.DEV<br>
DIP20.DEV<br>
EPOLY.DEV<br>
EUROPEANCAP.DEV<br>
EUROPEANPOLCAP.DEV<br>
EUROPEANRESISTOR.DEV<br>
FIXEDIND.DEV<br>
JUMPER.DEV<br>
NE555.DEV<br>
NEONBULB.DEV<br>
NIGBT.DEV<br>
PENTODE.DEV<br>
PIGBT.DEV<br>
SCR.DEV<br>
TETRODE.DEV<br>
TOWTOM2.DEV<br>
TRIAC.DEV<br>
TRIODE.DEV<br>
URC.DEV<br>
URC2.DEV<br>
XTAL.DEV<br>
XVARISTOR.DEV<br>
 
 
 <b>Small Outline IC</b>
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 
 
 
 
 
 



 
 <b>FRIWO Supply Connectors (TEXAS)</b><p>
http://www.friwo.com/<p>
<author>Created by librarian@cadsoft.de</author>
 
 
 PCB SUPPLY CONNECTOR<p>
FRIWO (TEXAS)
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 >NAME
 >VALUE
 
 
 




 

 

 
 

 


 
 <b>EAGLE Design Rules</b>
<p>
Die Standard-Design-Rules sind so gewählt, dass sie für 
die meisten Anwendungen passen. Sollte ihre Platine 
besondere Anforderungen haben, treffen Sie die erforderlichen
Einstellungen hier und speichern die Design Rules unter 
einem neuen Namen ab.
 <b>EAGLE Design Rules</b>
<p>
The default Design Rules have been set to cover
a wide range of applications. Your particular design
may have different requirements, so please make the
necessary adjustments and save your customized
design rules under a new name.
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		Enabling the IoT with the Intel Edison development platform

		The Intel Edison development platform is designed to lower the barriers to entry for Product Designers to rapidly prototype and produce "Internet of Things" (IoT) and wearables computing products. This on-demand webinar provides an opportunity to learn about Edison, development tools and IoT applications read more...
	





				
										
						
					
					Imagine the Panic situation in the Midnight when an intruder tries to break into the house. This Alarm will help you with its loud Police siren to abort the attempt of intrusion. With a single clap, the circuit generates the alarm for three minutes and then goes off. This is sufficient to catch the attention of neighbours.




The circuit is a sensitive Clap switch with timer action. IC1 is designed as a sensitive inverting amplifier to amplify the sound signals from the condenser mic. Variable resistor VR1 set the sensitivity of mic and resistor R1 and VR2 set the gain of the amplifier. If the sensitivity of mic and amplifier is suitably adjusted, the circuit can detect the sound from a distance of 5meters or more. 


Panic Alarm Circuit Diagram


[image: panic alarm circuit schematic]


When the mic detects clap sound, the ac signals pass through C1and IC1 amplifies the signal. This triggers T1 .When T1 conducts, the trigger pin of the Monostable Timer IC2 will be grounded and the timer triggers. With the given values of R5 and C2, output of IC2 remains high for three minutes. This high output provides power to the ROM IC UM3561. It generates the Police Siren since its pin6 remains unconnected. Resistor R8 determines the frequency of oscillation of IC3.The siren signals are amplified by T2 and the alarm tone can be heard through the speaker. Zener diode ZD gives 3.1 volt regulated supply to IC3.


555 datasheet

741 IC

UM3561 datasheet
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[image: burglar alarm system circuit schematic]Burglar Alarm System Circuit

[image: TINY-DOOR-GUARD]Tiny Door Guard with Alarm

[image: UM-3561-DESIGN]UM3561 Siren Generator Design

[image: datasheet]UM3561 Datasheet
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56 Responses to "Panic Alarm Circuit"




       		
   
      	  
         [image: ]		 
            Ed says:	on June 9, 2010 at 12:33 am			reply

				

      		
	  I just can’t tell u how much I have enjoyed this site !!  Though I haven’t recieved any anserws to my questions,,,,yet.  I have really looked forward to opening my e-mail to find NEW and different circuits to build and experiment with.  I know zealch about  electronics but find it alluring and fascinating.  I have learned,,,even @ 54 yrs of age and I LIKE IT!!


	
 	




   		
   
      	  
         [image: ]		 
            Arvince says:	on August 11, 2010 at 7:58 pm			reply

				

      		
	  Dear sir, i want to use panic alarm for my project. But, here are so hard to find ic  um3561 and T2 AC187. what the other component that can be replaced for both component? please reply this comment. thank


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on August 12, 2010 at 5:44 pm			reply

				

      		
	  We cannot substitute UM 3561. It is the siren generator IC.A simple buzzer can be connected at the output of IC555 is UM 3561 is not available. AC 187 can be substituted with BC547/548 eventhough the sound output will be low.You can use a high gain NPN transistor for it


	
 	




   		
   
      	  
         [image: ]		 
            AlanT says:	on January 13, 2015 at 2:20 am			

							reply
			
				

      		
	  Dear Sir,if I replace ic3 with a buzzer, which components will i have to take out of the circuit ?


	
 	








   		
   
      	  
         [image: ]		 
            Arvince says:	on August 14, 2010 at 9:18 am			reply

				

      		
	  Thank for the information sir.Now, i can proceed my project.


	
 	




   		
   
      	  
         [image: ]		 
            Arvince says:	on October 11, 2010 at 9:14 am			reply

				

      		
	  Dear sir, in my easy pc for panic alarm project, there have no pin ic for um3561, so that i have to use ic ne555. but,i dont know which pin to connect. can sir please tell me the pin need to be connected using ic ne555 by refer the ic um3561? thank you,sir


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on October 11, 2010 at 7:56 pm			reply

				

      		
	  You cannot substitute UM 3561 with 555 IC.Is it a simulation or real building


	
 	




   		
   
      	  
         [image: ]		 
            Arvince says:	on October 12, 2010 at 7:49 am			

							reply
			
				

      		
	  Dear sir,in my pcb board or real building i use ic um3561, but in the software of easy pc i am use the pin of ic ne555 because there have no ic um3561 in the software. i use ic ne555 because just want to connect the pin of the ic.


	
 	








   		
   
      	  
         [image: ]		 
            Arvince says:	on October 17, 2010 at 10:46 am			reply

				

      		
	  Sir, i have problem for the circuit of panic alarm. the speaker has sound but not the alarm sound. when i take the reading,all the reading show low voltage..microphone also didnt activated the speaker and zener diode just give 0.55v only even the ic um3561 need 3.1v to be activated.i dont know what the problem. can sir send me a pcb sketching or other that are useful to make the panic alarm function?…thank for your kindness..


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on October 17, 2010 at 6:11 pm			

							reply
			
				

      		
	  check the output from IC 555. It should be around 10 volts.Red LED will blink when MIC works. Adjust VR1 for sensitivity.Remove 0.22 capacitor and check whether IC1 is working. or not.If it is OK, replace a good quality Mic.


	
 	








   		
   
      	  
         [image: ]		 
            Arvince says:	on October 18, 2010 at 10:26 am			reply

				

      		
	  Sir, in the panic alarm circuit, should i add one connection on the pin 5 of ic um3561 to the positive line or just follow the actual circuit shown?


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on October 18, 2010 at 4:46 pm			

							reply
			
				

      		
	  UM 3561 is low power IC with maximum rating of 3 volts. Do not give higher voltage.IC will burn.


	
 	








   		
   
      	  
         [image: ]		 
            Arvince says:	on October 18, 2010 at 8:41 pm			reply

				

      		
	  Dear sir, i have testing my pcb for panic alarm circuit. Here, i am using the 3.3v led and when i on the power supply the led reading is 0.6v, the voltage of the microphone is 2.65v..is that the circuit function if the microphone show the voltage 2.65v? thank for the feedback from sir.


	
 	




   		
   
      	  
         [image: ]		 
            Arvince says:	on October 19, 2010 at 10:40 am			reply

				

      		
	  dear sir,wrong info from me…actually not 3.3v led but the zener diode which is 3.3v..


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on October 19, 2010 at 2:49 pm			reply

				

      		
	  dear sir, my panic alarm in the pcb, when i on the mic the will led on, then the led off when i off the micro..but, still not give alarm sound to the speaker but just normal speaker sound out.. the vr1 like to burn when i turn on the power supply.what the problem that should i fix?


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on October 24, 2010 at 8:24 am			reply

				

      		
	  Dear sir, i have another certain problem for my panic alarm circuit..here didnt sell the ac187 transistor so i have to use bc548.. when i testing, the speaker give police siren alarm when i on the supply. the microphone didnt give effect to the circuit. more than that, the bc548 which i use to replace the ac187 quick hot. what the solution and the problem for that circuit? thank


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on October 24, 2010 at 11:10 am			reply

				

      		
	  1. You can use BC 548 instead of AC187. But the output volume will be low.

2. Timer IC 555 is used to give power to UM 3561. So at power on the timer will be triggered but after the delay time, siren will stop.This helps to know that the Alarm is working. If the 555 IC is triggering continuously, it is due to the triggering of T1.T1 gets triggering pulse from IC1.Adjust VR2 to get zero output from IC1 in the standby mode.

3. Check the microphone for continuity. Solder it directly to the PCB with correct polarity.If you use wire for microphone, sensitivity will be greatly reduced.Adjust VR1 to get desired sensitivity.If the problem persists, replace 741 IC with CA 3140, more reliable OP Amp with same pin connection.

4. To check the circuit behind C1, momentarily give 9 volt supply to R1.If the circuit is working, the problem is with Mic or C1.

5. BC 548 is heating because the load( speaker ) is too high. Use a small 2 inch 8 ohms speaker.


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on October 24, 2010 at 9:49 pm			reply

				

      		
	  bc548 : pin no 1 collector, pin no 2 base and pin no 3 emitter

ac187 : pin no 1 emitter, pin no 2 base and pin no 3 collector.

when i use the bc548 to replace the ac187, should i use the pin of bc548 in my pcb or using ac187 pin in order to connect the circuit in easy pc software according the pin shown in the above?


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on October 25, 2010 at 3:49 am			reply

				

      		
	  AC 187 is a high gain NPN transistor with same pin connections as BC 548. Pin 1 is collector, pin 2 base and pin 3 emitter. The pins are identified from the front side with number printed.


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on October 25, 2010 at 12:44 pm			reply

				

      		
	  after make correction, when i turn on the power, the alarm at the same time give police alarm sound.the both variable resistor didnt have effect the circuit. the alarm kept on and the microphone didnt work.

i dont know what to do


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on October 29, 2010 at 5:13 pm			reply

				

      		
	  Sir, is that ac127 equivalent with ac187?


	
 	




   		
   
      	  
         [image: ]		 
            Bawek says:	on October 30, 2010 at 8:52 pm			reply

				

      		
	  Sir,when i on the power and the same time police siren alarm too active..so, this meant i have to wait the alarm stop after 3 minutes rite? is that meant when the delay time the ic2 which is ic555 output remain high, the component hot?just want to ensure the part i still wonder


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on October 31, 2010 at 4:46 am			reply

				

      		
	  At power on sometimes the Monostable will self trigger. This has one advantage.We can confirm that the circuit is working. I will post a circuit of monostable without false triggering.Reduce the current of the power supply to 500 mA or less to avoid heating.


	
 	




   		
   
      	  
         [image: ]		 
            Bawek says:	on October 31, 2010 at 8:50 am			reply

				

      		
	  Dear sir, at power on, the alarm too on.but,the alarm didnt stop on..i am use adaptor as the power supply.


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 1, 2010 at 6:58 pm			reply

				

      		
	  Dear sir,in order to avoid the false triggering,so i have to connect the pin 4 of ic555 with r1 and c1 rite. I have already put the all component to my pcb board. is that possible if i use a wire to connect the pin4 of ic555 with r1 and c1?


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 1, 2010 at 7:02 pm			reply

				

      		
	  Again, in this panic alarm circuit, how much the the false triggering time?


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 6, 2010 at 8:36 pm			reply

				

      		
	  Dear sir, may i know how to improve the condensor microphone?


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on November 7, 2010 at 4:16 am			reply

				

      		
	  Use a high quality condenser MIC.Adjust VR1 for maximum sensitivity


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 7, 2010 at 3:03 pm			reply

				

      		
	  Thank for your kindness sir. Now, my circuit work. Thank for all


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 8, 2010 at 7:35 pm			reply

				

      		
	  Dear sir,what is the ac signal meant?


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on November 9, 2010 at 3:50 am			reply

				

      		
	  Condenser MIC generates AC signals when its diaphragm vibrates due to sound pressure


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 9, 2010 at 7:11 am			reply

				

      		
	  Thank for the comment sir.

May i know what dc circuit of power supply suitable for this circuit?


	
 	




   		
   
      	  
         [image: ]		 
            Vincent says:	on November 10, 2010 at 1:15 pm			reply

				

      		
	  Dear sir, is that the mic and the ic ua741 is signal, ne555 receiver and um3561 transmitter in this panic alarm circuit?


	
 	




   		
   
      	  
         [image: ]		 
            D.Mohankumar says:	on November 10, 2010 at 1:59 pm			

							reply
			
				

      		
	  Dear Vincent

Mic is the sound sensor. IC 741 amplifies the sound.IC 555  is a monostable timer to give power to alarm generator IC UM 3561 for short duration


	
 	




   		
   
      	  
         [image: ]		 
            ashok says:	on September 25, 2012 at 7:32 am			

							reply
			
				

      		
	  Dear Mohankumar,

             thanks for your impressive replies.. Keep going..


	
 	








   		
   
      	  
         [image: ]		 
            Vincent says:	on November 10, 2010 at 2:16 pm			reply

				

      		
	  Sir, may i know what the block diagram of this panic alarm?


	
 	




   		
   
      	  
         [image: ]		 
            Bradley says:	on March 9, 2011 at 3:02 pm			reply

				

      		
	  Hey, i related very heavily towards this circuit for my AS coursework, however i used an op amp instead of transistors due to not having the transistors available for me to use.

I also used a 55 to generate a oscillating light to go with the circuit to make the light trigger aswell as the siren when switched on.


It works extremely well and the only problem i had was a slow time for capacitors charging before it functioned, however i resolved that. 


Thankyou, your circuit was very usefull.


Brad


	
 	




   		
   
      	  
         [image: ]		 
            musse says:	on February 15, 2015 at 1:32 am			

							reply
			
				

      		
	  Hi Bradley, 


I am currently using this schematic for my AS project this year do you know what suffix value C1 and C3 have. As in uF,pF or nF.


Thanks for your help.


	
 	








   		
   
      	  
         [image: ]		 
            sonybagus says:	on March 17, 2011 at 5:05 am			reply

				

      		
	  Can I install output speaker with power amplifier 60W ?, I need a loud sound min. 100 dB max. 150 dB. It can make a thief will shock and run. Thanks.


	
 	




   		
   
      	  
         [image: ]		 
            Bradley says:	on April 1, 2011 at 11:26 am			

							reply
			
				

      		
	  You could install a 60W power amplifier, i have installed a 5W power amplifier to my circuit and that works to a high enough standard to be heard from atleast 200M away when it is inside a building and switched on, so 60W could be a little too loud. try a 20-30W power amplifier that should be enough for just a panic alarm. [image: :)]


	
 	








   		
   
      	  
         [image: ]		 
            mariam says:	on August 1, 2011 at 11:55 am			reply

				

      		
	  sir,may i ask u something about shutter guard project?in the circuit simulation,we can’t find ic um3561.can i replace that ic with ne555?any suggestion from u sir?thank you for your reply [image: :)]


	
 	




   		
   
      	  
         [image: ]		 
            shashank mishra says:	on November 15, 2011 at 12:58 pm			reply

				

      		
	  sir ,i am making a shadow alarm detector circuit..plz do tell me how can i connect piezo buzzer,um3561 and speakers.what is the use of piezo buzzer in the circuit..


	
 	




   		
   
      	  
         [image: ]		 
            jj says:	on February 12, 2012 at 1:58 pm			reply

				

      		
	  can we include gsm feature to alert the neighbours .


	
 	




   		
   
      	  
         [image: ]		 
            F.john says:	on June 24, 2012 at 12:43 am			reply

				

      		
	  But,sir can i used another IC to replace UM3561 becoz there ar local electronics in our country


	
 	




   		
   
      	  
         [image: ]		 
            Capacitor says:	on July 28, 2012 at 11:22 am			reply

				

      		
	  Plz is good 2 replace 741 with ca3130


	
 	




   		
   
      	  
         [image: ]		 
            manoj says:	on September 14, 2012 at 5:35 pm			reply

				

      		
	  what is main use of this alaram tat is i need some applications about this alaram sir plz help me


	
 	




   		
   
      	  
         [image: ]		 
            ashok says:	on September 25, 2012 at 7:29 am			reply

				

      		
	  Thank you mr. mohankumar.. Your replies are very impressive.


	
 	




   		
   
      	  
         [image: ]		 
            ashok says:	on September 26, 2012 at 8:20 pm			reply

				

      		
	  How to connect vr1. . Is it has any polarity.. and capacitors are whether in picofarad or micro farad.. Please reply me


	
 	




   		
   
      	  
         [image: ]		 
            Jim Keith says:	on September 27, 2012 at 3:36 pm			

							reply
			
				

      		
	  VR1 is a potentiometer connected as a variable resistor.  It has no polarity, but the direction of increasing resistance reverses, depending upon how it is wired.  Capacitor values are in microfarads (uF).


	
 	








   		
   
      	  
         [image: ]		 
            dhawal says:	on March 29, 2014 at 5:57 am			reply

				

      		
	  How to change siren generating time? And Can we use bc187 transistor instead of ac187?


	
 	




   		
   
      	  
         [image: ]		 
            in panic alarm which sensor we r using says:	on August 1, 2014 at 8:19 am			reply

				

      		
	  which sensor is used in panic alarm


	
 	




   		
   
      	  
         [image: ]		 
            apoorv devarbhavi says:	on February 7, 2015 at 12:17 pm			reply

				

      		
	  sir i want to do a simple but intresting project using opamp aplications .can u please suggest n guide me to do this!!!!i am a 4th sem e&c student


	
 	




   		
   
      	  
         [image: ]		 
            GenericUser says:	on July 11, 2015 at 12:37 am			reply

				

      		
	  Most if not all smoke alarms and CO detectors use a 3 pin noise maker.  I want to use the noise maker in a completely different project for a hearing impaired person.

Does anybody know how to use the 3 pins?

Can anybody point me to a commercial noise maker with a similar pin-out? There is no number on the noise maker.  I can’t tell if it some kind of piezo device.

Remainder of detector will be recycled for hazardous materials.

Any kind of help appreciated.


	
 	




   		
   
      	  
         [image: ]		 
            Dheeraj says:	on October 23, 2015 at 1:44 pm			reply

				

      		
	  Hello sir,

In this circuit you have used an op amp with a single supply voltage.so when the circuit is on iam getting a DC offset of 3.3 volts …(I.e the voltage dropped across the positive terminal of ic 741).and iam getting a constant DC output voltage of 12 volts at collector of bc548…


Sir,can u please explain me this fast.


	
 	




   		
   
      	  
         [image: ]		 
            Dheeraj says:	on October 26, 2015 at 6:20 pm			reply

				

      		
	  Sir,

I thank u for this circuit .

Please answer my previous question which I have posted above

.

And also theres a change in the circuit ,the speaker should be connected to pin 5 of ic not directly to 12 volts.


	
 	




   		
   
      	  
         [image: ]		 
            Dheeraj says:	on October 28, 2015 at 3:41 pm			reply

				

      		
	  Can please any one reply to the above questions……its urgent .


	
 	








    
            

    
            







What do you think about this article? Leave a comment!


     
        Click here to cancel reply.         

    
                
            
            Name                (required)                
        


        
            
            Mail (will not be published)                (required)                
        


                
        

	
		You may add a picture too (related to electronics) 


        
            
            

        


        

 Check this checkbox to get notifications of followup comments via e-mail. You can also subscribe without commenting.




    
	   



								
		

			




	
		 			

<body style='background:transparent'></body></html>"" style="border: 0px; vertical-align: bottom;">





		
Login
		
			
			
				Email
				
			


			
				Password
				
			


			
			 Remember Me


			
				
				
			


			
		
Register | Lost your password?



Join all of us on our group			[image: electroschematics group on facebook]

		
Recent Questions		How to convert 120 VAC 60 Hz to Low Voltage 4-6 Hz? 

		How cell phone detector circuit works? 

		How mobile scanner circuit works? 

		Need help with Adrduino Relay LED programming 

		LA4440 vs CD4440.. What are the differences between these two IC’s.. How much does the sound quality differs? 




				recently added electronic circuits		
							
				Versatile 555 Schmitt Trigger /Logic Inverter /Level Translator
						


							
				Galvanic Skin Response System
						


							
				Mini Selfie Light Circuit
						


							
				Power Management of Xilinx ZedBoard using MMPF0100
						


							
				PIC32 Bluetooth Starter Kit; DM320018
						


				


		
																
	





	
	
	
	
	Links - Policy - Disclaimer - © Copyright 2008 - 2015 










This website uses cookies to improve your experience. We'll assume you're ok with this, but you can opt-out if you wish.Accept Read More
		
		
		
		







































[image: ]
[image: ]
[image: ]
[image: ]
[image: ]
[image: ]

[image: ]
[image: ]
[image: ]
[image: ]
[image: ]
[image: ]


image14.emf
Turn your EAGLE schematic into a PCB.pdf


Turn your EAGLE schematic into a PCB.pdf
instructables let’s make Explore (/tag/type-id/) Publish (/about/create jsp) You ~ (lyour)

d: shage wwatte}owwwmtel/) Gift Guide(/qgifts/) Snow(/tag/type-id/category-outside/channel-snow/?sort=FEATURED)

Holiday Sweets(/howto/holiday+sweets+cake+candy+cupcakes+pie+fudge+pumpkin/)

——
T —
__.__-—""
_—-_.’..-
Turn your EAGLE schematic into a PCB by westfw (memberiwestfw/) x

Download (/id/Turn-your-EAGLE-schematic-into-a-PCB/?download=pdf)
£22 (/id/Turn-your-EAGLE-schematic-into-a-PCB/?ALLSTEPS) 22 Steps  » (/id/Turn-your-EAGLE-schematic-into-a-PCB/step2/Menu-commands-used/)
oA
wmn;g'md 3

-Y;: : (o

+ Collection | Mad&it™ @ Favorite e Share v
N Ty

In a previous Instructable, | provided an intro to schematic entry using CadSoft's
EAGLE editor.
In this instructable, we'll make a printed circuit board from that schematic

I guess | should say that we'll make a PCB DESIGN; making the physical board
is a different task, and there are a lot of tutorials on the net (and even some
instructables) on making the board after you have the design.

Cadsoft EAGLE generic information:
About This Instructable
Cadsoft EAGLE is available from http://www.cadsoftusa.com/

(http://www.cadsoftusa.com/) @ 693,551 views Posted:
Oct 25, 2006
. ) . o @ 532 favorites
Cadsoft is a German company that is a veritable mecca of software distribution License:
enlightenment. In addition to the reasonably-priced professional PCB design

packages ($1200), they have freeware, lite, non-profit, and other intermediate
licenses. Their software runs under windows, linux, and MacOSX. It's slightly
quirky, with a steep (but not too high) learning curve on the front end, but from
most reports it is not any more so than other professional CAD packages. They

have online support forums that are active from both the company and other
1eare tha narkana iec 1indar riirrant davalanmant and nate hattar with aarh (/member/westfw/)

westfw
| (/member/westfw/)
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release. A number of PCB fabricators will accept their CAD files directly. It's
good stuff.
Use it. Propagate it. Buy it when you "go pro."

See also:

Schematic Entry (http://www.instructables.com/id/Draw-Electronic-Schematics-
with-CadSoft-EAGLE/)

Creating Library parts
(http://www.instructables.com/id/ERHQQ180Y3EP286NQY/)

Design rule modification
(http://www.instructables.com/id/EZVIGHUBGCEP287BJB/)

Send CAD Files to manufacturers (http://www.instructables.com/id/Professional-
PCBs-almost-cheaper-than-making-them-/)

Step 1: Starting from the schematic...

= =
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So this is the schematic we have from the Schematic Instructable
(http://www.instructables.com/id/EXU9BO166NEQHO8XFU/). Up in the file
menu, there's a "Switch to board" selection. If we do that from a bare schematic,
it will offer to create the board from the schematic for us (say "yes"), and then
leave us sitting in the Board Editor.
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abraxas2 (/member/abraxas2) 5 years ago Reply

| can't thank you enough for this excellent tutorial. | thought
I'd never get the hang of it and it's not a very intuitive
program. Do consider turning these tuts into a book. Now
hopefully one last question : after drawing the ground plane
with the ratsnest command | got a nice big plane but also a
bunch of tiny little islands that serve no purpose but to make
the board look dumb. | tried erasing these islands with the
rip up but it just ripped up the closest vital wire instead. Is
there away to zap these tiny little island ground planes ?
Thanks MUCHO !!

Flag
: westfw (/member/westfw) (author) » abraxas2 (/member/abraxas2) Reply
B)
© you can draw lines and/or rectangles in the tRestrict or 5 years ago
bRestrict layers, which will prevent the polygon fill from entering
those areas. You can see this in the PCB that goes with
http://www.instructables.com/id/Single-Sided-Really-Bare-
Bones-Board-Arduino-in-EA/ - | use it to prevent copper
between the pads of the bottom-side SMT capacitors. Note that
the restrict layers are not displayed by default; you'll have to
turn them on in the layer menu (they might get turned on
automatically when you draw on them, too.)
Flag
g A amereservant (/member/amereservant) » westfw (/member/westfw) Reply
m I've added text to the bRestrict using the vector font, but when2 months ago

| generate my gerber files, the text isn't there. Shouldn't the
gerber file containing the bottom copper layer include the
bRestrict layer and then show the missing copper when
viewing that gerber file with the gerber viewer?

Flag

abraxas2 (/member/abraxas2) » westfw (/member/westfw) 5 years ago Reply

It mysteriously fixed itself. Thanks.

Flag

jbste (/member/jbste) 2 months ago Reply

great tutorial but how do you deal with tracks present in the
schematic that don't appear on the pcb layout?

Flag
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bask185 (/member/bask185) a year ago Reply

eagle is so bad, there are no worse programs. | cannot delete
traces | just placed. and the resolution is horrible. despite
there is room for 4 or 5 lines, | can only draw 2 lines. | cannot
draw lines between 2 pads cuz of this crappy resolution. and
when | want to draw a line of a pad, it sometimes select
totally different pads. There are so many yellow to be routed
lines | can barely see what im doing, and when i disable them
| cannot see nothing. | cannot believe how bad this program
is made

Flag

nicky.ros (/member/nicky.ros) » bask185 (/member/bask185) a year ago Reply

| am sorry you're frustrated, but you can do all the things you're
complaining about.

It's just like a new language, you have to learn the new rules:

To delete traces made with "Route" use the "Ripup" function located to
the right of the "Route" button.

To delete traces made with "Wire" use the "Delete" function.

When you place a trace with "Route" it deletes the "Unrouted" yellow line,
if you put a trace with "Wire" you add a new trace and you should change
it's name to the net name you wish, otherwise it's just a piece of cooper
unconnected and it will give you DRC errors.

You can also change the grid and resolution to whatever you want. | built
boards with 6 layers and traces/gaps of 6mil and it works fine.

There are a lot of tutorials about this.

Flag

paw.uan (/member/paw.uan) » nicky.ros (/member/nicky.ros) a year ago Reply

| wish i could give you 1000 likes.....

Flag
Electrical Technology (/member/Electrical Technology) made it! Reply
I Thing MikrC is so easy for PCB Designing ayearago

Here is step by step tutorial for LED Flasher Circuit PCB Design in
MikroC

PCB Designing: How To Design a PCB (Step by Step & Pictorial
Views) (http://www.instructables.com/id/Turn-your-EAGLE-schematic-
into-a-PCB/?commentflag=1414769132351#C6H4AAY 1 XEJJFX)

(http://cdn.instructables.com/F40/SXRK/I1XEJJNI/F40SXRKI1XEJJINI.LARGE jpg)
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Electrical Technology (/member/Electrical Technology) a year ago

J-Rob McCoy (/member/J-Rob McCoy) 2 years ago

You have just taken me from dreading making the PCB from
the schematic to having one done in a flash. Excellent
instructable on taking the somewhat intimidating Eagle CAD
and teaching the basic functions on the PCB aspect of it.
Thank you.

gaurav157 (/member/gaurav157) 2 years ago

hey plz help me

when i print pcb from printer the size of ic lage will be
different in pdf and on paper

.How i set the sizes.
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hey plz help me

when i print pcb from printer the size of ic lage will be
different in pdf and on paper

.How i set the sizes.

mjeon (/member/mjeon) 2 years ago

The most helpful tips for me ever saw!!
Thanks for writer!!!

stuffstuffa (/member/stuffstuffa) 4 years ago

How can | mirror the whole board?

blinkyblinky (/member/blinkyblinky) » stuffstuffa (/member/stuffstuffa)

of Eagle, move it farther aside from the origin of the layout,
(spot with the plus sign that doesn't move when you click it)
release it. switch to mirror tool and then riaht click in the board

Reply

Flag

Reply

Flag

Reply

Flag

Reply

Flag

Reply

Flag

Reply

Flag

Reply

Flag

Reply

Group the board and then, assuming you're in the Light version 2 years ago
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and then lclick mirror:group

Flag
aashishsharma (/member/aashishsharma) 2 years ago Reply
hey
Nice eagle tutorials. | learned how to create custom parts
from scratch.

I just now want to learn how to create board from schematic.
Tutorial is nice.
| was wondering if | could have >.sch file so that | can
practice along as | go through tutorials
Thanks in advance
Flag

Good point; I'm surprised no one has asked before! ~ 2Yyearsago  Reply
https://docs.google.com/file/d/0B6dMB5dovDUZUDh4Y

westfw (/member/westfw) (author) » aashishsharma (/member/aashishsharma)
‘

Flag

49percentGood (/member/49percentGood) 2 years ago Reply

How do you go about printing it so that you can just take it
from the printer to the PCB (and the entire etching process)?
What | mean is, when you're all said & done with your PCB
design, how can | effectively take my board, print to a sheet
a paper, and do a toner transfer basically? Whenever | go to
Print as .PDF, even with Solid and Black checked off, it still
comes out with less-than desirable outcome. Any way that
the board can be simplified, or is there a program that can
take a ready to go .brd and turn it into a print ready file?

Flag

offtherails2010 (/member/offtherails2010) 3 years ago Reply
WHELP I WMHELP ! NTHELP I N HELP ! M
HELP !!!

| found your schematic tutorial only last night and its
AWESOME !

But trying this one but when i click on the next step after this
one there is no step and its replaced with the below
message and a load of HTML Coding !!!

Please excuse me, that was very impolite! -
javax.servlet.ServletException:
javax.servlet.jsp.JspException: ServletException in
'/common/instructable.jspx': ServletException in
'/pages/explore/typelinstructable_body.jsp":
java.lang.reflect.InvocationTargetException
Exception

Please help as your tutorials are out of this world and nice
and simple for a beginner like me to start learning how to
use EagleCADsoft !!!!

Any Idea's ??

Flag
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harishere (/member/harishere) 3 years ago Reply

I am new to Cadsoft Eagle and having trouble with designing
PCB. | used CAM processor tool to make PCB, but | only
want the tracks to remain after etching and rest of the
copper to disappear! Please tell me how can | do this!

| want a PCB like this, only tracks.

http://www.veys.com/wp-
content/uploads/2008/07/pcb_howto_drilled_bottom.jpg

Plz help! Thanks in advance!

Flag

thypnotist (/member/thypnotist) 4 years ago Reply

Your a Ledgend.

This is exactly what | needed to know from start to finish.
Thanks heaps.....

David

Flag

sallen14 (/member/sallen14) 4 years ago Reply

Nice tutorial!

I've been designing boards and schems using Eagle for a
while now, but where | am coming unstuck is finding
someone who can make a PCB from the board file that
Eagle produces.

My main board maker can't use the Eagle files, he only
wants files in Protel (Protrax etc) format.

My alternative boardmaker also can't use the Eagle files and
is asking for Gerbers.

So far | have not been able to find any program that can
convert Eagle files to either of these formats.

| did contact one boardmaker who said they could produce a
board for me using the Eagle files, but they wanted
something like $150 to make one board!!

Any suggestions?

Flag

Wichers (/member/Wichers) » sallen14 (/member/sallen14) 4 years ago Reply

You might try silvercircuits.com. They are much cheaper and can produce
boards directly from the eagle files.

Flag
westfw (/member/westfw) (author) » sallen14 (/member/sallen14) Reply
EAGLE can produce gerbers pretty easily; there is even an 4 years ago

instructable: http://www.instructables.com/id/Professional-
PCBs-almost-cheaper-than-making-them-/

Various PCB vendors (Sparkfun's BatchPCB, DorkbotPBX,
Itead, Seeed) provide the .CAM files that produce the right
gerbers with the expected filenames for that vendor...

I can recommend Dorkbot for small boards; helpful community,
nice boards. | think they'll actually take .BRD files, but it's
generally better to prepare the gerbers yourself so that you get
the content you want on the silkscreens (names, values, and
outlines are separate decisions!)
http://dorkbotpdx.org/wiki/pcb_order
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Flag

m1 (/member/aessam1) 4 years ago Reply

Amazing,very helpful tutorial

andi

have a small addition here

to export the PCB for toner transfer
view only (pads,vias,bottom layer)
then print from file menu

and mark (mirror,black,solid)

thanks
Flag
ptorelli (/member/ptorelli) 4 years ago Reply
Hello,
Great tutorial, much faster than the web-based videos.
What are your recommendations on production houses? |
googled PCB fabrication and found a dozen or so shops that
provide their own cam files. Rates range from $50 to $150
for a dozen or more 2"x2" 2 layer boards. Before | plunk
down that much for a mistake, wondering if you have any
favorite places?
thx,
p
Flag
abraxas2 (/member/abraxas2) 5 years ago Reply
Now that the autoroute has destroyed my hours of work,
how do | undo it ? Undo doesn't work !!!
Flag

A

computurwizard (/member/computurwizard) » abraxas2 (/member/abraxas2)

You can undo the autorouter. Click the ripup icon, then d yéars ago  Reply
on the top toolbar click the little traffic light icon. A
window will pop up asking if you are sure. Hit Yes.

Flag

westfw (/member/westfw) (author) » abraxas2 (/member/abraxas2) Reply

You can't undo the autorouter. It's a good idea to save your 5 years ago
work often, especially before large changes like autorouting.

The autorouter should not have destroyed any of the manual

routing you did; it just added a bunch of "other" traces. You can

get rid of individual traces, or sections, or everything, with

"ripup"”, but there isn't specifically a "ripup the bits you just

autorouted."

Flag
eriol (/member/eriol) 5 years ago Reply
using this instructable for creating a guitar pedal with friends.
thank you for sharing

Flag
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jonnyphenomenon (/member/jonnyphenomenon) 5 years ago Reply
Great instructable man. | just finished reading the "how to

draw a schematic" one and loved it. you helped me figure

out what i was doing wrong. :)

| sure would like to be able to download that hobby.dru file,
but the site keeps telling me | need to be logged in. (I am
logged in, or else | wouldnt be able to post this) Anyway,
guess | will have to follow your instructable and just make
my own :)

Flag

* a bmlbytes (/member/bmlbytes) » jonnyphenomenon (/member/jonnyphenomenon)

"
® Try the hobby.dru file on this page. Syearsago  Reply

http://www.instructables.com/id/Make-hobbyist-PCBs-
with-professional-CAD-tools-by-/

Flag

jonnyphenomenon (/member/jonnyphenomenon) » bmibytes
(/member/bmlbytes) 5 years ago Reply
Thanks! | dont remember how | did it, but somehow |

was eventually able to get it. the only problem | had

after using your hobby.dru file was that | coudint

change the shape of my pads. so some pads on

transistors violated the rules. | ended up exporting my

drawings into coreldraw format and trimmming them

there.

Flag

L) u hightekrednek2396 (/member/hightekrednek2396) 5 years ago Reply
®

if only i could put ten stars well done now in 30 minutes i
know how to make boards in eagle thanks

Flag

alr206 (/member/alr206) 5 years ago Reply

How do you get it to incorporate contacts that are connected
to gnd? Everytime | try, it excludes those areas (I am using
your design rules file). Thanks -- your instructables have
been VERY helpful!

Flag

westfw (/member/westfw) (author) » alr206 (/member/alr206) 5 years ago Reply

make sure that both the signal and the polygon have the same name (ie
"gnd") The easiest way to name the signal is to attach one of the "gnd"
symbols to it, and for the poly it's easiest to use the "poly gnd" to create it,
but you can also name them with the "name" command/button.

Flag

abraxas2 (/member/abraxas2) » westfw (/member/westfw) 5 years ago Reply

Every time | try to rename a signal path or pad, in board view, it says
"Cannot Back Annotate ...Change in Schematic View" So after many
attempts | finally manage to change one of these items names to "Base" ,
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IN scnematuc view, since It CONNECTS 10 a ransistor base. IT prompis me
with an invite to connect Base and Gnd, | respond "no". The adjacent
signal path which | do want renamed gnd, keeps on resetting to the name
Base and won't let me change it to gnd...no matter how many times | try.
Worse yet, when | do the gnd plane, both the Base and Gnd signals get

tied to the plane. It's driving me nuts.

abraxas2 (/member/abraxas2) » abraxas2 (/member/abraxas?2)

Flag

Reply

The only thing | can see is that | have some very faint phantom ° years ago

lines connecting the Base and GND traces. These are lines |
believe left over from a Rip Up repair. I'm guessing the program
still thinks these items are connected.

alr206 (/member/alr206) » westfw (/member/westfw) 5 years ago

Flag

Reply

| didn't realize that what | actually had was thermals, so the pads should
appear a little bit different under a closer view than in the pictures above.

Thanks again!

westfw (/member/westfw) (author) » alr206 (/member/alr206) 5 years ago

careful about that!

Naved Ahmad (/member/Naved Ahmad) 5 years ago

Hello Every body: This is N-A-G from Afghanistan, | need
help If any one has the basic, intermediat or advanced notes
about making remote control, motors, tank treads, PCB [in
pdf format or any other format] please send them to any one
of my accounts i will be thankful of that person. or if any
body has any link or some ones email, gmail, hotmail,
skype, yahoo that knows about the thinks i wrote above
please send them. i will be thankful of that person again.
thanks alot buddies. Contact: [0093 (0) 794 50 63 43] -
[0093 (0) 706 71 98 93] E-Mail
[nghafori@af.mercycorps.org] Gmail:
[navedahmadghafori@gmail.com] Yahoo:
[navedahmadghafori@yahoo.com] Skype:
[naved.ahmad.ghafori]

nicolo86 (/member/nicolo86) 6 years ago

Really useful, but i have a question. Is it possible to make
two different PCB connect with each other. if yes how.
thanks

tomtortoise (/member/tomtortoise) 6 years ago

yo when i did this step the two non-polar capacitors
disappeared from the whole thing? i have know idea what
happened to them and i still barely know how to use the
program.

Ah. Yes, | have thermals turned off in my init files, which makes my
normal behavior different than the default behavior. | should be more

Flag

Reply

Flag

Reply

Flag

Reply

Flag

Reply
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Flag

L) | amando96 (/member/amando96) 6 years ago Reply
RS
swett, helped me a lot
*faves™
Flag
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Chapter 1
Introduction

This manual describes the use of the EAGLE software and its basic prin-
ciples. The order of chapters follows the typical process from drawing a
schematic to a ready-to-use layout.

1.1 What is in This Manual?

A chapter’s main heading is intended to tell you briefly what the con-
tents of that chapter are. Here in the first chapter we want to give a
quick overview what you can expect from this manual.
Chapter 1 — Introduction

Contains a preview of the manual.

Chapter 2 — Installation
Deals with the program’s installation.

Chapter 3 — EAGLE Modules and Editions
Explains the various program variants.

Chapter 4 — A First Look at EAGLE
Gives a preview of the program’s structure and describes the
editor windows and their commands.

Chapter 5 — Principles for Working with EAGLE
Examines the basic ways of using and configuring EAGLE.

Chapter 6 — From Schematic to Finished Layout
Follows the route from schematic to layout.

Chapter 7 — The Autorouter
Dedicated to the Autorouter module and its configuration.

Chapter 8 — Component Design Explained through Examples
Explains the definition of library components through examples and
informs about library and component management.

Chapter 9 — Preparing the Manufacturing Data
Everything you need to know about generating manufacturing data.
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Appendix
Lists useful additional information and explains some error messages
EAGLE prompts in certain situations.

For a quick, hands-on introduction, refer to the EAGLE Tutorial.
Please read the tutorial for a better understanding before working with
the manual.

Anybody who has already been working with a prior version of
EAGLE is advised to read the file UPDATE under Linux or
UPDATE.TXT under Windows. It contains a description of all the dif-
ferences from earlier versions. This file is located in the eagle/doc direc-
tory. Please read it before you start working with EAGLE 4.

Information that was not available or that has been changed since print-
ing this manual is also described in UPDATE or UPDATE.TXT, or, if
it exists, in a README file.

Detailed information, especially about the EAGLE command language
and the EAGLE User Language, is available on the help pages. You can
reach a basic understanding very quickly by using this manual, and you
can use the convenient search features of the help function to quickly
locate the answers to particular questions.

1.2 Technical Terms

In this manual, in the help function, and in EAGLE itself we frequently
use some technical terms that should be explained here in a few words.

Airwire:
Unrouted connection on a board, displayed in the unrouted layer (=

rubber band).

Annulus Symbol:
An isolation ring that will be drawn in a supply layer or in a copper-filled
area.

Blind Via:

A plated-through hole for changing the layer of a track which has not
been drilled through all layers in the production process of a multilayer
board.

Buried Via:

A plated-trough hole, which has been drilled through the current layer
stack in the production process like a normal (through) via, but does
not connect all layers of the whole board.

Core: Two copper layers applied to a solid substrate.
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Design Rule Check (DRC):
EAGLE can identify the violation of certain Design Rules (e.g. if two
different tracks overlap or are too close) with the DRC.

Device:
A fully defined element in a library. Consists of a package and a symbol.

Device Set:
Consists of devices that use the same symbols for the schematic but
have different package variants or technologoies.

Drill:
Plated-through drilling in the layout (in pads and vias)

Electrical Rule Check (ERC):

EAGLE can identify the violation of certain electrical rules (e.g. if two
outputs are connected) with the ERC. It also checks the consistency of
the schematic and the layout.

Forward&Back Annotation:

Transforms all the actions one makes in a schematic online into the lay-
out (and with limitations from layout into schematic). Both files are
consistent all the time.

Gate:

The term gate is used in this manual for a part of a component which can
be individually placed on a schematic. This can be one gate of a TTL
component, one contact pair in a relay, or an individual resistor from a
resistor array.

Hole:

Non plated-through drilling in the layout (e.g. a mounting hole).

Layer Stack:

Current number and order of copper and isolation layers which are used
to build up a printed circuit board.

Micro Via:

A plated-through hole (like blind via) with a relatively small drill diame-
ter which connects an outer layer with the next reachable inner layer.
Net:

Electrical connection in a schematic.

Package:

Component footprint stored in a library.

Pad:

Through-hole pad associated with a package.

Pin:

Connection point on a schematic symbol.

Prepreg:

Used in a compound of inner and outer layers for multilayer boards.
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Rack:
Configuration table for a drilling machine. Needed for generating drill
data.

Ratsnest:
Command for calculating the shortest airwires.

Restring:

Remaining width of the copper ring around a plated-through pad or via.
Signal:

Electrical connection in a board.

Supply Symbol:

Represents a supply signal in the schematic. Causes the ERC to run spe-
cial checks.

Symbol:

Schematic representation of a component, stored in a library.

User Language:

Freely programmable, C-like language for data import and export.

Via:

Plated-through hole for changing the layer of a track. See also micro via,
blind via, and buried via.

Wheel:

Aperture configuration file. Generated with Gerber data for board
manufacturing.

Wire:

Electrical connection in a board, or a line (since lines are drawn with the
WIRE command).
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Chapter 2
Installation

2.1 What You Have Received

The EAGLE pack, with the license agreement on the outside, contains
the EAGLE CD-ROM, a license disk, the User License Certificate with
the personal installation code, a training manual and this reference
manual.

It may be that not all of these items are included if you have asked for an
upgrade to an existing Version 4.1 installation or for an extension of
your license. In all cases, however, there is a new License Certificate and
a new license disk.

If your computer is not equipped with a floppy disk drive, you may
copy the file license.key from the license disk to another media or, if
available, make it accessible through a network computer.

Keep the User License Certificate with your personal installation
code in a safe place, inaccessible to unauthorized persons! Never give
the license file or installation code to others! Never send your instal-
lation code by e-mail to CadSoft or to anyone else.

You need the license card as evidence of your entitlement to future
upgrades or updates.

2.2 New Installations
The CD contains EAGLE for Windows (95, NT 4.0, and above) and

Linux. Any particularly recent or additional information about the in-
stallation may be found in the README files in the relevant directories
on the CD-ROM or on an included floppy disk.
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Windows

Place the CD-ROM in the drive. After a short delay the CD-ROM
startup window should open. If this does not happen, double-click on
the CD-ROM symbol in the My Computer folder on the Windows
desktop.

When the CD-ROM startup window has opened, the first thing to do is
to select the language in which you want to work. The user interface,
help texts, and additional documentation will be installed in that lan-
guage. In the next window, click on the Install program item, and then
simply follow the setup routine.

You will be asked for the license disk as the installation proceeds. Keep it

to hand.

The program must be licensed the first time it is called. Enter the path
to the license file (usually A:\license.key) and your personal installation
code, as noted on the EAGLE User License Certificate, into the
EAGLE Product Registration window.

The program will then start, and will show the license data in the Con-

trol Panel. You can display the license data at any time in the EAGLE
Control Panel by means of the Help/Product Information menu.

Linux

You can either use the RPM or the TGZ archive to install EAGLE on
your system. Depending on the selected archive file the user interface,
help texts, and additional documentation will be installed in the respec-
tive language. The following assumes that you have mounted the
EAGLE CD-ROM as /cdrom, and that you are logged in to your system

as root user.

Installing the RPM Archive:

Use rpm to install the package:

rpm -1 /cdrom/english/linux/install/eagle-4.xxe-1.1386.rpm
By default this package installs to /opt/eagle, but you can relocate it to a
different directory using rpm’s -prefix option. Note that a shell script
will be executed that installs a symbolic link to the executable file in
Jusr/local/bin, and also copies the manual page to /usr/local/man/mani.
You can use rpm’s -noscripts option to avoid this.

Enter the command
/opt/eagle/bin/eagle

to invoke the product registration (you need to have write access to that
directory for doing this!).
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Installing the TGZ Archive:

Create a new directory on your system (e.g. /opt/eagle):

mkdir /opt/eagle

cd /opt/eagle

Use tar to extract the archive:

tar xvzf /cdrom/english/linux/install/eagled.xxe.tgz
Change into the directory that has just been extracted from the archive:
cd /opt/eagle/eagle-4.xxe

Run the installation script:

./install

Enter the command

bin/eagle

to invoke the product registration (you need to have write access to that
directory for doing this!).

Usage

To use EAGLE you should create a working directory
mkdir /home/username/eagle

change into that directory

cd /home/username/eagle

and start the program

eagle

2.3 Updating an Older Version

Follow the same procedure described in the section on New Installations
on page 15. Please read the file update.txt in the EAGLE directory, in or-
der to familiarize yourself with the changes in the new version of the
program. Additional notes on installing an update may be found in the
latest README files.

For reasons of safety it is good practice to create a backup of your previous
data before proceeding!

Files from earlier versions can be used directly with the current one. In case
the files were made with a version prior to EAGLE 2.60 you have to con-
vert them with a program named Update26.exe. Detailed information
about this can be found on page 243.
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2.4 Changing or Extending the License

If you are changing your license you will receive a new User License
Certificate with a new installation code, together with a floppy disk and
a new license file.

Run EAGLE, and select the item Product Registration in the Control
Panel under the Help menu. You will now be asked for the path to the
license.key file (on the license disc) and for the installation code. Enter

both of these and click OK.

The program has now been re-licensed. You can call up the license data
at any time in the EAGLE Control Panel by means of the Help/Product
Information menu.

This method also allows to upgrade a currently installed Freeware.

2.5 Multiple Users and Network Licenses

Multiple-user licenses may be installed separately on different comput-
ers, or may be used in a network within the scope of the license condi-
tions. The installation procedure in a network is generally the same as
that on a stand-alone computer, and is described in the section on New
Installations on page 15.

Installing in a Network

The user rights of multiple-user or network licenses differ from those of
the single-user version. It does not contain any special network mecha-
nism, and can therefore be used in most networks.

A typical installation can look like this:

The EAGLE program is installed on a server. Library, design, ULR, proj-
ect and other directories can be freely chosen. After installation,
EAGLE is started and licensed from one of the workstations. This re-
quires write access in the eagle/bin directory. The license file that has
been created, eagle.key, is not changed again after the installation. Write
access 1s no longer required.

EAGLE can now be called from all the other workstations. Please en-
sure that all the workstations call EAGLE in the same way as was used
when licensing.

A private working directory (local or on the network) can now be set up
for each computer. A user-specific configuration file (eaglerc.usr under
Windows, or .eaglerc under Linux) is located in this directory. Further
sub-directories can then, for instance, contain individual projects.
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Alternatively it is possible for each computer on which EAGLE is to be
available to have a separate license. In this case, copy the eagle.key file
that was created in the EAGLE program directory (eagle/bin) into the
computer’s private working directory. When first starting the program,
enter the installation code and the path to the license file license.key.
This procedure is recommended, for instance, for multiple-user licenses
for 3 to 5 users who will only work at specific computers.

Special Instructions Under Windows

Path Information

It has been found to be helpful to use the server names in UNC nota-
tion when giving the path for calling EAGLE, rather than the drive let-
ters. For example:

\\netservername\eagle\bin\eagle.exe

Different Operating Systems at the Working Computers

If network computers having different Windows systems are in use, it is
first necessary to perform an installation as described above.

The following situation can arise:

All the computers that are using, for instance, Windows 2000 can run
EAGLE. Computers with Windows ME, however, cannot. In order to
be able to operate the computers running Windows ME as well, copy
the files eagle.exe and eagle.key, located in the eagle\bin directory on the
server, to, for instance, eagle2000.exe and eagle2000.key. Now start all
the computers that run Windows 2000, using the command

EAGLE2000
Then start EAGLE from a computer with Windows ME, and license it

again with the installation code and the license disc. The eagle.key file is
then valid for all the Windows ME computers. The program is run with

EAGLE

You need write authorization for the eagle\bin directory to perform the
copying and licensing!
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Chapter 3
EAGLE Modules and Editions

3.1 EAGLE Modules

A number of EAGLE editions are offered. You can add an Autorouter
Module and/or a Schematic diagram Module to the Layout Editor. The
term module is used because EAGLE always behaves like one single
program. The user interface is identical for all parts of the program.

The Layout Editor, the Basic Module

The basic EAGLE software package comes with the Layout Editor,
which allows you to design printed circuit boards (pcbs), plus the Libra-
ry Editor, the CAM Processor, and the text editor. With the Library Edi-
tor you can already design packages (footprints), symbols and devices
(for a schematic). The CAM Processor is the program which generates
the output data for the production of the pcb (e.g. Gerber or drill files).
It is also possible to use User Language programs and script files.

Schematic Module

If you have the schematic module you begin by drawing a circuit dia-
gram. You can generate the associated circuit board at any time with a
mouse-click. EAGLE then changes to the Layout Editor, where the
packages are placed next to an empty board - connected via airwires
(rubber bands). From here you can go on designing with the Layout
Editor as usual. Schematic and layout are automatically kept consistent
by EAGLE (Forward&Back Annotation). Schematic diagrams can con-
sist of up to 99 sheets.
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Autorouter

You

can route the airwires automatically if you own the Autorouter

module. You can choose single nets, groups of nets or all nets for the
automatic routing pass (AUTO command). The program will handle
various network classes having different track widths and minimum
clearances.

3.2 Different Editions

EAGLE offers various performance/price categories (editions) called
Light, Standard, and Professional. The facilities mentioned in this man-
ual always refer to the Professional edition.

Professional Edition

General

maximum drawing area 64 x 64 inches
resolution 1/10,000 mm (0.1 microns)
mm or inch grid

up to 255 layers, user definable colors
command (script) files

C-like User Language for data export and import and the realizati-
on of self-defined commands

easy library editing
composition of self-defined libraries by Drag&Drop

simple generation of new package variants from other libraries by
Drag&Drop

free rotation of package variants (0.1-degree steps)
library browser and convenient component search function
technology support (e. g. 74100, 74LS00..)

output of manufacturing data on plotter, photo plotter and drilling
machine or as a graphic data format

print via the operating systems’ printer devices

user definable, free programmable User Language for generating
data for mounting machines, in-circuit tester and milling machines

Drag&Drop in the Control Panel

Automatic backup function
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Layout Editor
¢ full SMD support
* support of blind and buried vias
* rotation of elements in arbitrary angles (0.1-degree steps)
* texts can be placed in any orientation
¢ dynamic calculation of signal lines while routing the layout
* tracks can be layed out with rounded corners in any radius
* mitering to smooth wire joints
* Design Rule Check for board layouts
* copper pouring

* support of different package variants

Schematic Module

* up to 99 sheets per schematic

* simple copying of parts

* online Forward&Back Annotation between schematic and board
* automatic board generation

* automatic generation of supply signals (for IC’s)

* Electrical Rule Check (checks logic in the schematic and the con-
sistency of schematic and layout)

Autorouter Module

* fully integrated into basic program

* uses the set of Design Rules you defined for the layout

* change between manual and automatic routing at any time

* ripup&retry algorithm

* user-definable strategy (by cost factors)

* routing grid down to 0.8 mil (0.02 mm)

* no placement restrictions

* up to 16 signal layers (with user definable preferred directions)
* up to 14 supply layers

¢ full support of blind and buried vias

* recognizes signal classes that define special settings for wire with
and minimum distances
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Standard Edition

Circuit boards up to a maximum size of 160 mm x 100 mm can be cre-
ated with the Standard Edition. The components can only be placed
within the range of coordinates from (0 0) up to (160 100) mm.

The number of signal layers is limited to 4. This means that two inner
layers are possible.

Light Edition

The Light edition permits boards with a maximum size of 100 mm x 80
mm (half eurocard format).

A maximum of 2 signal layers (top and bottom) may be used.

Circuit diagrams can only be drawn on a single sheet.
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Chapter 4
A First Look at EAGLE

4.1 The Control Panel

The Control Panel normally appears after starting EAGLE, and this is
the program’s control center. All the files specific to EAGLE are man-
aged here, and some basic settings can be made. It is similar to the famil-
iar file managers used by a wide variety of applications and operating
systems. Each EAGLE file is displayed in the tree view by means of a
small symbol.

A context menu is opened by clicking with the mouse on an entry in the
tree view. This allows you, depending on the object, to carry out a vari-
ety of actions (rename, copy, print, open, create new etc.).

The Control Panel supports Drag&Drop. This can also be done be-
tween different programs. You can, for instance, copy files, move them,
or create links on the desktop. User Language programs or script files
that are pulled with the aid of the mouse out of the Control Panel and
into an editor window are started automatically. If, for instance, you pull
a board file with the mouse into the Layout Editor, the file is opened.

The tree structure provides a quick overview of the libraries, Design Ru-
les, User Language programs, script files, CAM jobs and projects. Spe-
cial libraries, text, manufacturing and documentation files can belong to
a project as well as schematic diagrams and layouts.

The first time it is called, the Control Panel will appear very much as
shown in the following diagram. If an object is selected in the tree view,
further relevant information is displayed in the right hand part of the
window.

Simply click on various folders and files in order to experiment with the
Control Panel’s facilities.
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Control Panel [ E3
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Control Panel: On the right, the description of a TTL library

Library Summary

The possibility of displaying the contents of the libraries is particularly
interesting. It provides a very rapid overview of the available devices.

Double-click on the Libraries entry. The library branch opens, and you
can see the available libraries. In the Description field you can see a brief
description of the contents. If a library is selected you will see more ex-
tensive information about the library in the right hand part of the Con-
trol Panel. If you then double-click on a library, the contents will be
displayed together with a short description of each element. Devices and
packages are marked with a small symbol.

Now select, for example, a device.

The description of the device and a graphical representation of it appear
on the right. The available package and technology variants are listed. If
you click on one of the package versions, the package shown above will
change.

If a Schematic Editor window is open, the entry ADD will be shown
right of the variant name. Click it and the device is attached to the
mouse cursor as soon as it is over the Schematic Editor window. Now
you can drop it in the schematic.

If you are only working with the Layout Editor, this will of course also
operate with packages. It is, additionally, possible to drag a device from
the tree view into a schematic diagram and to place it there by means of
Drag&Drop. If it has more than one package version, the ADD dialog
opens automatically, so that the desired package can be selected.
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The green marker behind the library entry indicates that this library is
in use. This means that it can be used in the current project. Devices in
this library will be examined by the search function in the ADD dialog
of the schematic diagram or of the layout. This makes them available for
the project. The library will not be examined if the marking is gray.

If starting EAGLE without a project (no eagle.epf file is read, the project
has been closed before exiting EAGLE last time) and creating a new
project (U File/New/Project) all libraries will be in use automatically.
However, opening an already existing project, where only certain librar-
ies are in use before creating the new project, will adopt this selection.

If the Library Editor window is open you can Drag&Drop a complete
Device set or package definition from the Control Panel into the library
window. This way you can copy it from one library into another.
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Control Panel: Library Summary with Device View

Design Rules

Special Design Rules can be specified in EAGLE to govern the board de-
sign. These can be saved as data sets in special files (*.dru).

The parameter set that is to govern the current project is specified in the
Design Rules branch of the tree view. If no data has been provided for
the Design Rules (DRC command), EAGLE will itself provide parame-
ters. The marking to the right of the file entry specifies the default pa-
rameter set for the current project. The layout will be checked by the
DRC in accordance with these criteria. Further information about the
DRC and the Design Rules is found starting on page 98.
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User Language Programs, Scripts, CAM Jobs

These entries show the contents of the ulp, scr and cam directories.
They contain various User Language programs (*.ulp), script files
(*.scr) and CAM jobs (*.cam) for the output of data using the CAM
Processor. If one of these files is selected in the Control Panel, you will
see a full description of the file.

The paths can be set by means of the Options/Directories menu. This is
discussed in more detail later in this chapter.

Projects

The various projects are managed from the Control Panel. A click on
the Projects entry displays various folders. These are located under the
path set under Options/Directories/ Projects. It is allowed to define more
than one path there.

A project usually consists of a folder (directory) which represents the
project by its name and the project's configuration file eagle.epf- The fol-
der usually contains all files that belong to your project, for example,
schematic and board file, special library files, script files and so on.

Project directories that contain the project file eagle.epf will be marked
with a red folder icon. Normal' folders will be marked with a yellow
icon.

The project to be edited is selected in the Projects branch. On the right
of the project's name you will find a marker which is either gray or
green. With the help of this marker one can open or close projects.
Clicking onto a gray marker, loads the project. The marker appears
green now. Clicking on the green marker again or clicking onto another
gray marker closes the current project respectively opens another pro-
ject after closing the current one. This way one can switch easily from
one project to another.

While closing a project the current settings will be stored in the corre-
sponding project file eagle.epf, provided that the option Automatically
save project file is set in the Options/Backup menu.

New projects are created by clicking the right mouse button on a folder
entry in this branch. A context menu opens which permits new files and
directories to be created and the individual projects to be managed.
Selecting the option New/Project invokes a new folder which has to be
given the project's title. The project file eagle.epf will be created
automatically.

You can also use the File/Open/Project or the File/New/Project menu to
open or create a new project.
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Context menu for project management

The context menu contains the Edit Description item. A description of
the project can be entered here, and this is then displayed in the Descrip-
tion box.

Menu Bar

The Control Panel allows various actions to be executed and settings
made through pull-down menus that are explained below.

File Menu

The File menu contains the following items:

New

Creates a new layout (board), schematic, library, CAM job, ULB script
or text file. The Project option creates a new project. This initially con-
sists simply of a new directory in which the files for a new project are
handled. These will consist as a rule of the schematic diagram and lay-
out, possibly of special libraries, script files, User Language programs,
documentation files etc. and of the file eagle.epf, in which project-
specific settings are stored.

The default directories for the various file types are defined in the
Options/Directories menu.

CAM jobs are definitions for generating output data which are created
with the CAM Processor.
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Script and ULP files are text files containing command sequences in the
EAGLE command language or the EAGLE User Language. They can be
created and edited with the EAGLE text editor, or with any other text
editor.

Open

Opens an existing file of the types mentioned above.

Open recent projects

Lists recently used projects.

Save all

All changed files are saved. The current settings for the project are saved

in the file eagle.epf.

Close project

The project will be closed. Project-specific settings are saved in the
eagle.epf file of the current project directory.

Exit

The program is terminated. When EAGLE is started again, the last pro-
gram status is restored, i.e. the windows and other working environ-
ment parameters appear unchanged. If there was no project loaded only
the Control Panel will be opened next time.

The current status is also saved when you leave EAGLE with Alt-X
from any program part.

View Menu

Refresh

The contents of the tree view are updated.

Sort

The contents of the tree view will be sorted by name or by type.

Options Menu

Directories

The default directories for particular EAGLE files are entered in the
directories dialog box.

More than one path may be entered for each of these. In the Windows
version the entries are separated by semicolons, while a colon is used in
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the Linux version. The Projects directory is the default directory for the
text editor.

The Projects directory contains subdirectories, each of which represents
a particular project. Each of the project directories contains an EAGLE
project file (eagle.epf). A project directory and its subdirectories usually
contain all the files that are associated with one particular project, such
as the schematic diagram and the layout, text files, manufacturing data,
documentation files and so on.

= Direclories Lx]
Libraries [$EAGLEDIR ]
Diesign Aules |$EAGLEDIF\/"dru

Liser Language Programs | SEAGLEDIR Al

Soripts [$EAGLEDIR /ser
CéM Jobs [$EAGLED IR /oam
Erojects [$EABLEDIR /prajects

Ok | Browse | Cancel

The directories dialog in the Options menu

Type the path directly into the corresponding box, or select the desired
directory by clicking on the Browse button.

The default settings can be seen in the diagram above. $EAGLEDIR
stands for the installation’s EAGLE directory.

You may also use $HOME for your home directory under Linux. Under
Windows it is possible to define this environment variable wit the SET
command.

If a HOME variable has not been set within the environment, then un-
der Windows EAGLE will suggest the directory My Documents.

This directory is defined in the Windows registry in:

HKEY_ CURRENT_USER\Software\Microsoft\Windows\CurrentVersi-
on\Explorer\Shell Folders\Personal

It is of course also possible to specify paths with an absolute format.

Please note:
The HOME variable must not point to the root directory of a drive.

Backup

When files are saved, EAGLE creates backup copies of the previous
files. The maximum backup level field allows you to enter the maximum
number of backup copies (default: 9). Backup files have different file ex-
tensions, enumerated sequentially. Schematic files receive the ending
s#x, board files b#x, and library files [#x. x can run from 1 to 9. The file
with x = 1 is the newest one.

31





EAGLE Manual

The automatic backup function also permits the backup to be
scheduled. The time-interval can be between 1 and 60 minutes (default:
5 minutes). The backup files have the endings b##, s## and [##
respectively.

All these backup files can be further processed in EAGLE if they are
renamed and given the usual file endings (brd, sch, lbr).

= Backup x|
Masimum backup level 3 =
Auta save interval [minukes) |9 ;I

¥ Automatically save project file

ak. | Canhizel ‘

Backup dialog

If the option to Automatically save project file is chosen, your project is
automatically saved when you close the current project or leave the
program.

User Interface

The User Interface dialog allows the appearance of the editor windows
for the layout, schematic diagram and library to be adjusted to your pre-
ferences.

You can also access this menu from the Editor windows.

Uszer interface

Contrals Lapaut

v Pulldown menu Background: ¢ Black " ‘white + Calored

v Action toolbar Cursor. & Small ¢ Large

¥ Parameter toolbar

¥ Command butions SEhEm=

I Commend tests Backgound: © Black & ‘White ¢ Colored
Cursor, % Smal  Large

Iizc

[T &hways vector font Help

W Limit zoom factor I Bubble help

Mouse wheel zoom ’127 Ve e

Cancel |

Settings for the User Interface

In the Controls box you specify which elements are to be displayed in
the editor window. If you deactivate all the Controls, only the command
line will remain for entry. This maximizes the free area available for the
drawing.
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The option Always vector font shows and prints texts with the built-in
vector font, independently from the originally used font. Using the vec-
tor font guarantees that the output with a printer or the CAM Processor
is exactly the same as shown in the editor window. Fonts other than vec-
tor font depend on the systems' settings and cannot be controlled by
EAGLE. The output of non-vector fonts may differ from the editor's
view.

Opening the User Interface dialog from one of the Editor windows (for
example, the Layout Editor) the Always vector font option offers an ad-
ditional item Persistent in this drawing. Setting this option causes
EAGLE to save the Always vector font setting in the current drawing file.
So you can be quite sure that the layout will be shown with vector font
at another's person computer (for example, at a boardhouse).

Please see the help function for details (TEXT command).

Limit zoom factor limits the maximum zoom factor in an editor window.
Deactivating this option allows to zoom into the drawing as far as one
square millimeter.

Please be careful with this option! Some graphics devices won't display
a proper drawing screen exceeding a certain zoom factor (16 bit coordi-
nate range). The worst case may result in a system crash due to a sloopy
programmed driver.

If you are working with a wheel mouse, you can zoom in and out by
turning the mouse wheel. Mouse wheel zoom determines the zoom fac-
tor. The value 0 switches this function off.

The background color and the appearance of the drawing cursor can be
separately adjusted for the layout and the schematic diagram editors.
The background may be black, white or shown in any other color (Colo-
red). The background color definition is described on page 80.

The cursor can be displayed optionally as a small cross or as large cross-
hairs.

The check boxes in the Help area allow you to switch on or off the
popup texts for the command icons (Bubble help) and the help texts for
the commands in the status line (User guidance).

Deselecting the User guidance check box allows commands like NET,
MOVE, ROUTE, SHOW to show information about the selected ob-

ject in the satus bar of the editor window.

Window Menu

From the Window menu you can choose the window (schematic, board,
etc.) to be displayed in the foreground. The number on the left is the
window number. It allows you to choose a window when combined
with the Alt key (e.g. Alt+1 selects window 1).

The combination Alt40 can be used anywhere in the program to bring
the Control Panel into the foreground.
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Help Menu

The Help menu contains an item for calling the help function, as well as
items for installing a new license (Product registration) and getting infor-
mation about the program version etc. (Product information).

Product Registration

The registration dialog is called automatically when you start EAGLE
the first time. If you want to install an upgrade you must start this dia-
log from the Help menu, and then enter the necessary information ac-
cording to the License/Product Registration section of the help function.
All editor windows have to be closed before. Read the notes in the chap-
ter Installation for more information.

Product Information

If you contact our technical support you should provide the informati-
on you will find under this menu item.
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4.2 The Schematic Editor Window

The Schematic Editor window opens when you load an existing sche-
matic or create a new one. There are several ways of opening files in

EAGLE.

You can, for instance, load a schematic diagram by means of the
File/ Open/Schematic menu in the Control Panel. Alternatively you can
double-click on a schematic diagram file in the tree view.

If you want to create a new schematic diagram, select the menu
File/New/Schematic. This will open a schematic with the name
untitled.sch in the current project directory.

If you want to create a schematic diagram straight away in a new project,
you may for example click with the right mouse button on a project in
the Projects entry of the tree view, and select the New project option
from the context menu. The new project receives a name. Then click on
this entry with the right mouse button. Now select New/Schematic
from the context menu.

A new schematic opens in this project directory.

B2 2 Schematic - R:Vhome\ric\E agle-4.1\projects\t_pwramp2.sch
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The Schematic Editor

On top you will see the title bar, which contains the file name, and then
the menu bar, and the action toolbar.
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Below the action toolbar there is the parameter toolbar, which contains
different icons, depending on the active command.

Above the working area you will find the coordinate display on the left,
with the command line, where commands can be entered in text for-
mat, to the right of it.

EAGLE accepts commands in different but equivalent ways: as mouse
clicks, text via keyboard, or from command (script) files.

On the left of the work space you find the command toolbar, which
contains most of the Schematic Editor’s commands.

Below, in the status line, instructions for the user appear if a command
1s active.

Each of the toolbars can be displayed or hidden using Options/User
Interface. It is also possible to rearrange the toolbars within certain
limits with the aid of the mouse. The command toolbar, for instance,
can also be placed on the right, or the action and parameter toolbars can
be placed together on one line.

How You Obtain Detailed Information About a
Command

Bubble Help or Tool Tips

If the mouse cursor remains above an icon for longer than a certain
time, the name of the EAGLE command appears. You also see a short
explanation below in the status line.

For example, move the cursor over the WIRE icon. Bubble help with the
word Wire appears directly by the cursor. The short description, Draw
lines, appears in the status line.

If you select the command, a short note appears below in the status line,
indicating what would normally be expected as the next action. For in-
stance, if you click on the WIRE icon, the status line will display the in-
struction: Left-click to start wire .

These functions can be activated or cancelled in the Control Panel by
means of the Options/User Interface menu.

ﬂ Help Function

If you want to learn more about a command, e.g. the WIRE command,
click its icon in the command toolbar, then click the help icon.

As an alternative you can type
HELP WIRE

into the command line. The « character symbolizes the Enter key.
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Command Parameters

A number of EAGLE commands need additional parameters. Refer to
the help pages for a description of the textual entry of parameters (via
command line or script file).

Most of the parameters can be entered by clicking the appropriate icons
in the parameter toolbar, which changes according to the selected com-
mand. These icons also show bubble help explanations.

This is how the parameter toolbar appears when the NET command is
activated.

) o e ST S Miten |0 " ¥ Swle: | Continuous > || Metclass: | 0 default x

On the left is the GRID icon for setting the grid pitch. To the right are
buttons for the bend mode (SET WIRE_BEND) of the net line, fol-
lowed by the miter radius for smoothing line joints with the options
straight or rounded (see MITER command). Next to this is the Style
menu where the type of line is defined. On the far right is a value menu
for assigning a Net class.

GRID command: This icon is available at any time. It is used to adjust
the grid and to select the current unit. In EAGLE, any value relates to
the current unit.

The Action Toolbar

This toolbar is composed of the following icons:

=1t E Y

From the left: Open file, save file, print file, call CAM Processor,
open/create corresponding board file (BOARD command).

141 7

Load, remove, or create a new schematic sheet.

il!| USE command: Select libraries which will be taken into consideration
by the ADD dialog. Can also be done with the Library/Use menu item
or by clicking the markers in the Libraries branch of the Control Panel's
tree view. The context menu of the entry Libraries or of its subfolders
contains the entries Use all and Use none for a quick and simple
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selection/deselection of all libraries (of the folder).
This command has to be used in script files in order to choose the li-
brary you want to take parts from.

£#| SCRIPT command: Execute a script file. This enables you to execute

any command sequence with a few mouse clicks.

2Pl RUN command: Start a User Language program (ULP).

(el

WINDOW command: These icons represent different modes of the
WINDOW command: Fit drawing into the screen (Alt-F2), zoom in
(F3), zoom out (F4), redraw screen (F2), display new area.

That part of the drawing displayed on the screen can be shifted by hold-
ing down the Ct7l key and moving the mouse at the same time.

To move the current drawing window click the middle mouse button
and move your mouse!

Press the Shift key simultaneously and you are allowed to scroll be-
yoned the drawing boundaries!

2l

UNDO and REDO: These commands allow you to cancel previous
commands and to execute commands which have previously been can-
celled. Function keys: F9 and F10 (default).

@| Terminates the execution of EAGLE commands (Edit/Stop command).

E Starts the execution of the active EAGLE command. This is only neces-
sary if further parameters could be entered by the user.

The Schematic Command Toolbar

ﬂINFO

Provides information about the object to be selected.
(=|sHowW
Highlights the object to be selected.

ﬂ DISPLAY

Select and deselect the layers to be displayed. See the Appendix for the
meaning of the layers. For further details please see help function.
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@ MARK

The following mouse click defines the new origin for the coordinate dis-
play. Relative coordinates (R x-value y-value) and polar values

( Pradius angle) are shown in addition to absolute coordinates in the co-
ordinate display box. If you first click the MARK icon and then the
traffic-light icon, only the absolute coordinate values will be displayed
again.

ﬂ MOVE

Move any visible object. The right mouse button rotates the object.

If you move a net over a pin, no electrical connection will be established.
If you move the pin of a gate over a net or another pin, an electrical con-
nection (net) will be created.

To move groups of objects: define the group with the GROUP com-
mand, click the MOVE icon, then select the group with the right mouse
button and move it to the desired location. The right mouse button ro-
tates the group by 90 degrees.

£z COPY
o Copy parts and other objects.
£3| MIRROR
Mirror objects.
| ROTATE
Rotate objects by 90 degrees (also possible with MOVE).
i J|GROUP

Define a group which can then be moved, rotated, or copied (with CUT
and PASTE) to another drawing. After the icon has been clicked, a rec-
tangular group can be defined by holding down the left mouse button
and dragging the cursor to the diagonal corner of the rectangle. If you
want to define a group by a polygon, use the left mouse button to deter-
mine the corners of the polygon. Then click the right mouse button to
close the polygon.

ﬂ CHANGE

Change the attributes of an object, e.g. the width of a line, the package
variant or the size of text. See help for details.

ﬁ CuT

Transfer the objects of a previously defined group into the paste buffer.
See PASTE command. Not identical to the Windows cut function.
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ﬂ PASTE

Insert objects from the paste buffer into the drawing. Restrictions: see
help. Not identical to the Windows paste function.

% DELETE

Delete visible objects.

Also in combination with GROUP command. If a group has been de-
fined, it can be deleted with the right mouse button.

The DELETE command deletes an entire part when clicking on a gate
with the Shift key pressed. In that case, the wires connected to the ele-
ment in the board will not be ripped up.

Clicking on a net or bus wire with the Shift key pressed deletes the enti-
re net or bus segment.

EADD

Add library elements to the schematic. A search function helps devices
to be found quickly. USE specifies which libraries are available.

g PINSWAP

Swap two nets connected to equivalent pins of a device, provided the
pins have been defined with the same swaplevel.

ﬁ GATESWAP

Swap two equivalent gates of a device, provided the gates have been de-
fined with the same swaplevel. In EAGLE terminology, a gate is a part of
a device which can be individually placed on a schematic (e.g. one tran-
sistor from a transistor array).

£ NAME

Give names to components, nets, or buses.

EVALUE

Provide values for components. Integrated circuits normally get the
type (e.g. 74LSOON) as their value.

E SMASH

Separate name and value texts from a device, so that they can be placed
individually. The size of smashed texts can also be individually changed.
Also in combination with GROUP If a group is defined, you can smash
it with a right mouse click.

Keep the Shift key pressed while using the SMASH command in order
to unsmash texts. They are not editable anymore and appear at their
original positions after a window refresh.
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~ MITER

Round off or bevel wire joints (also possible for nets, buses, polygon
contours). The grade of mitering is determined by the miter radius.
Positive sign results in a rounded joint, negative sign in a bevel.

The miter radius influences some wire bends, too (see help function:

SET, Wire_Bend).
F~ SPLIT

Insert an angle into a wire or net.
40| INVOKE

Fetch a particular gate from a device (e.g. gate D before gate C). This
command allows you also to add a gate from a device which is located
on another sheet. In such a case, type the name of the device (e.g. IC1)
into the command line after the INVOKE command has been selected.

A WIRE

Draw line (this command is called WIRE because it is used to define
electrical connections, i.e. wires, in the Layout Editor). The type of line
can be changed with CHANGE STYLE. Clicking the right mouse but-
ton changes the bend mode (SET WIRE_BEND).

WIRE can also be used to draw arcs.

Please note the particularities in combination with the Ctrl and Shift key
in the help function.

ﬂ TEXT

Placing text. Use CHANGE SIZE to alter the height of the text. If the
text is using a vector font, CHANGE RATIO will alter the thickness.
CHANGE TEXT is used to alter the text itselfl. CHANGE FONT al-
ters the typeface. You change label texts by assigning a different name to
the bus or to a net by means of the NAME command. See also LABEL
command.

g CIRCLE

Draw a circle. Circles with a width of 0 are drawn as filled circles.

ﬂ ARC

Draw an arc (also possible with WIRE).
CHANGE CAP FLAT | ROUND defines straight or rounded ends for

arcs.

RECT

Draw a rectangle.

POLYGON

Draw a polygon (copper areas in any shape).
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E BUS

Draw a bus line. The meaning of a bus is more conceptual than physical.
It is only a means to make a schematic easier to read. Only nets define
an electrical connection. Nets, however, can be dragged out of a bus.

%NET

Draw a net. Nets with the same name are connected (even if located on
different sheets).

Nets and pins which appear to the eye to be connected are not necessar-
ily electrically connected. Please check with the SHOW command, the
ERC, or by exporting a netlist with the EXPORT command. See also
MOVE.

ﬂJUNCTION

Place the symbol for a net connection. In general, junctions are placed
automatically, but nets which cross over can also be joined manually by

the JUNCTION command.
&< | LABEL

Place the name of a bus or net as a label. Labels cannot be changed with

CHANGE TEXT but rather with the NAME command.
@ ERC

Perform an Electrical Rule Check and a consistency check for schematic

and board.

Commands Not Available in the Command Tool-
bar

Menu items already explained in the Control Panel section are not dis-
cussed here.

The following commands can be entered into the command line. Some
of them are available as menu items.

ASSIGN

Assign function keys. The most convenient way of doing this is to use
the Options/Assign menu.

CLASS

Select and define net classes (Edit/Net classes...). A net class specifies the
width of a track, the clearance from neighboring signals, and the diame-
ter of vias for the Autorouter and the ROUTE command. These set-
tings are also used in polygons.
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CLOSE

Text command for closing an editor window (File/Close).

EDIT

Text command for loading a file or a library object. You can, for in-
stance, load a board from the Schematic Editor (EDIT name.brd).

EXPORT

Output lists (especially netlists), directories, script files, or images

(File/ Export...).

LAYER

Choose or define the drawing layer. When using drawing commands the
layer can be chosen in the parameter toolbar.

MENU

Specifies the contents of the text menu. See also the example in the ap-
pendix. The text menu can be made visible with the aid of Options/User
Interface. See help function for details.

OPEN

Text command for opening a library for editing (Library/Open). This
command is not identical to the File/Open menu item of the Schematic
Editor, which only lets you select schematics. You can use the OPEN
command as an alternative to the File menu of the Control Panel.

PRINT

Call up the print dialog with the printer icon in the action toolbar or the
menu item File/Print.... Normally the PRINT command is used to print
schematics or check the drawings needed for the pcb production. The
actual production data are generated with the CAM Processor. If you
want to output your drawing in black and white check the Black option
(and Solid, if you don’t want layers to be printed in their different fill
styles). The caption text is suppressed unless you check Caption (avail-
able via the Page button) . Set Page limit to 1 if your drawing is to be fit-
ted on one page.

QUIT
Quit EAGLE. Identical with the menu item File/Exit or Alt-X.
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REMOVE
Delete files or schematic sheets.
REMOVE .S3 «

for instance, deletes sheet 3 of the loaded schematic.

SET

Set system parameters and modes. Best done via the Options/Ser menu
item. Please note that not all of the possibilities are available through
this dialog. Presettings can be defined in the script file eagle.scr by using
text commands. Further information can be found in the help function.

UPDATE

The UPDATE command checks the parts in a board or schematic
against their respective library objects and automatically updates them if
they are different. (Library/Update... or Library/ Update all).

The context menu in the Control Panel's' tree view offers the Options
Use all and Use none for a quick selection of libraries.

USE

Select libraries that will be referred to by the ADD dialog. Click the
USE icon in the Layout Editor's or Schematic Editor's action toolbar or
select the menu item Library/Use to start this command. This selection
can also be done by clicking on the library markers (green for selected,
gray for deselected) in the Libraries branch of the Control Panel's tree
view. The context menu of the Libraries entry in the tree view contains
two items: Use all and Use none for an easy selection of all or none of
the libraries.

The command has to be used in script files to select the library from
which one wants to use elements.

WRITE

Text command for saving the currently loaded file. Please note that, in
contrast to Save as, the name of the currently edited file is never
changed when the WRITE command is used.

Mouse Keys

The middle and right mouse button have a special meaning for a number
of commands.You can use the middle mouse button only if the operat-
ing system knows your mouse is a 3-button mouse, that is your mouse
must be installed this way.
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If you are working with a wheel mouse you can use the wheel to move
the drawing area in an editor window. Selecting another value than 0 for
the option Mouse wheel zoom in the Options/User Interface menu sets a
zoom factor for zooming in and out with the mouse wheel.

Mouse clicks in combination with the Shift, Ctrl, and Alt key can have
various functions, for example, while selecting objects with MOVE or
while drawing lines with WIRE.

The help section on keyboard and mouse and the help of the referring
command gives you more details.

Selecting Neighboring Objects

If one of two objects which are very close together is to be selected, the
individual objects are highlighted one after the other. The user can select
the highlighted object with the left mouse button, or proceed to the
next one with the right mouse button. The status bar of the editor win-
dow shows information about the pre-selected object. See also help

function (SET command, SELECT _FACTOR).

4.3 The Layout Editor Window

The Layout Editor window opens when you open an existing board file
or create a new board. If you own the Schematic Editor you will nor-
mally draw a schematic first and then generate the board file with the
BOARD command, or by clicking the Board icon.

The Layout Editor window appears very much like the Schematic Editor
window. Even if you don’t work with the Schematic Editor, you should
study the previous section, as most of the information there applies to
the Layout Editor, too.

Only the commands in the command toolbar are discussed again, as
some commands differ in their use.

Descriptions of commands that cannot be reached through the com-
mand toolbar are also to be found in the section concerning the Sche-
matic Editor window.

All of the commands can also be reached through the pull-down menus
in the menu bar. This also applies, of course, to the Schematic and Lay-
out Editor windows.
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Layout Editor window

The Commands on the Layout Command Toolbar

ilINFO

Provides information about the object to be selected.

§| SHOW

Highlights the object to be selected.

!| DISPLAY

Select and deselect the layers to be displayed. Components on the top
side of the board can only be selected if the layer 23, tOrigins, is dis-
played. The same applies to components on the bottom side of the
board and layer 24, bOrigins. Only those signal layers that are defined
in the Layer setup are shown.

See Appendix for the meaning of the layers.

Additional information about further options of the DISPLAY com-
mand can be found in the program's help.
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@ MARK

The following mouse click defines the new (relative) origin for the co-
ordinate display. Relative coordinates are shown additionally in the form
(R x-value y-value), polar values in the form (P radius angle). Use the
same syntax to enter relative or polar values in the command line.

If you first click the MARK icon and then the traffic-light icon, only the
absolute coordinate values will be displayed again.

ﬂ MOVE

Move any visible object. The right mouse button rotates the object.

The MOVE command cannot connect signals even if a wire (trace) is
moved over another wire or a pad. Use ROUTE or WIRE to route
signals.

Keeping the Ctrl key pressed while selecting an object selects it in a par-
ticular manner. Please consult the help function for details (CRICLE,
ARC, WIRE, MOVE, ROUTE etc).

See Schematic Editor section for moving groups.

£% COPY
Copy objects.

E MIRROR

Mirror objects. Components can be placed on the opposite side of the
board by using the MIRROR command.

|" ROTATE

Rotate objects (also possible with MOVE). Keep the left mouse button
pressed to rotate the selected object by moving the mouse. The parame-
ter toolbar shows the current angle. This can be done with groups
(GROUP and right mouse button)as well. Alternatively type in the an-
gle in the Angle box or in the command line. More details can be found
in the help function.

}| GROUP

Define a group which can then be moved, rotated, or copied (with CUT
and PASTE) to another drawing. After the icon has been clicked, a rec-
tangular group can be defined by holding down the left mouse button
and dragging the cursor to the diagonal corner of the rectangle. If you
want to define a group by a polygon, use the left mouse button to deter-
mine the corners of the polygon. Then click the right mouse button to
close the polygon.

To be sure that all elements are selected DISPLAY ALL layers before.
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ﬂ CHANGE

Change the attributes of an object, e.g. the width of a track or the size
of a text. If the Esc key is pressed after changing a property, the previ-
ously used value menu will appear. In this way a new value can be con-
veniently chosen. See the help pages.

ﬁ CuT

Transfer the objects of a previously defined group into the paste buffer.
See PASTE command. Not identical to the Windows cut function.

ﬂ PASTE

Insert objects from the paste buffer into the drawing. Restrictions: see
help. Not identical to the Windows paste function.

% DELETE

Delete visible objects.

If a group has been defined, it can be deleted with the right mouse
button.

DELETE SIGNALS erases all signals in the layout, provided there is no
consistent schematic opened.

The DELETE command deletes an entire polygon when clicking on a
polygon wire with the Shift key pressed.

Keeping the Ctrl key pressed while clicking on a wire bend will delete
the bend. A new direct connection between the next bends will be
drawn now.

If objects cannot be deleted, the reason can lie with error polygons re-
lated to the DRC command. They can be deleted with the ERRORS
command (ERRORS CLEAR). If layer 23, tOrigins, or 24, bOrigins, is
not displayed, components cannot be deleted.

EADD

Add library parts to a drawing. It offers a convenient search function.
The USE command determines which libraries are available.

g PINSWAP

Swap two signals connected to equivalent pads of a component, pro-
vided the pins have been defined with the same swaplevel.

ﬂ REPLACE

Replace a package with another package from any library. This is
permitted as long as you are working in a layout that is not connected to
a consistent schematic by Forward&Back Annotation. In that case you
must use CHANGE PACKAGE in order to change the package variant.
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£2 NAME

Give names to components, signals (polygons as well) or vias.
+|VALUE

Provide values for components. Integrated circuits normally get the IC
type (e.g. 7400) as their value.

E SMASH

Separates name and value texts from a component, so that they can be
placed individually. The size of smashed texts can also be changed indi-
vidually.

Also in combination with GROUP. All elements are smashed with a
right mouse click in that case.

Keep the Shift key pressed while using the SMASH command in order
to unsmash texts. They are not editable anymore and appear at their
original positions after a window refresh.

7~ MITER

Round off or bevel wire joints (also possible for polygon contours). The
grade of mitering is determined by the miter radius. Positive sign results
in a rounded joint, negative sign in a bevel.

The miter radius influences some bend modi, too (see help function:

SET, Wire_Bend).
F~ SPLIT

Insert a bend into a wire.

ﬁ OPTIMIZE

Joins wire segments in a signal layer which lie in one straight line.

E ROUTE

Route signals manually. Airwires are converted to wires.

ERIPUP

Convert routed wires (tracks) into unrouted signals (airwires). Change
the display of filled (calculated) polygons to outline view.

A WIRE

Draw lines and arcs. If used in the layers 1 through 16, the WIRE com-
mand creates electrical connections.

The style parameter (CHANGE) determines the line type. The DRC
and the Autorouter always treat a WIRE as a continuous line, regardless
of what style is used.

Clicking the right mouse button changes the wire bend (SET
WIRE_BEND). Please note the particularities in combination with the
Ctrl and Shift key in the help function.
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ﬂ TEXT

Place a text string. Use CHANGE SIZE to set the height of the text. If
the text is using a vector font, CHANGE RATIO will alter the thick-
ness. CHANGE TEXT is used to alter the text itsell. CHANGE
FONT alters the typeface. The option Always vector font (Options/User
Interface) shows and prints all texts in vector font, regardless of which
font is actually set for a particular text.

It is strongly recommended to write texts in copper layers as vector font! So
you can be sure that the CAM Processor's output is identical with the
text shown in the Layout Editor. See also help function.

g CIRCLE

Draw a circle. This command creates restricted areas for the Autorouter
if used in the layers 41, tRestrict, 42, bRestrict, or 43, vRestrict. Circles
with wire width = 0 are drawn as filled.

j ARC

Draw an arc (also possible with WIRE).
CHANGE CAP FLAT | ROUND defines straight or rounded ends for

arcs.
If the arc is a part of a trace and both ends are connected to a wire, caps
will be round.

RECT

Draw a rectangle. This command creates restricted areas for the Auto-
router if used in the layers 41, tRestrict, 42, bRestrict, or 43, vRestrict.

POLYGON
Draw a polygon.

Polygons in the signal layers are treated as signals. They keep an adjust-
able distance to objects belonging to other signals (copper pouring,
flood fill). This enables you to realize different signal areas on the same
layer.

The POLYGON command creates restricted areas for the Autorouter if
used in the layers tRestrict, bRestrict, or vRestrict, .

For other possibilities of the POLYGON command see help.

ﬂ VIA

Place a via-hole. Vias are placed automatically if the layer is changed dur-
ing the ROUTE command. You can assign a via to a signal with the
NAME command by changing it’s name to the name of the signal.

M SIGNAL

Manual definition of a signal. This is not possible if the Forward&Back
Annotation is active. In that case you have to define the connection
with the NET command in the Schematic Editor.
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ﬂ HOLE

Define a mounting hole.

E RATSNEST

Calculate the shortest airwires and the real mode (filled) display of
polygons. The polygon calculation can be deactivated with the SET
command (Options/Set/Misc). This command will be executed auto-
matically for the selected signal while drawing a wire with ROUTE.

ﬂ AUTO

Start Autorouter.

@ ERC

Perform consistency check of schematic and board.

@ DRC

Define Design Rules and perform Design Rule Check.

(®)| ERRORS
Show errors found by the DRC and clear error polygons.

4.4 The Library Editor Window

The Library Editor window opens when you load a library for creating
or editing components. A library normally has three different elements:
packages, symbols and devices.

* A package is a device’s housing, as will be used in the Layout Edi-
tor (on the board).

* The symbol contains the way in which the device will be shown in
the schematic.

* The device represents the link between one (or more) symbol(s)
and a package. Here we define the connection between a pin of a
symbol and the referring pad of the package.

We call it a Device set if the component exists in more than one
package and/or technology variant.

Even if you do not have the schematic module, you can still create and
edit symbols and devices.

A library need not contain only real components. Ground or supply
symbols as well as drawing frames can also be stored as devices in a li-
brary. These symbols do not normally contain any pins. There are also
libraries that only contain packages.

Extensive examples of the definition of library elements are to be found
in a section entitled Component Design Explained through Examples,
starting on page 157 in this manual.
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When a library is loaded the following window appears first:
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File Edit Draw “iew Library Options ‘window Help

led& 38+ zzaaaad@ - D7

=

? 0.05 inch (1.151.00) | | f

nl

v

Kl
|
Library Editor window: No element has yet been loaded

Load or Rename Package, Symbol, or Device
The following commands are important for navigating within a library:

El EDIT
Load device or package (if you only have the Layout Editor) for editing.
33|88 o
From the left: Load device, load package, load symbol. These icons are
shown in the action toolbar.

REMOVE
Delete device/package/symbol from library. Available only through the

Library menu or the command line. See help.

RENAME
Rename device/package/symbol. Available only through the Library

menu or the command line. See help.
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The Package Editing mode

The definition of a device is described briefly below. There is a more ex-
tensive guide in the Component Design Explained through Examples
section.

The icons available in the command toolbar are equivalent to the identi-
cal icons of the Schematic or Layout Editor.

Design New Package

You change into package editing mode through the Package icon in the
action toolbar. Type in the name of a package, and reply to the confirm-
ing question Create new package ‘packagename’s with yes.

Place pads (though-hole contacts) or SMDs (SMD contact areas) with
the following commands which are only available in the Package Editor.

ﬂ PAD

Place the pad of a conventional component.

jSMD

Place a SMD pad.
You can change the name of the pads or SMDs with the NAME

command.

Use the WIRE, ARC, etc. commands to draw
* the symbol for the silkscreen on layer 21, tPlace,

¢ additional graphical information for the documentation print into
layer 51, tDocu.

Draw restricted areas for the Autorouter, if needed, in layers 41, tRe-
strict, 42, bRestrict, or 43, vRestrict, or in layers 39, tKeepout, or 40, bKee-
pout, by using the commands CIRCLE, RECT, or POLYGON.

Place mounting holes with the HOLE command, if needed.
Use the TEXT command to place

¢ the string >NAME in layer 25, tNames, serving as a text variable
containing the name of the component,

* the string >VALUE in layer 27, tValues, serving as a text variable
containing the value of the component.

Use the DESCRIPTION command to add a description for the pack-
age. Rich Text format can be used for this. You will find further informa-
tion in the help pages.
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Design a New Package from an Existing One

Load the existing package, display all layers, define a group (GROUP
command) containing all of the objects, click the CUT icon and then
the origin of the drawing area (coordinates 0 0).

You can also type the CUT command on the command line and give a
reference point, for example:

CUuT (0 0) ;

Open a new package (in the same or another library) for editing, click
the PASTE icon and then the origin of the drawing area.

Or enter again the PASTE command with a reference point in the com-
mand line, for example:

PASTE (0 0) ;
Now edit the objects in whatever way you want.

You can use the coordinate values for the CUT and PASTE commands
to move the group in the coordinate system. This may be useful for ob-
jects that are not drawn in the correct grid.

GROUBP, CUT, and PASTE can be used to copy Packages and Symbols,
but not to copy Devices.

See also EXPORT SCRIPT on page 75.

The Symbol Editing mode

Defining a symbol means defining a part of a device which can be placed
individually in a schematic. In the case of a 74L00 this could be one
NAND gate and the two power pins, defined as another symbol. In the
case of a resistor, the device contains only one symbol which is the rep-
resentation of the resistor.

You now change into symbol editing mode through the Symbol icon in
the action toolbar. Enter the name of the symbol, and reply to the con-
firming question Create new symbol ‘symbolname’? with Yes.

Design a New Symbol

Use the commands WIRE, ARG, etc. to draw the schematic representa-
tion of the symbol into layer 94, Symbols.

Place the pins by using the following PIN command, which is only
available in the symbol editing mode:

ﬂPIN

Place pins.
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You can adjust the pin parameters (name, direction, function, length, visi-
ble, swaplevel) while the PIN command is active, or with the CHANGE
command. The pin parameters are explained starting on page 162 and in
the help pages under the keyword PIN. Pin names are changed using the
NAME command.

Use the TEXT command to place

¢ the string >NAME in layer 25, tNames, serving as a text variable
containing the name of the component,

¢ the string >VALUE in layer 27, tValues, serving as a text variable
containing the value of the component.

Design a New Symbol from an Existing One

Load the existing symbol, display all layers, define a group (GROUP
command) containing all of the objects, click the CUT icon and then
the origin of the drawing area (coordinates 0 0).
You can also type the CUT command on the command line and give a
reference point, for example:

CUT (0 0) ;
Open a new symbol (in the same or another library) for editing, click
the PASTE icon and then the origin of the drawing area.
Or enter again the PASTE command with a reference point in the com-
mand line, for example:

PASTE (0 0) ;
Now edit the objects in whatever way you want.

You can use the coordinate values for the CUT and PASTE commands
to move the group in the coordinate system. This may be useful for ob-
jects that are not drawn in the correct grid.

GROUB, CUT, and PASTE can be used to copy Packages and Symbols,
but not to copy Devices.

See also EXPORT SCRIPT on page 75.

The Device Editing mode
Components are defined as devices. In the device editing mode you do
not draw anything, but you define the following:

* which package variant is used,

* which symbol(s) is/are used (called gate within the device),

* which names are provided for the gates (e.g. A, B),

* which technologies are available (e.g. 74100, 74LS00, 74HCT00),

¢ if there are equivalent gates which can be interchanged
(swaplevel),

* how the gate behaves when added to a schematic (addlevel),
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the prefix for the component name, if a prefix is used,

if the value of the component can be changed or if the value
should be fixed to the device name,

* which pins relate to the pads of the package (CONNECT com-

mand)

* whether a description for this component should be stored in the
library.

The following diagram shows the fully defined 7400 device with four
NAND gates and a supply gate in various package and technology
versions.

81 1 Library - R:/home/ric/eagled.0/1br/ttl-74xx. Ibr (74=00.dev]
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Device Editor window

Create Actual Components from Symbols and Packages

Switch to the device editing mode by clicking the Device icon of the ac-
tion toolbar. Type in the device name and confirm the question Create
new device 'devicename'? with Yes.

Use the following commands to create a device.
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ADD

Add a symbol to a device. Gate name, swaplevel, and addlevel can be de-
fined in the ADD command in the parameter toolbar, or redefined later

with the CHANGE command.
The swaplevel specifies whether there are equivalent gates.

The addlevel defines, for instance, if a gate is to be added to the sche-
matic only on the users request. Example: the power gate of an inte-
grated circuit which is normally not shown on the schematic.

NAME
Change gate name.

CHANGE
Change swaplevel or addlevel.

PACKAGE

Define and name package variant(s). The PACKAGE command is
started by clicking on the New button in the Device Editor window, or
by typing on the command line. Choose the requested package variant.

More information about this can be found on page 199.

CONNECT
Define which pins (gate) relate to which pads (package).

PREFIX

Provide prefix for the component name in the schematic (e.g. R for re-
SIStOrs).

VALUE

In the device mode, VALUE is used to specify whether the component
value can be freely selected from within the schematic diagram or the
layout, or whether it has a fixed specification.

On: The value can be changed from within the schematic (e.g. for resi-
stors). The component is not fully specified until a value has been
assigned.

Off: The value corresponds to the device name, including, when present,
assignment of the technology and the package version (e.g. 74LS00N).

Even if the value is Off; the value of a component can be changed. The
new value is specified after a query checks that the action is intended. If,
however, the technology or the package version is altered at a later stage
by means of CHANGE PACKAGE or CHANGE TECHNOLOGY,

then the value of the component returns to the original value.
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TECHNOLOGY

If necessary, various TECHNOLOGIES can be defined for, for exam-
ple, a logic component.

DESCRIPTION

Compose a description of the device which can also be examined by the
search function associated with the ADD dialog.

Information about Copying of packages, symbols and devices can be found
on page 205.

4.5 The CAM Processor Dialog

Manufacturing data is generated by means of the CAM Processor. A
number of drivers for the data output are available. The drivers are de-
fined in the file eagle.def , which can be edited with any text editor.

Output to matrix printers, however, is not created with the CAM Pro-
cessor but with a PRINT command.

The EAGLE license conditions allow you to give the CAM Processor to
your board manufacturer. To do this, you only need supply him with a
copy of the EAGLE freeware.

Please, however, do not pass on your installation code. This is punishable by
law.

The CAM Processor can run without support from any licensing
mechanism. Alternatively, your board manufacturer can order the
EAGLE freeware directly from CadSoft.

The CAM Processor can also be started directly from the command
line. A number of command line parameters can be passed to it when it
is called. These are listed in the appendix.
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CAM Processor

Generate Data

Load Job File

A job defines the sequence of several output steps. You can, for exam-
ple, use a job to generate individual files containing the Gerber data for
several pcb layers.

A job is loaded with the File menu of the CAM Processor or via the
Control Panel.

A job is not absolutely essential for output. All the settings can be made
manually.

Load Board

Before you can generate an output you must open the File menu and
load a board. At the bottom left in the CAM Processor window you can
see the BRD file for which data is being generated.

Output Parameters

If a job file is loaded, the output parameters are already adjusted. A job
can contain several sections with different parameter sets. The various
peripheral devices accept different parameters.
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If no job is loaded, set the parameters to whatever you need (see page
220).

Start Output

If you want to execute the job which has been loaded, click the Process
Job button. If you just want to get an output using the currently visible
parameter settings, click the Process Section button.

Define New Job

Perform the following steps to define a new job:

1. Click Add, to add a new section .
2. Set parameters.

3. Repeat 1. and 2. if necessary.

4. Save job with File/Save job.

The Description button allows to describe the job file. This description
will be shown in the Control Panel.

The chapter on Preparing the Manufacturing Data contains detailed in-
formation on this subject.
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4.6 The Text Editor Window

EAGLE contains a simple text editor.

You can use it to edit script files, User Language programs or any other
text file.

When in the text editor, the right mouse button calls up a context menu.

The menus bring you to a variety of functions such as commands for
printing, copying and cutting, searching, replacing (also regular expres-
sions), changing font and size, and so on.

2’1 Test Editor - D-/eagled/ulp/checklbr.ulp o]
File Edt ‘Window Help
#usage "<b>Library checker</b><p>\n" |

"Checks a library against a set of standards.<p>'n"
"Usgage: RUN checklbr.ulp<p>in"
"sauthorrAuthor: supportf@cadsoft.de</author>"
if (!library) {
dlgMessageBox(usage + "<hr><h»ERROR: Mo library!</b><p>‘nThis program can o
exit(1);
i

int MININT = 0x80000000; //XZX
int MAXINT = OxT7FFFFFFF; //XIX

//EEX checkUnconnectedPins!ll

int checkDuplicates =
int checkDescriptions

int checkOriginsitCenter =
int checkPinPadAtOrigin =
int checkTechnolaogystar =

1
1
1;
1
1

//TODO check active layers, no user defined layers!
string CheckDeviceSet (UL DEVICESET D&)

{

string Errors;

4 o

T:1 lhe

The Text Editor
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Chapter 5
Principles for Working with EAGLE

5.1 Command Input Alternatives

As an alternative to the mouse, the EAGLE Schematic, Layout, and
Library Editors allow you enter all commands:

* on a command line by typing text commands,
* via function keys,

* via script files.

* via User Language programs.

In any case it is necessary to understand the syntax of the EAGLE com-
mand language which is described in the following section. The com-
mands are described in detail on the help pages.

Command Line

When entering commands into the command line of an editor window
you may abbreviate key words as long as they cannot be mistaken for
another key word, or you may use small or capital letters (the input is
not case sensitive). The following command line entries are equivalent:

CHANGE WIDTH 0.024
is equivalent to
cha wi 0.024
The actual unit for values is set in the GRID menu.

Most commands can be executed whilst declaring coordinate values in
the command line.

Examples:
MOVE IC1l (2.50 1.75) ;

Element IC1 moves to position 2.50 1.75 in the layout.

63





EAGLE Manual

MIRROR Ul;
Part U1 will be mirrored to the bottom side of the board.

HOLE 0.15 (5 8.5) ;
Place a hole with drill diameter 0.15 at position 5 8.5.

VIA 'GND' 0.070 round (2.0 3.0) ;

A round shaped via with a diameter of 0.070 belonging to signal GND
will be placed at position 2.0 3.0.

History Function

You can recall the most recently entered commands by pressing Crsr-
Up (1) or Crsr-Down (1) and edit them. The Esc key deletes the con-
tents of the command line.

Function Keys

Texts may be allocated to the function keys and to combinations of
those keys with Alt, Ctrl and Shift, if not occupied by the operating sy-
stem or a Linux Window Manager (for example F1 for help). If a func-
tion key is pressed, this corresponds to the text being typed in via the
keyboard. Since every command is capable of being entered as text,
every command, together with certain parameters, can be assigned to a
function key. Even whole sequences of commands can be assigned to a
function key in this way.

The command
ASSIGN

displays the current function key assignments. Changes to the key as-
signments can be carried out in the assign window.

The New button can be used to define a new key assignment. A click on
Del will delete a marked entry, while Change alters an existing defini-
tion. OK closes the dialog and saves the definitions, while Cancel aborts

the dialog.

These settings can also be made via the Options/Assign menu in the
Schematic or Layout Editor.
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= Assign [x]

Key Command

Shit+AlBS Redo
F2 window;
AlF2 window fit
F3 window 2
F4 window 05
F5 Window (@);
FE Gird:
F? Mave
Fe Spit
FS Undo
FI0 Redo
F12 window (G window 2: show
CHl+G - Girid

oK Mew | Del ‘ Change | Cancel | Help ‘
The dialog for the ASSIGN command

To predefine certain assignments you can also use the ASSIGN com-
mand in the file eagle.scr (see page 83).

Examples:
The combination of Ctr] + Shift + G displays a grid of 0.127mm:
ASSIGN CS+G 'GRID MM 0.127 ON;';

The combination of Alt + F6 changes the layer to Top and starts the
ROUTE command:

ASSIGN A+F6 'LAYER TOP; ROUTE';

The combination of the keys Alt + R displays only the layers Top, Pads,
Vias and Dimension first and then starts the print out with the default
printer:

ASSIGN A+R 'DISPLAY NONE 1 17 18 20; PRINT;';

The combination of Alt + 0 brings the Control Panel into the fore-
ground. The combinations Alt + 1 upto 9 are assigned to the various
editor windows, according to the window number which is shown in the
respective title bar.

Script Files

Script files are a powerful tool. They can contain long sequences of
commands, such as the specification of specific colors and fill-patterns
for all layers. On the other hand they might contain netlists converted
from the data of other programs.

The SCRIPT command is used to execute script files.

Many User Language programs (ULP) create script files that can be
read in order to modify a layout or a schematic.
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EAGLE outputs an entire library, for instance, as a script file with the
aid of the EXPORT command (Nezscript option). This file can be modi-
fied with a text editor, after which it can be read in again. This allows
changes to be made to a library quite easily.

There is more information about script files and export commands later
in this chapter.

Mixed Input

The various methods of giving commands can be mixed together.

You can, for instance, click the icon for the CIRCLE command (which
corresponds to typing CIRCLE on the command line), and then type
the coordinates of the center of the circle and of a point on the circum-
ference in this form

(2 2) (2 3) «
on the command line.

The values used above would, if the unit is currently set to inch, result in
a circle with a radius of one inch centered on the coordinate (2 2). It is
irrelevant whether the CIRCLE command is entered by icon or by typ-
ing on the command line.

5.2 The EAGLE Command Language

You only need a knowledge of the EAGLE command language if you
want to make use of the alternative input methods discussed in the pre-
vious section.

The syntax of the EAGLE command language will be discussed in this
section, and typographical conventions, which are important for under-
standing the descriptions, will be specified.

Typographical Conventions

Enter key and Semicolon

If EAGLE commands are entered via the command line they are fin-
ished with the Enter key. In some cases a command must have a semico-
lon at the end, so that EAGLE knows that there are no more
parameters. It is a good idea to close all commands in a script file with a
semicolon.

The use of the Enter key is symbolized at many places within this hand-
book with the ~ sign.
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However in the following examples neither the Enter key sign nor the
semicolon are shown, since all of these commands can be used both on
the command line and within script files.

Bold Type or Upper Case

Commands and parameters shown here in UPPER CASE are entered
directly. When they are entered, there is no distinction made between
upper and lower case. For example:

Syntax:
GRID LINES
Input:
GRID LINES

grid lines

Lower Case
Parameters shown here in lower case are to be replaced by names, num-
bers or keywords. For example:
Syntax:
GRID grid size grid multiple
Input:
GRID 1 10

This sets the grid to 1 mm (assuming that the current unit is set to mm).
Every tenth grid line is visible. The figures 1 and 10 are placed into the
command instead of the placeholders grid_size and grid_multiple.

Underscore

In the names of parameters and keywords the underscore sign is often
used in the interests of a clearer representation. Please do not confuse it
with an empty space. As can be seen in the example above, grid_size is a
single parameter, as is grid_multiple.

If a keyword contains an underscore sign, such as COLOR_LAYER
does in the command

SET COLOR LAYER layer name color word
then the character is to be typed in just like any other. For example:
SET COLOR_LAYER BOTTOM BLUE

Spaces

Wherever a space is permissible, any number of spaces can be used.
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Alternative Parameters
The | character means that the parameters are alternatives. For example:
Syntax:
SET BEEP ON|OFF
Input:
SET BEEP ON
or
SET BEEP OFF

The beep, which is triggered by certain actions, is switched on or off.

Repetition Points

The .. characters mean either that the function can be executed multiple
times, or that multiple parameters of the same type are allowed. For
example:

Syntax:
DISPLAY option layer name..
Input:
DISPLAY TOP PINS VIAS
The layer number can alternatively be used:
DISPLAY 1 17 18
More than one layer is made visible here.
If a layer (in this case Bottom) is to be hidden:
DISPLAY -16

Mouse Click

The following sign

usually means that at this point in the command an object is to be
clicked with the left mouse button. For example:

Syntax:
MOVE ¢ ..
Input:

MOVE < (or click the icon)

Mouse click on the first element to be moved
Mouse click on the destination

Mouse click on the second element to be moved
and so on.

You can also see from these examples how the repetition points are to be
understood in the context of mouse clicks.
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Entering Coordinates as Text

The program sees every mouse click as a pair of coordinates. If it is de-
sired to enter commands in text form on the command line, then in-
stead of clicking with the mouse it is possible to enter the coordinates
through the keyboard in the following form:

(xy)
where x and y are numbers representing units as selected by the GRID
command. The textual input method is necessary in particular for script
files.

The coordinates of the current cursor position can be fetched with (@)
For example:

WINDOW (@) ;

Examples of coordinate entry in text form:
You want to enter the outline of a circuit board with precise dimensions.

GRID MM 1;

LAYER DIMENSION;

WIRE O (0 O0) (160 0) (160 100) (O 100) (0O 0);
GRID LAST;

The first step is to switch to a 1 mm grid. The dimension layer is then
activated. The WIRE command then first sets the line width to 0 and
draws a rectangle with the aid of the four given coordinates. The last
command returns the grid to whatever had previously been selected,
since circuit boards are usually designed using inches.

Relative values:

It is possible to use relative coordinate values in the form (R x y) which
refer to a reference point set with the MARK command before. If you
don't set a reference point the absolute origin of the coordinate system
will be taken.

Setting a via relative to the reference point:

GRID MM 0.5;
MARK (20 10);
VIA (R 5 12.5);
MARK;

First the grid is set to Millimeters, then the reference point at the posi-
tion (20 10) is placed. The via is located at a distance of 5 mm in x and
12.5 mm in y direction from the this point. Then the reference point is
removed.

Polar values:
Polar coordinates are given in the form of (P radius angle).
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GRID MM;

MARK (12.5 7.125);

LAYER 21;

CIRCLE (R 0 0) (R 0 14.5);
PAD (P 40 0);

PAD (P 40 120);

PAD (P 40 240);

This examples shows how to set the reference point at position (12.5
7.125). Then a circle with a radius of 40 mm is drawn in layer 21, tPlace.
Three pads are placed on the circumference with an angle of 120°.
Right Mouse Click:
The > character within parenthesis represents a right mouse click. That
way one can move a whole group, for example:

MOVE (> 0 0) (10 0);

The previously selected group will be moved 10 units in x direction.

Modifier:
Within parenthesis one can use some modifiers. For combinations you
don't have to care about the order:

A represents the pressed Alt key, the alternativ grid
C represents the pressed Ctrl key

S represents the pressed Shift key

R relativ coordinates

P polar coordinates

> right mouse click

C and S cause miscellaneous commands to behave in different manners.
More information can be found in the help function of the respective
command.

If the commands are being read from a script file, each one must be
closed with a semicolon. In the above cases the semicolons can be omit-
ted if the commands are being entered via the keyboard and each is be-
ing closed with the Enter key.

A component in the Layout Editor is to be transposed to a specified
position.

GRID MM 1;
MOVE IC1 (120 25) ;

Alternatively:
MOVE (0.127 2.54) (120 25);

IC1 is located at coordinates (0.127 2.54) and is moved to position
(120 25). The current position of a device can be obtained with the aid
of the INFO command.
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When a symbol is defined, a pin is placed at a certain position.
PIN 'GND' PWR NONE SHORT R180 (0.2 0.4) ;
You draw a rectangular forbidden area in layer 41 tRestrict:
LAYER TRESTRICT;
RECT (0.5 0.5) (2.5 4) ;

5.3 Grids and the Current Unit

EAGLE performs its internal calculations using a basic grid size of

1/10 000 mm (0.1 micron). Any multiple of that can be set as the work-
ing grid.

Microns, mils, inches and mm can be used for the unit. The current unit
as set with the GRID command applies to all values.

You should always use the pre-set 0.1 inch grid for schematic diagrams.
This grid should also be used when defining schematic diagram symbols
in the Library Editor.

When starting the design of circuit boards or libraries it pays to give
prior thought to the question of which grid size (or sizes) will be used
as a basis. For example, it is only the origin of a package that will be
pulled onto the board’s placement grid. All other objects constituting
the package (such as pads) are placed relative to that point on the board,
just as it was defined in the library.

The basic rule for boards is: always make the grid as big as possible and
as small as necessary.

Various grid sizes can be preset in the eagle.scr file for different types of
editor windows (see page 79).

= Grid
Display Shyle
" On o+ O " Dotz = Lines
Size |D.‘I | inizh j Finest
Multiple: [1

Al [} [inch =] Finest
0k | Default | Last | Cancel |

The Grid Menu
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The current grid Size is set in the grid menu. The units chosen in the
combo box are used.

The Multiple option indicates how many grid lines are displayed. If, for
instance, the value 5 is entered at Multiple, every fifth line will be
displayed.

The Alt line allows to set an alternative grid which can be activated by
pressing the Alt key (while, for example, MOVE, ROUTE, ADD, or
WIRE is active). This can be very useful for placing parts in a dense lay-
out or arranging labels in the schematic. If you decide not to place it in
the alternative grid and release the Alt key before placing it, the object
stays in its origin grid.

Style specifies the way it is displayed: Lines or Dots.

The options On and Off under Display switch the grid display on or off.

Finest sets the finest grid that is possible.
Clicking on default will select the editor's standard grid.
The last button returns to whatever grid was previously set.

Beginning with a certain zooming limit, grid lines are not displayed any-
more. This limit can be set in the menu Options/Set/Misc, Min. visible
grid size.

Grid lines and grid dots can have any color. Click the colored button of
the respective palette (depends on the background color) in the menu
Options/Set/Colors and select the color as requested. This can also be
done in the command line, for example:

SET COLOR_GRID BLUE
Instead of the color name the color number can be given, as well. It can

be in the range 0 .. 63. The shown color depends on the (self-)defined
colors of the current palette.

The Redraw option causes EAGLE to redraw grid lines/dots whenever
changes concerning the grid are made in the editor window. This is not
necessary for a black background.

See also the hints concerning Color settings on page 80.
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5.4 Names and Automatic Naming

Length
Names in EAGLE can have any desired length. There is no limit.

Forbidden Characters

No names may contain spaces or umlauts. Quotation marks, semico-
lons, and other exotic characters (above 127 in the ASCII table) should
be avoided as far as possible.

Device names must not contain either question marks or asterisks, since
these characters are used as placeholders for package variants and
technologies.

Commas must be avoided in pad names.

Part-bus names must not contain colons, commas or square brackets.

Automatic Naming

If a name is given together with one of the commands PIN, PAD, SMD,
NET, BUS or ADD, then other names will be derived from it as long as
the command is still active.

The name is simply typed into the command line before placing the ele-
ment (while it is attached to the mouse). Note that the name must be
placed within simple quotation marks. Entry is completed with < .
The examples illustrate how automatic naming functions:

ADD DIL14 'Ul' <« o o o
fetches three DIL14 elements to the board and names them U1, U2 and
U3 (s corresponds to a mouse click).

PAD OCT '1l' <« LA
places four octagonal pads with the names 1, 2, 3, and 4.
If the name consists of only one character from A...Z, then the follow-
ing objects receive the following letters of the alphabet as names:

ADD NAND 'A' < o o o o
fetches four NAND gates with the names A, B, C and D. If the gener-

ated name reaches Z, then names with the default prefix will again be
generated (e.g. G$1).
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5.5 Import and Export of Data

EAGLE provides a number of tools for data exchange.
* Script files for importing
* The export command for exporting
* EAGLE User Language programs for import and export.

The User Language is very flexible, but does call for a suitable program
to be created. You will find further details in the section on The EAGLE
User Language.

Script Files and Data Import

The script command makes a universal tool available to the EAGLE user
for data import.

Since every EAGLE operation can be carried out with the aid of text
commands, you can import all types of data with the aid of a script file.
A script file can in turn call other script files.

Script files can be created with a simple text editor. The prerequisite for
the development of your own script files is that you understand the
EAGLE command language. You will find the precise functioning and
the syntax of the individual commands in the EAGLE help pages.

The file euro.scr in the eagle/scr directory, which draws the outline of a
eurocard with corner limits, provides a simple example.

If a netlist is to be imported into a board design which already contains
the appropriate components, then a script file of the following form is
necessary:

SIGNAL GND IC1 7 IC2 7 J4 22;
SIGNAL VCC IC1 14 IC2 14 J4 1;

A Netscript of this sort can easily be created from the schematic diagram
by the EXPORT command.

You will get a further impression of the power of importing, if you out-
put a library with the EXPORT command (Script option). The script
file that is generated provides an instructive example for the syntax of
the script language. It can be examined with any text editor. If SCRIPT
is then used to read this file into an empty library, a new library file will
be created.

Comments can be included following a #-character.

The execution of a script file can be stopped by clicking the Stop icon.
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File Export Using the EXPORT Command
The EXPORT command has the following modes:

DIRECTORY

Outputs a list of the contents (devices, symbols, and packages) of the
currently loaded library.

NETLIST

Outputs a netlist for the currently loaded schematic or board in an
EAGLE-specific format. It can be used to check the connections in a
drawing. Use a ULP to obtain other formats.

NETSCRIPT

Outputs a netlist of the currently loaded schematic in the form of a
script file. The netscript can be read into the board file with the help of
the SCRIPT command.

This could be possibly suggestive if there are differences in the netlist
between schematic and layout. In this case export the netscript from the
schematic, delete all signals in the layout with DELETE SIGNALS (all
traces are lost!), and import the netscript with the SCRIPT command.

PARTLIST

Outputs a component list for the schematic or board.

PINLIST

Outputs a pin/pad list for the schematic or board, listing the connected
nets.

SCRIPT

Outputs the currently loaded library in the form of a script file.

This script can be modified with a text editor in order to generate, for
example, a user defined library, or to copy parts of one library into an-
other. The modified script file can be imported into a new or an already
existing library with the help of the SCRIPT command.

The script file also serves as a good example for the EAGLE command
syntax.

In order to avoid loss of precision the grid unit in the script file is set to
Millimeters.
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IMAGE

The option Image allows you to generate files in various graphic
formats.

The following formats are available:
bmp  Windows Bitmap file
png Portable Network Graphics file
pbm  Portable Bitmap file
pgm  Portable Grayscale Bitmap file
ppm  Portable Pixelmap file
tif Tag Image file
xbm X Bitmap file
xpm X Pixmap file

I Export Image

File |Fl:a’hnme.f'ric.-’lmp.n"test.bmp m

[~ Clipboard v Monochrarne

Resolution |'|5|3 j‘ dpi

Image Size |1155 = 1607 pixel

(1] | Cancel

Settings for graphic file output

Click the Browse button, select the output path, and type in the graphic
file name with its extension. The file extension determines the graphic

file type.

To generate a black and white image activate the option Monochrome. To
make the image available via the system's clipboard set the Clipboard
option. The Resolution can be set in dots per inch. The resulting Image
Size will be shown in the lowest field.

Further graphic formats, like HPGL, Postscript (PS), or Encapsulated
Postscript (EPS), can be generated with the belp of the CAM Processor.
The User Language Program dxf.ulp generates DXF data.
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5.6 The EAGLE User Language

EAGLE contains an interpreter for a C-like User Language. It can be
used to access any EAGLE file. Since version 4 it has also been able to
access external data. It is possible, with very few restrictions, to export
data from EAGLE, import a wide range of data into EAGLE, or to ma-
nipulate data within EAGLE. ULPs can, for example, manipulate a lay-
out file or a library directly. The manipulation may be more transparent
if a script file is first created and read. The script file contains the appro-
priate commands for the data manipulation.

The program examples included (*.#lp) will provide some insight into
the capacity of the User Language. They are located in your installa-
tion’s ULP directory. A description of the way in which a ULP works is
located in the file header. This is also displayed in the Control Panel or
in the usage box when the program is called. User Language programs
must be written in a text editor that does not add any control codes.

A ULP is started with the RUN command, or by dragging a ULP from
the Control Panel into an editor window (Drag&Drop). To cancel the
execution of an ULP click the Stop icon.

EAGLE prompts a message in the status bar, Run: finished, if the User
Language program has been ended.

The language is described in detail in the EAGLE help pages, under the
keyword User Language.

Typical applications for ULPs:

* Creating parts lists in various formats.
See also page 230.

* Output in graphical formats.

* Data output for component insertion machines, in-circuit testers
etc.

* Linking to an external database.

* Manipulation of the silk screen print, the solder stop mask, and so
on.

A lot of valuable ULPs can be found on our web pages. Take a look at
http://www.cadsoftusa.com/download.htm.
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5.7 Forward&Back Annotation

A schematic file and the associated board file are logically linked by
automatic Forward&Back Annotation. This ensures that the schematic
and the board are always consistent

As soon as a layout is created with the BOARD command (or by means
of the Board icon), the two files are consistent. Every action performed
on the schematic diagram is simultaneously executed in the layout. If,
for instance, you place a new device, the associated housing will appear
on the layout at the edge of the board. If a net is placed, the signal lines
are simultaneously drawn in the layout. Certain operations such as the
placement or deletion of signals are only allowed in the schematic. The
Layout Editor does not permit these actions, and issues an appropriate
warning. Renaming devices or changing their values, for example, are
permitted in both files.

The EAGLE help pages contain a closer description of the technical
details.

It is not necessary for you, as the user, to pay any further attention to
this mechanism. You only have to ensure that you do not work on a
schematic whose associated board file has been closed, and vice versa.
This means that both files must always be loaded at the same time. Oth-
erwise they loose consistency, and the annotation can no longer work.

If you have, however, once edited the board or the schematic separately,
the electrical rule check (ERC) will check the files for consistency when
they are loaded. If inconsistencies are found, the ERC opens an error
file with appropriate messages about the schematic diagram and the
layout.

Correct the layout or the schematic diagram in accordance with the er-
ror messages in the ERC file. Run the ERC frequently to check prog-
ress, until the two files are consistent again. The message at the end of
the ERC file must be:

Board and schematic are consistent.

Then save the files.
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5.8 Configuring EAGLE Individually

There are a number of settings that permit the program to be adjusted
for individual needs. We distinguish between program, user and
project-specific settings.

Basic program settings that will apply to every user and every new proj-
ect are made in the eagle.scr file. Under Windows, personal preferences
are stored in the file eaglerc.usr, or, under Linux, in ~/.eaglerc.

EAGLE remembers settings that only apply to one particular project in
the eagle.epf project file.

Values that, for instance, only apply to one specific board, such as the
Design Rules, special layer colors, unique newly defined layers or the
grid setting are stored directly in the layout file. This also applies, of
course, to schematic diagram and library files.

Configuration Commands

Most of the options are usually set by means of the Options menus of
the individual EAGLE editor windows.

The Control Panel allows settings to be made for Directories, file
Backup and the appearance of the editor window (User interface). These
options are described in the chapter on the Control Panel under the
Options menu heading, starting on page 30.

Through the User interface settings it is possible to select the icon-based
menu or a configurable text menu.

The MENU command allows the text menu to be given a hierarchical
configuration by means of a script file. There is an example of this in the
appendix.

The Options menu in the editor windows for schematic diagrams, lay-
outs and libraries contains, in addition to the User interface item, two
further entries:
Assign and Set.

The ASSIGN command alters and displays the assignment of the func-
tion keys. You will find information about this on page 64.

General system parameters are altered with the SET command.

The CHANGE command allows a variety of initial settings for object
properties.

The GRID command sets the grid size and the current unit. Further in-
formation about this starts on page 71.
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SET Command

Most common options of the SET command are available in the Sertings
window of the menu Oprions/Set. This window can be reached also by
entering

SET
on the command line.

The number of available layers shown in the DISPLAY or LAYER menu
can be set with the option Used_Layers. That way it is possible to hide
unused layers for clarity reasons.

SET USED LAYERS 1 16 17 18 19 20 21 23 25 27
29 31 44 45 51;

stored in the file eagle.scr shows only the mentioned layers. After
SET USED LAYERS ALL;

all layers are available again.

Color Settings
The Colors tab contains settings for layer and background colors and
colors for grid lines or dots.

= Setlings

Colors | DAC | Dil | Misc |

Grid
Falette Dotz Lines Redraw

Elack background . . |—
white: background 2
Colored background 2

Cancel |

Settings Window: Color Settings

Three color palettes are available: for black, white and colored back-
ground. Each palette allows a maximum of 64 color entries, which can
be given any RGB value.

By default EAGLE uses the first 16 values (entries 0..15). Eight colors
followed by further eight so-called highlight colors.

The first entry of the palette determines the background color. In the
white palette, however, it is not possible to change the background color
because it's needed for print-outs, which normally are made on white

paper.
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The image above shows three buttons in the Palette column. Click on
one of them. For example, the button for Colored Background. The Col-

or window opens now.

On the left an 8 x 8 matrix is visible that contains already 16 pre-defined
colors. There are alternating eight 'normal' colors with their correspond-
ing eight highlight colors. A color of the palette at position x can be
given the corresponding highlight color at position x+8.

In order to define new values select an unused box of the matrix and ad-
just the new color with the help of the color selection area and the satu-
ration bar on the right. Click Set Color to apply your color. Now select a
new color box in the matrix and repeat the procedure for the next color.

You may also enter values for Red, Green, Blue or Hue, Sat, Val directly.

= Color K
A

e 8 0 el
[~ .-
HEE

Hue: lﬁ Red: |255
. Sat |245  Green
oK | ssedor | canel | vab [55 Bl

Color Window: Defining Colors

The image above shows four further pairs of colors (normal and corre-
sponding highlight color vertically arranged).

In order to change the color palette for an editor window select the ap-
propriate Background in the menu Options/User Interface.

Alternatively the color definition and change of palette can be made in a
script file or in the command line.

SET PALETTE <index> <rgb>

defines a color, where the color value has to be given hexadecimal.
Example:

SET PALETTE 0 OxFFFFO0O

sets the background color (entry 0) to yellow (corresponds to the deci-
mal RGB value 255 255 0 which is hexadecimal FF FF 00). Hexadecimal
values are marked by a leading 0x.

To activate the black color palette type in the command line:
SET PALETTE BLACK

The new palette will become visible after refreshing the drawing area

with the WINDOW command.
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The color assignment for layers is done with the DISPLAY command or
with SET COLOR_LAYER.

More details about the syntax can be found in the help function.

Miscellaneous SET Options

The Misc tab of the Settings window contains the most common op-
tions, which are switched on or off by check boxes. Some options allow
entering values.

= Settings
Colors | DRC | Dil | Misc |

[v¥ Beep Min. wvizible text size ’37 pixel
¥ Check conmects Min. wizsible grd size ,57 pizel
W Undo Select factor 2 =
¥ Dptimizing Snap length W

W Ratsnest processes polygons  — Display made

[ Shap bended wires " Nodills

[™ Display pad names i+ Beal

¥ Auto end net and bus

V¥ Auto zet junchion

Cancel

Settings at Options/Set/Misc
Options overview:
Beep:
Switches on/off the confirmation beep. Default: on.
Check connects:
Activates the package check while placing parts in the schematic.
Default: on.

Undo:

Switches on/off the undo/redo buffer. Default: on.

Optimizing:

Enables the automatic removal of bends in straight lines. Default: on.

Ratsnest processes polygons:
The contents of polygons will be calculated with the RATSNEST com-
mand. Default: on.

Snap bended wires:
If active, wire bends always lie on a grid intersection point. Due to this
fact it can happen that traces don't adhere 45° angles. Default: off.

Display pad names:
Pad names are displayed in the Layout or Package Editor. Default: off.
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Auto end net and bus:
If placing a net on a pin or a bus the net drops from the mouse cursor.
Default: on.

Auto set junction:
Ending a net on another net a junction will be set automatically.
Default: on.

Min. visible text size:

Only texts with the given minimum size are displayed.

Default: 3 pixels.

Min. visible grid size:

Grid lines/dots which are closer than the given minimum distance are
no longer displayed on the screen. Default: 5 pixels.

Select factor:
Within this radius (given in % of the height of the current drawing win-
dow) EAGLE offers objects for selection. Default: 2%.

Snap length:

Ending a wire with the ROUTE command within this radius around a
pad or smd will snap it on the middle of the pad/smd automatically. This
is also true for airwires which are dynamically calculated while ROUTE
is active. Default: 20 mil.

Display mode:

Pads/vias are shown with a drill hole (real) or without it (No drills).
Default: real.

Changes can also be made by typing in the complete SET command.
Entering

SET POLYGON_RATSNEST OFF
or, in short
SET POLY OFF

for instance switches off polygon calculation for the RATSNEST
command.

The help system provides you with more instructions about the SET
command.

The eagle.scr File

The script file eagle.scr is automatically executed when an editor win-
dow is opened or when a new schematic diagram, board or library file is
created, unless a project file exists.

It is first looked for in the current project directory. If no file of this
name exists there, it is looked for in the directory that is entered in the
Script box in the Options/ Directories dialog.
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This file can contain all those commands that are to be carried out
whenever an editor window (other than the text editor) is opened.

The SCH, BRD and LBR labels indicate those segments within the file
which are only to be executed if the Schematic, Layout or Library Editor
window is opened.

The DEV, SYM and PAC labels indicate those segments within the file
which are only to be executed if the device, symbol or package editor
mode is activated.

Commands which are defined before the first label (normally BRD:) are
valid for all Editor windows.

If, because of the specifications in a project file, EAGLE opens one or
more editor windows when it starts, it is necessary to close these and to
reopen them so that the settings in eagle.scr are adopted. It is, as an al-
ternative, possible simply to read the file eagle.scr through the SCRIPT

command.

Comments can be included in a script file by preceding them with #.

Example of an eagle.scr file:

# This file can be used to configure the editor windows.

Assign AF3 'Window 4;';
Assign AF4 'Window 0.25;"';
Assign AF7 'Grid mm;';
Assign AF8 'Grid inch;';

# net class configuration
grid mm;

Class 0 Default 0.3 0.2 0.6;

Class 1 Power 0.8 0.5 0.8;

grid default;

BRD:

#Menu Add Change Copy Delete Display Grid Group Move\
# Name Quit Rect Route Script Show Signal Split \
# Text Value Via Window ';' Wire Write Edit;

Grid inch 0.05 on;

Grid alt inch 0.01;

Set Pad names on;

Set Width menu 0.008 0.01 0.016;

Set Drill menu 0.024 0.032 0.040;

Set Size menu 0.05 0.07 0.12;

Set Used layers 1 16 17 18 19 20 21 22 23 24 25 26 \
27 28 39 40 41 42 43 44 45;

Change width 0.01;

Change drill 0.024;

Change size 0.07;

SCH:
Grid Default;
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Change Width 0.006;
#Menu Add Bus Change Copy Delete Display Gateswap \

# Grid Group Invoke Junction Label Move Name Net \
# Pinswap Quit Script Show Split Value Window ';' \
# Wire Write Edit;

LBR:

#Menu Close Export Open Script Write ';' Edit;

DEV:

Grid Default;
#Menu Add Change Copy Connect Delete Display Export \

# Grid Move Name Package Prefix Quit Script Show \
# Value Window ';' Write Edit;
SYM:

Display all;
Grid Default On;
Change Width 0.010;

#Menu Arc Change Copy Cut Delete Display Export \

# Grid Group Move Name Paste Pin Quit Script \
# Show Split Text Value Window ';' Wire Write Edit;
PAC:

Grid Default On;

Grid Alt inch 0.005;
Change Width 0.005;
Change Size 0.050;
Change Smd 0.039 0.039;

#Menu Add Change Copy Delete Display Grid Group \
# Move Name Pad Quit Script Show Smd Split Text \
# Window ';' Wire Write Edit;

The eaglerc File

Under Windows, user-specific data is stored in the file eaglerc.usr, or,
under Linux, in ~/.eaglerc. This file is stored in the user's home direc-
tory. If there is no home environment variable set, the Windows registry
entry will be taken. More about this can be found in the section Directo-
ries on page 31 .

It contains information about the:

SET command (Options/Set menu)
ASSIGN command (function key assignments)
User Interface

Currently loaded project (path)
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EAGLE looks for the configuration file in various locations in the given
sequence and executes them (if existing):

<prgdir>/eaglerc (Linux and Windows)
Jetc/eaglerc (Linux only)
$HOME)/.eaglerc (Linux)
$SHOME/eaglerc.usr (Windows)

These files should not be edited.

With the help of various User Language programs it is also possible to
define settings in EAGLE. Visit our web site:
http://www.cadsoftusa.com/download.htm.

EAGLE Project File

If a new project is created (by clicking the right mouse button on an en-
try in the Projects branch of the tree view and then selecting New/Project
in the context menu in the Control Panel), a directory is first created
which has the name of the project. An eagle.epf configuration file is
automatically created in every project directory.

EAGLE takes note of changes to object properties that are made with
the CHANGE command during editing and the contents of the Width,
Diameter, and Size menus in the project file.

It also contains information about the libraries i use for this project.
The position and contents of the active windows at the time the pro-
gram is closed are also saved here. This assumes that the Automatically
save project file option under Options/Backup in the Control Panel is ac-
tive. This state will be recreated the next time the program starts.

Those who have previously worked on projects with EAGLE 3.5x can
most easily adapt them to the structure that applies from Version 4.0
onwards as follows:

* Create a directory with the project name

* Copy the old project file under the name eagle.epf into this direc-
tory

* Copy all the files belonging to the project into this directory

The path that leads to these project directories is specified in the
Control Panel under Options/Directories/ Projects.
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Chapter 6

From Schematic to Finished Board

This chapter illustrates the usual route from drawing the schematic dia-
gram to the manually routed layout. Particular features of the schematic
diagram or Layout Editor will be explained at various points. Use of the
Autorouter and the output of manufacturing data will be described in
subsequent chapters.

We recommend to create a project (folder) first. Details about this can be
found on page 28.

6.1 Creating the Schematic Diagram

The usual procedure is as follows:

Devices are taken from existing libraries and placed on the drawing area.
The connecting points (pins) on the devices are then joined by nets
(electrical connections). Nets can have any name, and can be assigned to
various classes. Power supply voltages are generally connected automati-
cally. In order to document all the supply voltages in the schematic dia-
gram it is necessary to place at least one so-called supply symbol for each
voltage.

Schematic diagrams can consist of a number of pages (but not in the
Light edition). Nets are connected across all the pages if they have the
same name.

It is assumed that libraries containing the required components are
available. The definition of libraries is described in its own chapter.

It is possible at any time to create a layout with the BOARD command
or with the Board icon. As soon as a layout exists, both files must al-
ways be loaded at the same time. This is necessary for the association of
the schematic diagram and the board to function. There are further in-
structions about this in the section on Forward &Back Annotation.
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Open the Schematic Diagram

You first start from the Control Panel. From here you open a new or ex-
isting schematic diagram, for instance by means of the File/Open or the
File/New menus, or with a double click on a schematic diagram file in
the directory tree. The schematic diagram editor appears.

Create more schematic sheets if needed. For that purpose, open the
combo box in the action toolbar with a mouse click, and select the New
item. A new sheet will be generated (see page 37). Another way to get a
second sheet is to type in

EDIT .S2

on the command line. If, however, you do not in fact want the page, it is

deleted with
REMOVE .S2

the entire sheet.

Set the Grid

The grid of schematic diagrams should always be 0.1 inch, i.e. 2.54 mm.
Nets and symbol connection points (pins) must lie on a common grid.
Otherwise connections will not be created between nets and pins.

Place Symbols

First you have to make available the libraries you want to take elements
from with the USE command. Only libraries which are in use will be
recognized by the ADD command and its search function. More infor-
mation concerning the USE command can be found on page 37.

Load Drawing Frame

It is helpful first to place a frame. The ADD command is used to select
devices from the libraries.

When the ADD icon is clicked, the ADD dialog opens.

It shows all the libraries that are made available with the USE command,
first. You can expand the library entries for searching elements manually
or you can use the search function .

A letter format frame is to be used. Enter the search key letter in the
Search line at the lower left, and press the Enter key. The search result
shows a number of entries from frames.lbr. If you select one of the en-
tries (LETTER_P), a preview is shown on the right, assuming that the
Preview option is active. Disabling the option Description does not take
into consideration the part’s descriptive texts.
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Clicking OK closes the ADD window, and you return to the schematic
diagram editor. The frame is now hanging from the mouse, and it can be
put down. The bottom left hand corner of the frame is usually at the co-
ordinate origin (0 0).

Library names, device names and terms from the device description can
be used as search keys. Wildcards such as * or ? are allowed. A number
of search keys, separated by spaces, can be used.

In the Layout Editor's ADD dialog package names and terms from the
package descriptions (Description enabled) can be searched for.

S x
Mame IDescliDtion
- frames Frames for Sheet
PR ETTER [ FRAME
L LETTER_P FRAME
FRAME
. I LETTER landscape
Seach v Smds [ Description [ Preview
|Ieller ;I
kK I Drop | Cancel |

ADD dialog: Results from the search key letter

The ADD command may also be entered via the command line or in
script files. The frame can also be placed using the command:

add letter p@frames.lbr
Wildcards like * and ? may also be used in the command line. The
command

add letter*@frames.lbr

for example opens the ADD windows and shows various frames in let-
ter format to select.

The search will only examine libraries that are iz use. That means that

the library has been loaded by the USE command (Library/Use).

If a certain library should not be listed in the ADD dialog anymore, se-
lect the library name in the tree and click the Drop button. Now it is not
in use anymore.
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Place Circuit Symbols (Gates)

All further devices are found and placed by means of the mechanism de-
scribed above. You decide a package variant at this early stage. It can eas-
ily be changed later if it should turn out that a different package form is
used in the layout.

If you have placed a device with ADD, and then want to return to the
ADD dialog in order to choose a new device, press the Esc key or click
the ADD icon again.

Give the devices names and values (NAME, VALUE).

If the text for the name or the value is located awkwardly, separate them
from the device with SMASH, and then move them to whatever posi-
tion you prefer with MOVE. Clicking with DELETE on either of the
texts makes it invisible. Use the Shift key with SMASH to get the texts
at their original positions. The texts are now no longer separated from
the device (unsmash). The same effect has DELETEing the remaining
text.

MOVE relocates elements, and DELETE removes them. With INFO or
SHOW information about an element is displayed on the screen.

ROTATE turns gates by 90°. The same can be done with a right mouse
click while the MOVE command is active.

Multiple used parts may be copied with the COPY command. COPY
places always a new part even if it consits of several gates and not all of
them are already used.

Repeated circuitry can be reproduced in the schematic diagram with the
aid of the GROUP, CUT and PASTE commands. First make sure that
all the layers are made visible (DISPLAY ALL).

Hidden Supply Gates

Some devices are defined in the libraries in such a way that the power
supply pins are not visible on the schematic diagram. Visibility is not
necessary, since all the power pins with the same name are automatically
connected, regardless of whether or not they are visible.

If you want to connect a net directly to one of the hidden pins, fetch the
gate into the schematic diagram with the aid of the INVOKE command.
Click on the INVOKE icon, and then on the device concerned, assum-
ing that it is located on the same sheet of the schematic diagram. If the
gate is to be placed on a different schematic diagram sheet, go to that
sheet, activate INVOKE, and type the name of the device on the com-
mand line. Select the desired gate in the INVOKE window, then place it.
Then join the supply gate to the desired net.
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= Invoke: IC5 [HCTL2016] H

Gate |S_I.Jmh0| |,-’.'n.|:||:| |5wap |Sheet |

PR Request

(1] | Cancel

INVOKE: Gate P is to be placed

Devices with Several Gates

Some devices consist not of one but of several gates. These can normally
be placed onto the schematic diagram one after another with the ADD
command. To place a certain gate you can use the gate name directly.
Example:
The device 74%00 from the 74xx-ex library consists of for NAND gates
named A to D and one power gate named P, If you want to place the gate
C first, use the gate name with the ADD command:

ADD 'IC1l' 'C' 74LS00@74xx-eu.lbr

See also help function for the ADD command.

As soon as one gate has been placed, the next one is attached to the
mouse (addlevel is Next). Place one gate after another on the diagram.
When all the gates in one device have been used, the next device is
brought in.

If the gates in one device are distributed over several sheets, place them
first with ADD, change to the other sheet of the schematic diagram, and
type, for example

INVOKE IC1

on the command line. Select the desired gate from the INVOKE
window.
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Wiring the Schematic Diagram

Draw Nets (NET)

The NET command defines the connections between the pins. Nets be-
gin and end at the connection points of a pin. This is visible when layer

93, Pins, is displayed (DISPLAY command).

Nets are always given an automatically generated name. This can be
changed by means of the NAME command. Nets with the same name
are connected to one another, regardless of whether or not they appear
continuous on the drawing. This applies even when they appear on dif-
ferent sheets.

If a net is taken to another net, a bus, or a pin connecting point, the net
line ends there and is connected. If no connection is made when the net
is placed, the net line continues to be attached to the mouse. This behav-
ior can be changed through the Options/Set/Misc menu (using the Auto
end net and bus option). If this option is deactivated, a double click is
needed to end a net. Nets are shown on layer 91, Nets.

Nets must end exactly at a pin connecting point in order to be joined. A
net is not joined to the pin if it ends somewhere on the pin line.

EAGLE will inform you about the resulting net name or offer a selec-
tion of possible names if you are connecting different nets.

The JUNCTION command is used to mark connections on nets that
cross one another. Junctions are placed by default. This option, (Auto set
junction), can also be deactivated through the Options/Set/Misc menu.

Nets must be drawn with the NET command, not with the WIRE
command.

Do not copy net lines with the COPY command. If you do this, the
new net lines won’t get new net names. This could result in unwanted
connections.

If the MOVE command is used to move a net over another net, or over
a pin, no electrical connection is created. To check this, you can click the
net with the SHOW command. All the connected pins and nets will be
highlighted. If a gate is moved, the nets connected to it will be dragged
along.

An identifier can be placed on a net with the LABEL command. Pro-
vided you have defined an alternative grid, labels can be arranged com-
fortably in a finer grid with the Alt key pressed.
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Drawing a bus (BUS)

Busses receive names which determine which signals they include. A bus
is a drawing element. It does not create any electrical connections.
These are always created by means of the nets and their names. The as-
sociated menu function is a special feature of a bus. A menu opens if
you click on the bus with NET. The contents of the menu are deter-
mined by the bus name.

The bus in the diagram is named Bus1:A/0..12],D[0..7],Clock.

BUS1:A[0..12],D[0..7],CLOCK

V4
IC1
;.g AD Do f-52
= Al D1
[EEEN || Ao Dz 23
DTl * a4y A3 D3 i
cLack 29
e Ad D4 o0
m Ab D5 KD
25 A6 D6 B
4B A7 D7 —
AT AB
48
A9 +
49
— Al0 1
T an Al RES\ 3
412 Al2 IRV ————e———
Bus menu

Clicking on the bus line while the NET command is active, opens the
menu as illustrated above. The name of the net that is to be placed is se-
lected from here.

The index of a partial bus name may run from 0 to 511.

The help system provides you with more information about the BUS
command.

Specifying Net Classes

The CLASS command specifies a net class (also Edit/Net classes) . The
net class specifies the minimum track width, the minimum clearance
from other signals and the hole diameter for vias in the layout for a spe-
cific class of signals. The default setting is net class 0, which means that
none of these things are specified. A maximum of 8 net classes is
possible.

Net classes can be changed at a later date by means of the CHANGE
command (the Class option).

These settings can also be left until you reach the layout stage.
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B Net classes ]
MNr Mame Wwidth Clearance Coill
0 [defaut [ il ] [ il
1 [Fower [ 40mil [ 24mil [ 24mil
o2 |HighVUItage |150mil |150mn |4Dmi|
3 |Digital |12mi| |8mil |2Dmi|
o4 [ il | i [ ol
| [ Ol [ Ol [ il
| [ ol [ il [ omil
7 [ ol ] [ omil
ak. Cancel | Help |

Net classes: Various settings

For a permanent definition of net classes, as for all projects, one can use
the CLASS command in the eagle.scr file. See example on page 83.

Pinswap and Gateswap

Pins or gates that have the same swaplevel can be exchanged with one
another. These properties are specified either when the symbol is de-
fined (pinswap) or when the device is created (gateswap).

Provided the swaplevel of two pins is the same, they can be exchanged
for one another. Display layer 93, Pins, in order to make the swaplevel of
the pins visible.

Pins or gates may not be swapped if the swaplevel = 0.

1

1

Ot
20y

Swaplevel: Pins layer is visible

Input pins 1 and 2 have swaplevel 1, so they can be exchanged with one
another. The output pin, 3, which has swaplevel 0, cannot be exchanged.

You can find the swaplevel of a gate by means of the INFO command.
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Power Supply

Pins defined as having the direction Pwr are automatically wired up.
This is true, even if the associated power gate has not explicitly been
fetched into the schematic. The name of the Pwr pin determines the
name of the voltage line. This is already fixed by the definition of the
symbols in the library.

If nets are connected to a device’s Pwr pins, then these pins are not
automatically wired. They are joined instead to the connected net.

For every Pwr-pin there must be at least one pin with the same name but
the direction Sup (a supply pin). There must be one on every sheet.
These Sup pins are fetched into the schematic in the form of power sup-
ply symbols, and are defined as devices in a library (see supply.lbr).
These devices do not have a package, since they do not represent com-
ponents. They are used to represent the supply voltages in the schematic
diagram, as is required by the electrical rule check (ERC) for the pur-
poses of its logical checks.

Various supply voltages, such as 0 V or GND, which are to have the
same potential (GND, let’s say), can be connected by adding the corre-
sponding supply symbols and connecting them with a net. This net is
then given the name of that potential (e.g. GND).

Supply symbols

If a supply pin (with pin direction Sup) is placed on a net (with ADD,
MOVE) then this net segment will receive the name of the supply pin.
The user will be informed if the net name changes as soon as a supply
pin is connected. If the last supply pin on a net is deleted, it is given a
new, automatically generated name.

Check and Correct Schematic

A schematic diagram must be checked with the aid of the Electrical Rule
Check (ERC), when the design of the schematic diagram has been com-
pleted, if not before. The ERC writes all its warnings and error messages
into a text file (*.erc), and displays this file in a the text editor window.

Please check all the messages and make corrections in the schematic, if
necessary. Run ERC again to check your efforts.
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Please remember:

The ERC checks the schematic diagram according to a rigid set of rules.
It can sometimes happen that an error message generated from your
schematic can be tolerated.

If necessary, make an output of the net and pin lists (EXPORT).
SHOW allows nets to be traced in the schematic diagram.

Experience has shown that printing out the schematic diagram by means
of the PRINT command is helpful when searching for faults.

In the case of a corresponding board file, the ERC also checks the con-
sistency between schematic and board. If there are no differences, ERC
reports Board and schematic are consistent at the end of the text file.
Otherwise the message Board and schematic are not consistent will be
prompted. The differences will be listed in the ERC file above.

See also page 78 for further information concerning Forward&Back
Annotation.

Points to Note for the Schematic Editor

Superimposed Pins

Pins will be connected if the connection point of an unconnected pin is
placed onto the connection point of another pin. Pins will not be con-
nected if you place a pin that is already connected to a net line onto an-
other pin.

Open Pins when MOVEing

If an element is moved then its open pins will be connected to any nets
or other pins which may be present at its new location. Use UNDO if
this has happened unintentionally.

Merge Different Schematics
The commands GROUP, CUT, and PASTE can be used to copy a sche-

matic or parts of it into another one. To do this open a schematic, dis-
play all layers (DISPLAY ALL), select all objects that should be copied
with GROUR and select the group with CUT and a right mouse click.
Open another schematic now and use the PASTE command.

While inserting a group EAGLE checks the objects' names and com-
pares them with those already existing in the schematic. If there are
matches the affected objects to be inserted get new unequivocal names.

This works also with board files, provided there is no consistent schematic
available.
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6.2 Considerations Prior to Creating a Board

Checking the Component Libraries

The EAGLE component libraries are developed by practicing engineers,
and correspond closely to present-day standards. The variety of compo-
nents available is, however, so wide that it is impossible to supply librar-
ies which are suitable for every user without modification.

There are even different packages which are supplied by various manu-
facturers using the same identification! Manufacturers recommend very
different sizes for SMD pads, and these depend again on the soldering
procedure being applied.

In short: You cannot get away without checking the components, in
particular the package definitions, being used when laying out.

In the case of SMD components please take particular care to ensure that the
package from the library agrees with the specifications of your component.
Housings from different manufacturers with the same name but different
dimensions are often found.

Agreement with the Board Manufacturer

If you plan to have your pcb films made using a Gerber photoplotter,
then, if you have not already done so, now is the time to inquire at your
board maker whether he stipulates any particular values for the follow-
ing parameters:

e track width

* shape of solder lands

¢ diameter of solder lands
* dimensions of SMD pads
* text size and thickness

e drill hole diameters

* number of signal layers

* in case of multilayer boards: manufacturing directions for blind
and buried vias and composition of the board
(see page 121)

* distance between different potentials
* parameters concerning solder stop mask

You will save yourself time and money if you take these stipulations into
account in good time.

You will find more details on this in the section on the Preparing of Ma-
nufacturing Data (Chapter 9).
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Specifying the Design Rules

All the parameters relevant to the board and its manufacture are speci-
fied in the Design Rules. Use the menu Edit/Design Rules.. or the DRC
command to open the Design Rules window. Opening the window with
the DRC command allows to start the Design Rule Check with the
Check button after setting the parameters. The layout can be checked at
any time.

The following window appears when DRC has been called:

= DRC (default) [ |
File: }Laya.s | Cleaance | Distance | Sies | FRestring | Shapes | Supply | Masks | Misc |
EAGLE Design Rules
The default Design Flules have been set to cover 3 wide tang of applcations. Your paticular design may have diferent iequitements,
30 please make the necessany adjustments and save your customized design 1ules Lnder 3 new name.
Edit Deseiplion..
Load Save as
Select | Apply | Bz ‘

DRC: Adjusting the Design Rules

General Principles

The first time that you call the DRC, the Design Rules are provided by
the program. If necessary, adjust the values to suit your requirements.
When you have finished the adjustments, start the error check by click-
ing on OK. This will result in the Design Rules being stored in the lay-
out file itself.

By clicking on Select you specify the region of the layout that is to be
examined. Simply drag a rectangle over the desired region with the
mouse. The error check will then automatically start.

Only signal layers visible before the Design Rule Check has been started
are examined (DISPLAY).

The Apply button stores the values that are currently set in the layout
file. This means that the values that have so far been chosen are not lost
if you do not immediately start the error check and if you want to leave
the DRC dialog via the Cancel button.

Changes to various Design Rules are immediately displayed in the Lay-
out Editor after clicking on Apply.
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The Design Rules can be saved in a special Design Rules file (*.dr«) by
the use of the Save as.. button.

To apply a set of Design Rules to a board, you can drag any dr« file of
the Design Rules branch of the tree view in the Control Panel into the
Layout Editor window.

The Load.. button allows any particular set of Design Rules to be loaded
from a file.

Change can be used to alter the descriptive text for the current parame-
ter set. The description usually appears in the DRC dialog (File tab), as
can be seen in the foregoing diagram. Rich Text format can be used with
the text. You will find notes on this in the help system.

Usually one sets the common Design Rules with the Edit/Design Rules
menu first and starts the Design Rule Check when required with the
DRC command. But it is also possible to adjust the Design Rules if you
use the DRC command.

If you open the Design Rules dialog with the menu Edit/Design Rules.. the
Select button will not be shown. In this case OK ends the dialog and saves
the parameters in the board file.

If you use the DRC command, the Check button starts the Design Rule
Check.

The Design Rules dialog offers a range of different options that can be
selected through the tabs. The options include:

File Manage the Design Rules

Layers Number of copper layers, structure of multilayer
boards, kind and length of vias, thickness of copper and
isolation layers

Clearance Distances between objects in the signal layers
representing signals that may be different or the same

Distance Distances from the board edge and between holes

Sizes Minimum track width and hole diameter, particularly for
micro and blind vias

Restring  Width of the remaining ring at pads and (micro) vias
Shapes  Shapes of pads and SMDs

Supply = Thermal and insulation symbols in supply layers
Mask Values for solder stop and solder cream masks

Misc Additional checks
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Notes on the Parameters

Most parameters are explained with the help of a graphical display. As
soon as you click with the mouse on a parameter line, the associated dis-

play appears.

Layers

Define the number of signal layers and the kind of vias (blind or buried
vias) here. With the help of a mathematic expression in the Setup line the
proper structure of the board O the appropriate combination of cores
and prepregs and the resulting facilities for vias O can be defined.

Fie | Laars | Clearance | Distance | Sizes | Resting | Shopes | Supply | Masks | Misc |

Nr Copper Isolation
1 [0.035mm
1.5mm
16 [0.035mm

Setup [1116)

Layers are combined through sither core of prepreg material. a=h combines layers 2 and b with a core, while a+b does the same
with prepreg.

Buried ard through viss are defined by writing ¢ -

Blind vias are defined by wiling Tt : . . . zb1. which defines a bind via from top to layer ¢ and from battom to layer 6.

Example: [2: 1+ ({23} +(4*16)) | iz a multiayer zetup with two cores, combining layers 2/3 and 4/1E, respectively, with
buried vias going through both cores. The cores sre combined thiough a prepreg and buried vias are produced through e
resulling stack. Finally layer 1 is added, with blind vias goirg from lager 1 to 2

oK I Apply Cancel

Design Rules: Layer Setup

In most cases (for simple two or more layer boards) the vias are drilled
through all layers. The image above shows the default setup for a two
layer board. The expression (1*16) defines one core with layers 1 and
16, which can be connected with vias. Parenthesis around the expression
define through-hole (continuous) vias.

Basic examples:

1 layer:
16 Only layer 16, no vias.

4 layers, vias through all layers:
(1*2+15*16) Two cores are affiliated with each other.

6 layers, vias through all layers:
(1*2+3%14+15*16) Three cores are affiliated with each other.

The fields for Copper and Isolation are used to define the thickness of
copper and isolation layers. These settings are only relevant for complex
multilayer boards that use blind or micro vias.
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The commands DISPLAY, LAYER, WIRE, and ROUTE work only
with those signal layers defined in the Layer setup.

Further information and examples about the Layer setup can be found in
the section Multilayer Boards beginning with page 121.

Loading a board file that was made with an older version causes EAGLE
to check which signal layers contain wires. These layers appear in the layer
setup. Please adjust it if necessary.

Minimum Clearances

Clearance refers to the minimum distances between tracks, pads, SMDs
and vias of different signals, and between SMDs, pads and vias of the
same signal.

Setting the values for Same signal checks to 0, disables the respective

check.

Distance allows settings to be made for the minimum distances between
objects in layer 20, Dimension, in which the board outline is usually
drawn, and between holes.

Setting the value for Copper/Dimension to 0 switches off the minimum
clearance check between copper and dimension. In this case EAGLE
does not recognize holes that are placed on wires.

Polygons don't keep their distance to objects in layer 20, Dimension, either!

Nets that belong to special net classes are an exception here. Values for
minimum clearance and hole diameters defined by means of the CLASS
command apply to these, provided they are higher than those given in
the Design Rules.

EAGLE's minimum resolution is 1/10.000 of a millimeter. That is why the
DRC can report only distance and clearance errors which are larger than
1/10.000 mm.

Sizes

The minimum values for track width and for hole diameter allowed in
the layout are selected here.

Here you set the aspect ratio of drill depth to drill diameter for boards
that contain blind vias. Please contact your boardhouse for this infor-
mation! If the boardhouse specifies, for example, an aspect ratio of
1:0.5 you have to enter the value 0. 5 in the line Min. Blind Via Ratio.

For micro vias you have to set the minimum drill diameter in the line
Min. MicroVia. Setting this value higher than the value in Minimum
Drill means that there are no micro vias used (default).
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Restring

The settings made under Restring determine the width of the ring re-
maining at pads, vias, and micro vias. The remaining ring refers to the
ring of copper that remains around a hole after a pad or via has been
drilled. Different selections can be made for the width of the remaining
ring in the inner and outer layers. Pads may also differ between the Top
and Bottom layers.

Usually the value is expressed as a percentage of the hole diameter.
Minimum and maximum values can additionally be specified.

As soon as you change a parameter and click on the Apply button you
can directly see the effects in the layout. If you want to use different va-
lues for the upper and lower layer (or different shapes, see Shapes tab), it
is recommended to set the layer color for layers 17, Pads, and 18, Vias,
the same as the background color (black or white). In this case you can
recognize the real size and shape of the pad/via in its respective layer.

The INFO command shows the via diameter separately for outer and
inner layers, and additionally the initially user-defined value.

= DAC (default)

Fie | Layers | Clearance | Distance | Sizes | Resting ISl’\apes | ey | Masks | Misc |

Min % Max Diameler

I—— Pads Tep [tomi [z [20imi
Inner [10ewil E3 [l r

Battorn [10mil |25 [20mil

Vias Outer  [mil [ [20mil
Iriner —[mil [ [20mil I

Micro Vias Outer  [4mil [ [20mil

Inner— [4mil [ [20mil

Restrings for pads and vias are defined in percent of the dil dismete (imited by Min and Max]. If the dismeter of an sctual pad or via
would resultin 3 larger reting, that walus will be usedin the outer layers.

Ifthe Diameter option is checked the actual pad o via diameter will be taken into account in the inner lavers, too.

Micto Vias are blin viss that are exactly ane layer deep and have  dilldiameter that s smaller than the Minimum Diill vaius defined
under Sizes (hich may bs oversiitten by a larger Diill value in the At cfassss]

ak Apply Cancel

Design Rules: Restring setting

The diagram illustrates the template for setting the width of the residual
ring. The standard value for the restring around holes is 25% of the hole
diameter. Since the width of the ring on small holes specified this way
would soon fall below a technically feasible value, a minimum value
(here: 10 mil for pads, 8 mil for vias, 4 mil for micro vias) is specified
here. It is also possible to specify a maximum value.

Example:

The ring around a hole with 40 mil diameter is 10 mil (25%). It there-
fore lies in between the maximum and minimum values.

If the hole is only 24 mil in diameter (e.g. for a via), the calculation
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yields a restring value of only 6 mil. For a board made in standard tech-
nology this is extremely fine, and cannot easily be made. It might well
involve extra costs. In this case a minimum value of 10 mil is given.

If you like to define a restring with a fixed width, use the same value for
minimum and maximum. The value in percent has no effect in this case.

Set the check boxes Diameter, and the via/pad diameter will be taken
into consideration for the inner layers. This can be of interest if a pre-
defined pad or via diameter exceeds the calculated value. Otherwise the
pad or via in the inner layers would be smaller than in the outer layers. If
you want pads/vias to have the same diameter in all layers, set the option
Diameter.

The option is set off, by default, for new created boards, but will be set
on for boards that are updated from version 3.5 or prior because in these
versions pads and vias had the same diameter in all layers. Thus the up-
date process does not change the original layout.

All the values can also be given in millimeters (for example 0.2mm).

Shapes

Smd:
A rounding factor can be specified here for SMD pads. The value can be
between 0% (no rounding) and 100% (maximum rounding).

Roundness: 0 - 10 - 25 - 50 - 100 [%]. Right: 100%, square

A square SMD has been placed instead of an oblong one on the far right
of the diagram. After assigning the property Roundness = 100%, the
SMD becomes round.

Pad:

This is where the form of the pads is specified. It is possible to give dif-
ferent settings for the top and bottom layers.

The As in library option adopts the form defined in the Package Editor.
Clicking on Apply shows the change immediately in the Layout Editor.
Pads within inner layers are always round, the diameter being deter-
mined by the restring settings.

Provided a pad was given the First flag in the library one can specify a
certain shape for all those pads in the layout.
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= DRC (default)

File | Layers | Clearance | Distance | Sizes | Resting | Shapes ISuDD\y | Masks | Mise |

Elongation = %-100 b Min * Mat

Roundness  [Omil o [orail

Pads Shape

Ton [ As i library |
Eattom [ s in library =
First [ Wat special -
Elongation% o0 foo

Shapes of pads and smds.

oK Apply Cancel
Design Rules: Adjusting Pad Shapes

Elongation defines the aspect ratio of length to width of Long and Offser
pads (see image). The value is given in percent. Click with the mouse
into the field Long or Offset and the image on the left shows the corre-
sponding calculation rule.

100% is equivalent to an aspect ratio of 2:1. 0% results in a normal octa-
gon pad with an aspect ratio of 1:1. The maximum is 200% (ratio 4:1).

Notes on the display in the Layout Editor:

If pads or vias have different shapes on different layers, the shapes of the
currently visible (activated with DISPLAY) signal layers are displayed
on top of each other.

If the color selected for layer 17, Pads, or 18, Vias, is 0 (which represents
the current background color), the pads and vias are displayed in the co-
lor and fill style of their respective layers. If no signal layer is visible,
pads and vias are not displayed.

If the color selected for layer 17, Pads, or 18, Vias, is not the background
color and no signal layers are visible, pads and vias are displayed in the
shape of the uppermost and undermost layer.

This also applies to printouts made with PRINT.

Supply

Specifies the settings for thermal and annulus symbols. These special
symbols are generated in supply layers that are created automatically
(layer name starting with a $-sign).

EAGLE calculates the required dimensions for annulus and thermal ap-
ertures based on the pad’s drill diameter and the annulus and thermal
parameters set in the Design Rules:
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Gap defines the gap between the insulation bridges on a thermal sym-
bol. The specification is made as a % of the hole diameter, and is con-
strained by maximum and minimum values.

The Isolate values for Thermal and Annulus determine the width of the
thermal bridge or ring.

The Restring option determines whether the insulation bridge of the
thermal symbol should be drawn immediately at the edge of the hole or
at a distance from the hole given by the restring value (Restring tab, In-
ner setting).

If the Restring option for Annulus is deactivated, a filled circle is gener-
ated instead of the annulus ring. This is the default setting.

The isolate value for Thermal also applies to polygons. It determines the
distance between a polygon and the restring of the pad or via that is
joined to the polygon through a thermal symbol.

The Generate thermals for vias flag permits thermal symbols at through-
hole contacts. Otherwise vias are fully connected to the copper plane.
This applies also for polygons. But you can disable this option for indi-
vidual polygons (CHANGE THERMALS OFF).

Calculations for automatically created symbols in supply layers:

Annulus:

Inner diameter
Outer diameter

pad hole diameter + 2 * restring
max (pad-hole diameter, inner diameter)
+ 2*isolate

Default: restring = 0 (fully filled), isolate = 20 (mil).

Thermal:

Inner diameter
Outer diameter

pad hole diameter + 2 * restring
inner diameter + 2 * isolate

AN

N\
N \ \
§ Q

Isolate Gap Restring

Pads or smds marked with the flag NOTHERMALS (resp. CHANGE
THERMALS OFF) in the Package Editor will be connected basically
without thermal symbols.

7 2
Y
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Masks

Settings for the overmeasure of the solder stop mask (Stop) and the sol-
der cream mask (Cream) are made here.

[ DAC [default)

Fie | Clearance | Distance | Siees | Resting | Shapes | Supply | Masks | iso |

Min % Max
Step [ 4mi [100 [4m1
Ciam | Uil [0 [omil
Limit | Omil

Mask values are defined in percent of the smaller dimension of smds, pads and vias [imited by Min and Max)
Stop masks aie generated for smds, pads and those vias that have a dill diameter that exceeds Limit,
Cream masks are generated for smds anly.

ok | Apply ‘ Cancel |

Design Rules: Settings for Solder Stop and Cream Frame

The default value for solder stop is 4 mil, i.e. minimum value is maxi-
mum value is 4 mil. The percent value has no effect in this case.

The value for the cream frame is set to 0, which means that it has the
same dimensions as the smd.

If values are given in percent, in the case of smds and pads of the form
Long or Offset, the smaller dimension is the significant one. The values
are constrained by minimum and maximum values.

The value for Cream is given positively, as is Frame, although its effect is
to reduce the size of the solder cream mask (creamframe).

The solder cream mask is only generated for SMDs, and is displayed on
layer 31, tCream, or layer 32, bCream. The solder stop mask is drawn in
layers 29, tStop, or 30, bStop.

Setting the flag STOP or CREAM (only for SMD) to OFF for a pad or
smd at the package definition forbids EAGLE to generate a solder stop
mask or a cream frame for it.

Limit determines, together with the hole diameter, whether or not a via
is to be covered with solder stop lacquer.

Example:

The default value for Limir is 0. This means all vias get a solder stop
symbol. They are free of solder stop laquer.

Set the Limir = 24:

All through-plated holes with diameters up to 24 mil don’t get a solder
stop symbol (they are laquered), but vias with larger hole diameters get
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a solder stop symbol.
For vias with hole diameters below the Limit the STOP flag can be set
(CHANGE STOP ON). EAGLE generates a solder stop mask then.

Misc
Here you can select/deselect various checks:

Check grid examines whether elements lie precisely on the grid currently
set by the GRID command. This test is not always worthwhile, since in
many cases devices built to both metric and imperial grids are in use at
the same time. No common grid can be found in such a case.

Check angle ensures that all tracks are laid at whole multiples of 45 de-
grees. This test is normally switched off, but can be activated if required.

Check font (de-)selects the font check.

The DRC checks if texts are written in vector font. Text which is non-
vector font is marked as an error. This check is necessary due to the fact
that the CAM Processor can't work with others than vector font for the
generation of manufacturing data.

Assumed you use proportional font text in the bottom layer, place it
between two tracks, and use the CAM Processor to generate Gerber
files, it could happen that the tracks are shorted by the text (height and
length of the text can change)!

Default: on.

Check restrict can be set off if copper objects should not be checked
against restricted areas drawn in layers 39, tRestrict, and 40, bRestrict.
Default: on.

Stop after xx errors specifies the maximum number of errors in the error
list. As soon as this many errors have been found, the DRC stops exam-
ining the layout and automatically opens the error list.

Advice on handling errors is found later in this chapter.

The DRC treats a line (wire) whose Style is LongDash, ShortDash or
DashDot in the same way as a continuous line.

If a wire drawn with one of these styles is laid as a signal, the DRC re-
ports a Wirestyle error.
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6.3 Create Board

After you have created the schematic, click the Board icon.

An empty board is generated, next to which the components are placed,
joined together with airwires. Supply pins are connected by those sig-
nals which correspond to their name, unless another net is explicitly
joined to them.

The board is linked to the schematic by the Forward&Back Annotation.
Provided that both files are always loaded during editing they are guar-
anteed to remain consistent. Alterations made in one file are automati-
cally carried out in the other.

If, for example, the schematic diagram is loaded and edited without the
layout, consistency is lost. The Forward&Back Annotation no longer
functions. Differences must then be rectified manually with the aid of
the error messages provided by the ERC.

Without the Schematic Editor

If you work without a Schematic Editor, you must generate a new board
file, place the packages with the ADD command and define the connec-
tions with the SIGNAL command.

To understand this process, please read the section on Placing Compo-
nents on page 88, and the section on Specifying Net Classes on page 93.
These two points apply to the Layout Editor as well as to the Schematic
Editor.

The remaining procedures are identical for users with and without the
Schematic Editor.

Specify the Board Outline

A board that has just been generated from a schematic diagram initially
appears as in the following diagram:
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Move an object

Board command: Create the layout from the schematic

The devices are automatically placed at the left of the board. The board
outline is drawn as a simple line in layer 20, Dimension. The outline of
an eurocard is displayed in the Professional and Standard editions, a
half-eurocard in the Light edition.

If you wish, you may alter the size or shape of the empty board with the
MOVE and SPLIT commands. Please note the hints in the help func-
tion for WIRE and MITER. It's easily possible to draw round outlines,
too.

You can also delete the outline and place a frame from a library (such as
19inch.lbr) with ADD.

A script file can, alternatively, be read by the SCRIPT command. The
euro.scr file, for instance, can be used. Simply type

SCRIPT EURO
on the command line.

The board outline serves simultaneously as a boundary for the auto-
router (if present).
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Arrange Devices

Drag the various elements to the desired positions. You use the MOVE
command for this purpose. Devices can be clicked on directly, or ad-
dressed by name.
If, for example, you type

MOVE R14
onto the command line, the device named R14 will be attached to the
mouse cursor, and can be placed.
Precise positioning results from input such as:

MOVE R14 (0.25 2.50)
R14’s locating point is now located at these coordinates.

Keep the Ctrl key pressed while selecting a component in order to let its
origin jump at the mouse cursor and move it onto the currently used
grid.

A group of devices can be transposed by combining the GROUP and
MOVE commands. Click on the GROUP icon and then draw a frame
around the desired elements, click MOVE, and then click within the
group with the right mouse button in order to select it. With a click of
the left mouse button you can place the group at the desired location.

ROTATE, or a click with the right mouse button while the MOVE
command is active turns a device through 90 degrees. This also applies
to groups.

In order to place a component in any angle you may specify the rotation
directly with the ADD command or later with ROTATE or MOVE in
the parameter toolbar.

i | angle |45 =] wf ' (H B

Parameter toolbar for ROTATE, MOVE, ADD, COPY, TEXT
Next to the Angle box are the buttons for the Spin and Mirror flag.
Entering

ROTATE R45 'IC1l' ;
in the command line adds a rotation of 45° to the current position of
element IC1. Assumed you tried, for example, to rotate the element
with the ROTATE command and pressed mouse button, and you de-

cided that it is not possible to obtain the exact rotation angle this way
(because of a too coarse grid) type in the command line:

ROTATE =R45 'IC1l' ;

The rotation of IC1 is now exactly 45°. The = sign stands for absolute
values. The initial position does not matter.
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If, for example, a smd should be placed on the bottom side of the board
you may add the Mirror flag, as in:

ROTATE =MR45 'IC1l' ;

An additional Spin flag causes texts to be written upside down (by a ro-
tation of 180°), that means they can be read from the top view:

ROTATE =SMR180 'IC1l' ;

The Spin flag is alternating, i. e. using it again causes the text to be dis-
played 'normal' again.

Check frequently whether the placement is favorable or not. To do this,
use the RATSNEST command. This calculates the shortest connections
of the airwires.

The position of particular devices can be displayed by typing the device
name onto the command line or by clicking directly on an element while
the SHOW command is active.

Clicking with INFO onto a device provides detailed information about
it.

If the text for the name or the value is located awkwardly, separate them
from the device with SMASH and move them to whatever position you
prefer with MOVE. At the same time EAGLE shows a line from the
text’s origin to the belonging element. Clicking with DELETE on either
of the texts makes it invisible.

Holding down the Shift key while the SMASH command is active the
name and value texts will appear at their original positions again. They
are no longer editable and are so to speak unsmashed.

Please keep in mind that the CAM Processor always uses vector font for
generating manufacturing data.

We recommend to write texts in the layout always in vector font (at least in
the signal layers). If you do so the shown text meets exactly reality. Further
information can be found on pages 33 and 119.

Boards with Components on Both Sides

If the board is also going to have components on the underside, the
MIRROR command is used. It causes devices on the underside to be in-
verted. SMD pads, the silk screen and the layers for the solder stop and
solder cream masks are automatically given the correct treatment here.

While ADD, COPY, MOVE, or PASTE is active it is possible to mirror

an element or a selected group with the middle mouse button.

It is not necessary for the Package Editor to define devices in the library as
being on the bottom side.
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Exchanging Packages

If, as the layout is developed, you want to replace the selected package
variant with a different one, then you can use either the CHANGE or
the REPLACE command, depending on the situation.

CHANGE Command

It is assumed that the layout and the schematic diagram are consistent
and the Device has been defined with more than one package variant.
Click on the CHANGE icon and select the Package option. You select
the desired package, and confirm it with OK, in the dialog that then
appears.

B Change package of C1 HE
[ ame | Package I:|
C-EUCOS04 COs04
C-EUCOBD3 COBN3 [0 |
C-EUCO305 Coans
C-EUCT005 C1o0s
C-EUCT208 |
C-EUCTI210 C1210 ) ]
C-EUCTI310 C130 chip capacitor
C-EUCT1E0S C1e03 J
C-EUCTIE312 ciaz
C-EUC1825 C1a25 j
[ Show all
Ok | Cancel |
CHANGE package dialog

If the Show all option is active, the package versions for all the technolo-
gies available for this device are displayed. If this option is not active
you will only see packages that are defined in the selected technology.

The package can also be exchanged from within the schematic diagram.

Devices with a single package variant have to be modified in the Library
Editor before. Add further package variants as needed. See page 186
Choosing the Package Variants for further information.

If you want to change a package which you gave a new value with the
help of the VALUE command before, the value text of the new package
will drop to the original value although the device has been defined with
VALUE Off in the library. See also page 57.
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REPLACE command

If you have a layout without an associated schematic diagram, you ex-
change the package with the aid of the REPLACE command.
REPLACE opens the window that is familiar from the ADD dialog, in
which it is possible to search for devices. When the package has been
chosen you click on the device that is to be replaced in the layout.

The REPLACE command operates in two ways, chosen with the SET

command:
SET REPLACE_SAME NAMES; (default)
SET REPLACE_SAME COORDS;

The first mode permits packages whose pad or SMD names are identical
to be exchanged. The connecting areas can have any position.

In the second case (replace_same coords) the pads or SMDs in the new
package must be located at the same coordinates (relative to the origin).
The names may differ.

The text for the name and value of a device is only exchanged if they
have not been separated from the device with SMASH.

The new package can come from a different library, and can contain ad-
ditional pads and SMDs. Connections on the old package that were con-
nected to signals must exist correspondingly in the new package. The
new package can even have fewer connections, provided that this condi-
tion is satisfied.

Changing the Technology

It is possible to change the technology of a device in the layour at any
time , provided there are various technologies defined in the library. Use
the CHANGE command with the Zechnology option. This procedure is
identical to the one described before in which package forms are ex-

changed using CHANGE.

Define Forbidden Areas

Areas in the form of rectangles, polygons or circles in layers 41, tRe-
strict, 42, bRestrict, and 43, vRestrict, are forbidden for the Autorouter
(see RECT, POLYGON, CIRCLE). No tracks may be drawn in the top
or bottom layers inside these areas. Through-plated holes may not be
located in a vRestrict region. These regions are examined by the DRC.
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Routing — Placing Tracks Manually

The ROUTE command allows the airwires to be converted into tracks.
A click on the center mouse button while a track is being laid allows a
change of layer. A via is placed automatically. Clicking with the right
mouse button changes the way in which the track is attached to the
mouse and how it is laid (SET command, Wire Bend parameter).
Among them are two modi which allow to use a wire as a 90-degree or as
a free-definable arc.

The signal's name and net class will be displayed in the status bar, as far
as the User guidance has been deactivated in the menu Options/User
Interface. When a signal line has been completely laid, EAGLE confirms
that there is a correct connection with a short beep as it is placed.

If there is no longer a wiring route available for some signals, other
tracks are relocated with MOVE and SPLIT, or the properties of tracks
(width, layer) are modified with CHANGE.

If a through-plated hole is to be placed at a certain point, this can be
done with the VIA command. The via is given the name of a signal using

NAME.

If you want to begin a wire of a partially routed signal at another posi-
tion than the start or end point of an airwire (for example, at a farther
position on a wire that belongs to the same signal) simply press the Ctr/
key. EAGLE generates a new airwire from this position (see also help

function for ROUTE).

Airwires with length of 0 (for example, from Top to Bottom layer) are
drawn as a cross in layer 19, Unrouted.

Ending a wire at the same position where another wire of the same sig-
nal but in another layer already exists and pressing the Shift key at the
same time causes EAGLE to place a via. Otherwise it won't.

If you intend to design a multilayer board and use blind and buried or
micro vias, please note the details (also for the VIA command) in the
section about Multilayer Boards beginning at page 121.

While laying out wires EAGLE calculates the shortest connection to the
closest point of the current signal automatically. This connection is rep-
resented by an airwire.

As the routing proceeds it is helpful to run the RATSNEST command

frequently, in order to recalculate all the airwires.

Use RIPUP if you want to convert the whole or part of a track or a via
that has been laid back to a signal line. By clicking on a track it is decom-
posed between the nearest bends. If you click on this location again (on
the airwire), the whole signal branch back to the nearest pads is decom-
posed. If you want to undo the whole of the signal, click RIPUP and en-
ter the name of the signal on the command line. More than one may be
entered at the same time.
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The command
RIPUP GND VCC +5V

converts the three signals GND, VCC and 45V back to airwires.
RIPUP ! GND VCC

on the other hand converts all signals apart from GND and VCC to

alrwires.
RIPUP ;

converts all signals (that are visible in the editor) into airwires. To truly
include every track, all the layers in which tracks have been drawn must

be visible (DISPLAY).

If you want to use wires as arcs or try to smooth the wire bends see the
hints concerning the MITER command in the help function. The miter
radius determins how the wire joints are mitered. A positive value gen-
erates a rounding, a negative one a straight line. The miter radius influ-
ences some bend modi (0, 1, 3, 4; see SET command) and is shown
additionally in the parameter toolbar of the commands SPLIT, ROUTE,
WIRE, and POLYGON.

While WIRE or ROUTE is acitve it is possible to click through the pre-
viously mentioned wire bends (bend modi) with the right mouse but-
ton. EAGLE knows eight modi (0..7).

Holding down the Shift key while clicking the right mouse button
reverses the direction of selection.

Holding down the Ctrl key allows to toggle between complementary
wire bends.

If you want to have only some wire bends available for the right mouse
button, you can define this, for example, in the eagle.scr file.

Supposed you want to work with wire bends number 2, 5, 6, and 7 use
the following syntax:

SET WIRE BEND @ 2 5 6 7 ;

However, if you want to use another bend mode you can always chose it
from the parameter toolbar.

It is also possible to leave the track laying to the Autorouter which has
its own chapter in this manual.

Defining a Copper Plane with POLYGON

EAGLE can fill regions of a board with copper. Simply draw the borders
of the area with the POLYGON command. You give the polygon a sig-
nal name, using NAME followed by a click on the border of the poly-
gon. Then all the elements that carry this signal are connected to the
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polygon. Both pads and, optionally, vias (as specified in the Design Ru-
les) are joined to the copper plane through thermal symbols. Elements
not carrying this signal are kept at a specified distance.

RATSNEST calculates and displays the surface area. RIPUR followed
by a click on the polygon border, makes the content invisible again. The
content of the polygon is not saved in the board file. When you first

load the file, you will only see the outline of the polygon. It is only cal-
culated and displayed again by RATSNEST.

Various options can be changed via the parameter toolbar, either as the
polygon is being drawn or, with CHANGE, at a later stage.

i [ eEon  *||l g 2 s s S M0 “lr 7 widnome =]/ @ @ @8 @ | 1sok=0 ~| spacing: [005 | Rank 1 =

POLYGON command: Parameter toolbar

Width:

Line thickness with which the polygon is drawn. Select the largest possi-
ble width. That avoids unnecessary quantities of data when the board is
sent for manufacture. If the wire width is lower than the resolution of
the output driver in the CAM Processor, a warning is issued.

A finer line width permits the polygon to have a more complex shape.

Pour:
Specifies the filling type. The whole area (Solid) or a grid (Hatch).

Rank:

Overlapping polygons must not create any short-circuits. Rank can
therefore be used to determine which polygons are to be subtracted
from others. A polygon with rank = 1 has the highest priority in the
Layout Editor (no other polygon drawn in the layout is ever subtracted
from it), while one with rank = 6 has the lowest priority. As soon as
there is an overlap with a higher rank, the appropriate area is cut out
from the polygon with rank = 6. Polygons with the same rank are com-

pared by the DRC.

Polygons that are created in the Package Editor can be assigned the rank
0 or 7. Rank = 0 has highest priority and will not be touched by other
polygons. Polygons with rank = 7 will be pushed away from all other
polygons drawn in the layout.

Spacing:

If the option Hatch is chosen for Pour, this value determines the spacing
of the grid lines.

Isolate:

Defines the value that the polygon must maintain with respect to all
other elements not part of its signal. If higher values are defined for spe-
cial elements in the Design Rules or net classes, the higher values apply.
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Thermals:

Determines whether pads in the polygon are connected via thermal
symbols, or are completely connected to the copper plane. This also ap-
plies to vias, assuming that the option has been activated in the Design
Rules.

The width of the thermal connectors is calculated as the half of the pad's
drill diameter. The width has to be in the limits of a minimum of the
wire width and a maximum of twice the wire width of the polygon.

Don't choose the polygon's width too fine, otherwise the thermal con-
nectors won't resist the current load.

Orphans:

Determines if a polygon may contain areas (islands) which are not elec-
trically connected to the polygon's signal.

If Orphans is set Off such un-connected areas won't be drawn.

When drawing a polygon, please take care to ensure that the outline is not
drawn more than once (overlapping) anywhere, and that the polygon out-
line does not cross over itself It is not possible for EAGLE to compute the
contents of the area in this case.

An error message Signalname contains an invalid polygon! is issued, and
the RATSNEST command is aborted.

If this message appears, the outline of the polygon must be corrected. Other-
wise, manufacturing data cannot be created by the CAM Processor.

The CAM Processor automatically computes the polygons in the layout be-
fore generating its output.

DRC — Checking the Layout and Correcting Er-
rors

The Design Rule Check (DRC) is carried out at the end of the board
design, if not before. If you have not yet specified any Design Rules for
the layout, this is your last opportunity. See the section on Specifying the
Design Rules from page 98.

If the DRC finds errors, an error window opens automatically. This lists
all the errors. The window can be opened at any time by means of the
ERRORS command.

If an error in the list is selected, a line points to the corresponding loca-
tion. The error is marked. Correct the error in the layout. The DRC er-
ror window remains in the foreground.

Clicking on the Del button will delete the selected error entry. Del all
deletes all the error marks from the layout.

The dialog is ended with Close.
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DRC error list in the Layout Editor

Signal layers which are not visible (DISPLAY command) will not be
checked by the Design Rule Check!

Error messages and their meaning

Angle:

Tracks are not laid in an angle of 0, 45, 90 or 135°. This check can be
switched on or off in the Design Rules (Misc tab).

Default: off.

Blind Via Ratio:
The limit of the ratio of depth to drill diameter is exceeded. In this case
you have to adjust the via's drill diameter (see Design Rules, Sizes tab).

Clearance:

Clearance violation between copper elements. The settings of the De-
sign Rules' Clearance tab and the value for Clearance of a given net class
will be checked. In addition the Isolate value will be taken into conside-
ration for polygons with the same rank and polygons which are defined
as part of a package.

To deactivate the clearance check between elements that belong to the
same signal, use the value 0 for Same signals in the Clearance tab.

Dimension:

Distance violation between smds, pads, and connected copper objects
and a dimension line (drawn in Layer 20, Dimension), like the board's
outlines. Defined through the value for  Copper/Dimension in the
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Design Rules (Distance tab).

Setting the value Copper/Dimension to 0 deactivates this check.

In this case polygons do not keep a minimum distance to objects in lay-
er 20, Dimension, and holes! The DRC will not check if holes are placed
on tracks!

Drill Distance:
Distance violation between holes. Defined by the value Drill/Hole in
the Design Rules (Distance tab).

Drill Size:

Drill diameter violation in pads, vias, and holes. This value is defined in
the Design Rules (Minimum Drill, Sizes tab). It is also possible to define
a special value (Drills) for vias in a given net class (CLASS command).

Keepout:

Restricted areas for components drawn in layer 39, tKeepout, or 40,
bKeepout, lie one upon another. This ceck is made only if layers 39 and
40 are displayed.

Layer Abuse:

Layer 17, Pads, or 18, Vias, contains objects which can't be determined
by EAGLE. Those layers are exclusively dedicated to pads and vias. Bet-
ter move such objects into another layer.

Layer Setup:

This error is shown if an object in a layer is found that is not defined by
the Layer setup is found. The same for vias that do not follow the set-
tings of the Layer setup, for example, if a via has an illegal length

(blind/buried vias).

Micro Via Size:
The drill diameter of the micro via is smaller than the value given in the
Sizes tab.

No vector font:

The font check (Design Rules, Misc tab) recognizes text in a signal layer
which is not written in EAGLE's internal vector font.

If you want to generate manufacturing data with the help of the CAM
Processor the texts, at least in the signal layers, ought to be written in
vector font. This is the only font the CAM Processor can work with.
Otherwise the board will not look the same as it is shown. Change the
font with the help of the command CHANGE FONT or use the option
Always vector font in the Layout Editor's Options/ User Interface menu:
If activated, the Layout Editor shows all texts in vector font. This is the
way the manufactured board will look like.

Activating the sub-option Persistent in this drawing saves the setting in
the drawing file. If you send the layout file, for example, to the board-
house you can be sure that the vector font will be displayed also at his
system.
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No real vector font:

The font check (Design Rules, Misc tab) recognizes text in a signal layer
which is not written in EAGLE's internal vector font although it is dis-
played as vector font in the Layout Editor window. This situation arises
if the option Always vector font in the menu Options/User Interface is ac-
tive.

See error message No vector font for further details.

Off Grid:

The object does not fit onto the currently chosen grid.

This check can be switched on or off in the Design Rules (Misc tab).
Default: off.

Restrict:
A wire drawn in layer 1, Top, or 16, Bottom, or a via lies in a restricted
area which is defined in layer 41 or 42, t/bRestrict.

Width:

Minimum width violation of a copper object. Defined by Minimum
Width in the Design Rules (Sizes tab) or, if defined, by the track parame-
ter Width of a referring net class. Also texts in signal layers will be

checked.

Wire Style:
The wire style of a wire which is connected to a signal is not Continuous.

Net, device and pin lists can be output by means of EXPORT or by vari-
ous User Language programs.

Creating Manufacturing Data

Prints of the layout can be created for purposes of documentation using
the PRINT command. Layers that have been activated with DISPLAY
are printed. The printout has the same appearance as the layout has on
the screen.

Exception: Origin marks of texts and grid lines are not printable.

The manufacturing data is typically generated with the CAM Processor.
A variety of drivers are available to create drilling data, Gerber data,
plotter data and so forth. We will return to this subject in a specific
chapter later.

In order to save costs, it may be worth supplying the layout to the board
manufacturer in the form of a multiple board. You can reproduce the
layout to create a multiple board with the GROUB, CUT and PASTE
commands. It should be noted that this will change the board’s silk
screen, since devices and signals receive new names when the layout is
placed. Ensure that all the layers are displayed before using the GROUP
and CUT commands.
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Any other data format can be created with the aid of ULPs (User Lan-
guage programs). See the short description of ULPs in the Control
Panel.

6.4 Multilayer Boards

You can develop multilayer boards with EAGLE. To do this, you use
one or more inner layers (Route2 to Routel5) as well as the layers Top
and Bottom for the top and undersides. You display these layers when
routing.

Before starting the routing of the layout you should be aware of the
number of signal layers to use, if vias should go through all layers, or if
you have, due to the complexity of the layout, to work with blind, bur-
ied or micro vias. In this case you realy ought to contact your board-
house to inform you about the possible structure of the board and the
resulting costs to be expected.

Also think about how to use the inner layers: As a normal inner signal
layer or as a supply layer? On this, for example, depend reasonable via
lengths that have to be defined in the Layer setup.

Inner Layer

Inner layers are used the same way as the outer layers Top and Bottom.
They can be filled with copper areas (polygons) as well. A special status
have the so-called supply layers which are generated automatically.

Before using inner layers you must define them in the Design Rules,
Layers-Tab. More details can be found in the following sections and on
page 100.

Signal Layers

You use the ROUTE command as usual to place tracks in those inner
layers which are provided for signals. Eagle will itself ensure that the
tracks are connected by way of plated-through holes to the appropriate
signals in the outer layers. The settings of the Layer setup in the Design
Rules apply for this procedure.

Supply Layers with Polygones and More than One Signal

Areas of the board can be filled with a particular signal (e.g. ground) us-
ing the POLYGON command. The associated pads are then automati-
cally connected using thermal symbols. The isolate value for the thermal
symbols is specified in the Design Rules (DRC command, Supply tab).
The width of the connecting bridge depends on the line thickness with
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which the polygon is drawn (see page 117). You can also specify whether
or not vias are to be connected through thermals. The minimum clear-
ances from elements carrying other signals specified in the Design Rules
are maintained (Clearance and Distance tabs). Changes are shown in the
layout when the polygon is next computed (RATSNEST command).

In this way you can also create layers in which several areas are filled
with different signals. In that case you can assign different ranks (priori-
ties) for the polygons. The rank property determines which polygon is
subtracted from others if they overlap. Rank = 1 signifies the highest
priority in the layout; nothing will be subtracted from such a polygon
(with the exception of polygons with rank = 0, drawn as a part of a
package in the Package Editor). Rank = 6 signifies the lowest priority.
Polygons with the same rank are compared by the DRC.

Please read the notes regarding polygons in the section on Defining a
Copper Plane on page 115.

Do not choose the wire width for polygons too fine! This can lead to
huge amounts of plot data and problems for the manufacturing process.

Power Supply Layer with One Signal

A power supply layer with one signal is implemented by renaming one
of the Route2...15 layers in such a way that the new name consists of the
corresponding signal name prefixed by a $ sign. If, for example, the sig-
nal called GND is to be realized as a power supply layer, then a layer is
specified as having the name $GND.

The DISPLAY menu shows only those layers defined in the Layer setup of
the Design Rules!

- Display For this purpose you activate the
Layers DISPLAY command. You select layer 2
from the menu with the mouse. Then
click on the Change button.

= Change layer properties
Mumber |2

Name
Urrouted

Color . ¥ Displayed
Dimension
Place Fillstyle . ™ [iupply Layer

bPlace

el tOriging |
bfigins ok Cancel

g tHames

bNames

Enter the signal name for the layer, and

o |
Hew | chenge % v | activate the Supply layer check box. If the
Al None PPy

layer is to be visible in the layout imme-

B diately, then click also on the Displayed
check box.
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The command corresponding to this example would be:
LAYER 2 $GND

This specifies that layer number 2 (previously known as Route2) is
henceforth known as $GND, and that it will be treated as a power sup-
ply layer.

Supply layers are displayed and plotted inversely!

Pads are connected to power supply layers with what are known as ther-
mal symbols, or are isolated with annulus symbols. Thermal symbols
usually just have four thin bridges as a conductive connection to the
through-plated hole. They are used because the high thermal conduc-
tion of a continuous copper plane would result in the pad being no
longer solderable. The shape and size of the annulus and thermal sym-

bols are specified in the Design Rules (DRC command, Supply tab).

To keep the board edges free of copper draw an isolating wire around
the layout. This avoids possible short circuits between adjacent (supply)
layers. If you want to use the Autorouter, however, these wires must not
be drawn until the routing process has been finished. Automatically
generated supply layers have to be disabled in the Autorouter setup.

No additional signals or signal polygons may be drawn in these layers. That
would lead inevitably to an unusable circuit board!

Details on Supply Layers and Autorouter:

The Autorouter takes into account all inner layers, and so delivers the
full set of patterns for multilayer boards. It connects SMD pads to inner
layers with vias.

Assumed only vias that can connect all layers (from layer 1 to 16) are
used (through vias), the preferred direction for the Autorouter has to be
set to N/A for power supply layers (this means the layer is not available
for routing). This is only possible for layers that do not contain any
wires.

If you are using, among vias through all layers, blind, buried, or micro
vias the Autorouter can't work with supply layers. In that case you have
to change the supply layer into an inner layer with polygon:

Therefore deselect the Supply flag in the Change window of the
DISPLAY menu and draw a polygon in the inner layer. The polygon has
to be given the name of the supply signal.
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Multilayer Boards with Through Vias

This type should be preferred if possible. Vias go through all signal lay-
ers and will be drilled at the end of the production process. The produc-
tion costs are relatively moderate.

Layer Setup

The settings concerning layer composition and number of signal layers
are made in the Design Rules, Layers tab, Setup. See page 100.

For through vias the setup is very simple. No considerations about
thickness of copper and isolation layers are necessary.

Simply join two layers by an asterisk (like /%2 or 3*16) to one core and
combine several cores. This is symbolized by a plus character (like in
1%2+3%4). The isolation layer between two copper layers is called
prepreg. To express the possibility to have vias through all layers the
whole expression is set into paranthesis.

Examples:
4 layers: (1%2+43*%16)
6 layers: (1*2+3%4+5%16)
8 layers: (1*2+3%4+45%6+7%16)

Here vias always have the length 1-16. They are reachable from all layers
(see also the help function for VIA).

Multilayer with Blind and Buried Vias

In high density boards it is often necessary to use blind and burid vias.
These kinds of vias don't connect all layers, but are only reachable from
a certain number of layers. How these layers are connected depends on
the manufacturing process of the board which has to be determined in
the Layer setup in the Design Rules.

Please contact your boardhouse before starting your work! Check which
Layer setup is suitable for your purpose.

Disambiguation

Core:
The non-flexible kernel which is coated with copper on one or on both
sides.

Prepreg:

Flexible glueing or isolating layer which is used in the manufacturing
process of a multilayer board to press inner and outer layers onto each
other.
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Layer Stack:
A pack of any number of layers consisting of cores and prepregs which
are handled together in the current step of production.

Buried Via:

The production process of this via does not differ from a through (nor-
mal) via. The current layer stack will be drilled through completely. In
the following production steps the already drilled vias can be covered
(buried) by pressing further cores and prepregs on the current layer
stack. If the via is not visible on the completed board we call it a buried
via.

Blind Via:

Blind vias connect an outer layer with any inner layer but don't go
through all copper layers. The specialty of a blind via lies in the produc-
tion process. The current layer stack is not drilled all through. The drill
hole has a certain depth depending on the number of layers that should
be allowed to be connected with each other. Blind vias have to follow a
given ratio of depth to drill diameter. Please contact your boardhouse to

get information about this. This ratio has to be defined in the Sizes tab
as Min. Blind Via Ratio.

Micro Via:
The micro via is a special case of a blind via. It has a maximum depth of
one layer and a very small drill diameter. See page 131.

Layer Setup

Combining cores and prepregs allows many variants. In the following
section some examples show the function of the Layer setup.

Please read this paragraph entirely. Even if you intend to design a four
layer board, for example, it is most advisable to read also all the other
examples for a better understanding.

4-Layer Board
Example 1:
Layers 1, 2, 3 and 16 are used.
Board structure: One core inside, outside prepregs.
Connections: 1-2 (blind vias), 2-3 (buried vias) and 1-16 (through vias)
The setup expression looks like this:
[2:(1+(2*3)+16) ]
Explanation:
2*3
Layers 2 and 3 form the core.
(2*3)
Parenthesis allow buried vias from 2 to 3.
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(1+(2+3) +16)
On both sides of the core copper layers are pressed on with prepregs.
The outer parenthesis define continuous vias from 1-16.

[2: (1+(2%3)+16)]
In square brackets and separated by a colon blind vias are defined.
Here from layer 1 to 2.

The following image shows the related setup expression in the Layers
tab of the Design Rules.

= DRC [default)

Fie | Layers | Clesrance | Distance | Sizes | Resting | Shapes | Supoly | Masks | Misc |

N Copper Isolation
1 [0.035mm
0.36mm
2 [0.0%5mm
0.71mm
3 [0035mm
0.35mm
16 [0.035m

Setup [[201+(Z3116])

Layers are combined thiough sither care ar prepreg material. a®h combines lavers 2 and b with a cove, while a+h does the same with
prepreg.

Buried and through vias are defined by witing . . _»

Blind vias are defined by witing Lt - - - - <bJ, which defines a blind via from bop to laper ¢ and fram bottorn to layer 5.

Example: [2:1+i 02731+ (47161 ] it a mukilaper setup with two cores, combining layers 2/3 and 4/16, respectively. with buried
vias going thiough both cores. The cores are combined thiough a prepreg and buried vias are produced through the resulting stack.
Finally layer 1 is added. with blind vias going from layer 1 to 2.

QK Apply ‘ Caneel

Example 1: Layer Setup for a 4-Layer Board

Blind vias have to keep a certain ratio of via depth to drill diameter. For
this reason it is necessary to specify values for the layer thickness.
These values are given by your boardhouse! You are supposed to contact
it in either case before starting the layout!

Type in the values in the Copper (thickness of copper layer) and Isola-
tion (thickness of isolation layer) fields as shown in the image.

Example 2:
Layers 1, 2, 3, and 16 are used.
Board structure: One core inside, outside prepregs.
Connections: 1-2, 3-16 (blind vias), 1-16 (through vias)
Setup expression:

[2: (1+2*3+16) :3]
Explanation:

2*3
Layers 2 and 3 form the core.
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1+2*3+16

On both sides of the core copper layers are pressed on with prepregs.
(1+2*3+16)

The outer parenthesis define through vias from 1-16.

[2: (1+2%3+16) :3]

In square brackets and separated by a colon blind vias are defined.
Here from layer 1 to 2 and 16 to 3.

~ DRC [default) E

Fie | Layers | Clearance | Distance | Sizss | Resting | Shapes | Supply | Masks | Wisc |

Hr Copper Isolation
1 |0.035mm
0.2mm
2 |0.035mm
0.4Tmrn
3 |0.035mm
0.2mm
16 |0.035mm

Setup [[2(1+2°3+1613]

Layers are carbined thraugh sither core of preprey materisl, a*b combines layers 2 and b with a care, while a+h doss the
same with prepreg.
Buried and through vias are defined by wiing ¢ . . »

Example: [z:14((Z=2)+(4716)) ] is 8 multilayer setup with bwo cores, combining lavers 2/3 and 4716, respectively, with
buried vias gaing thiough both cores. The cores are combined thiough a prepieg and buried vias are produced though the
resulting stack. Firally layer 1 is added, with blind vias going from layer 1 to 2

oK I sppy | Coneal

Example 2: Layer Setup for a 4-Layer Board

6-Layer Board
Example 3:
Layers 1, 2, 3, 4,5, and 16 are used.
Board structure: Two cores, prepregs outside.
Connections: 2-3, 4-5 (buried vias), 1-16 (through vias)
Setup expression:
(1+(2*3)+(4*5)+16)
Explanation:
(2*3)+(4*5)
Two cores with buried vias are pressed together.
1+ (2*3)+(4*5)+16
This layer stack is covered with outer layers 1 and 16 which are
isolated with prepregs.
(1+(2*3)+(4*5)+16)

The whole expression in parenthesis defines through vias from 1-16.
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= DRC [default) =]

Fie | Lavers | Ciearance | Distance | Sizes | Resung | Shapes | Suombs | Masks | Misc |

Hr Capper Isalation
1 [0.035wm

0.2mm
2 [0.035mm

0.41mm
3 [0.035wm

0 .2mm
4 [0.035mm

0.41mm
5 [0.035wm

0. 2mm
16 [0.0%5mm

Satup [[142°3+(4°5)+16]

Layers are combined trough either care of prepreg material. ah combines layers & and 4 with a core, while a+b dogs the same
with prepeeg.
Buried and through viss are defined by witing ¢ . >

Example: [2:1+((2*2)+(4*16)) | is a multilayer setup with two cores, combining layers 2/3 and 4418, iespectively, with
buried wias going trough bath cores. The cores are combined through a prepreg and buried vias are produced through the
resulting stack. Finally layer 1 is added, with bind viss going from laver 1 to 2

ok | ewb | Concal

Example 3: Layer Setup for a 6-Layer Board

The values for layer thickness used in these examples are fictive. Please
contact your boardhouse to get the allowed values.

Example 4:
Layers 1, 2, 3, 4, 5, and 16 are used.
Board structure: One core, on each side two prepregs.
Connections: 3-4 (buried vias), 2-4 (blind vias in inner layer stack),
1-16 (through vias)
Setup expression:
(1+[4:2+(3%4) +5]+16)
Explanation:
24(374)+5
The core with buried vias. One prepreg on each side.
[4:2+ (374)+5]
Blind vias from layer 2 to 4.
1+ [4:2+ (374)+5] +16
On this layer stack a prepreg on each side is pressed on.
(1+[4:2+(3*4)+5] +16)
Parnethesis allow through vias from 1 to 16.
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= DRC [default)

Fie | Layers | Clesrance | Distance | Sizes | Resting | Shepes | Supply | Masks | Misc |

i Copper Isalation
1 ] 0.035mm
0. 2ram
2 |0.035mm
0. Zram
3 |0.035mm
0. 41rmm
4 |0.035mm
0. 2riarn
5 |0.035mm
0. 2rnmn
16 |0.035mm

Setup [[1+{8:2+(3415]+16)

Laers are combined thouah sither care or peeprey material a=h combines layers 2 and b with 3 core, while a+b does the same with
proprey.

Buried and through vias are defined by wriing (.- -y

Blind vias are defined by witing Lt . . . <1, which defines 2 blind via from top o laper t and hrorn battom to layer 2.

Example: [2:141{(2#3) + (4*18}) ] is & mulilayer selup with two cores, combining layers 2¢3 and 4/16, respectively, wih buried
viazs gaing though both cores. The cores are combined thiough a prepreg and buried vias are produced thiough the resuling stack.
Finally layer 1 iz added, with blind vias going from layer 1 to 2

oF, gy | Cancal |

Example 4: Blind Vias in the Inner Layer Stack

8-Layer Board
Example 5:
Layers 1, 2,3, 4,5, 6, 7, and 16 are used.

Board structure: Three cores, prepregs outside.

Connections: 1-3, 6-16 (blind vias), 2-3, 4-5, 6-7 (buried vias),

1-16 (through vias).
Setup expression:
[3:1+(2*3)+(4*5)+(6*%7)+16:6]
Explanation:
(2%3)+(4*5)+(6*7)

Three cores, each with buried vias, are pressed together and isolated

with prepregs.
1+(2*3)+(4*5)+(6*7)+16

Outer copper layers 1 and 16 which are isolated through prepregs

are pressed onto this layer stack.
(1+(2*3)+(4*5)+(6*7)+16)
Parenthesis allow through vias from 1-16.
[3: (1+(2*3)+(4*5)+(6*7)+16):6]
Blind vias from 1-3 and 16-6.

129





EAGLE Manual

~ DRC [default)

Fie | Lavers | Cisrance | Distance | Sizes | Resting | Shapes | Supply | Masks | Misc |

N Copper Isolation
1 |0.055mm

0.18mm
2 [0.035mm

0.1mm
3 [0.035nm

0.18mm
4 [0.035mm

0.1mm
5 [0.0350m

0.18mm
& [0.035mm

0.1mm
7 |0.0350m

0.18mm
16 [0.055mm

Satup [[3:(1+2 3451 ETHELE]

Layers are combined thiough either care of prepreg material, a*b combines lapers  and b with a core, while a+b does the same
with prepreg.

Buried and through vias are defined by witing ¢~ .

Blind vias are defined by wiing Lt - - - - <D, which defines a bind via from top to layer ¢ and from bottom to layer &

Example: [2:1+((2*2)+(4*16)) | is a multilayer setup with two cores, combining layers 2/3 and 4418, iespectively, with
buried vias gaing through both cores. The cores are combined through a prepreg and buried vias are produced through the
resulting stack. Finally layer 1 is addsd, with biind viss going from laver 1 to 2.

oK boply | Cancel
Example 5: Layer Setup for an 8-Layer Board

Hints For Working With Blind, Buried, and Micro Vias

VIA command

Depending on the Layer setup vias can have different lengths. The
parameter toolbar of the VIA command shows all available lengths in
the Layer box. When routing manually (ROUTE command) EAGLE
takes the shortest possible via length in order to change layers. It is also
possible that vias at the same position are elongated.

The via length can be changed with the CHANGE VIA command. Se-
lect the value from the according menu and click the via with the left
mouse button.
Alternatively use the command line:

CHANGE VIA 2-7
and a click on the via changes the length from layer 2 to 7.
If the given via length is not defined in the Layer setup it will be elon-
gated to the next possible length or, if this is not possible, an error mes-
sage will be generated.

VIA 'GND' 1-4 (1.05 2)
places a via that belongs to the signal GND and reaches from layer 1 to
4 at position (1.05 2).

ROUTE Command

If you want to change the layer while laying-out the board, EAGLE al-
ways takes the shortest possible via (CHANGE LAYER). It is also pos-
sible that a via at the same position is elongated automatically.
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If micro vias are enabled in the Design Rules, EAGLE sets a micro via
when routing from an SMD and immediately changing to the next inner
layer.

Autorouter

The Autorouter supports blind and buried vias.

If you decide to use the Autorouter for a multilayer board that uses
blind and buried vias it is not allowed to work with automatically gener-
ated supply layers (see page 122). In this case inner layers can be defined
with the help of polygons.
Already existing supply layers can be transformed into layers with sup-
ply polygons by

* renaming the layer (no $ sign at the beginning of the name),

* removing possibly existing isolation wires,

* drawing a polygon covering the whole layout, and

* naming the polygon with the favored signal name.

Micro Via— A Special Case of Blind Via

In contrast to blind vias that can reach several layers deep into the board
the micro via connects an outer layer with the next inner layer. The drill
diameter of a micro via is relatively small. Presently the usual values are
about 0.1 to 0.05 mm.

For manufacturing resons micro vias, as blind vias, have to follow a cer-
tain aspect ratio of depth to drill diameter. This ratio defines the maxi-
mum via depth for a certain drill diameter.

The proper value can be learned from your boardhouse.

Set this value in the Design Rules, Sizes tab, Min. Blind Via Ratio.
Assumed the boardhouse demands the ratio as 1:0.5 you have to enter
0.5 for Min. Blind Via Ratio.

Addltlonally the Demgn Rule Check verifies the minimum drill diame-
ter for mircro vias given in Min. MicroVia. If this value is higher than the
value for Minimum Drill (default), micro vias won't be checked.

The diameter of micro vias is set in the Restring tab of the Design Rules.
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6.5 Updating Components (Library Update)

The UPDATE command allows components in a schematic diagram or
a layout to be replaced by components defined in accordance with the
current libraries. This function is of particular interest for existing
projects. If, in the course of development, the definitions of packages,
symbols or devices in the libraries are changed, the existing project can
be adapted to them.

The menu item Library/Update causes all the components in a project
to be compared with the definitions in the current libraries. If EAGLE
finds differences, the components are exchanged.

Those libraries on the path specified for Libraries in the Control Panel
under Options/Directories will be examined.

It is also possible to update components from one particular library.
Type the UPDATE command on the command line, stating the library,
for instance as:

UPDATE linear
or
UPDATE /home/mydir/eagle/library/linear.lbr

or select the library in the File dialog of the Library/Update... menu
item.

In the case you want to replace parts from one library with parts from
another library you can use the command:

UPDATE old-lbr-name = new-lbr.name

Old-lbr-name represents the name of the library as shown by the INFO
command in the layout or schematic. New-lbr-name stands for the li-
brary from which you want to take elements. You may add paths as well.
Please see the help function for more information.

In many cases you will be asked whether gates, pins or pads should be
replaced according to name or according to position. This always hap-
pens if library objects are renamed, or if their position (sequence) is

changed.

If too many changes are made in the library at one time (e.g. pin names
and pin positions are changed) it is not possible to carry out an automa-
tic adaptation. In such a case it is possible either to carry out the modifi-
cations to the library in two steps (e.g. first the pin names and then the
pin positions), or the library element can be given a new name, so that it
is not exchanged.

If Forward&Back Annotation is active, the components are replaced in
the schematic diagram and in the layout at the same time.

You will find further information on the program's help pages.
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After any library update, please carry out both an ERC on the schematic
and a DRC on the layout!

Individual components can, for instance, be updated with the aid of the
ADD command. If you use ADD to fetch a modified component from
a library, you will be asked whether all the older definitions of this type
should be updated.

After the update you can delete the component that you just fetched.
Again here it is wise to carry out an ERC and a DRC affter the update!

6.6 Print Out Schematic and Layout

Schematic diagrams, boards and also library elements can be printed out
with the PRINT command.

Using DISPLAY you should first select the layers that you want to
print. The basic rule is: if you can see it in the editor, you will see it on
the print.

Crosses markmg coordinate origins for text, grid lines and polygons
that can’t be calculated (only the polygon contours are visible in the
Layout Editor after RATSNEST) are exceptions to this rule.

When the printer icon on the action toolbar is clicked, the PRINT
dialog opens.

=Pit _____________________H
Prititer: HF Lazerlet 4050 Senies PCL 6
Faper: A4 (2104297 mm, 8.26411.7 inches]
Qrientation: portrait
Style
[ Mirrar

R s 1
Botate Scale factor: ’7
Upside dawn

Black Page Jimit: 1

Solid

0K | Frinter... | Page... | Cancel |

The PRINT window

The currently selected printer is shown at the top of the window. The
selected printer can be altered by means of the Printer... button.

<]

<1 < 7

Style permits a number of output options to be selected:

Mirror inverts the drawing from left to right, Rozate turns it 90 degrees,
and Upside down turns it through 180 degrees. If both are activated, a
rotation of 270 degrees is the result.

If the Black option is chosen, a black-and-white printout is made.
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Otherwise the print will be either in color or gray scale, depending on
the printer.

Solid causes each element to be entirely filled. If you want to see the dif-
ferent filling patterns of the individual layers, then deactivate this
option.

The Scale factor specifies the scale of the drawing.

If Page limit is set to 0, the printer will use whatever number of pages is
needed to print the output at the selected scale. If a different value is se-
lected, EAGLE will adjust the scale of the drawing to fit it onto the sta-
ted number of pages. This can mean that, under unfavorable
circumstances, the selected scale cannot be used.

It is possible to select which sheets from a schematic diagram are prin-
ted using the Sheets box. This only appears in the Schematic Editor.

The Page... button brings you to another window that permits various
page settings.

= Page setup =]

Fririter: HP Lazerlet 4050 Series PCL &
Paper: A4 (210297 mm, 8.26x11.7 inches)

Origntation: portrait

Border Calbrate
Left |B.053?mm Riight |B.053?mm % |1
Tap |4 2757mm Bottom |42?5?mm Y |1
Wertical Horizaontal
" Top " Left
&+ Center &+ Center
" Battam " Right

V¥ Caption

Ok | Cancel |

PRINT: Page Setup

The edges of the print can be defined with the aid of the four entry
boxes under Border. The values may be entered in mm or in inches. If
you have changed the values and want to use the printer driver's
standard settings again, simply enter a 0.

The Vertical and Horizontal boxes allow the position of the printout on
the sheet to be specified.

Calibrate allows correction factors for the x and y directions to be ente-
red. This allows linear errors in the dimensional accuracy of the print to
be corrected.

The Caption option switches the appearance of the title, printing date,
filename and the scale of the print on or off.
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If, when a layout is printed, the drill holes in the pads and vias are not to
be visible, select the No Drills option for the Display mode by way of the
menu item Options/Set/Misc.

The PRINT command can also be given directly on the command line,
or can be run by a script file.

Information about the selection of options is available on the help
pages.

For all those who have experiences with previous EAGLE versions:
EAGLE comes with an User Language Program named cam2print.ulp
that converts your previous CAM jobs into script files in order to use

them with the PRINT command.

Another User Language Program cam2dxfulp allows to use a previous

CAM job for generating DXF data.
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Chapter 7
The Autorouter

7.1 Basic Features

* Any routing grid (min. 0.02 mm)
* Any placement grid (min. 0.1 micron)
* SMDs are routed on both sides

* The whole drawing area can be the routing area (provided enough
memory is available)

* The strategy is selected via control parameters

* Simultaneous routing of various signal classes with various track
widths and minimum clearances

* Common data set (Design Rules) for the Design Rule Check and
the Autorouter

* Multilayer capability (up to 16 layers can be routed simultane-
ously, not only in pairs)

* Full support of blind and buried vias

* The preferred track direction can be set independently for each
layer: horizontal and vertical, true 45/135 degrees (important for
inner layers!)

* Ripup and retry for 100 % routing strategy
* Optimization passes to reduce vias and smooth track paths

* Prerouted tracks are not changed
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7.2 What Can be Expected from the

Autorouter

The EAGLE Autorouter is a “100 %” router. This means that boards
which, in theory, can be completely routed will indeed be 100 % routed
by the Autorouter, provided - and this is a very important restriction -
the Autorouter has unlimited time. This restriction is valid for all 100 %
Autorouters whatsoever. However, in practice, the required amount of
time is not always available, and therefore certain boards will not be
completed even by a 100 % Autorouter.

The EAGLE Autorouter is based on the ripup/retry algorithm. As soon
as it cannot route a track, it removes prerouted tracks (ripup) and tries it
again (retry). The number of tracks it may remove is called ripup depth
which is decisive for the speed and the routing result. This is, in princi-
ple, the previously mentioned restriction.

Those who expect an Autorouter to supply a perfect board without
some manual help will be disappointed. The user must contribute his
ideas and invest some energy. If he does, the Autorouter will be a valu-
able tool which will greatly reduce routine work.

Working with the EAGLE Autorouter requires that the user places the
components and sets control parameters which influence the routing
strategy. These parameters must be set carefully if the best results are to
be achieved. They are therefore described in detail in this section.

7.3 Controlling the Autorouter

The Autorouter is controlled by a number of parameters. The values in
the current Design Rules, the net classes and special Autorouter control
parameters all have an effect.

The Design Rules specify the minimum clearances (DRC commands for
setting Clearance and Distance), the via diameter (Restring setting) and
the hole diameter of the vias (Sizes setting). The minimum track width
is also specified.

The net classes - if any are defined - specify special minimum clearances,
track widths and the hole diameters for vias carrying particular signals.

There is also a range of special cost factors and control parameters that
can be changed via the Autorouter menu. They affect the route given to
tracks during automatic routing. Default values are provided by the pro-
gram. The control parameters are saved in the BRD file when the layout
is saved. You can also save these values in an Autorouter control file
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(*.ctl). This allows a particular set of parameters to be used for different
layouts. Neither Design Rules nor the data for various net classes are
part of the control file.

A routing process involves a number of separate basic steps:

Bus Router

Normally the bus router (whose parameters are set such that the bus
structures can be optimally routed) is the first pass. This step may be
omitted.

Busses, as understood by the Autorouter, are connections which can be
laid as straight lines in the x or y direction with only a few deviations.
Busses are only routed if there is a layer with an appropriate preferred
direction.

The bus router takes only those signals into consideration that belong
to net class 0.

Routing Pass

The actual routing pass is then started, using parameters which make a
100 % routing as likely as possible. A large number of vias are deliber-
ately allowed to avoid paths becoming blocked.

Optimization

After the main routing pass, any number of optimization passes can be
made. The parameters are then set to remove superfluous vias and to
smooth the track paths. In the optimization passes tracks are removed
and rerouted one at a time. This can, however, lead to a higher degree of
routing, since it is possible for new paths to be freed by the changed
path of this track.

The number of optimization passes must be specified before starting the
Autorouter. It is not possible to optimize at a later stage. Once the rout-
ing job has been completed all the tracks are considered to have been
prerouted, and may no longer be changed.

Any of the steps mentioned above may be separately activated or
deactivated.
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7.4 What Has to be Defined Before

Autorouting

Design Rules

The Design Rules need to be specified in accordance with the complex-
ity of the board and of the manufacturing facilities available. You will
find a description of the procedure and of the meanings of the individual
parameters in the section on Specifying the Design Rules on page 95.

Track Width and Net Classes

If you have not already defined various net classes in the schematic dia-
gram you now have the opportunity, before running the Autorouter, of
specifying whether particular signals are to be laid using special track
widths, particular clearances are to be observed, or whether certain drill
diameters are to be used for vias for particular signals. Please consult the
help pages (CLASS command) or the section on Specifying Net Classes
on page 93 for information about the definition of net classes.

If no special net classes are defined, the values from the Design Rules
apply. The value Minimum width in the Sizes tab determines the track
width, the values for minimum clearances/distances are taken from the
Clearance and Distance tabs. The diameter of vias is defined by the va-
lues in the Restring tab.

Did you set values in the Design Rules and for net classes? In this case
the Autorouter uses the higher value.

Grid

The Design Rules determine the routing and placement grid. The mini-
mum routing grid is 0.02 mm, which is about 0.8 mil.

Placement Grid

Although the Autorouter does permit any placement grid, it is not a
good idea to place the components on a grid that is too fine. Two good
rules are:

* The placement grid should not be finer than the routing grid.

o If the placement grid is larger than the routing grid, it should be
set to an integral multiple of the routing grid.
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These rules make sense if, for example, you consider that it might be
possible, within the Design Rules, to route two tracks between two pins
of a component, but that an inappropriate relationship between the two
grids could prevent this (see diagram).

Routing Grid

The Autorouter grid has to be set in the AUTO command setup menu
(Routing Grid). This is not the same as the currently used grid in the
Layout Editor window that you have selected with the GRID command.

Bear in mind that for the routing grid the time demand increases expo-
nentially with the resolution. Therefore select as large a grid as possible.
The main question for most boards is how many tracks are to be placed
between the pins of an IC. To answer this question, the selected Design
Rules (i.e. the minimum spacing between tracks and pads or other
tracks) must of course also be considered.

The result is:

The two grids must be selected so that component’s pads are located on the
routing grid.

/
o O O

e )

o O O
\

+

o O O

\NO = O,
\0'—‘ mo/

Track patterns with different placement grids

There are of course exceptions, such as with SMDs to which the oppo-
site may apply, namely that a position outside of the routing grid leads
to the best results. In any event the choice of grid should be carefully
considered in the light of the Design Rules and the pad spacing.

The example above may clarify the situation:

For the component on the left, the pads are placed on the routing grid.
Two tracks can be routed between two pads. The pads of the component
in the middle are not on the routing grid, and therefore only one track
can be routed between them.
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On the right you see the exception from the rule shown for SMD pads,
which are placed between the routing grid lines so that one track can be
routed between them.

When choosing the grid, please also ensure that each pad covers at least
one grid point. Otherwise it can happen that the Autorouter is unable to
route a signal, even though there is enough space to route it. In this case
the Autorouter issues the message Unreachable SMD at x y as it starts.
The parameters x and y specify the position of the SMD pad.

The default value for the routing grid is 50 mil. This value is sufficient
for simple through-hole layouts. Working with SMD components de-
mands a finer routing grid. Usual values are 25, 12.5, 10, or 5 mil.

Please remember that finer wvalues require significantly more routing
memory.

Memory Requirement

The amount of routing memory required depends in the first place on
the selected routing grid, the area of the board and the number of signal
layers in which tracks are routed.

The static memory requirement (in bytes) for a board can be calculated
as follows:

number of grid points x number of signal layers x 2

Note that a supply layer generated by giving the appropriate name
($name) does not occupy any autorouting memory. On the other hand,
a supply layer that has been created with the aid of one or more poly-
gons consumes as much routing memory as any other signal layer.

Space is also required for dynamic data, in addition to the static memory
requirement. The dynamic data require in a very rough estimate about
10% up to 100 % (in some cases even more!) of the static value. This de-
pends heavily on the layout.

Total memory requirement (rough approximation):

static memory x (1.1..2,0) [bytes]
This much RAM should be free before starting the Autorouter. If this is
insufficient, the Autorouter must store data on the hard disk. This
lengthens the routing time enormously, and should be avoided at all

costs. Short accesses to the hard disk are normal, since the job file on
the hard disk is regularly updated.

Try to choose the coarsest possible routing grid. This saves memory space
and routing time!
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Layer

If you want to design a double-sided board, then select Top and Bottom
as route layers. You should only use the Bottom layer for a single-sided
board. In the case of inner layers, it is helpful to use the layers from the
outside to the inside, i.e. first 2 and 15 and so on.

Inner layers are converted to supply layers if they are renamed to
$name, where name is a valid signal name. These layers are not routed.
Supply layers with more than one signal can be implemented with poly-
gons. These layers are treated as normal signal layers.

In the case of boards that are so complex that it is not certain whether
they can be wired on two sides, it is helpful to define them as multilayer
boards, and to set very high costs for the inner layers. This will cause the
Autorouter to avoid the inner layers and to place as many connections
as possible in the outer layers. It can, however, make use of an inner
layer when necessary.

These settings are made in the Autorouter menu (see page 148).

The autorouter shows the message Unreachable smd in layer..., if a layer
that contains smds is not active. Clicking OK starts the autorouter
nevertheless. If you want to change the autorouter setup click Cancel.

Preferred Directions

On the two outside layers the preferred directions are normally set to 90
degrees from each other. For the inner layers it may be useful to choose
45 and 135 degrees to cover diagonal connections. Before setting the
preferred direction it is well worth examining the board (based on the
airwires) to see if one direction offers advantages for a certain side of
the board. This is particularly likely to be the case for SMD boards.
Please also follow the preferred direction when pre-placing tracks. The de-
faults are vertical for the Top (red) and horizontal for the Bottom (blue).
Experience has shown that small boards containing mainly SMD com-
ponents are best routed without any preferred direction at all (set * in
the Autorouter setup). The router then reaches a usable result much
faster.

Single sided boards should be routed without a preferred direction.

Restricted Areas for the Autorouter

If the Autorouter is not supposed to route tracks or place vias within
certain areas, you can define restricted areas by using the commands
RECT, CIRCLE, and POLYGON in the layers 41, tRestrict, 42, bRe-

strict, and 43, vRestrict.
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tRestrict: Restricted areas for the Top layer.
bRestrict: Restricted areas for the Bottom layer.
vRestrict: Restricted areas for vias.

Such restricted areas can already be defined in a device package (around,
for instance, the fixing holes for a connector, or for a flat-mounted tran-
sistor under which there should not be any tracks).

Wires drawn in layer 20, Dimension, are boundary lines for the Auto-
router. Tracks cannot be laid beyond this boundary.
Typical application: board boundaries.

An area drawn in layer 20 can also be used as a restricted region for all
signals. It should, however, be noted that this area should be deleted be-
fore sending the board for manufacture, since layer 20 is usually output
during the generation of manufacturing data.

Cost Factors and Other Control Parameters

The default values for the cost factors are chosen on the basis of our ex-
perience in such a way as to give the best results.

The control parameters such as mnRipupLevel, mnRipupSteps etc. have
also been set to yield the best results according to our experience.

We want to emphasize, that we recommend working with the default
values. If you nevertheless do want to experiment with these parame-
ters, please consider the description of the cost factors in the following
section. In the case of many parameters even small alterations can have
large effects.

7.5 How the Cost Factors Influence the

Routing Process

Values between 0..99 are possible for each cost factor (cfXXX), but the
full range is not useful for all parameters. Sensible values are therefore
given with each parameter. The control parameters (mnXXX) accept
values in the range 0..9999. Reasonable figures are also provided under
each parameter.

cfBase.xx: 0..20

Base costs for one step on the corresponding layer. Recommendation:
outside layers (Top, Bottom) always 0, inside layers greater than 0.
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cfVia: 0..99

Controls the use of vias. A low value produces many vias but also allows
the preferred direction to be followed. A high value tries to avoid vias
and thus violates the preferred direction. Recommendation: low value
for the routing pass, high value for the optimization.

cfNonPref: 0..10

Controls following of the preferred direction. A low value allows tracks
to be routed against the preferred direction, while a high value forces
them into the preferred direction.

If ¢fNonPref is set to 99, track sections can only be placed in the pre-
ferred direction. Only select this value if you are certain that this behav-
ior is really wanted.

cfChangeDir: 0..25

Controls how often the direction is changed. A low value means many
bends are allowed within a track. A high value produces virtually
straight tracks.

cfOrthStep, cfDiagStep

Implements the rule that the hypotenuse of a right-angled triangle is
shorter than the sum of the other two sides. The default values are 2 and
3. That means that the costs for the route using the two other sides are
242, as against 3 for the hypotenuse.

This parameter should only be altered with great care!

cfExtdStep: 0..30

Controls the avoidance of track sections which run at an angle of 45 de-
grees to the preferred direction, and which would divide the board into
two sections. A low value means that such sections are allowed while a
high value tries to avoid them. In combination with the parameter
mnExtdStep you can control the length of these tracks. If mnExtdStep =
0, each grid step at 45 degrees to the preferred direction causes costs
that are defined in parameter cfExtdStep. Choosing for example
mnExtdStep = 5 allows a track to run five steps at 45 degrees without
any additional costs. Each further step causes costs defined in
of ExtdStep.

In this way, 90 degree bends can be given 45 degree corners. Settings like
ofExtdStep = 99 and mnExtdStep = 0 should avoid tracks with 45 degree
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angles.

This parameter is only relevant to layers which have a preferred direc-
tion. Recommendation: use a lower value for the routing pass, and a
higher value for the optimization.

cfBonusStep, cfMalusStep: 1..3

Strengthens the differentiation between preferred (bonus) and bad (ma-
lus) areas in the layout. With high values, the router differentiates
strongly between good and bad areas. When low values are used, the in-
fluence of this factor is reduced. See also ¢fPadImpact, cfSmdImpact.

cfPadimpact, cfSmdimpact: 0..10

Pads and SMDs produce good and bad sections or areas around them in
which the Autorouter likes (or does not like) to place tracks. The good
areas are in the preferred direction (if defined), the bad ones perpen-
dicular to it. This means that tracks which run in the preferred direction
are routed away from the pad/SMD. With high values the track will run
as far as possible in the preferred direction, but if the value is low it may
leave the preferred direction quite soon.

It may be worth selecting a somewhat higher value for ¢fSmdImpact for

densely populated SMD boards.

cfBusimpact: 0..10

Controls whether the ideal line is followed for bus connections (see also
cfPadImpact). A high value ensures that the direct line between start and
end point is followed. Only important for bus routing.

cfHugging: 0..5

Controls the hugging of parallel tracks. A high value allows for a strong
hugging (tracks are very close to each other), a low value allows for a
more generous distribution. Recommendation: higher value for routing,
lower value for the optimization.

cfAvoid 0..10

During the ripup, areas are avoided from which tracks were removed. A
high value means strong avoidance.
Not relevant to the optimization passes.
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cfPolygon 0..30

Every step within a polygon is associated with this value. A low value al-
lows routing inside a polygon. The probability that the polygon is bro-
ken into several pieces is higher. A higher value causes the Autorouter
to make as few connections as possible inside a polygon.

mnVia 0..30

Controls the maximum number of vias that can be used in creating a
connecting track.

mnSegments 0..9999

Determines the maximum number of wire pieces in one connecting
track.

mnExtdSteps 0..9999

Specifies the number of steps that are allowed at 45 degrees to the pre-
ferred direction without incurring the value of ¢fExtdStep.
See also ¢fExtdStep.

7.6 Number of Ripup/Retry Attempts

Due to the structure of the Autorouter there are some parameters
which influence the ripup/retry mechanism. They are set in such a way
that they offer a good compromise between time demand and routing
result. The user should therefore only carefully change the values for
mnRipup Level, mnRipupSteps and mnRipup Total when needed.

As a rule, high parameter values allow for many ripups but result in in-
creased computing times.

To understand the meaning of the parameters you need to know how
the router works.

To begin with the tracks are routed one after the other until no other
path can be found. As soon as this situation occurs, the router removes
up to the maximum number of already routed tracks (this number has
been defined with mnRipupLevel) to route the new track. If there are
eight tracks in the way, for example, it can only route the new track if
mnRipupLevel is at least eight.
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After routing the new track, the router tries to reroute all the tracks
which were removed. It may happen that a new ripup sequence must be
started to reroute one of these tracks. The router is then two ripup se-
quences away from the position at which, because of a track which
could not be routed, it started the whole process. Each of the removed
tracks which cannot be rerouted starts a new ripup sequence. The maxi-
mum number of such sequences is defined with the mnRipupSteps
parameter.

The parameter mnRipupTotal defines how many tracks can be removed
simultaneously. This value may be exceeded in certain cases.

If one of these values is exceeded, the router interrupts the ripup pro-
cess and reestablishes the status which was valid at the first track which
could not be routed. This track is considered as unroutable, and the
router continues with the next track.

7.7 The Autorouter Menu

When running the Autorouter with the AUTO command, the setup
menu appears first. All the necessary settings are made there.

= Autorouter Setup 1]

General lBusses ] Foute ] Optimize1 I Optimize2 ] Optimize3 ]

Preferted Directions

1Top || =] 9Rouwed [Hé
2 Routez | N4 =] 10 Routetn | M
3 Routed | N4 =] 11 Routett | HA
4 Routed | N/ =] 12 Rowet2 [ N4

[~ |
[ |
[ |
- |
E Routel | N4 =] 13 Rouwelz [ Ni& =]
[~ |
[~ |
- |

Fiauting Grid 50 il

ViaGhaps | Found =l

& Routet | N8 =] 14 Rowetd [ M
7 Route? | N8 x| 15 Rowte15 | M
8 Routed | N4 =] 16 Battom | -

Save as... |

Ok | Select | Cancel | Help |

Autorouter setup: General settings (General tab)

This is where you specify the layers that may be used for routing and
which preferred directions apply. Click in the appropriate combo box
with the mouse, and select the desired value.

Setting the preferred directions:
- horizontal
| vertical
/ diagonal at 45°
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\ diagonal at 135°

* none

N/A Layer not active
Define a suitable Routing grid and select the shape of the through-plated
holes (Via shape).

You may use the Load... and Save as.... buttons to load a different pa-
rameter set from an Autorouter control file (*.ctl) or to save the current
settings for further projects.

You now make the settings for the individual routing steps. Click on the
corresponding tab and make any settings you may want.

= Autorouter Setup (=]
General ] Busses | Route 1 Optimize1 I Optirize2 ] Optimize3 ]
Layer Costs Costs  asimum
1 Top 'D_ 9 Routed '1_ Yia '8_ M alusStep '1_ Wia ’207
2 Route2 '1_ 10 Routel10 '1_ MonPref '5_ Fadlmpact '4_ Segments ’W
3 Route3 '1_ 11 Routel1 '1_ Changelir '2_ Smdlmpact '4_ ExtdSteps ’W
4 Routed ’1_ 12 Routel2 ’1_ OrthStep ’2_ Buslmpact ’U_ RipupLevel ’107
5 Fouted ’1_ 13 Routel3 ’1_ DiagStep ’3_ Hugging ’3_ FipupSteps ’mi
BRoutet [T 14Routels |1 || EsdStep [0 Aveid [+ | RipupTaal [100
7 Floute? '1_ 15 Route15 '1_ BonusStep '1_ Palygon 'W
2 Routed '1_ 1E Eottom 'U_ b ctive
Add |
Ok | Select | Cancel | Help |

Autorouter setup: Settings for the Route pass

The parameters in the Layer costs, Costs and Maximum groups can be
different for each pass.

The Active check box specifies whether this step should be executed or
not.

Additional optimization passes can be inserted with the Add button.

Clicking on the Select button allows certain signals to be selected for
autorouting. Select these with a mouse click, or enter their names on the
command line. Then start the Autorouter with a click on the traffic-
light icon in the action toolbar. It is, alternatively, possible to enter the
signals on the command line while the AUTO command is active.
Examples:

VCC GND ;
The signals VCC and GND are routed. The semicolon at the end of the

line starts the Autorouter immediately. It is alternatively possible to
click on the traffic-light icon.

! VCC GND ;
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All signals except VCC and GND are routed.

The Autorouter is started for all the signals that have not yet been laid
by clicking on the OK button.

The Cancel menu item interrupts the AUTO command without storing
any changes.

= Autorouter Setup 1]

General lBusses ] Foute ] Optimize1 I Optimize2 ] Optimize3 ]

Prefened Directions

Fiouting Grid | 1.27 i
o I N ViaShaps [Fiow |
2 gandl [N 2] [0 Foueto AT
a Foutea [ A& =] 11 Rouetd [ A 5]
4 Fouted | N8 2] 12 Rouetz [ WA ]
& Foutes [ WA 2] 12 Rowet2 [HA <] | Cantinue ssisting job [Routs 35.5%)
) R N
7 Fouter | 48 7] 16 Rioute1s [ HéA - =]
8 Fouted [ N8 7] 16 Battern |- &

Load.. | Save as... |

Ok | End Job | Cancel | Help |

Autorouter setup: Restarting an interrupted job

Do not at first make any changes to the parameters if you want to re-
start an interrupted routing job. Use the Continue existing job check box
to decide whether you want to continue with an existing job, or whether
you want to choose new settings for the remaining signals.

End job ends the autorouting job and loads the previous routing result.

7.8 Routing Multi-Layer Boards

There are two different ways of implementing supply layers.
* Supply layers with a $-sign at the start of the layer name
* Supply layers with polygons

Supply Layers

The definition of supply layers has already been described in the previ-
ous section under Power Supply Layers with One Signal on page 111.
The following points must be considered when autorouting:

* The layer name specifies the signal that is carried by this layer. The
layer $VCC, for example, only carries the VCC signal.

* The layer is represented with an inverse display.
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* The layer is not active during autorouting (setting N/A in the Au-
torouter setup, General tab).

e After routing, you should draw an isolation wire around the lay-
out. This prevents short-circuits at the edges of the board.

* No other signals or polygons may be drawn!

The Autorouter can't use supply layers in combination with blind and
buried vias. Use inner layers with polygons instead!

Polygons as Supply Layers

It is possible with polygons to create supply layers that contain more
than one supply voltage, and a few individual wires as well. Please note
the instructions on page 121, Ground Planes and Supply Layers with Sev-
eral Signals. These are not the kind of supply layer identified by a $ in
the name, but are in fact ordinary layers.

* Define the polygons before running the Autorouter.
* Give the appropriate signal names to the polygons.

* Select the preferred directions and base costs (¢fBase) for the layer
in the Autorouter setup. A higher value of ¢fBase for the polygon
layer causes the Autorouter to avoid these layers more strongly.

e After routing, check that the polygon still connects all the signal
points. It is possible that the polygon was divided as a signal was
laid. RATSNEST recomputes polygons, and issues the message
Ratsnest: Nothing to do!, if everything is in order.

7.9 Backup and Interruption of Routing

As, with complex layouts, the routing process may take several hours, a
backup is carried out at intervals (approx. every 10 minutes). The file
name.job always contains the last status of the job. If the job is inter-
rupted for any reason (power failure etc.) the computer time invested so
far is not lost, since you can recall the status saved in name.job. Load
your board file in the Layout Editor, and then enter:

AUTO;

Answer the prompt as to whether the Autorouter should recall (Con-
tinue existing job?) with Yes. The Autorouter will then continue from the
position at which the job was last saved (a maximum of 10 minutes may

be lost).

If the autorouting is interrupted via the stop icon, the name.job file also
remains intact and can be recalled. This may be useful when you have
started a complex job on a slow computer and want to continue with it
on a fast computer as soon as one is available.
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Please note that changing the parameters before recalling will not influ-
ence the job, since it will have been saved together with the parameters
which were valid at the time of the initial Autorouter start.

When the Autorouter has finished, the routed board is saved as
name.b$$. You can rename it to name.brd and use it, for instance, if a
power failure occurred after the autorouting run and you could not save
the board file. This file is deleted automatically after the board has been
saved.

7.10 Information for the User

Status Display

During the routing, the Autorouter displays information on the actual
routing result in the status bar.

Foute: 65.3% Viaz 109 Conn: 147/96/0 Ripup: 2/0/1 Signals: ¥3/0/28

The displayed values have the following meaning:

Route: result % (hitherto maximum, best data

Vias: Number of vias

Conn. : Connections total/found/not routable

Ripup: No. of ripups/cur. RipuplLevel/cur. RipupTotal

Signals: Signals found/signals handled/signals prepared
Connections means 2-point connections.
The significance of the various RIPUP options:

Number of ripups:

This indicates the number of connections that have already been routed
during the foregoing routing procedure that have been (can be) remo-
ved in order to be able to route new signals.

Current RipupLevel:
This indicates the number of connections that have been removed or
converted in airwires in order to lay the track for the current signal.

Current RipupTotal:

After a signal's routes have been ripped up it can be broken down into a
large number of two-point connections. These connections are then
routed again. This variable indicates the number of such two-point
connections still to be routed.
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Log file
For each routing pass the Autorouter generates a file called name.pro,
containing useful information.

Example:

EAGLE AutoRouter Statistics:

Job d:/eagled/test-design/democpu.brd

Start at 15.43.18 (24.07.2000

End at 16.17.08 (24.07.2000

Elapsed time 00.33.48

Signals 84 RoutingGrid: 10 mil Layers: 4

Connections 238 predefined: 0 ( 0 Vias )

Router memory 1121760

Passname: Busses Route Optimizel Optimize2 Optimize3 Optimized
Time per pass: 00.00.21 00.08.44 00.06.32 00.06.15 00.06.01 00.05.55
Number of Ripups: 0 32 0 0 0 0
max. Level: 0 1 0 0 0 0
max. Total: 0 31 0 0 0 0
Routed: 16 238 238 238 238 238
Vias: 0 338 178 140 134 128
Resolution: 6.7 % 100.0 % 100.0 % 100.0 % 100.0 % 100.0 %
Final: 100.0% finished

7.11 Parameters of a Control File

We see here how the individual parameters in an Autorouter control file
(name.ctl) are used.

Parameter Default Meaning
RoutingGrid = 50Mil Grid used by the Autorouter for tracks and
via-holes
Cost factors for...
cfvia = 8 .Vias
cfNonPref = 5 .Not using preferred direction
cfChangeDir = 2 ..Changing direction
cfOrthStep = 2 ..0 or 90 deg. step
cfDiagStep = 3 .45 or 135 deg. step
cfExtdStep = 30 .Deviation 45 deg. against preferred direction
cfBonusStep = 1 .Step in bonus area
cfMalusStep = 1 .Step in handicap area
cfPadImpact = 4 .Pad influence on surrounding area
cfSmdImpact = 4 .SMD influence on surrounding area
cfBusImpact = 4 ..Leaving ideal bus direction
cfHugging = 3 .Wire hugging
cfAvoid = 4 .Previously used areas during ripup
cfPolygon =10 .Avoiding polygons
cfBase.l = 0 Basic costs for a step in the given layer
cfBase.2 1
cfBase.1l5 =1
cfBase.16 = 0
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Maximum number of...

mnVias = 20 ...Vias per connection
mnSegments = 9999 ...Wire segments per connection
mnExtdSteps = 9999 ...Steps 45 deg. against preferred direction
mnRipupLevel = 100 ...Ripups per connection
mnRipupSteps = 300 ...Ripup sequences per connection
mnRipupTotal = 200 ...Ripups at the same time

Track parameters for...
tpViaShape Round ...Via shape (round or octagon)
PrefDir.1 = | Preferred direction in the given layer
PrefDir.2 = 0 Symbols 0 -7 1\~
. 0 Layer not used for routing
PrefDir.15 = 0 * : No preferred direction
PrefDir.16 = - : X is preferred direction

: Y is preferred direction
: 45 deg. is preferred direction
135 deg. is preferred direction

~—

7.12 Practical Tips

This section presents you with some tips that have, over a period of
time, been found useful when working with the Autorouter.

Look on these examples as signposts suggesting ways in which a board
can be routed. None of these suggestions guarantee success.

General

The layer costs (c¢fLayer) should increase from the outer to the inner
layers or be the same for all layers. It is unfavorable to use lower values
in the inner layers than in the outer layers. This could increase the nee-
ded routing memory enormously.

The Autorouter can't layout wires as arcs.

The Autorouter can’t set micro vias!

Single-Sided Boards

There are two procedures, depending on the kind of layout:

In the simplest case, only layer 16, Bottom, is active. No preferred direc-
tion is defined. Select a suitable grid and run the Autorouter.

If the layout is rather more complex, it may be possible to achieve a us-
able result with special parameter settings. Please take a look at the pro-
ject named singlesided, which can be found in the eagle/projects/examples
directory. This example project comes with various control files (*.ctl),
which are optimized for singlesided routing.
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The Autorouter may use the Top layer as well. The tracks laid there will
be realized as wire bridges on the board. In layer 41, tRestrict, you can
define restricted areas around the components and in regions where
wire bridges are not allowed.

Feel free to experiment with the parameter settings for your layout.

SMD Boards With Supply Layers

The following procedure has been found effective:

The supply signals are routed first. In general, a short track is wanted
from a SMD component to a via that connects to the inner layer.

Before altering the parameters, save the current (default) values in an
Autorouter control file (CTL file). Click on the button Save as.. in the
General tab of the Autorouter setup window and input any name, for
example, standard.ctl.

Now switch off the bus router and all the optimization passes in the Au-
torouter setup. Only the routing remains active. Alter the following
cost factors:

cfvia = 0 Vias are wanted

mnVia = 1 Max. 1 via per connection

cfBase.l/16 30..99 Short tracks
in Top/Bottom

mnSegments = 2..8 short tracks

Start the Autorouter, using the Select button, and choose the signals to
be routed. After the routing pass it is possible, if appropriate, to opti-
mize the result manually.

The rest of the connections are routed after this. Use AUTO to open
the Autorouter setup menu, and load the previous stored control pa-
rameters with the Load.. button (standard.ctl). Adjust the values to any
special wishes you may have, and start the Autorouter.

This procedure is identical for both types of supply layer (automatically
generated supply layer, or a supply layer generated with polygons).

What can be done if not all signals are routed?
If this happens, check your settings.

* Has a sufficiently fine routing grid been selected?
* Have the track widths got appropriate dimensions?
¢ Can the vias have smaller diameters?

* Have the minimum clearances been optimally chosen?
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If it is either impossible or unreasonable to optimize these values any
further, an attempt to achieve a higher level of routing may be made by
increasing the ripup level. Observe the notes in the section on the Num-
ber of Ripup/Retry Attempts on page 147.
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Component Design Explained
through Examples

When developing circuits with EAGLE, components are fetched from
libraries and placed into the schematic or, if the Schematic Editor is not
being used, into the layout. All the component information is then
saved in the schematic or board file. The libraries are no longer needed
for continued work with the data. So when you want to pass your sche-
matic to a third party to have a layout made from it, you do not also
have to supply the libraries. An alteration in a library has no effect on a
schematic or board.

The most important procedures for designing components (devices)
and working with libraries are explained from page 53 on. Please read
this paragraph before you continue to read the current chapter!

Some practical examples follow, from which the effective application of
the relevant commands and parameters will be seen. First we will take
the example of a resistor and go through the whole process of designing
a simple component.

The second example provides a full description of the definition of a
complex component, including various package variants and technolo-
gies. After that we shall discuss the special features which have to be
taken into account with more complicated components.

Starting at page 205 hints concerning library and device management
can be found. How to create my own library? How to copy elements
from one library into another?

First attempts at editing packages, symbols, or devices may result in the
need to delete various library elements. To do this, use the REMOVE
command (see page 208).
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8.1 Definition of a Simple Resistor

)

o

First open a new library in the EAGLE Control Panel using the
File/New/Library menu.
Alternatively you can type the command

OPEN

on the command line of the Schematic or Layout Editor windows. Then
enter a library name in the file dialog. The library window open:s.

Resistor Package

Define a New Package

Select the package editing mode via the icon in the action toolbar, and
enter the package name R-70 in the New field. Answer the question
Create new package ‘R-10°¢ with Yes. Later when creating a new symbol
and a new device you will again have to answer the corresponding ques-
tions with Yes.

Set the Grid

i|Use the GRID command to set an appropriate grid size for the pad

placement. 0.05 inch (i.e. 50 mil) is usual for standard components with
lead wires.

Solder Pads

For a resistor with lead-wires, select PAD, and set the pad shape and the
drill diameter in the parameter toolbar. The default value for the pad di-
ameter is auto (respectively 0). This value should be kept. The actual di-
ameter is specified by the Design Rules for the layout. Then place two
pads at the desired distance. The origin of the drawing will later be the
identifying point with which a component is selected. For this reason it
should be somewhere near the center of the device.

You should not draw any objects in layer 17, Pads, or 18, Vias! They will
not be recognized, nor by the DRC, neither by polygons drawn in the lay-
out, and can lead to short circuits!

For a SMD resistor, select SMD, and set the pad dimensions in the pa-
rameter toolbar. You can either select one of the offered values, or di-
rectly type the length and breadth into the entry field.
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g8 /Il 1Top =] Smd [005:0025 =] Roundress: [0 = angles [0 =]

SMD command: Parameter toolbar

All properties can be altered after placement using the CHANGE com-
mand or by typing the command directly on the command line.

Select Top as the layer, even if the component will later be placed on the
underside of the board. SMD components are located on the other side
of a board using the MIRROR command. This moves the elements in all
the t..-layers into the corresponding b..-layers.

Place the two SMD pads (which in EAGLE are just called SMDs) at the
desired distance. It may be necessary first of all to alter the grid setting
to a suitable value. The SMD can be rotated with the right mouse button
before it is placed.

The parameter ROUNDNESS specifies whether the corners of the
SMDs are to be rounded. By default this value is set to 0% (no round-
ing). This value is usually kept, since the final roundness of SMDs is
specified in the Design Rules. The help system provides you with more
information about this parameter.

Angle determines the rotation of the SMD pad.

The INFO command provides you here with a quick summary of the cur-
rent properties of a SMD or pad.

Pad Name

22| You can now enter the names, such as 7 and 2, for the pads or SMDs us-
— ing the NAME command.

Silkscreen and Documentation Print

A Now use the WIRE command to draw the silkscreen symbol in layer 21,
tPlace. This layer contains what will be printed on the board. It is up to
you how much detail you give to the symbol. Set a finer grid size if it
helps.

Take the information provided in library.txt as a guideline for the design
of components.. The line thickness for the silk screen is usually 0.01
inch (0.254 mm).

You can also use the ARC, CIRCLE, RECT and POLYGON com-
mands to draw the symbols for the silkscreen.

Layer 51, tDocu, is not used to print onto the board itself, but is a sup-
plement to the graphical presentation which might be used for printed

documentation. Care must be taken in layer 21, tPlace, not to cover any
areas that are to be soldered. A more realistic appearance can be given,
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however, in the tDocu layer, which is not subject to this limitation. In
the example of the resistor, the symbol can be drawn in layer 21, ¢tPlace,
but the wires, which go over the pads, are drawn in layer 51, tDocu.

) 4 Libraty - R-\homeicAE agle-4.1%IbrircLIbr (R-10.pac)

File Edit Draw View Library Options MWindow Help
EHE En 02 eaaady @ E 7
i ange o x| wiwd (BB

f @\25mn[275-125] || |

X
7

~

COBEON MR
1B

Desciription
RESISTOR
Grid 10mm

Left-click ta select object ta mave

The Package Editor

Labeling

ﬂ\With the TEXT command you place the texts >NAME (in layer 25,
tNames) and >VALUE (in layer 27, tValues) in those places where in
the board the actual name and the actual value are to appear. 0.07 inch
for the text height (size) and 10% for the ratio (relationship of stroke
width to text height, which can only be set, using CHANGE, for vector
fonts) are recommended.

SMASH and MOVE can be used later to change the position of this text
relative to the package symbol on the board.

In the case of ICs, for instance, the value corresponds to what will later
be the device name (e.g. 74LS00).

When working with only the Layout Editor, the value is specified in the
board.
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Restricted area for components

In layer 39, tKeepout, you should create a restricted area over the whole
component (RECT command). This allows the DRC to check whether
components on your board are too close or even overlapping.

Description

Finally, you click on the Description box. Text can then be entered in the
lower part of the window which then opens. Rich Text format can be
used. This is a syntax somewhat similar to HTML, which permits for-
matting of the text. You will find detailed information in the help sys-
tem under Rich Text.
Example:

<b>R-10</b>

<p>

Resistor 10 mm grid.

Keywords from this text can be searched for from the ADD dialog in
the layout.

Do not forget to save the library from time to time!

Note

The CHANGE command can be used at a later stage to alter object
properties such as the stroke thickness, text height, pad shape, or the
layer in which the object is located.

If you want to change the properties of several objects at one go, define
a group with the GROUP command, click the CHANGE command,
select the parameter and the value, and click on the drawing surface with
the right mouse button.

Example: Use GROUP to define a group that contains both pads, then
select CHANGE and SHAPE/SQUARE. Click on the drawing surface
with the right mouse button. The shape of both pads changes.
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Resistor Symbol

Define a New Symbol

ﬂ Select the symbol editing mode, and enter the symbol name R in the
New field. This name only has a meaning internal to the program, and
does not appear in the schematic.

Set the Grid

i | Now check that 0.1 inch is set as the grid size. The pins in the symbol

must be placed on this grid, since this is what EAGLE expects.

Place the Pins

j Select the PIN command. You can now set the properties of these pins
in the parameter toolbar, before placing them with the left mouse but-
ton. All these properties can be changed at a later stage with the
CHANGE command. Groups can again be defined (GROUP) whose
properties can then be altered with CHANGE and the right mouse but-
ton. See also page 161.

gl = L= [ = 2 i Diecion [10 [Swaplevet [0 <]

Pin command - Parameter toolbar

Orientation

Set the direction of the pins (Orientation parameter) using the four
left-hand icons in the parameter toolbar or, more conveniently, by rotat-
ing with the right mouse button.

Function

The function parameter is set with the next four icons on the parameter
toolbar. This specifies whether the symbol is to be shown with an inver-
sion circle (Dot), with a clock symbol (Clk), with both (DotClk) or
simply as a stroke (None). The diagram illustrates the four representa-
tions on one package.

Pin Functions
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Length

The next four icons on the parameter toolbar permit setting of the pin
length (0, 0.1 inch, 0.2 inch, 0.3 inch). The 0 setting is used if no pin-line
is to be visible, or if, as in the resistor symbol, a pin shorter than 0.1 inch
is desired. In that case the pin is to be drawn with the WIRE command
as a line in layer 94, Symbols.

The SHOW command can be used to check whether a net is connected
to a pin in the schematic diagram. The pin line and the net are displayed
more brightly if they are connected. If a pin with length 0 is used, or if it
was drawn as a line with the WIRE command, it cannot be displayed

brightly.

Visible

The next four icons in the parameter toolbar specify whether the pins
are to be labeled with pin names, pad names, both or neither. The dia-
gram illustrates an example in which pin names are shown inside and
pad-names outside. The location of the label relative to the pin is fixed.
The text height is also fixed (at 60 mil).

2 3

Z R ) F——
—Jd R DS |=%

> 1 cv +THR =2
81 v

1 GND

555

Pin labeling

Direction

The Direction parameter specifies the logical direction of the signal
flow:

NC Not connected

In Input

Out Output

I/0 Input/output

oC Open Collector or Open Drain

Hiz High impedance output

Pas Passive (resistors, etc.)

Pwr Power pin (power supply input)

Sup Power supply output for ground and

power supply symbols
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The electrical rule check is based on these parameters. It will flag, for ex-
ample, if two pins whose direction is out are connected. Please note that
the ERC can only offer warnings. You must interpret the messages
yourself.

The Pwr and Sup directions are used for the automatic connection of
supply voltages (see page 192).

Swaplevel

The swaplevel is a number between 0 and 255. The number 0 means that
the pin cannot be exchanged for another pin in the same gate. Any
number bigger than 0 means that pins can be exchanged for other pins
which have the same swaplevel and are defined within the same symbol.

The pins can be swapped in the schematic or in the board with the
PINSWAP command.

The two pins of a resistor can have the same swaplevel (e.g. 1), since
they are interchangeable.

If the layer 93, Pins, is being displayed, the connection points on nets
are shown with green circles. The Direction and Swaplevel parameters
moreover (here Pas and 1) are displayed in this layer.

The connections of a diode, for instance, cannot be exchanged, and are
therefore given swaplevel 0.

I 4 Library - R:\home\ricAE agle-4.15Ibrvrcl. Ibr (R-EU.sym)

File Edit Draw Wiew Library Options window Help
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The Symbol Editor
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Pin Names

The NAME command allows you to name pins after they have been
placed. The automatic name allocation, as described on page 73 also
operates.

Schematic Symbol

The schematic symbol is drawn in the symbols layer using WIRE and
the other drawing commands. Place the texts > NAME and >VALUE in
layers 95, Names, and 96, Values (TEXT command). Place them where
the name and value of the component are to appear in the schematic.

Precise placement of the text can be achieved by setting the grid finer,
which can even be done while the TEXT command is active. Afterwards,
however, set the again grid to 0.1 inches.

Resistor Device

Define a New Device

% Create the new device R-10 with this icon. When you later use the ADD
command to fetch the component into the schematic, you will select it
by using this name. It is only a coincidence that in this case the name of
the package and the name of the device are the same.

So enter the name R on the New line. The Device Editor opens after the
confirming question Create new device ‘R’?.

Selecting, Naming and Configuring Symbols

EThe previously defined resistor symbol is fetched into the device with
the ADD command.
If a device consists of several schematic symbols which can be placed in-
dependently of one another in the circuit (in EAGLE these are known

as gates), then each gate is to be individually brought into the schematic
with the ADD command.

Set an addlevel of Next and a swaplevel of 0 in the parameter toolbar, and
then place the gate near the origin. (There are further explanations
about addlevel in the following sections.)

The swaplevel of a gate behaves very much like the swaplevel of a pin.
The value of 0 means that the gate cannot be exchanged for another gate
in the device. A value greater than 0 means that the gate can be swapped
within the schematic for another gate in the same device and having the
same swaplevel. The command required for this is GATESWAP.

Only one gate exists in this example; the swaplevel remains 0.
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22 You can change the name of the gate or gates with the NAME com-

mand. The name is unimportant for a device with only one gate, since it
does not appear in the schematic.
Keep the automatically generated name!

In the case of devices with several gates, the name of the particular gate
is added to the name of the device.

Example:

The gates are called A, B, C and D, and the name of the component in
the schematic is IC1, so the names which appear are IC1A, IC1B, IC1C
and IC1D.

Selecting the Package

Now click on the New button at the lower right of the Device Editor
window. Choose the R-10 package from the selection window, and enter
a name for the version. If only one package version is used, it is usual to
use two single quote marks (") for the name of the package version. It is,
however, quite possible to assign a particular name.

= Create new package variant for B B
Packages

F128-40 Al adiithe

F128-50

F128-60

.

RO402 : .

HDBD3 - Resistor Grid 10 mm
Wariant name

The package selection

Connect — Connections Between Pins and Pads

With the CONNECT command you specify which pins are taken to
which package pads.

= Connect [H 10] ﬂ
Bin Pad Cornection
Name Mame Fin | Pad
Gi1.2
LConnect Disconnect |
Capy frafm
The CONNECT window
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The resistor gate in this example is automatically identified as G$1, for
which reason the pins G$1.1 and G$1.2 of this gate appear in the Pin
column.

The two connections of the housing are listed in the Pad column. Mark
a pin and the associated pad, and click on Connect.

If you want to undo a connection that you have made, mark it in the
Connection column and click Disconnect.

Clicking on a column’s header bar changes the sorting sequence.

Finish the CONNECT command by clicking on OK.

Define Prefix

The PREFIX command is used to specify a prefix for a name. The name
itself will initially be automatically allocated in the schematic. For a re-
sistor this would, naturally enough, be R. The resistors will then be
identified as R1, R2, R3 etc..

The names can be altered at any time with the NAME command

Value

On: You are allowed to change the value in the schematic (for example
for resistors). Without a value the part will not be specified exactly.

Off: The value will be generated from the device name and includes
technology and package variant (e. g. 74LSOON), if available. Also re-
commended for supply symbols.

Description

Click on the Description in the description box. You can enter a descrip-
tion of the component here. The search facility of the ADD command
in the schematic diagram will search through this text.

You can use the Rich Text format, as in the package description. You will
find notes about this in the help system under the keyword Rich Text.

It can look like this:
<b>R-10</b>
<p>

Resistor 10mm package

167





EAGLE Manual

o Jotimenpeoa [ =l

Ao

MAME

>NAME =
Pas@_ _@aeﬂ

Ll _>I_I
Description i New | comnect |
Ristor 10 mm package: R Prefix ,R—

Value COOE® On

\ [ 7

The Device Editor: Fully defined resistor

Save

This completes definition of the resistor, and it can be fetched into the
schematic diagram. If you have not already saved the library, please do it
at this stage!

Use

The newly created library has to be made available for the schematic or
layout with the help of the USE command.

This command has to be used in the Schematic or Layout Editor. It is
also possible to mark a library as iz Use in the Control Panel's tree view.
See help for details. Now the library will be recognized by the ADD

command and its search function.
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8.2 Defining a Complex Device

In this section we use the example of a TTL chip (541032) to define a li-
brary element that is to be used in two different packages (pin-leaded
and SMD). It is a quad OR gate. The schematic diagram symbol is to be
defined in such a way that the individual OR gates can be placed one af-
ter another. The power supply pins are not initially visible in the sche-
matic diagram, but can be fetched into the diagram if needed.

The definition proceeds in the following steps:
* Creating a new library
* Drawing the pin-leaded housing (DIL-14)
* Creating the SMD housing (LCC-20)
* Defining the logic symbol
* Creating the power supply symbol
* Associating the packages and symbols to form a Device set
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SN54ALS1032A, SN54AS1032A, SN74ALS1032A, SN74AS1032A
QUADRUPLE 2-INPUT POSITIVE-OR BUFFERS/DRIVERS

D2661, DECEMBER 1982 —REVISED MAY 1986

® 'ALS1032A is a Buffer Version of ‘ALS32
® °'AS1032A is a Driver Version of 'AS32

® °'AS1032A Offers High Capacitive Drive
Capability

® Package Options Include Plastic ‘*Small
Outline’” Packages, Ceramic Chip Carriers,
and Standard Plastic and Ceramic 300-mil
DIPs

® Dependable Texas Instruments Quality and
Reliability

description

These devices contain four independent 2-input
OR buffers/drivers. They perform the Boolean
functions Y = A+BorY = A.+Bin positive logic.
The SN54ALS1032A and SN54AS1032A are
characterized for operation over the full military
temperature range of —55°C to 125°C. The
SN74ALS1032A and SN74AS1032A are
characterized for operation from 0°C to 70°C.

FUNCTION TABLE

(each gate)
npuTs | outPuT
A B v
, X H
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Lo L
logic symbolt
)
1A D [
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prym
a ((s] ® 4
180100
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TThis symbol is in accordance with ANSVIEEE Std 91-1984 and
IEC Publication 617-12.
Pin numbers shown are for D, J, and N packages.

SNG4ALS1032A, SN54AS1032A . . . J PACKAGE
SN74ALS1032A, SN74AS1032A . . . D or N PACKAGE

(TOP VIEW)
1A Uidgvee
182 13[]48
ws  1z[Jaa
2a[]a  n[d4v
28(]s 10[]3B
2v[e 9[]3A
GND 7 8[]3Y

SN54ALS1032A, SN54AS1032A . . . FK PACKAGE

(TOP VIEW)

9 10111213

>a o
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NC —No internal connection

> <
™ o

logic diagram (positive logic)

3B

PRODUCTION DATA documents contain information
current as of publication date. Products conform to
specifications per the terms of Texas Instruments
standard warranty. Production processing does not
necessarily include testing of all parameters.

Data sheet for the 541032

All the data for this component has been extracted from a data book
published by Texas Instruments, whom we thank for permission to repro-

duce it.

s %

TeEXA:
INSTRUMENTS

Copyright © 1982, Texas Instruments Incorporated
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Creating a New Library
Click on the File/New/Library menu in the EAGLE Control Panel. The

Library Editor window appears, containing a new library, untitled.lbr.

It is, of course, also possible to expand an existing library. In that case
you would use File/Open/Library to select the library you want, or you
would click on the Libraries entry in the Control Panel’s tree view, se-
lecting the desired library with a click of the right mouse button. This
will open a context menu, one of whose options is Open. The Library
Editor is opened.

Drawing the Pin-Leaded Package

The component is manufactured in a pin-leaded package. This is a
DIL-14 housing with a pin spacing of 2.54 mm (0.1 inch) and a width of
7.62 mm (0.3 inch).

If there is a suitable package in another library, it can be copied into the
current library. A new definition would not be necessary.

14-PIN J CERAMIC

19,94 (0.785)
19,18 (0.755}

Falls Within JEDEC TO-116 and
E1A MO.001AA Dimensions. OO
[AWANAWAWAWA WA
0,63 (0.025) R NOM -\‘b
€ €
7,87 (0.310) VUV YYLUTY
7,37 (0.290)
7,11 (0.280) @ @ @ @ @ @ @
6.22(0.245)
| ¥ AX 14 PLACES
w127 0,51 {0.020) MlN—] —» | 1,78 (0.070) M.
(0.050) NOM & - 1 eLass
5,08 (0.200) l SEALANT
max q
o —SEATING PLANE ¥ 06910027 MIN
“50% 14 PLACES
14 PLACES
S wika- 05810.023) 1, o1 aces
0,36 (0.014) savioazod 10-01 ~H—ssoms
qulggges) b 1"78 {0:070) PIN SPACING 2,54 (0.100) T.P.

4 PLACES

ALL LINEAR DIMENSIONS ARE IN MILLIMETERS AND PARENTHETICALLY IN INCHES

NOTE A: Each pin centerline is located within 0,25 (0.010) of its true longitudinal position.

DIL-14 data sheet

fizd| Click on the Edit a package icon in the action toolbar, and enter the
name of the package in the New box of the Edit menu, which is DIL-14
in our present example. Click on OK, and confirm the question Create
new package ‘DIL-14’¢ by answering Yes.

The Package Editor window now opens.
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Set the Grid

First set the appropriate grid (50 mil in this case) using the GRID com-
mand, and let the grid lines be visible.
The grid can easily be shown and hidden with the F6 function key.

Place Pads

Use the PAD command, and place the solder pads in accordance with
the specifications on the data sheet. The pads should be arranged in such
a way that the coordinate origin is located somewhere near the center of
the package.

Each pad can have individual properties such as Shape, Diameter, and
Drill hole diameter. Available shapes are: Square, Round, Octagon, Long,
and Offset (Long with offset drill).

Select the desired pad shape and specify the hole diameter.

The pad diameter usually is defined with the standard value auto
(respectively 0), since the size is finally determined in the layout by
means of the Design Rules, Restring tab. The pad appears in the library
with the default value of 55 mil.

You may, however, assign an individual value. If, for instance, you spec-
ify 70 mil, the consequence is that the diameter of the pad on the board
cannot be less than 70 mil (independent of the calculated value of the
Design Rules). You select this value when the PAD command is active
(i.e. the pad is attached to the mouse cursor) using the parameter tool-
bar. It is also possible to specify the drill hole diameter and the pad
shape.

|| H @ © © || Diamster: |0.07 x| ol [003z2 || angle: [0 |

The parameter toolbar when the PAD command is active

The properties of pads that have already been placed can be altered at a
later stage by means of the CHANGE command. Click on the
CHANGE icon and select the property and the appropriate value. Then
click on the pads whose properties are to be altered. CHANGE can also
be applied to groups (using the GROUP command). After the property
has been selected, click inside the group with the right mouse button.

As soon as a pad has been placed, EAGLE automatically generates sol-
der stop symbols in layers 29 and 30, t/bStop. The dimensions of the sol-
der stop symbols is specified in the Design Rules, Mask tab, Stop
parameter.

Pads can be marked with special flags (First, Stop, Thermals). They can
be altered with CHANGE subsequently. Giving one pad of a package
the First flag (CHANGE FIRST ON) allows to define a special shape
for it in the Design Rules, Shapes tab, option First, in order to mark it as
the number '1' pad of the package.
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Setting the Thermals flag off prevents generating a thermal symbol in a

copper area.
CHANGE STOP OFF prevents automatic solder stop mask generation
for a pad.

Pad Name

= EAGLE automatically assigns pad names, P$1, P$2, P$3 etc., as place-
~ ment proceeds. Assign the names in accordance with the information in

the data book.

The names can be checked easily by clicking the Options/Set/Misc menu
and choosing the Display pad names option. All pad names are displayed
after refreshing the screen (F2).
Alternatively type in the command line:

SET PAD ON
To hide the pad names again:

SET PAD OFF

The following procedure is recommended for components that have a
large number of sequentially numbered pads:

Select the PAD command, type in the name of the first pad, e.g. '1', and
place the pads in sequence. The single quote marks must be typed on the
command line. See also the section on Names and Automatic Naming on
page 73.

Draw the Silk Screen Symbol

/| A simple silk screen symbol that is to be visible on the board is drawn in
layer 21, tPlace. Use the commands WIRE, CIRCLE, and ARC. Ensure
that it does not cover soldered areas, since this can cause problems when
the boards come to be soldered. If necessary, use the GRID command
to set a finer grid or use the Alt key for the alternative grid (see GRID
command). The standard width (CHANGE WIDTH) for lines in the

screen print is 10 mil (0.254 mm), and should not be made thinner.

It is also possible to create an additional and rather better-looking silk
screen for documentation purposes in layer 51, tDocu. This may indeed
cover soldered areas, since it is not output along with the manufacturing
data.

Package Name and Package Value
ﬂ The labeling now follows. Use the TEXT command and write
>NAME

in layer 25, tNames, for the name placeholder, and
>VALUE
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in layer 27, tValues, as the placeholder for the value, and place this at a
suitable location. We use proportional font with a text height of 70 mil
as default.

If you want to have texts upside down by a package rotation of 180°,
you have to use the Spin flag (see help function for TEXT command).

The texts can be relocated at a later stage using SMASH and MOVE.

Areas Forbidden to Components

A In layer 39, tKeepout, you should create a restricted area over the
whole component using the RECT command or draw a frame around

the package with WIRE. This allows the DRC to check whether compo-
nents on your board are too close or even overlapping.

Description

Click on Description in the description box. A window opens in whose
lower part it is possible to enter text, while the formatted appearance of
the description is displayed in the upper part (Headline). The text can
be entered in Rich Text format. This format works with a subset of
HTML tags that allow the text to be formatted. You will find detailed
information in the help system under Rich Text.

The descriptive text for our DIL-14 might look like this:
<b>DIL-14</b>
<p>

14-Pin Dual Inline Plastic Package, Standard
Width 300 mil

It is also possible to add, for instance, the reference data book,

the e-mail address of the source or other information here. The search
facility in the Layout Editor’s ADD dialog also looks in this text for
keywords.
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lib.lbr (DIL14.pac)
Window Help

B =2 a8 88 i

DIL-14

14-pin Dual Inline Plastic Packane, Standard Wwidth 300mil

Package Editor with DIL-14

Save

At this stage if not before the library should be saved under its own
name (e.g. my_lib.lbr).

Defining the SMD Package

The second type of housing for this component may be seen in the fol-
lowing scale drawing.

The size of the soldering areas is to be 0.8 mm x 2.0 mm. The SMD 1, at
0.8 mm x 3.4 mm, is larger.
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FK CERAMIC CHIP CARRIER
(28-terminal package shown)

CERAMIC CHIP CARRIERS

JEDEC
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7 T3 16 [ 031 163
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*All dimensions and notes for the specified JEDEC outline apply.
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ALL LINEAR DIMENSIONS ARE IN MILLIMETERS AND PARENTHETICALLY IN INCHES

SMD package, FK version.

Click again on the Edit a package icon, and enter the name of the pack-
age in the New box in the edit menu. The package is to be called
LCC-20. Click on OK and confirm the question Create new package
‘LCC-20’¢ by answering Yes.

Set the Grid

Adjust the grid to 0.635 mm (0.025 inch), and let the grid lines be visi-
ble. It is useful to define an alternative grid of 0.05 mm for designing
this package.

Placing SMD Solder Pads

ﬂ SMD devices are generally defined on the top of the board; SMDs are
therefore always in layer 1, Top.
If you do want to have components on the solder side, the item is if
needed reflected on the board with the MIRROR command. See also
the section on page 199.
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Begin by placing 5 SMDs at a distance of 1,27 mm from each other in
two horizontal rows close to the coordinate origin. Since the value 0.8 x
2.0 is not contained in the SMD menu, this must be entered as 0.8 2.0,
either on the command line or in the SMD box on the parameter tool-

bar.
Click therefore in the SMD icon, and type
0.8 2 «

on the command line. Create two vertical rows as well. The SMDs can
be rotated in 90 degree increments with the right mouse button.

5l 3 Library - r:\homesicheagle-4.1\br\mylib. Ibr (LCC-20.pac)

Fle Edit Draw Miew Libawy Oplions Window Help
Eﬂé RBED [ HY6 aaa g e N
G [ 1Tor x]smafze0m | Roundress: [0 >]| anae [0 >

\usasmm[-msuuuu] I |

%7

@ BONT
B0 =

Description
Use the DESCRIPTION command to enter a description of this package.

Left-click to placs smd

Placing the SMDs

The Roundness parameter (CHANGE command) specifies whether
curves should be given to the corners of the solder pads. The default
value is 0%, which means that there is no rounding.

See also the section on page 103.

If a square SMD is selected, and if Roundness is defined as 100%, the re-
sult is a round SMD, as is needed when creating ball grid array housings
(BGA). Roundness is usually chosen to be 0% when a package is being
defined. A general value can be specified in the Design Rules if slightly
rounded solder pads are preferred.

Drag the 4 SMD rows into the correct position. Therfore use the finer
alternative grid of 0.05 mm by pressing the Alt key. The commands
GROUP and MOVE, followed by a right mouse click on the marked

group can be used to drag the marked group into the correct position.
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The size of the central SMDs in the upper row can be altered with the
CHANGE SMD command. Since the value 0.8 x 3.4 is not contained in
the menu as standard, type

change smd 0.8 3.4

onto the command line, then click on the SMD. Drag it with MOVE so
that it is located at the correct position.

The INFO command is helpful for checking the position and properties
of the solder pads.

When a SMD is placed (in the Top layer), symbols for solder stop and
solder cream are automatically created in layer 29, tStop, and layer 31,
tCream, respectively.

If the component in the layout is mirrored onto the bottom side, these
are changed to the layers with the corresponding functions, namely 30,

bStop and 32, bCream.

SMDs can have special flags (Stop, Cream, Thermals) that can be modi-
fied with the CHANGE command.

Setting the Thermals flag off avoids a thermal symbol for the SMD cop-
per areas.

CHANGE STOP OFF or CHANGE CREAM OFF prevents EAGLE
from generating a solder stop mask or a cream frame for the SMD auto-
matically. See also help function.

SMD Names

If no names are visible in the SMD pads, click the Options/Set/Misc
menu and activate the Display pad names option.

Alternatively you can type the following onto the command line:

set pad names on «
All the names will be visible once the screen is redrawn (WINDOW

command).

Use the NAME command to adjust the names to match the specifica-
tions of the data sheet.

It is alternatively possible to assign names as the SMDs are being placed,
if the component has a large number of pads with sequential numbers.
Select the SMD command, type in the name of the first SMD, e.g. '1',
and place the pads in the correct sequence. The single quote marks must
be entered on the command line. See also the section on Names and
Automatic Naming on page 73.

You can also combine several statements on the command line, for
example:

smd 0.8 2 '"1' ~

A SMD of 0.8 mm x 2.0 mm and with the name 1 is now attached to the
mouse Cursor.
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Draw the Silk Screen

d First set the grid to a suitable value such as 0.254 mm (10 mil). Draw the
silk screen print in layer 21, tPlace. Note that it must not cover soldered
areas, as this can cause problems when the boards come to be soldered.

Do not use a line width below the minimum of 0.2 mm. The standard
value is 0.254 mm (10 mil).

It is also possible to create an additional, more detailed, silk screen for
documentation purposes in layer 51, tdocx. This may indeed cover sol-
dered areas, since it is not output along with the manufacturing data.

Package Name and Package Value

ﬂ The labeling now follows. Use the TEXT command and write
>NAME
in layer 25, tNames, for the name placeholder, and
>VALUE

in layer 27, tValues, as the placeholder for the value, and place this at a
suitable location. The texts can be separated and relocated at a later

stage using SMASH and MOVE.

Area Forbidden to Components

A In layer 39, tKeepout, you should create a forbidden area over the
whole component (RECT command) or draw a frame around the pack-
age with the WIRE command. This allows the DRC to check whether
components on your board are too close, or even overlapping.

Locating Point

As soon as you have finished drawing the package, please check where
the coordinate origin is located. It should be somewhere near the middle
of the package. If necessary, use GRID to choose a suitable grid (e.g.
0.635 mm), and shift the whole package with GROUP and MOVE.
First make sure that all the layers are made visible (DISPLAY ALL).
That is the only way to be sure that all the elements have indeed been
moved.

Description

Then click on Description in the description box. You can insert a de-
tailed description of this package form here. The Rich Text format can
be used. This format is described in the program’s help system under

Rich Text .
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The entry of the LCC-20 in Rich Text format could look like this:
<b>LCC-20</b>
<p>
FK ceramic chip carrier package from Texas
Instruments.

The ADD dialog in the Layout Editor can search for this description or
for keywords within it.

Save

Please do not forget to save the library from time to time!

B 3 Library - 1-\home\richeagle-4. 1\brimylib.Ibr [LEC-20.pac)
File Edit Draw Yiew Ly Options Window Help

?ﬂé dm e ARG E » B 2

][l |

0.635 mm [10.795 8.255]
e LT

~

40 HO NNk
e

Description
LCcC-20

FK ceramic chip carier package from Texas Instuments

The fully defined LCC-20

Supposed you found a package that is exactly the one you need, simply copy
it into your current library. More information about this on page 205.
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Defining the Logic Symbol for the Schematic Dia-
gram

Our device contains four OR gates, each having two inputs and one out-
put. We first create an OR symbol.

logic diagram {positive logic)

1A
1Y
1B

2A
2y
2B

3A
3B

3y

4A
a4y

o9y

4B

Logical appearance of the 541032.

I | Click on the Edit a symbol icon. Enter a name for the symbol on the
New line, such as 2-input_positive_or, and click OK. Confirm the ques-
tion Create new symbol 2-input _positive_or’? by answering Yes. You
now have the Symbol Editor window in front of you.

Check the Grid

Check that the grid is set to the default value of 0.1 inch. Please try to
use only this grid, at least when placing the pins. It is essential that pins
and net lines are located on the same grid. Otherwise there will not be
any electrical connection between the net and the pin!

Place the Pins

— | Select the PIN command, and place 3 pins. The pin properties can be
changed by means of the parameter toolbar as long as the pin is attached
to the mouse cursor and has not been placed. If a pin has already been
placed, its properties can be altered at a later stage with the CHANGE
command. A number of pins can be handled at the same time with the
GROUP and CHANGE commands followed by a click with the right
mouse button. The parameters Orientation, Function, Length, Visible,
Direction and Swaplevel have been thoroughly described when the ex-
ample of the resistor symbol was examined (see p. 162).

The coordinate origin should be somewhere near the center of the sym-
bol, and, if possible, not directly under a pin connection point. This
makes it easy to select in the schematic diagram.
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Pin Name

You assign pin names with the NAME command. In our symbol the two
input pins are named A and B, and the output pin is named Y.

Draw the Symbol

Use the WIRE command to draw the symbol in layer 94, Symbols. The
standard line thickness for the Symbol Editor is 10 mil. You may also
choose any other line thickness.

Placeholders for NAME and VALUE

_I For the component labeling, use the TEXT command in the schematic

diagram to write
>NAME

in layer 95, Names and
>VALUE

in layer 96, Values. Place the two texts at a suitable location. It is possi-
ble to move the texts again in the schematic diagram after using SMASH
to separate it. The symbol should now have the appearance shown in the
following diagram.

Save

This is a good moment to save the work that you have done so far.

5| 3 Library - R:\home\ricAE agle-4.14Ibr\mylib.Ibr (2_INPUT_POSITIVE_OR_sym)

Fie Edt Draw s Windaw Help

=@ &3 waeaa®o -T2 }

I

o (I 0703 [ |
. .
2%

E3

e >NAME

®

ﬁ" In

/T

ehe] 4 uto

B A

= In

>SVALUE
l wll

|‘H home:iic/E agle-4.1/br/mylib br' saved 7

The Symbol Editor: Logic symbol (American representation)
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Supposed you found a symbol that is exactly the one you need use GROUR,
CUT, and PASTE to copy it into the current library. See also page 206.

Defining a Power Supply Symbol

Two pins are needed for the supply voltage. These are kept in a separate
symbol, since they will not initially be visible in the schematic diagram.

13| Click on the Edit a symbol icon. Enter a name for the symbol on the new
line, such as VCC-GND, and click OK. Confirm the question Create
new symbol ‘VCC-GND’? with Yes.

Check the Grid

First check that the grid is set to the default value of 0.1 inch. Only ever
use this grid when placing pins!

Place the Pins
— | Fetch and place two pins with the PIN command. The coordinate origin
should be somewhere near the center of the symbol.

Both pins are given PWR as their direction. To do this, click with the
mouse on CHANGE, select the Direction option, and choose PWR.
Now click on the two pins to assign this property.

The green pin label is updated, and now shows Pwr 0. It is only visible
when layer 93, Pins, is active!

Pin Name
2 You use the NAME command to give the two pins the names of the sig-
~ nals that they are to carry. In this case, these are GND and VCC.

For reasons of appearance, the pin property Visible is set to Pad in the
symbol shown below, and the pin label has been placed on layer 95,
Names, using TEXT.

Placeholders for NAME and VALUE

ﬂ For the component labeling, use the TEXT command in the schematic
diagram to write

>NAME

in layer 95, Names. Place the text at a suitable location. No placeholder
is necessary for value here.
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14Ibrsmylib. lbr (VCC-END.sym)
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The Symbol Editor: Supply Symbol

Associating the Packages and Symbols to Form a
Device Set

We now come to the final step, the definition of the Device set. A De-
vice set is an association of symbols and package variants to form real
components

A Device set consists of several devices, which use the same symbols for
the schematic but different technologies or package variants.

Defining a Device set or a device consists essentially of the following
steps:

* Select symbol(s), name them and specify properties
¢ Assign package(s) or specify variants
* Specify the assignment of pins to pads using the CONNECT

command
* Define technologies (if desired/necessary)
* State prefix and value
* Describe the device

Click on the Edit a device icon. Enter the name for the device on the
new line.

In our example this is a 541032A. This device is to be used in two differ-
ent technologies, as the 54AS1032A and as the 54ALS1032A. A * is
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used as a placeholder at a suitable location in the device name to repre-
sent the different technologies. Enter, therefore, the name 54710324,
and confirm the question Create new device 54¥1032A’? with Yes.

The Device Editor window opens.

Select Symbols

E First use ADD to fetch the symbols that belong to this device. A win-
dow opens in which all the symbols available in the current library are
displayed. Double-click on the 2-input_positive_or symbol and place it
four times.

Click again on the ADD icon, and select the VCC-GND’ symbol from

the list. Place this too onto the drawing area.

Naming the Gates

22| A symbol that is used in a device is known as a gate. They are automati-
~ cally given generated names (G$1, G$2 etc.). This name is not usually
shown on the schematic diagram.

It is nevertheless helpful to assign individual gate names when compo-
nents are composed of a number of gates. To distinguish the individual
OR gates, you use the NAME command to alter the gate names. Assign
the names A, B, C and D, and name the power supply gate P

Specify the Addlevels and Swaplevels

The addlevel can be used to specify how the gates are placed in the sche-
matic diagram by the ADD command. You can see the current addlevel
for each gate written above left in layer 93, Pins.

ﬂ Assign the addlevel Next for gates A to D, and the addlevel Reguest to
the power supply gate. Do this by clicking on the CHANGE icon, se-
lecting the Addlevel entry, and then selecting the desired value for a gate.
Then click on the gate that you want to change.

This means that as soon as the first OR gate has been placed on the
schematic diagram, the next one is attached to the mouse cursor. All 4
gates can be placed one after another. The power gate does not auto-
matically appear. You can, however, fetch it into the schematic diagram
if necessary, by making use of the INVOKE command.

The parameter ADDLEVEL is described in full detail in the section en-
titled More About the Addlevel Parameter on page 195.

The swaplevel determines whether a device’s gates can be swapped
within the schematic diagram. The value that is currently set is - like the
addlevel — displayed above left in layer 93, Pins, for each gate. The
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default value is 0, meaning that the gates may not be exchanged. The
swaplevel can have a value from 0 to 255. Gates with the same swaplevel
can be exchanged with one another.

Our device consists of four identical gates that may be swapped. Click
on CHANGE, select the Swaplevel entry, and enter the value 7. Click
on the four OR gates. The information text in layer 93, Pins, changes
correspondingly.

Choosing the Package Variants

In the Device Editor window, click on the New button at the lower
right. A window opens that displays the packages defined in this library.
Select the DIL-14 package and give the version name J. Click on OK.
Repeat this procedure, select the LCC-20, and give the version name
FK.

In the list on the right you will now see the chosen package variants,
with a simple representation of the selected package above it.

Clicking on a package variant entry with the right mouse button will
open a context menu. This allows variants to be deleted, renamed or
newly created, technologies to be defined, or the CONNECT com-
mand to be called.

Both entries are marked by a yellow symbol with an exclamation mark.
This means that the assignment of pins and pads has not yet been (fully)
carried out.

Supposed you don't find the appropriate package variant in the current li-
brary you may use packages from another library. Use the PACKAGE com-
mand to copy the package into the current variant and to define a new
variant.

Example:

PACKAGE DIL14@d:\eagle-4.1\1br\dil.lbr J

This command copies the package named DIL14 from dil.lbr into the cur-
rent library. Simultaneously the variant ] is generated for the device. See
also page 199.

The Connect Command

This must be the most important step in the library definition.
CONNECT assigns each pin to a pad. The way in which nets in the
schematic diagram are converted into signal lines in the layout is defined
here. Each net at a pin creates a signal line at a pad. The pin assignment
for the 541032 is specified in the data sheet. Check the connects in the
library with care. Errors that may pass unnoticed here can make the lay-
out useless.
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SNG4ALS1032A, SN54AS1032A . . . FK PACKAGE
(TOP VIEW)

SNB4ALS1032A, SN54AS1032A . . . J PACKAGE

(TOP VIEW)
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The pin assignment for the packages

Select the J version from the package list and click on the CONNECT

button. The connect window opens.
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CONNECT dialog

The list of pins is on the left, and the pads are in the center. Click on a
pin-entry, and select the associated pad. Both entries are now marked.
You join them with the connect button. This pair now appears on the
right, in the Connection column. Join each pin to its pad in accordance
with the data sheet. Finish the definition by clicking on OK.

Define the connections for the second package version, FK, in the same
way. Select the version, and click on the Connect button. The usual dia-
log appears in the connect window. Proceed exactly as described above.
Please note that six pads are not connected in this version. They are left
over in the Pad column. Finish the process by clicking on OK.

There is now a green tick to the right of both package variants, and this
indicates that connection is complete. This is only true when every pin
is connected to a pad.
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One pin has to be connected to exactly one pad! It is not possible to connect
several pins with a common pad! A device may contain more pads than
pins, but not the other way around!

Pins with direction NC (not connected) must be connected to a pad, as
well!

Defining Technologies

As noted above, the 541032 is to be used in two different technologies —
AS and ALS -. By including a * as a placeholder in the device name we
have already taken the first step towards this. In the schematic diagram

the code for the chosen technology will appear instead of the *. The data
sheet shows that both technologies are available in both packages.

Select the J package from the list on the right of the Device Editor win-
dow. Then click on Technologies in the description box. The technolo-
gies window opens. Define the technology in the New line, and confirm
the entry with OK. When the entry has been completed, the AS and
ALS entries are activated with a tick.

B Technologies of 54=10324A [J] %]

Technologies

ok | Cancel |

Technologies for package version J

Close the window by clicking on OK again.

Select the FK version from the package list. Click on Technologies in the
description box again. You will now see that AS and ALS are available as
selections in the technologies window. Activate both of these by click-
ing in the small box to the left, so that a tick is displayed. Finish the
definition by clicking on OK.

The technologies available for the selected package version are now
listed in the description area of the Device Editor.

Specifying the Prefix

The prefix of the device name is defined simply by clicking on the Prefix
button. /C is to be entered in this example.
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Value

The setting of value determines whether the VALUE command can be
used to alter the value of the device in the schematic diagram and in the
layout. The default setting is off, so that alteration is not permitted.
Since that appears to be appropriate here too, value is left off-

The value of the device corresponds to the device name in this case.

Description

Click on the Description in the description box. You can enter a descrip-
tion of the device in the window which now opens. Use typical terms
that you might apply for a keyword search. The search facility of the
ADD command in the schematic diagram will also search through this
text.

You can use Rich Text format. This is described in the help system under
the keyword Rich Text.

It can look like this:
<b>541032A</b>
<p>

Quadruple 2-Input Positive-OR Buffers/Drivers
from TI.

Save

This completes definition of the Device set. If you have not already
saved the library, please do it at this stage!
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Device-Editor: 54*1032A.dev

8.3 Supply Voltages

Component Power Supply Pins

The components’ supply pins are to be given the direction Pwr in the
symbol definition. The pin name determines the name of the supply sig-
nal. Pins whose direction is Pwr and which have the same name are
automatically wired together (even when no net line is shown explic-
itly). Whether the pins are visible in the schematic diagram or are
fetched by means of a hidden symbol is also not relevant.

Invisible Supply Pins

We do not want as a rule to draw the supply connections for logic com-
ponents or operational amplifiers in the schematic. In such a case a spe-
cific symbol containing the supply connections is defined. This can be
demonstrated with the example of a 7400 TTL component:

You first define a NAND gate with the name 7400, and the following
properties in the Symbol Editor:
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"G
"G

NAND symbol 7400 (European representation)

The two input pins are called /0 and /7 and are defined as having direc-
tion In, swaplevel 1, visible Pin and function None.

The output pin is called O and is defined with direction Ouz, swaplevel
0, visible Pin, and function Dot.

Now define the supply gate with the name PWRN, and the following
properties:

Bwr @

Power gate

The two pins are called GND and VCC. They are defined with direction
Pwr, swaplevel 0, function None, and visible Pad.

Now create the 7400 device in the Device Editor:

Specify the package with PACKAGE (which must already be present in
the library) and use PREFIX to specify the name prefix as /C.

Use the ADD command to place the 7400 symbol four times, with ad-
dlevel being set to Next and swaplevel to 1. Then label the gates as A, B,
C and D with the NAME command.
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The addlevel of Next means that as these gates are placed into the sche-
matic, they will be used in that sequence, i.e., the sequence in which they
were fetched into the device.

Then place the PWRN symbol once, using addlevel Reguest and
swaplevel 0. Name this gate P

Addlevel Reguest specifies two things:

* The supply gate will only be fetched into the schematic if re-
quested, i.e. with the INVOKE command. The ADD command
will only be able to place NAND gates.

* The supply gate will not be included when names are allocated to
the schematic. Whereas an IC with two next-gates appears in the
schematic as something like IC1A and IC1B, an IC with one
Next-gate and one Request-gate will only be identified as IC1.

So use the CONNECT command to define the housing pads to which
the supply pins are connected.

8.4 Supply Symbols

Supply symbols, such as might be used in the schematic for ground or
VCC, are defined as devices without a package. They are needed for the
automatic wiring of supply nets (see page 94).

The following diagram shows a GND symbol as it is defined in one of
the supplied EAGLE libraries.

Note that when defining your own supply symbols, the pin and the de-
vice name need to agree.

The pin is defined with direction s#p and has the name GND. This
specifies that the device containing this symbol is responsible for the
automatic wiring of the GND signal. The text variable for the value
(>VALUE) is chosen for the labeling. The device also receives the name
GND. Thus the label GND appears in the schematic, since by default
EAGLE uses the device name for the value.

It is very important that the labeling reproduces the pin names, since
otherwise the user will not know which signal is automatically
connected.

The pin parameter Visible is therefore set to off, since otherwise the plac-
ing, orientation and size of the pin name would no longer be freely se-
lectable. Directly labeling with the text GND would also have been
possible here. With the chosen solution however, the symbol can be
used in various devices (such as for DGND etc.).
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plyl.lbr (GND.sym)
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Supply symbol for GND

As has been explained above, the device receives the name of the pin
that is used in the symbol. The corresponding device is defined with
addlevel Next. If you set value to off you can be sure that the labeling is
not accidentally changed. On the other hand, you have more flexibility
with value set to on. You can alter the label if, for instance, you have a
second ground potential. You must, however, then create explicit nets
for the second ground.

Quick guide to define a Supply Symbol:
* Create a new symbol in the library
* Place the pin, with direction Supply
* Pin name corresponds to the signal name

* Value placeholder

¢ Create a new device
* Device name is signal name

* Package assignment not necessary
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8.5 Labeling of Schematic Symbols

The two text variables > NAME and >VALUE are available for labeling
packages and schematic symbols. Their use has already been illustrated.
There are two further methods that can be used in the schematic:
>PART and >GATE.

The following diagram illustrates their use, in contrast to >NAME. The
symbol definition on the left, the appearance in the schematic diagram
on the right.
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o o al
>EATE >EATE
D

‘

¥ %

D\(

Labeling of a schematic symbol

In the first case all the symbols are labeled with >NAME. In the second
case, the symbol of the first gate is labeled with >PART and >GATE,
the other three with >GATE only.

8.6 Pins with the Same Names

If you want to define components having several pins of the same name,
then proceed as follows. Let us suppose that three pins are all to be
called GND. During the symbol definition the pins are given the names
GND@1, GND@2 and GND@3. Only the characters in front of the
“@? are visible in the schematic, and the pins are treated there as if they
were all called GND. However these pins are not necessarily internally
connected.
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8.7 More about the Addlevel Parameter

The addlevel of the gates that have been fetched determines the manner
in which these gates are fetched into the schematic, and under what con-
ditions it can be deleted from the schematic.

Summary

Next: For all gates that should be fetched in sequence (e.g. the NAND
gates of a 7400). This is also a good option for devices with a single gate.
The ADD command first takes unused next-gates from components
which exist on the current sheet before “opening” a new component.

Must: For gates which must be present if some other gate from the
component is present. Typical example: the coil of a relay. Must-gates
cannot be deleted before all the other gates from that component have

been deleted.

Can: For gates which are only used as required. In a relay the contacts
may be defined with addlevel Can. In such a case the individual contacts
can be specifically fetched with INVOKE, and can later be deleted with
DELETE.

Always: For gates which as a general rule will be used in the schematic
as soon as the component is used at all. Example: contacts from a
multi-contact relay, of which a few are occasionally left unused. These
contacts can be removed with DELETE, provided that they were de-
fined with addlevel Always.

Request: Only for components” supply gates. The difference from Can
is that they are not counted in name allocation. So a device with a Next-
gate and a Reguest-gate will not be named IC1A and IC1B.

Relay: Coil and First Contact must be Placed

A relay with three contacts is to be designed, of which typically only the
first contact will be used.

Define the coil and one contact as their own symbols. In the device, give
the coil and the first contact the addlevel Must. All the other contacts
are given the addlevel Can.
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Relay with one coil and three contacts

If the relay is fetched into the schematic with the ADD command, the
coil and the first contact are placed. If another contact is to be placed,
this can be done with the INVOKE command. The coil cannot be de-
leted on its own. It disappears when all the contacts have been deleted
(beginning with those defined with addlevel Can).

Connector: Some Connection Surfaces can be
Omitted

A pcb connector is to be designed in which normally all the contact ar-
eas are present. In some cases it may be desirable for some of the con-
tact areas to be omitted.

Define a package with 10 SMDs as contact areas, giving the SMDs the
names 1 to 10.

>NAIVIE VALUE

Package of a circuit board connector

Now define a symbol representing one contact area. Set visible to Pad,
so that the names 1 to 10, defined in the package, appear in the

schematic.

Connector symbol for the schematic diagram
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Then fetch the symbol ten times into a newly created device, setting the
addlevel in each case to Always, and use the CONNECT command to
create the connections between the SMDs and the pins. When you now
fetch this device into a schematic, all the connections appear as soon as
it is placed. Individual connections can be removed with DELETE.

e=C-PA0D
BT
H%uaus
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)

2
@dd

After ADD, all the connections are visible in the schematic

Connector with Fixing Hole and Forbidden Area

A connector is to be defined having fixing holes. On the solder side
(bottom), the Autorouter must avoid bringing tracks closer to the holes
than a certain distance.

Fixing holes with restricted areas
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The drill holes are placed, with the desired diameter, on the package us-

ing the HOLE command. The drilling diameter can be retrospectively
changed with CHANGE DRILL.

The forbidden area for the Autorouter is defined in layer 42, bRestrict,
using the CIRCLE command. For reasons of representational clarity
the circle is shown here with a non-zero width. Circles whose width is 0
are filled. In this case it has no effect on the Autorouter, since it may not
route within the circle in either case. These forbidden areas are also
taken into account by a polygon in layer 16, Bottom.

8.8 Drawing Frames

It may be true that drawing frames are not components, but they can be
defined for schematics as devices with neither packages nor pins. Such
devices in EAGLE’s frames library contain a symbol consisting merely
of a frame of the appropriate size, and a documentation field, which is
also defined as a symbol.

In both cases the identification point is located at the bottom left, so
that neither the frame nor the documentation field will be unintention-
ally selected while working within the drawing area.

TJITLE:  >DRAWING_NAME

‘Document Number: REV:

Date: »LAST_DATE_TIME |§heet: S>SHEET

Text variables in the documentation field

The text variables >DRAWING _NAME, >LAST DATE TIME and
>SHEET are contained, as well as some fixed text. The drawing’s file
name, date and time of the last change appear at these points together
with the sheet number in the schematic (e.g., 2/3 = sheet 2 of 3).

In addition, the variable >PLOT DATE_TIME is available. It contains
the date and time of the last printout.
All of these text variables can be placed on the schematic, and (with the
exception of >SHEET) on the board.
The frame is defined in the device with addlevel Next, and the documen-

tation field with addlevel Must. This means that the documentation field
cannot be deleted as long as the frame is present.
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There are frames defined as packages available for the Layout Editor
which can be placed even if there is a consistent schematic/layout pair.
These frames don’t have any electrical significance because they are de-
fined without pads or smds.

8.9 Components on the Solder Side

SMD components (and leaded ones too) can be placed on the top or
bottom layers of a board. For this reason EAGLE makes a set of prede-
fined layers available which are related to the top side (Top, tPlace, tOri-
gins, tNames, tValues etc.) and another set of layers related to the
bottom side (Bottom, bPlace etc.).

SMD components are always defined in the layers associated with the
top.

In the board, a component of this sort is moved to the opposite side
with the MIRROR command. Therfore click the component with the
mouse or enter the component's name in the command line. This causes
objects in the Top layer to be reflected into the Bottom layer, while all
the elements in the ¢. layers are reflected into the corresponding b..
layers.

If one of the commands ADD, COPY, MOVE, or PASTE is active the

component can be mirrored by clicking the middle mouse button.

8.10 Creating New Package Variants

Most components are manufacured in various package variants. Sup-
posed you do not find the appropriate package for a certain device in
one of the libraries, it is very easy to define a new package.

To describe this procedure clearly we want to come back again to our
example device 5410324 from paragraph 8.2.

Please notify the explanations concerning this topic, in particular if the
appropriate package already exists in the current library beginning with
page 186.

The third package variant to be designed bere only serves as an example
for practice and does not meet the specifications of the manufacturer!

Package from Another Library

In the most favorable case you can use an already existing package from
another library. The easiest way to define the new package variant is to
use the PACKAGE command directly in the Device Editor.
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After searching all libraries, either in the Libraries branch of the tree
view in the Control Panel or with the help of the search function of the
ADD command in the Layout Editor (only there, not in the Schematic,
one can search for packages), it is possible to Drag&Drop the package
from the Control Panel directly into the library. As an alternative you
could use the PACKAGE command.

Open the library (here: my_lib.lbr from paragraph 8.2) that contains the
device you want to define the new package variant for. For example, by
the menu File/Open/Library of the Control Panel.

Click the Edit-a-Device icon and select the device 54%7032A from the
menu. The Device Editor opens.

Defining the Package Variant

The new variant should be named 7est. The package must have a mini-
mum of 14 pads because both gates together have 14 pins. As an exam-
ple, we take the SO 14 package from the smd-ipc.lbr library.

If Control Panel and Library Editor window are arranged side by side,
select the SO14 package and Drag&Drop it into the opened Library
Editor window. After releasing the mouse button you will be asked for
the new package variant name. Enter it and confirm it by clicking OK.
The new variant is now shown in the package list.

It is also possible to define the package variant in the Device Editor di-
rectly with the PACKAGE command.
Type in the command line:

PACKAGE SOl4@smd-ipc.lbr TEST
Or include the path (if necessary):

PAC SOl4@d:\eagle-4.1\1br\smd-ipc.lbr TEST
If the path contains spaces include the path name in single quotes, for
example:

PAC 'S014@\With Spaces\smd-ipc.lbr' TEST
Now on the lower right of the Device Editor window a new entry for
the package SO 14 and the variant name TEST appears.

On the left a black exclamation mark on yellow ground is shown which
indicates that there are no connections between pins and pads defined

yet.
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Device Editor: List of Package Variants

The PACKAGE command copies the complete package definition into the
current library and makes available the new variant with the given name
for the device.

If you decide to erase a newly defined variant you can do this with the
UNDO function (as far as possible) or by using the context menu of the
package entry (right mouse click, Delete entry).

Connect Command

Click the Connect button now. The Connect window opens (see image
one page 187). Connect pins with pads by clicking on the pin and pad
entries belonging together as described in paragraph 8.2.

It is also possible to adapt the pin/pad connections from an already ex-
isting package variant. In our example the assignment does not differ
from the DIL14 package. Therefore select the entry DIL14 from the
Copy from: combo box.

After clicking OK the CONNECT command is finished.
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Defining Technologies
The device 54%1032A is available in two technologies (ALS and AS).
These still have to be set up for the new package variant.

Select the package variant Test from the list on the lower right of the
Devcice Editor window. A click on Technologies in the description field
opens a window. Click the New button and set up technology ALS with
a following click on OK, and AS again with a following click on OK.
Both entries are shown with a tag now. A further click on the OK but-
ton closes the window again.

Save

The definition of the package variant is finished. Now it is time to save
the library.

Using a Modified Package from Another Library

If there is no appropriate but a similar package available in another li-
brary you should copy the package in the current library first, then
modify it, and use it afterwards as new variant for the device.

Copying the Package

We want to use a package named SOPI4 from the smd-ipc.lbr library
here. This package should get a new name, MYSOPI4, in the library
my _lib.1br.

Using the COPY command

Type in the command line of the Library Editor window (it does not
matter which editor mode is active) the following:

COPY SOPl4@smd-ipc.lbr MYSOP14
Or with the whole path:

COPY SOPl14@d:\eagle4.l\lbr\smd-ipc.lbr MYSOP14
If the path contains spaces use single quotes for it, for example:

COPY 'SOP14@\P A T H\smd-ipc.lbr' MYSOP14

The Package Editor window opens and the package can be modified as
needed.

In the Control Panel

First of all open a Library editor window with the library that should
contain the new package (File/Open/Library). It is not necessary to

select a certain editing mode. Now switch to the Control Panel (e. g.
Window menu) and expand the Libraries branch of the tree view.
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Choose the library which contains the requested package and select it.
On the right half of the Control Panel a preview of the package is visible

now.

If the Control Panel and the Library Editor window are arranged in a
way that both windows are visible you can move the packge into the li-
brary window by keeping the left mouse button pressed. After releasing
the mouse button (Drag&Drop) the Library Editor will be in the pack-
age editing mode. The package is shown there.

Alternatively you could use a right mouse click to open the context
menu of the package entry in the tree view. Select Copy to Library now.
The Library Editor needs not to be visible.

Now the package can be modified. The package name is adopted from
the source library. To change the package name use the RENAME
command.

Don't forget to save the library.

Defining the Variant

We want to define a further variant for our example device. Switch to the
Device editing mode, for example, by the menu Libraries/Device. The
Edit window opens. Select the entry 54%7032A. Click OK to open the
editor window.

Use the New button to define a new variant. Select the package
MYSOP14 in the selection dialog and enter, for example, TEST2 as
variant name. After clicking OK a new entry is shown in the package
list.

To complete the definition execute the CONNECT command and de-
fine Technologies (as described in the previous paragraph) now.

8.11 Defining Packages in Any Rotation

Components can be defined in any rotation with a resolution of 0.1 de-
grees in the Package Editor. Usually the package is definied in normal
position first and rotated afterwards as a whole. The definition of pack-
ages has been already explained in this chapter. Here we only want to
elaborate on the rotation of packages.

Packages can be defined in any rotation! Schematic symbols can be rotated
in 90-degrees steps only!
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Rotating a Package as a Whole

To come back to the example of this chapter, please open the library
my_lib.lbr and edit the package LCC-20.

Display all layers with DISPLAY ALL to make sure you have all objects
rotated. Now use GROUP and draw a frame around everything.

Use the ROTATE command to rotate the group:

Now click with the left mouse into the Angle box of the paramter tool-
bar and type in the requested angle. Then use a right mouse click into
the group to define the rotation point.

The package is shown now in the given angle.

Alternatively you can work with the command line:
ROTATE R22.5 (> 0 0)

rotates, for example, the previously selected group 22.5° further around
the point (0 0). The > sign (right angle bracket) within the parenthesis
for coordinates causes the rotation of the whole group (as a right mouse
click on the point (0 0) would do).

Packages with Radial Pad Arrangement

It is possible to work with polar coordinates to place pads or SMDs in a
radial arrangement. Set a suitable reference point, for example, in the
center of the package with the MARK command first. The command
line shows now additional information about the cursor position.

W& E s 26 @ . e El
B O O o % Dimeter:|aue J Cill: ‘0.032 || Angle: [0 =]
L EEnchp20005 [R020005 POz 1406) ]

Package Editor: Relative and Polar Coordinates Display

Values marked with an R are relative values referring to the previously
set reference point. The leading P indicates polar values referring to the
reference point.

Example:
Three pads are to be placed on the circumference of a circle with a radius
of 50 mm. The center of the part is at position (0 0).

GRID MM;

MARK (0 0);

PAD '1' (P 50 0);
PAD '2' (P 50 120);
PAD '3' (P 50 240);

Depending on the used pad shape it may be useful to place the pads ro-
tated (for example for Long pads or SMDs).

It is possible to enter the angle directly in the parameter toolbar or in
the command line while the PAD or SMD command is active.
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Example:

GRID MM ;
MARK (0 0);
PAD '2' LONG R120 (P 50 120) ;

8.12 Library and Part Management
Copying of Library Elements

Within a Library

If you want to use a symbol or a package which already exists in a re-
lated manner for a device definition you can copy it within the library
with the commands GROUP, CUT, and PASTE. Afterwards it can be

modified as requested.

The following sections explain every single step with the help of an ex-
ample package taken from linear.lbr.

Open Library

Use the menu File/Open/Library in the Control Panel to open the li-
brary linear.lbr or select the entry Open from its context menu of the
tree view's expanded Libraries branch.

Edit Existing Element

Open the Edit window with Library/Package and select the package
DIL08. After clicking OK it is shown in the Package Editor window.
Use DISPLAY to show all layers.

Draw a frame around all objects to be copied with GROUP.

Now click the CUT icon followed by a left mouse click into the group.
Alternatively you may enter a reference point in the command line for
CUT, as for example:

CUuT (0 0) ;

Define New Element

Click the Edit-a-package icon in the action toolbar. Enter the name
DILO8-TEST in the New field of the Edit window and confirm with
OK.

Click the PASTE icon followed by a click at the drawing's reference
point. The package will be placed.

Or use again the command line:
PASTE (0 0) ;

205





EAGLE Manual

Now it can be modified as requested.

The given coordinates for CUT and PASTE can be used to move a
group by a certain value in the coordinates system. This may be valuable
for elements that have been drawn in the wrong grid.

This procedure can be applied to symbols too!
Devices can't be copied within a library!

From One Library into Another

Devices

If there is a proper device or Device set that you want to use in your
current library you can copy it in two different ways.

In the Control Panel:

Move (with Drag&Drop) the requested Device set from the Control
Panel's tree view into the opened Library Editor window. The complete
Device set with symbol(s) and package(s) will be copied and newly de-
fined.

As an alternative you could use the entry Copy to Library in the context
menu of the device entry.

With the COPY command:

Type, for example,

COPY 75130@751xx.lbr
or with the whole path

COPY 75130@d:\eagle-4.1\1br\751xx.1lbr
in the command line, the Device 75130 from library 751xx.lbr is copied
into the currently opened library.
If the path contains spaces use single quotes for it, for example:

COPY '75130@d:\P A T H\751xx.lbr'
If the Device should be stored in the current library under a new name
simply enter it, like here:

COPY 75130@751xx.lbr 75130NEW

Symbols

As symbols are not shown in the tree view of the Control Panel it is not
possible to copy them from there into the Library Editor.

Symbols are copied from one library into another the same way as one
would do it within the same library. Therefore we use the commands

GROUP, CUT, and PASTE (see previous paragraph).

The only difference to copying a symbol within a library is that you have
to open the other library (File/Open) after CUT and click into the
group. Then you define a new symbol that may have the same or an-
other name as before.
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In short:
* OPEN the source library and EDIT the Symbol
* DISPLAY all layers
* Select all elements with GROUP
* Use CUT and click into the group to set a reference point
* OPEN your target library with File/Open
* EDIT a new Symbol
* Use PASTE to place it

* Save library

Packages
The procedure to copy packages is nearly the same as to copy devices.

Either move (with Drag&Drop) the requested package from the Con-
trol Panel's tree view into the opened Library Editor window. The com-
plete package will be copied and newly defined in the current library. As
an alternative you could use the entry Copy to Library in the context
menu of the package entry.

Or use the COPY command. Type, for example,
COPY DIL16@751xx.1lbr
in the command line, the package DIL16 from library 75xx./br is copied

into the currently opened library. If the library is not in the current
working directory you have to enter the whole path, as for example, in:

COPY DIL16@\eagle-4.1\mylbr\751xx.lbr
If the path contains spaces use single quotes for it:

COPY 'DIL16@D:\P A T H\mylbr\751xx.lbr’'
If the package should be stored in the current library under a new name
simply enter it directly in the command line:

COPY DILl16@\eagle-4.1\mylbr\751xx.lbr DIL16NEW
The package is stored with the new name DIL1I6NEW now.

If you want to copy a package that already exists with the same name in
the target library the package will be simply replaced.

If the package is already used in a device and the position or the name of
one or more pads/SMDs changes, EAGLE prompts a message in which
mode the pads/SMDs are to be replaced. This procedure can also be can-
celled. The package remains unchanged then.

If the enumeration and position of the pads are unchanged but the order
is, EAGLE will ask you for the appropriate update mode. Depending on
your selection the pin/pad connections of the device may change (see

CONNECT command).
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Update Library

A different version of package DIL14 iz already prezent in this file,

Since there are differences in the pads, they will be replaced bwy...

" Mames

" Coordinates

Ok to update with new vergion’?

Cancel

Requesting the Update Mode

Composition of Your own Libraries

The previously mentioned methods to copy library elements make it
very easy to compose your own libraries with selected contents.

Provided the Control Panel and the Library Editor window are arranged
in a manner that both are visible on the screen at the same time, it is very
easy to make user-defined libraries while browsing through the library
contents in the Control Panel. Simply use Drag&Drop or the context
menu Copy to Library of the current device or package.

Removing and Renaming Library Elements

Devices, symbols, and packages can be removed from a library with the
REMOVE command. Defining a new library element can't be cancelled
by UNDO.

Example:

You would like to remove the package named DIL16.

Open the menu Library/Remove.... A dialog window opens where you
can enter the name of the element to be deleted.

This can be done also at the command line:
REMOVE DIL16;

Packages and symbols can be removed only if they are not used in one
of the library’s devices. In this case the message Package is in use! or
Symbol is in use! appears. Remove the corresponding device first or de-
lete the particular package or symbol in the device (set).

Would you like to change the name of an element in your library? Then
use the RENAME command.

Switch to the Package editing mode so that the element that should be
renamed is shown first and open the menu Library/Rename. A dialog
window opens where you can enter the new name of the element.
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This can also be done at the command line:
RENAME DIL16 DIL-16;
The package DIL16 gets the new name DIL-16.

The device, symbol, or package name may also be given with its exten-
sion (.dev, .sym, .pac), for example:

REMOVE DIL16.PAC

In this case it is not necessary to switch to the related editing mode
before.

Update Packages in Libraries

As already mentioned in the section Copying of Library Elements it is
possible to copy packages from one library into another one. An already
existing package is replaced in that case.

Each library contains packages which are needed for device definitions.
In many libraries identical types of packages can be found. To keep them
uniform over all libraries it is possible to replace all packages of a library
with those of another library with the help of the UPDATE command.
An existing package with the proper name will be replaced by the cur-
rent definition.

If you have, for example, special requirements for packages you could
define them in a custom-built package or SMD library. The UPDATE
command could transfer them to other libraries.

Therefore open the library to be updated und select Library/Update....
Now select the library which you want to take the packages from.

Having finished the update EAGLE reports in the status bar:
Update: finished - library modified!

If there was nothing to replace: Update: finished - nothing to do.
It is also possible to use the commad line for this procedure.

If you want to update your library with packages from, for example,
dil.Ibr, type:

UPDATE dil.lbr

To transfer packages from different libraries, type in one after another:
UPDATE dil.lbr smd.lbr special.lbr

To update a single package, type in the package name:
UPDATE S014@smd

The extension ./br is not necessary. You may also use the whole library
path. See page 207 for further information.
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Chapter 9
Preparing the Manufacturing Data

There are pcb firms who need only the EAGLE board file in order to
manufacture films or prototypes. You will find links to such firms on
our Internet pages.

If however your board maker is not set up to process EAGLE board
files directly, you will have to supply him with a set of files. You generate
these with the aid of the CAM Processor.

You obtain a parts list if, for instance, you load your schematic diagram
into the editor and execute the User Language program bom.ulp with
RUN. See also page 230.

Additional useful ULPs are available on CadSoft’s Internet pages and on
the current EAGLE-CD-ROM. They can be used, for example, for the

generation of glue masks, for the calculation of milling contours, or for
the output of data for automatic mounting and testing equipment.

9.1 Data for Board Manufacture

Gerber Format

Nowadays most pcb manufacturers use Gerber photoplotters with vari-
able aperture wheels. In contrast to photoplotters with fixed aperture
wheels, no agreement about the aperture table is required between you
and the film maker.

Please inquire which format is desired. The simplest way is the RS-274X
format, in which the aperture table is integrated into the output file. The
generation of the data is just as easy as it is for PostScript or any other
printer. Use the GERBER_RS274X driver for this. There is a predefined
job file, gerb274x.cam, for easy generation with the CAM Processor.
This job can be modified so suit your own requirements. Please read the
following chapters describing how to modify or extend jobs with, for
example, gerber.cam.
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RS-274D, or subsets of it, is the commonest format, which can be gene-
rated with the CAM Processor. Therefore choose the devices GERBER
and GERBERAUTO. In this case a file with the associated aperture ta-
ble must be supplied, in addition to the files with the plot data. All the
further explanations in this section are based on this format.

Drill Data

The generation of drill data is very similar to the generation of photo-
plot data. The aim is to create files which are sent to the board manufac-
turer. The appropriate device drivers are SM1000, SM3000, and
EXCELLON resp. EXCELLON_RACK. A drill configuration has to
be defined before an output can be generated. The manufacturer must
know this configuration, otherwise he cannot drill the proper holes. It is
therefore advisable to send the drill rack configuration file along with
the drill data file(s) to the manufacturer.

Since EAGLE 4.11r2 the EXCELLON device writes the rack file infor-
mation into the drill data file automatically. So you do not have to care
about the rack file as it was in previous versions with the EXCELLON
device.

The device EXCELLON_RACK works with a separate rack file as it is
with SM1000 and SM3000 (and was with EXCELLON in earlier
EAGLE versions).

EAGLE generates drill holes for the objects pads, vias, and holes. The
appropriate data for pads and vias (plated-through holes) are generated
if layer 44, Drulls, is active during the CAM Processor output session.
The data for holes (with no contact between different layers) are gener-
ated if layer 45, Holes, is active. Both layers must be active if all holes
should be drilled together. If they should be drilled separately, either the

Holes or the Drills layer must be active, and two separate files created.

A tolerance can be specified for drills. In such cases please make sure
that your Design Rules are maintained.

The Rotate option given in the configuration is useful if the board ap-
pears in the Layout Editor in landscape format.

Data for Milling Machines

Data used by milling machines are normally drawn in layer 46, Milling.
This is where, for example, the contours of board cut-outs are drawn.
The output is made via the CAM Processor in Gerber or HPGL format.
Agree the required format with your board manufacturer beforehand.

You can generate outline data for milling a prototype board with the
help of the User Language programs.
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A simple example ist the outlines.ulp. Start it with the RUN command.
Start the ULP with the RUN command.

Select the layer for which outline data will be generated, define the dia-
meter of the milling tool, and select the output file format (script file
format or HPGL, further formats will follow) in the ULP's dialog win-
dow. The script file containing the outline data can be imported into
EAGLE with the SCRIPT command. In this case use the CAM Proces-

sor to generate manufacturing data.

The ULP executes the following steps:

* Drawing a polygon with the name _OUTLINES_ in the selected
layer over the whole board area

* Setting the properties of the polygon:
Rank = 6
Width = diameter of milling tool

* Computing the polygon; the filling defines what has to be milled
out

* Generating output data
* Deleting the polygon in the layout

Further information can be found in the help function, Outline data.

There is a further User Language program mill-outlines.ulp that gener-
ates outline data. This one offers, compared to outlines.ulp some more
configuration parameters.

Data for Component Insertion Machines

EAGLE includes some ULPs which create data for various component
insertion machines and in-circuit testers. In the eagle/ulp directory you
will find various programs of this type (e.g. mount _smd.ulp, fabmas-

ter.ulp, unidat.ulp).

To start an User Language Program use the RUN command in the Lay-
out Editor.

9.2 Which Files does the Board Maker Need?

Files Generated with the CAM Processor

The following list contains the files which should be generated for the
four-layer board demo.brd. In this example Layer 2 is a normal inner
layer with various signals. Layer 3 is a supply layer for the GND signal,
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which the user has renamed to $GND in accordance with EAGLE’s
naming convention for supply layers. The filenames are suggestions.
You are, of course, free to use unequivocal names of your own
definition.

The options given in the list are recommendations, which in some cases
can be changed.

File Active Comments/recommended options
layers
demo.cmp Top Component side.
Via Options: pos. coord., optimize, fill pads.
Pad
demo.ly2 Via Multilayer inner layer.
Pad Options: pos. coord., optimize, fill pads.
demo.ly3 $GND Multilayer supply layer.

Is automatically output inverse.
Options: pos. coord., optimize.

demo.sol Bottom Solder side.
Vias Options: pos. coord., optimize, fill pads.
Pads

demo.plc tPlace Component side silkscreen.
Dimension  Options: pos. coord., optimize.
tName

demo.pls bPlace Solder side silkscreen.
Dimension  Only needed if there are components on the
bName underside

Options: pos. coord., optimize.

demo.stc tStop Component side solder mask.
Options: pos. coord., optimize.

demo.sts bStop Solder side solder mask.
Options: pos. coord., optimize.

demo.crc tCream Component side cream frame.
Options: pos. coord., optimize.

demo.crs bCream Solder side cream frame.
Only required if there are SMD components
on the bottom side
Options: pos. coord., optimize.

demo.drd Drills Drilling data for NC drilling machines.
Holes Options: (rotate), pos. coord., optimize.
demo.drd.xxxx Drills Drill data for multilayer boards for distinction of
Holes via lengths of blind and buried vias.

Optiones: (rotate), pos. coord., optimize.
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Additional Information for the Board Manufacturer

You must also supply the service company with the configuration files
for apertures (name.whl) and drills (name.drl). You can also include the
board file name.brd. This can help to avoid problems with what can be-
come time-consuming questions.

In general, alignment marks (which are for example defined in layer 49,
Reference) or an information field (in, for example, layer 48, Documen-
tation) can be included.

A text file, such as demo.txt, should contain instructions for the board
manufacturer.

9.3 Rules that Save Time and Money

* Each layer should without fail be uniquely identified (e.g. CS for
Component Side).

* For cost reasons you should, if at all possible, avoid track that nar-
rows to below 8 mil.

* Only angles should be drawn at the corners to delimit the board.
Closed borders can lead to manufacturing difficulties.

* You should always leave at least 2 mm (about 80 mil) around the
edge of the board free of copper. In the case of supply layers on
multilayer boards, which are plotted inverse, you do this by draw-
ing a wire around the edge of the board.

* As already mentioned, text in copper layers ought to be written in
vector font. So you can really be sure that the text on your board
looks the same as it does in the Layout Editor window.

* For the sake of completeness we want to point out here again that
all questions concerning layer setup, layer thickness, and drill di-
ameter for multilayer boards with blind, buried, or micro vias have

to be pre-examined.

9.4 Generating the Data with Ready-Made
CAM Jobs

The CAM Processor provides a job mechanism with the aid of which
the creation of the output data for a board can be automated.

The Control Panel's tree view (CAM Jobs branch) lists all jobs and
shows a brief description.
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Gerber.cam Job for Two-Layer Boards

The gerber.cam job uses the GERBERAUTO and GERBER drivers.
These generate files in the RS-274D format. It is set up for two-layer
boards which are to receive a solder stop mask on the component and
on the soldering side, and is to receive a silkscreen print.

Load the job by double-clicking on the gerber.cam entry in the tree view
of the Control Panel.

In the first step an aperture table name.whl is automatically generated.
Two messages appear, which you confirm with OK.

I | = Warning £
\i;) Delete name. $3% after job has been processed & tare than 1 signal layer activel

Cancel | Cancel |

Gerber job messages

The first message is generated by the entry in the Prompt field, and re-
minds you to delete the temporary files created when generating the ap-
erture table when the job is done.

The second message advises you that more than one signal layer is active
at the same time. Normally only one signal layer is active while output is
generated. However, when generating the wheel, all the layers need to
be active at the same time in order to form a common aperture table for
all Gerber output.

Data for the following layers is subsequently output:

name.cmp component side

name.sol solder side

name.plc Silkscreen

name.stc Solder stop mask, component side
name.sts Solder stop mask, solder side

If other layers are also to be generated, e.g. silkscreen for the bottom
side, or a solder cream mask, the Gerber job can be extended as
required.

Extending the job is discussed later in this section.

Job rs274x.cam

This job can be used as an alternative to gerber.cam if the circuit board
manufacturer uses the Extended Gerber format. In contrast to ger-
ber.cam, a separate aperture table is not created. The various Gerber files
are simply output one after another. Each file contains aperture defini-
tion and Gerber data.
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Drill Data

The CAM Processor offers the usual output devices for drill data, like
Excellon, SM1000, and SM3000.

Job excellon.cam

The easiest way to generate drill data is to use the pre-defined CAM job
excellon.cam. Used with the CAM Processor a file that contains drill
data and the respective drill table will be generated automatically.

Proceed as follows:
* Start the CAM Processor (for example File/ CAM Processor).
* Load the board into the CAM Processor (File/ Open/Board) if it

was not loaded automatically during the start sequence.
* Load the predefined job excellon.cam, e.g. with File/ Open/]ob.
* Execute the job (Process Job).

* Send the files name.drl and name.drd (for layouts with blind and
buried vias name.drd.xxxx) and perhaps the info file name.dri as
well to your boardhouse.

4 CAM Processor - G:\eagle'411'cam"excellon.cam - EAGLE 4.12 N [=] ]
File Layer Window Help
Generate diill data |
b T
Section Iﬁenerale diill data I~ Mimar A4 Dills
45Holes
Prampt | [~ Rotate
[ Upside down
- el ¥ pos. Coord
Devies [~ | Buickplat
| Dptimize
Fil || drd ¥ | Fill padls
—Oftset
# IDinch
e IUinch
Process Job | Frocess Sectiunl [rescription | Add | Dl |
Gifeagle-4. 11 Projektejexamples/lg_01dsp.brd 4

CAM Processor: Generate drill data with the excellon.cam job

The EXCELLON device combines drill table and drill coordinates in
one common file. The default unit for the drill table is inch.

If the drill table would be preferred in millimeters the device definition
can be changed in the file eagle.def. More details concerning this can be
found in the section Units for aperture and drill tables.
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Further output devices

If you prefer drill data in another data format like Sieb&Meyer 1000 or
3000 (SM1000, SM3000) or to work with the Excellon format that
EAGLE used in its previous versions with a separate rack file (now
device EXCELLON_RACK) a drill table is required first. This is cre-
ated from the Layout Editor by means of a User Language program. The
drill data is then output with the CAM Processor.

You proceed as follows:

* Load the board into the Layout Editor.

* Execute the drillcfg.ulp User Language program with the RUN
command. It generates the boardname.drl drill configuration file.

* Start the CAM Processor (e.g. File/ CAM Processor).
* Load the board into the CAM Processor (File/Open/Board) if it

was not loaded automatically during the start sequence.
Load the predefined job excellon.cam, e.g. with File/Open/Job.

Check the parameters and change the output device to
EXCELLON_RACK, SM1000, or SM3000. A tolerance of

+ 2.5% makes sense to avoid problems due to internal unit con-
versions. Only the layers 44, Drills, and 45, Holes, may be selected.
No other layers! You can display the selected layers by clicking
Layer/Show selected.

After changing the output device the CAM Processor demands for
a Rack. Type in the file extension .drl. The CAM Processor now
looks for the previously generated rack file in the same directory
as the board file is.

* Save the job file via File/Save job with a new name.
* Execute the job (Process Job).

* Send the files name.drl and name.drd (perhaps name.dri as well) to
your boardhouse.

Drill Data for Multilayer Boards With Blind and BuriedVias

The CAM Processor generates one drill data file for each via length for a
layout that uses blind and buried vias.

The file extension .drd is expanded by the via length specification. If
there are, for example, vias from layer 1 to 2, the output file extension
will be .drd.0102.

The layer specification can be moved to another position with the help
of the wildcard %L. Writing, for example, in the File box of the CAM

Processor .%L.drd results in an output file with the file extension
.0102.drd.

218





Preparing the Manufacturing Data

Pads and trough vias will be written into the output file with extension
.drd.0116. If you have placed holes (HOLE command) in the layout and
the Holes layer is active for output, the CAM Processor writes these val-
ues also in the same file with extension .drd.0116.

Your boardhouse finally gets the common rack file name.drl which is
generated by drillcfg.ulp, provided you did not use the EXCELLON de-
vice which combines drill table and drill coordinates in a common file,
and all files name.drd.xxxx containing the drill coordinates for each via
length. Maybe also the common info file name.dri.

Drill configuration file (Rack)

This file is usually created by means of a ULP (drillcfg.ulp). It is of
course also possible to use fixed drill table with the aid of a text editor.
Then enter the table’s path and filename in the CAM Processor’s rack
field. The rack file usually has dr/ as its extender.

TO1 0.010
T02 0.016
TO3 0.032
TO04 0.040
TO5 0.050
TO06 0.070

Example of a drill configuration file:

All dimensions are given here in inches. It is also possible to enter the
values with their unit, e.g. 0.010in or 0.8mm. Comments in drill con-
figuration files are identified by a semicolon, which may stand at the
start of a line or be preceded by a space.

Drill Info File

The file name.dri contains the missing drill diameters and other impor-
tant information. It is written into the same directory as the output file.
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9.5 Set Output Parameters

This section describes the setting of the parameters for the output of a
drawing or a file, which will then be started with the button Process job
or Process section. The parameters for a section, as described below, are
set in the same way.

Load the schematic or board file from the CAM Processor’s File/ Open
menu, and set the following parameters:

* Select the driver for the desired output device in the Device combo
box.

* Enter the output data in the File field.
If output is to go directly to a plotter, enter the name of the print
queue that is connected to the corresponding computer interface
in UNC notation, e.g.
\\Servername\ Plottername.
If, under File, Wheel, or Rack, you only give the dot and the file
extension, the entry will be expanded with the name of the sche-
matic or layout file that is loaded.
Example: .cmp is expanded to boardname.cmp.
See also the section on the Names of the Output Files.

Select the output layers by clicking the appropriate layer number.
Click the menu Layer/Deselect all to first uncheck all the layers.
Layer/show selected displays only the currently selected layers.

Set device-specific parameters (aperture wheel etc.).

Selecting the Gerber device driver, for example, invokes the Wheel
field. Here you have to input the path to your aperture list. If you
want to generate drill data (devices: EXCELLON_RACK,
SM1000, SM3000), EAGLE asks for a drill table in the Rack field
(see also page 212, Drill data).

Set flag options.

Mirror:

Mirrors the output

Rotate:

Rotates the output by 90 degrees.

Upside down:

Rotates the output by 180 degrees. When combined with Rozate,
the drawing is rotated by a total of 270 degrees.

Pos. Coords.:

Offsets the output so that negative coordinates are eliminated and
the drawing is referenced to the origin of the output device. This is
advisable for devices which generate error messages if negative co-
ordinates are detected. The default is on.

Quickplot:

Draft output which shows only the outlines of objects. This op-
tion is not available for all devices.

Optimize:

Activates the optimization of the drawing sequence for plotters.
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Fill Pads:

Pads will be filled. This option is on for generating manufacturing
data.

Devices of the generic type (see eagle.def), for example PostScript,
allow to deactivate this option. The drill holes for pads will be visi-
ble on the output.

* Select sheet (for schematics only):
Use the Sheet combo box as far as the schematic consists of more
than one page.

9.6 Names of the Output Files

The extensions for the output files given in the table on page 214 are
only suggestions. If you are defining a job for Gerber data, which gener-
ates all the files with these extensions, the information file (*.gp7) will be
overwritten with each succeeding section. If you want to supply infor-
mation files to your photoplotting service, proceed as follows:

For output, enter either name.xx# or .xx#.

Here, name stands for any name, and xx stands for any characters (that
are allowed in file names).

The output files generated will look like this:

name.xx# results in name.xxx, the info file will be named name.xxi,
xx# results in boardname.xxx, the info file will be named boardname.xxi.

The files will be written into the same directory as the board file is.

Example:

The board myboard.brd is loaded. .cp# is entered into the File field.
The output file is called myboard.cpx, and the information file is called
myboard.cpi.

The file extension can have any length. The # character must occupy
the last place of the extension.

Please ensure when defining a job that the extensions of the output file
for each section are unique and therefore distinguishable.

If you want to output a file on a particular drive, place the drive
identifier or, if appropriate, the path in front of the filename ending. For
instance, under Windows, d:\.cmp would place the file boardname.cmp
in the root directory of drive D. This also applies to the Linux version,
so that, for example, /dev/hdc2/.cmp, would place the file on drive hdc2.
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.+ 4 CAM Processor - R:/home/ric/eagled/cam/gerber. cam
File Layer Window Help

Generate awheelfile | Comporentside | Selder side | Sik screen CMP | Solder stop mask CMP | Solder stop mask SOL |

Job Style
Sectiop | Solder side M Miror

I Rotate
Prompt ‘ i

™ Upside down
Dutput ¥ pos. Coord
Device [ sERBER =l I=| Guickplat

_wheal |[ i M Opinize
¥ | Fill pads
File | sol

Emulate
Dffset Tolerance [~ Apertures
3 | Oinch Diraw - ‘1"/\, . |1z ™ Annulus
| Tinch Flash - ‘12 . |12 ™ Themal
Process Job | Process Section | Description | Add ‘ Del ‘

[:/eagle/democmp. brd

CAM Processor: Solder side section of the gerber.cam job.

The diagram shows the ending .wh! in the Wheel line for the aperture ta-
ble. This means that the file democmp.whl is looked for. The output
(File) receives the name democmp.sol. The flag options Optimize and
Pos. coords. are active.

A tolerance of + 1% is permitted for the aperture selection. This is nec-
essary in order to compensate for small roundmg errors (of around
0.00005 inch) that can arise during the conversion from mm to inch val-
ues as the aperture table is generated.

The status line below shows which layout is loaded.

9.7 Automating the Output with CAM
Processor Jobs

Defining a Job

A job consists of one or more sections. A section is a group of settings,
as described above in the Set Output Parameters chapter, which defines
the output of one file. In this way you can use a job to generate all the
files that are necessary for a project.

You define a job as follows:

¢ Start the CAM Processor. No job is loaded at first, unless there is
a file called eagle.cam in the cam directory.

¢ Click on the Add button and enter a name for the section which is
to be defined.

If, for example, you assign the section name Wheel: Generate Aper-
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ture File, only the title Wheel is visible as a tab name. The addi-
tional description can be read in the section line. The colon ends
the title in the tab.

* Make a complete set of parameter settings. That means you have
to select the Device, to activate the appropriate layers, to select the
output, to set the scale factor if needed, and to check the flag op-
tions (Mirror, Rotate, Upside Down...).

* In the prompt field enter a message which is to appear on the
screen before execution, should you so wish.

* Define further sections in the same way using different names.
Very important: First use Add to create a new section, then set the
parameters.

* Delete a section if needed by clicking the Del button.

* Save all the sections of a job under a name of your choice (with

File/Save job.. ).

You can load a job through the tree view of the Control Panel (the CAM
jobs entry) or via the File/Open/Job menu in the CAM Processor.

To generate the output for a particular board, the file must be loaded via
the CAM Processor’s file menu (File/ Open/Board).

All the sections of the job will be executed if you click the Process job
button.
A specific section will be executed if you click the Process section button.

The Description button allows a description of the CAM job that will be
displayed in the Control Panel.

Extending gerber.cam Job for Multilayer Boards

The gerber.cam job can be used as the basis of the job for multilayer
boards. It must simply be extended for the additional layers.

Example: You want to output the files for a board with SMD compo-
nents on the top and bottom sides, a supply layer §GND in Layer2, and
another inner layer with a polygon VCC in Layer 15 (which is renamed
to VCC).

You need silkscreen prints for the upper and lower sides, solder stop
masks, and a mask for the solder cream for both sides.

Before you start to change the CAM job you should save the job under a
new name through the File/Save job as.. menu.

The CAM job then contains the following sections:

1. Creating the aperture table with the GERBERAUTO driver.
All the layers which will be needed in later sections must be activated
here.
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2. Section for the component side (already contained in
GERBER.CAM). You create the output files:

name.cmp Layers: Top, Pads, Vias

3. Solder side (already contained in gerber.cam):
name.sol Layers: Bottom, Pads, Vias

4. Silkscreen print, component side (already contained in gerber.cam):
name.plc Layers: tPlace, Dimension, tNames

5. Silkscreen print, solder side (already contained in gerber.cam):
name.pls Layers: bPlace, Dimension, bNames

6. Supply layer $GND (new in gerber.cam):
name.ly2 Layers: $GND

7. VCC inner layer (new in gerber.cam):
name.l15 Layers: VCC, Pads, Vias

8. Solder stop mask, component side (already contained in gerber.cam):
name.stc Layers: tStop

9. Solder stop mask, solder side (already contained in gerber.cam):
name.sts Layers: bStop

10. Solder cream mask, component side (new in gerber.cam):
name.crc Layers: tCream

11. Solder cream mask, solder side (new in gerber.cam):

name.crs Layers: bCream

Check once more whether all the necessary layers for the creation of the
aperture table are active in the first section. The output file generated in
the first section cannot be used. For this reason, the file name.$$3

should be deleted.

Layers that refer to the bottom side of your layout will be generated
mirrored in all predefined job files. If your board house recommends
non-mirrored files, please deactivate this flag option for each section.

If you want to generate output files for supply layers with one signal (here
$GND), you must only select the inner signal layer. No pads, no vias!

For other inner layers that may contain polygons you have to select addi-
tional pads and vias layers (as you would also do for the top or bottom
side).

If the Layer Setup defines blind and buried vias, the combination of one
signal layer and the Vias layer shows (according to the via length) only
those vias that belong to this signal layer. If there is only the via layer active
(no signal layer) the CAM Processor will output all vias of the layout.

224





Preparing the Manufacturing Data

9.8 Gerber Files for Photoplotters with Fixed
Aperture Wheels

This section goes into more detail on the definition of the aperture
table. Some circuit board manufacturers may perhaps still be using a
Gerber plotter that works with a fixed aperture wheel. In such a case it is
necessary to adapt the aperture table to the restricted facilities of the
Gerber plotter. Files for Gerber photoplotters with fixed aperture
wheels are generated with the GERBER driver. It is essential to confer
with your photoplot service bureau in good time, so as to adjust
EAGLE to the available apertures.

There are various types of apertures. They differ in size and shape. The
most common are circle, octagon, square, thermal and annulus symbols.
The drawing aperture used for tracks is normally the round aperture.

You must specify the aperture configuration before you can generate
files for a fixed aperture wheel photoplotter.

To do this, enter the configuration file for apertures name.whl e.g. with
the EAGLE text editor, and then load this file into the CAM Processor
by clicking the Wheel button after selecting the GERBER device driver
(see also the Set Output Parameters section, page 220).

The CAM Processor normally chooses the aperture from the configura-
tion file appropriately for each object. For each line, a draw aperture
must be present with the appropriate diameter. For each symbol (e.g.
pad) an aperture with the correct shape and size is required. If this is not
available, no output file will be produced.

Info File

The apertures which have not been found are then listed in the file
name.gpi, where name here stands for the name chosen for the output

file.

You can then change your board in such a way that the existing aper-
tures can be used. After generating plot or drill files you should always
check the related info files.

Aperture Emulation

If objects exist in a drawing which are not compatible with the available
aperture sizes, it is possible to emulate the desired dimensions by select-
ing the Emulate Apertures option. The CAM Processor then selects
smaller apertures to emulate dimensions which are not matched by aper-
ture sizes. Emulation results in longer plot times and higher costs, so it
should be avoided whenever possible.
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Thermal or annulus apertures are only emulated with draw apertures if
the Emulate Thermal or Emulate Annulus options, respectively, are acti-
vated.

The file name.gpi indicates the need for emulation and which apertures
must be emulated.

Arcs with flat caps (CHANGE CAP FLAT) will always be emulated
and drawn with short small wires (draw aperture). Arcs with round caps
won't be emulated.

Aperture Tolerances

If you enter tolerances for draw and/or flash apertures, then if the aper-
ture with the exact value is not available the CAM Processor will use ap-
ertures within the tolerances. Please bear in mind that your Design
Rules might not be observed as a result of allowing tolerances!

Refer to file name.gpi for tolerances used.

Defining the Aperture Configuration

The CAM Processor distinguishes DRAW apertures from FLASH aper-
tures. The first type is used to draw objects (e.g. tracks). The second
type is used to generate symbols (e.g. pads) by a light flash. Only if
draw apertures are defined can the plotter draw lines. Therefore, if the
plotter doesn’t distinguish between draw and flash apertures, you must
additionally define round or octagonal apertures as draw apertures.

The following apertures are available:

Name Dimension

Draw diameter

Round diameter

Square length

Octagon diameter

Rectangle length-X x width-Y

Oval diameter-X x diameter-Y
Annulus outside diameter x inside diam.
Thermal outside diameter x inside diam.

Use of Aperture Shapes in the CAM Processor:

Draw draws wires and emulates
apertures

Round draws round pads and vias

Square draws square pads, SMDs and vias

Octagon draws octagonal pads and vias

with the same X- and Y-dimensions
Rectangle draws rectangles and SMDs
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Oval draws octagonal pads with
different X- and Y-dimensions

Annulus draws isolation rings in a supply
layer

Thermal draws connections in a supply
layer

Aperture configuration file example:

D001 annulus 0.004 x 0.000
D002 annulus 0.005 x 0.000
D017 annulus 0.063 x 0.000
D020 round 0.004
D033 round 0.059
D040 square 0.004
D052 square 0.059
D054 thermal 0.090 x 0.060
D057 thermal 0.120 x 0.080
D105 oval 0.090 x 0.030
D100 rectangle 0.060 x 0.075
D101 rectangle 0.075 x 0.060
D110 draw 0.004
D111 draw 0.005

All values default to inches, unless a unit is added (e.g. 0.010in or
0.8mm). Comments are marked with semicolons at the beginning of a
line, or with a semicolon following a blank character.
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9.9 Device Driver in File eagle.def

Creating Your Own Device Driver

Output device drivers are defined in the eagle.def text file. Here you will
find all the information that is needed for the creation of your own de-
vice driver. The best way is to copy the block for an output device of the
same general category, and then alter the parameters where necessary.

Please use a text editor that does not introduce any control codes into

the file.

Here is an example for a Gerber(auto) device that generates data in mm
units:

[GERBER_MM33]

Type = PhotoPlotter
Long = “Gerber photoplotter”
Init = “G01*\nxX000000Y000000D02*\n"”
Reset = “X000000Y000000D02*\nM02*\n"”
ResX = 25400
ResY = 25400
Wheel = W
Move = “X%06dY%06dD02*\n"” ;o(x, y)
Draw = “X%06dY%06dD01*\n"” ;o(x, y)
Flash = “X%06dY%06dD03*\n” i (%)
Units = mm
Decimals = 4
Aperture = “%s*\n” ; (Aperture code)
Info = “Plotfile Info:\n”\
“\n”\
“ Coordinate Format : 3.3\n”\
“ Coordinate Units : 1/1000mm\n”\
“ Data Mode : Absolute\n”\
“ Zero Suppression : None\n”\
™ End Of Block : *\n”\
“\n”

[GERBERAUTO MM33]

@GERBER MM33

Long = “With automatic wheel file generation”
Wheel = “ ; avoids message!
AutoAperture = “D%d” ; (Aperture number)

FirstAperture = 10
MaxApertureSize = 2.0
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Units in the Aperture and Drill Table

When automatically generated with the GERBERAUTO driver, the ap-
erture table contains values in inches. This is also the case for the drill
table which is automatically written into the drill data file with the out-
put device EXCELLON.

If your pcb manufacturer insists on mm units for aperture sizes and drill
diameters, you can achieve this by altering the GERBER or
GERBERAUTO respectively the EXCELLON driver.

In order to do this, use a text editor (one that does not introduce any
control codes) to edit the eagle.def file. Look for the line

[GERBER]
or
[GERBERAUTO]
and at the end of that section add/edit the lines:
Units = or Decimals =
Example:
Units = mm
Decimals = 4

To avoid problems arising from rounding errors during the conversion,
a tolerance of 1% should be allowed for draw and flash apertures.
To change the drill table units there, look for the line:

[EXCELLON]

and change:

Units = Inch to Units = mm

9.10 Film Generation Using PostScript Files

Whereas, until a few years ago, Gerber files almost exclusively had to be
generated for the manufacture of professional pcb films, there are today
PostScript raster image recorders which offer a high-quality alternative
which is simple to handle and economical.

With the PS driver, the CAM Processor generates files in PostScript for-
mat. These can be processed directly by appropriate service companies
(most of which operate in the print industry).

For PostScript recorders the Width and Height parameters should be set
to very high values (e.g. 100 x 100 inches), so that the drawing is not
spread over several pages.

Films and drawings that relate to the bottom side are usually output in
mirrored form (Mirror option in the CAM Processor or in the PRINT
dialog).
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The EPS driver generates Encapsulated PostScript files, and these can be
further processed with DTP programs.

9.11 Documentation

Many documentation items can be generated with the aid of User Lan-
guage programs. You can find a description of a ULP in the User Lan-
guage programs branch of the tree view in the Control Panel, or at the
start of a ULP file itself. In that case, examine the ULP with a text edi-
tor.

Note also the wide range of programs that are made available on our
web server.

Parts List

The parts list can be created by a number of User Language programs.
One very convenient program for the generation of the parts list is
bom.ulp. Start it from the schematic diagram editor, using the RUN
command. The Bill Of Material window with the parts summary opens

first.
B Eagle: Bill Of Material 0]
Part |Value | Device ‘ Package | Description |
Cl1 30p C-EUCT 206 C1208 capacitor EUrop Symbal
C2  30p C-ELCT 206 C1206 capacitor EUrop Symbal

C3 10n C-EL025-028+000 CO025-025-000 capacitor EUrop Symbal
C4 47025 CPOL-TAPS-45  TAPS45 polarity capacitor [T antalum, Electralyt] Elrop Symbal
C5  4Fu CPOL-TAPS-45  TAPS-45 polarity capacitor [T antalum, Electrolyt) Elrop Symbol

01 1M4148 1H4148 Do3as10 1H4148 - High Conductance Fast Diode
IC1 1EF8450 S0-18L
JF1 PROG  PINHD-1x4 1204
P2 APPL PINHD-1x1T 117
o HTALS 05
A1 22k R-EU_R1208 R1206 rezistor Elrop Symbol
U1 FALOE  FELWE T092 positiv voltage regulator / low power TOS2
Database: Load New
Ligt type Olutput format
v Parts & Text
™ Walues  HTML

Edit | Wiew | Save | Help | Claze |

bom.ulp: Dialog window

It is possible to import additional information from a database into the
parts list (Load), or to create a new database with its own properties
such as manufacturer, stores number, material number or price (New).

You can obtain further details about the current version of the ULP by
clicking the help button.
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A simple parts list can also be created by means of the EXPORT com-
mand (Partlist option).

Drill Plan

A drill plan can be printed which enables you to check the drill holes
and their diameters. It shows an individual symbol for each diameter.
EAGLE uses 19 different symbols: 18 of them are assigned a certain di-
ameter; one (@) appears if no symbol has been defined for the diameter

of this hole.

The diameter symbols appear in layer 44, Drills, at the positions where
pads or vias are placed, and in layer 45, Holes, at the positions where
holes are placed. These layers must therefore be active when the drill
plan is generated.

The relation between diameters and symbols is defined via the Op-
tions/Set/Drill dialog of the Layout Editor

= Settings
Colors | DRC | Dl | Misc |
Crrills Symbols
Nr - Diameter W
Hew
100
2002 Width Trail
3 0.018 Changs
4 0,024
5 0032 Delete
£ 0.04
¥ 0.0s Add
8 0.056
Set

Configuration of the drill symbols

The buttons New, Change, Delete and Add can be used to create a new
table, to modify certain entries, delete them or to add new ones. The Set
button extracts all the hole diameters from the layout and automatically
assigns them a drill symbol number.

The values of Diameter and Width determine the diameter and line
thickness of the drill symbol on the screen and in a printout.

The image shows that drill symbol 1 is assigned to a drill diameter of
0.01 inch. In the following image you can see the related symbol drawn
in layer 44, Drills, or 45, Holes, looks like. The symbol number 1 looks
like a plus character (+).
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1+ 10 X
2 X 11 Y
s 12 A
4 & 13 A
5 X 14 D
& X 15 &
o le @
8 4 17 H
3 X 18

Assignment of the drill symbols

The dill symbol assignment is stored in the user-specific file eaglerc.usr
(-eaglerc for Linux).
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A. Layers and their Usage
In Layout and Package Editor

1 Top Tracks, top side

2 Route?2 Inner layer (signal or supply)

3 Route3 Inner layer (signal or supply)

4 Route4 Inner layer (signal or supply)

5 Routeb Inner layer (signal or supply)

6 Route6 Inner layer (signal or supply)

7 Route? Inner layer (signal or supply)

8 Route8 Inner layer (signal or supply)

9 Route9 Inner layer (signal or supply)

10 RoutelO Inner layer (signal or supply)

11 Routell Inner layer (signal or supply)

12 Routel2 Inner layer (signal or supply)

13 Routel3 Inner layer (signal or supply)

14 Routeld Inner layer (signal or supply)

15 Routelb Inner layer (signal or supply)

16 Bottom Tracks, bottom side

17 Pads Pads (through-hole)

18 Vias Vias (through all layers)

19 Unrouted Airlines (rubber bands)

20 Dimension Board outlines (circles for holes) *)

21 tPlace Silk screen, top side

22 DbPlace Silk screen, bottom side

23 tOrigins Origins, top side (generated autom.)

24 DbOrigins Origins, bottom side (generated autom.)

25 tNames Service print, top side (component NAME)

26 bNames Service print, bottom s. (component NAME)

27 tValues Component VALUE, top side

28 DbValues Component VALUE, bottom side

29 tStop Solder stop mask, top side (gen. autom.)

30 bStop Solder stop mask, bottom side (gen.
autom.)

31 tCream Solder cream, top side

32 DbCream Solder cream, bottom side

33 tFinish Finish, top side
34 DbFinish Finish, bottom side
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tGlue
bGlue
tTest
bTest
tKeepout
bKeepout
tRestrict
bRestrict
vRestrict
Drills
Holes
Milling
Measures
Document
Reference
tDocu
bDocu

Glue mask,

Restricted
Restricted
Restricted
Restricted
Restricted
Conducting

Milling
Measures

top side
Glue mask, bottom side

Test and adjustment information, top side
Test and adjustment inf., bottom side

areas
areas
areas
areas
areas

for
for
for
for
for

components, top side
components, bottom s.
tracks, top side
tracks, bottom side
via-holes

through-holes
Non-conducting holes

Documentation
Reference marks
Detailed top screen print
Detailed bottom screen print

In Schematic, Symbol, and Device Editor

91
92
93
93

94
95
96

*)

Nets
Busses
Pins
Pins

Symbols
Names
Values

Nets
Busses
Buses

Connection points for component symbols
with additional information

Shapes of component symbols

Names of component symbols
Values/component types

Holes generate circles with their diameter in this
layer. They are used to place restrictions on the

Autorouter.

Layers can be used with their names or their numbers. Names can be
changed with the LAYER command or in the DISPLAY menu. The
functions of the special layers remain.

If you want to create your own layers, please use layer numbers above
100. Use the DISPLAY menu to create new layers (New button) or type
the LAYER command on the command line. If you want to create, for
example, layer 200, Remarks, type in:

LAYER 200 Remarks

To set up color and fill style of this layer use the DISPLAY command.
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B. EAGLE Files

EAGLE uses the following file types:

Name

*.brd
*.sch
.1lbr

*

.ulp
.scr
LExt
.dru

* ok k%

.ctl
.pro
.job
.bs$$

* ok ok

*

. cam
.erc

*

.bix
.s#x
Ll#x
o##
.s##
C1H#

LR

Type of file

Layout
Schematic
Library

User Language Program

Script file

Text file (also other suffixes)
Design Rules

Control parameter for the Autorouter
Autorouter protocol file

Autorouter job

Backup file of brd after finishing
the Autorouter

CAM Processor job

Error file from electrical rule check

Backup file of BRD (x = 1..9)
Backup file of SCH (x = 1..9)
Backup file of LBR (x = 1..9)
Automatic backup file of BRD
Automatic backup file of SCH
Automatic backup file of LBR

EAGLE for Linux only creates and recognizes lower case characters in

file endings!
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C. EAGLE Options at a Glance

In order to output manufacturing data, for instance, with the CAM Pro-
cessor, EAGLE can be started directly from a terminal window under

Linux or from a console window under Windows.

Since Windows programs give up their connection to the console they
have been started from, you can use the file eaglecon.exe (located in the
demo/bin subdirectory on the CD-ROM) if you want to run the CAM

Processor from a batch file.

This version of EAGLE is exactly the same as the eagle.exe, except that it

doesn't disconnect from the console.
Type eaglecon -¢ for a list of CAM Processor options.

The following options are permitted:

-Dxxx
-Exxx
-Fxxx
-N+
-0+
-Pxxx
-Rxxx
-SxXxXX
—Wxxx
_X_
—a-
-c+
—dxxx
—e-
-f+
—hxxx
—m-
—0XXX
—pPXXX
-g-
—r—
—SXXX
_t_
—VXXX
—u-
—WXXX
—XXXX
—YXXX

Where:

>3
S

0
0

Draw tolerance (0.1 = 10
Drill tolerance (0.1 =1
Flash tolerance (0.1 = 1
Suppress message prompts
Optimize pen movement
plotter Pen (layer=pen)
drill Rack file

Script file

aperture Wheel file
eXecute CAM Processor
emulate Annulus

positive Coordinates
Device (-d? for list)
Emulate apertures

Fill pads

page Height (inch)
Mirror output

Output filename/channel
Pen diameter (mm)

Quick plot

Rotate output 90 degrees
Scale factor

emulate Thermal

pen Velocity

rotate output 180 degrees
page Width (inch)

offset X (inch)

offset Y (inch)

o0 —

o

)
)

xxx Further data, e.g. file name as with -W or
decimal number as with -s.
Examples:

+

-W /home/user/eagle/project/aperture.whl

-s 1.25
Default for option is off
Default for option is on
Example:

a
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-e Aperture Emulation on
-e+ ditto
-e- Aperture Emulation off

Flag options (e.g. -e) can be used without repeating the
‘-’ character:

—eatm Aperture emulation on, annulus and thermal
emulation on, mirror output

-ea-t+ Aperture emulation on, NO annulus
emulation, thermal emulation on

Defining tolerance values:

If there is no sign, the value applies to either direc-
tion,

+ signifies a positive tolerance,

- a negative tolerance.

-D0.10 adjusts the draw tolerance to *10%
-D+0.1 -D-0.05 adjusts the draw tolerance
to +10% and -5%

Notes on the individual options:

-D

-E

-P

R

Draw Tolerance (0.1 = 10%):

Default: 0
Drill Tolerance (0.1 = 10%):
Default: 0
Flash Tolerance (0.1 = 10%):
Default: 0

Supress messages:
This option supresses warnings or other information
in the console window (DOS box, Linux console).

Thus CAM jobs run without interruption.
Default: off

Route-Optimizing:

With this option the route-optimizing for the plotter can
be turned on and off.

Default: on

Plotter Pen (layer=pen):

If you use a color pen plotter, you can determine which layer
is to be drawn in which color.

Example: -P1=0 -P15=1

Drill Rack File:
With this option you define the path to a file with the drill
configuration table.
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-S

-W

X

-a

Y

-

Script File:

When opening the editor window; EAGLE executes the
eagle.scr file. This option allows a different name or directory
to be selected for the script file.

The script file is not read by the CAM Processor.

Aperture Wheel File:
This option defines the path to the wheel file which should
be used

Calls command line version of the CAM Processor

Annulus Symbol Emulation:
Default: off

Positive Coordinates:

If this option is set the CAM Processor creates data
without negative coordinates. The drawing is moved
to the zero-coordinates. This option can be turned
off with the option -c-. Please be careful with this
option, especially if you use mirrored and rotated
drawings, because negative coordinates normally
cause problems.

Default: on

Device:

This option determines the output driver. The following
command displays a list of the available drivers:

eagle -d?

Emulate Apertures:

If this option is selected, apertures that do not exist are
emulated with smaller apertures. If this option is turned off,
no apertures are emulated. Thermal or annulus apertures are
not emulated either

Default: off
Fill Pads:

This option can only work with generic devices like
Postscript.

Default: on for all devices

Page Height (inch):

Printable region in the y-direction (in inches). The Y
direction is the direction in which the paper is transported.
See also the -w parameter.

Mirror Output:
Default: off.

Output File Name
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-p Pen Diameter [mm]:
EAGLE uses the Pen-diameter measurement to
calculate the number of lines required when areas
are to be filled.
Default: 0

-q Quick Plot:
Generates a draft or fast output, which only prints
the frames of the objects.
Default: off

-r Rotate Output:

Rotates the output by 90 degrees.
Default: off

-s Scale Factor:
Those devices which cannot change their
scale-factor (in the menu of the CAM Processor),
have a scale factor of 1.

Default: 1

-t Emulate Thermals:
Works only in combination with -e+.

Default: off

-u Rotate Output by 180 degrees:
In combination with -r+ one can rotate by 270 degrees.

Default: off

-v Pen Velocity in cm/s:
This option is for pen plotters supporting different
speeds. To select a plotter’s default speed, use a
value of 0.
Default: 0

-w Page Width (inch):
Printable area in x direction. See also -h.

-X Offset X (Inch):
This option can be used to move the origin of the drawing.
Default: 0

-y Offset Y (Inch):
Default: 0

Example for starting eaglecon.exe:

eaglecon =X -dgerber -Waperture.whl =-oboard.sol
-D-0.1 name.brd pad via bottom

This generates a Gerber file board.sol which contains data of the layers
Pads, Vias, and Bottom. Draw apertures may have a negative tolerance
up to 10%.

All parameters have to be written in a common line!
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D. Configuration of the Text Menu

With the help of a script file (e.g. menu.scr) you can configure your own
text menu.
# Command Menu Setup
#
# This is an example that shows how to set up a complex
# command menu, including submenus and command aliases.
MENU ‘Grid {\
Metric N\

Fine : Grid mm 0.1; |\
Coarse : Grid mm 1;\
P
Imperial {\
Fine : Grid inch 0.001; |\
Coarse : Grid inch 0.1;\
PN
On : Grid On; | \
Off : Grid Off;\
PN
‘Display {\
Top : Display None Top Pads Vias Dim; |\
Bottom : Display None Bot Pads Vias Dim; |\
Placeplan {\
Top : Display None tPlace Dim; |\
Bottom : Display None bPlace Dim;\
AN
A

\N__7/ \
‘Fit : Window Fit;’\
Add Delete Move ‘;’ Edit Quit)\

’

The backslash \ at the end of a line shows that a command continues in

the next line. Here the MENU command runs from the first line after

the comment to the last line.

The pipe sign | has to be used if a command within braces {} is followed
y another command.
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E. Text Variables

Text variable Meaning

>NAME Component name (eventually + gate name) 1)
>VALUE Component value/type 1)
>PART Component name 2)
>GATE Gate name 2)
>SHEET Sheet number of a circuit diagram 3)

>DRAWING NAME Drawing name

>LAST DATE TIME Time of the last modification
>PLOT_DATE TIME Time of the plot creation

1) Only for package and symbol

2) Only for symbol
3) Only for symbol or circuit diagram

F. Error Messages

When Loading a File

Library objects with the same names.

% B Text Editor - R:/home/ric/tmp/LcdT erminal. sch_upd

File Edit Window Help

Update Report for "R:/home/ric/tmp/LedTerminal. sch”

Date: 2%.11.2000 11.24.53
©ld wersion: 3.55
New wversion: 4.00

This file contained library ochjects with the sawme names,
which have been renamed by adding the "@" character and
a number to their existing name.

11:1 |Ins

The text editor shows this message if you attempt to load an older file
(BRD or SCH) that contains different versions of a library element. In
this case it added @1, @2, @3... to the names of the devices so that they

can be identified.

This message can also appear if you use CUT and PASTE commands.
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Pad, Via Replaced with a Hole

In older versions of EAGLE it was possible to define pads in which the
hole diameter was larger than the pad diameter. This is no longer
permitted.

If you attempt to load a library file that was created with an earlier
version and that contains such a pad, the following message appears:

4 Text Editor - R:\home\ric\E agle-4.1\projectsy35.brd. upd

Eile Edit Window Help

Update Report for "R:/homefric/Eagle-4.1/projects/35.brd"
Date: 25.04.2003 12:12:3%

old wversion: 3.55
Mew wversion: 4.10

The following vias had a diameter that was smaller than their drill
and thus have been replaced with 'holes™:
dignal FPosition

54 (-17250mil 13100mil})

il Z

The pad or via is automatically converted into a hole, provided it is not

connected by CONNECT to a pin in one of the library's devices.

If there is such a connection to a pin, the following message appears:

- /home/ric/tmp/x_brd_upd

File Edit MWindow Help

Update Report for "R:/home/rie/tmp/x.brd"

Date: Z9.11.2000 11.41.1%2
0ld wversion: 3.33
HNew wversion: 4.00

The following pads have a diameter that is smaller than their drill
and should ke replaced with 'holes". However, since these pads are
connected to signals this <can't bhe done automatically:

Library Package Pad Element Signal
40XX DIL14 14 Icz VDD
| 15:1 ins] A

In that case the file must be manually edited in order to correct the pad.
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Can't update file

If this message appears when loading an EAGLE file that was made with
a version earlier than 2.60 it is necessary first to convert the file.

= Error

Can't update file B:hometmpdicd.ds2_ 01 brd
[data structure iz older than verzsion 2.60)

Cancel |

The program update26.exe, which is located in the eagle/bin directory, is
used for this purpose.

Copy the file that is to be converted into the directory containing both
update26.exe and the file layers.new. Then open a DOS window under
Windows, and change into this directory. Type the command:

update?26 dateiname.ext

The file is converted, after which it can be read by the new version of
EAGLE. If the conversion is successful, the message in the DOS box is:
ok...

If the message Please define replacement for layer xxx in layers.new should
appear, it means that you have defined your own layers in layout/sche-
matic/library.

Because of the new layer structure used since version 2.6, a new layer
number (greater than 100) must be assigned.

This requires you to edit the file layers.new using a simple text editor,
adding, for example, a new layer number as the last line of the file.

If, for instance, you have used layer 55, and want to give it number 105,
enter:

55 105
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In a Library

Package/Symbol is in use

If a package or symbol is used in a device, no pads or pins may be dele-
ted or added. Therfore the following messages appear after the PAD or
PIN command have been selected:

e Package iz in usel e Spmbal iz in uzel

It is allowed to CHANGE pins or pads.

To change the number of pins/pads you have to delete the correspond-
ing device(s) first (REMOVE command).

This message appears also if you try to remove the whole package/sym-
bol from the library with the REMOVE command. You have to delete
the whole device or the package variant or symbol in the device before.

In the CAM Processor
Signal contains a polygon that may cause extremely large
plot data

Signal 'S$1' cantainz a polygaon that may cauze extremely large plat data.
Continue?

Cancel |

This message always appears if you have drawn a signal polygon in the
layout whose line thickness is less than the resolution of the selected
output driver (Device).

In order to avoid unnecessary large plot files you should assign a higher
value to the polygon’s line width (CHANGE width).
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A

Action toolbar
Add
Components
ADD
Addlevel
Airwire
Alt-X
Always
Annulus aperture
Annulus symbol
Aperture
Configuration
Draw
Emulation
Fixed wheel file
Flash
Forms
Shapes
Table
Tolerance
Units
ARC
ASSIGN
AUTO
Automatic naming
Autorouter
Backup
Control file
Cost Factors
Design Rules
Features
Grid
Interrupting
Layer
Load parameters
Log file
Memory requirement
Menu
Min. distance/clearance

35,37

40
40,48,57
195

12

30

195
225,226
12,104

215,226
226
225
225
226
226
226
229

226,229
229
41,50
42,64,79
51

73

137

151

153

144

140

137
140,141
151

143

149

153

142

148

140

Minimum grid 137
Preferred direction 137,143,148
Restarting 150,151
Restricted areas 143
Ripup/Retry 147
Run 148
Save parameters 149
Select signals 149
Single-sided boards 154
Status display 152
Supply layer 123,150,223,224
Supply polygons 151
Track width 140
Unreachable SMD 142,143
Via, drill diameter 140
Autorouter module 22
B
Back annotation 78
Background adjustment 33
Backup file 31
Bend
Inserting 49
Bend mode 115
Blind via 12,125,131
Bmp graphic 76
Board
Components on both sides 111
Creation 97
Layer setup 100
BOARD 37
bRestrict 143
Bubble help 36
Buried via 12,125
BUS 42,93
Bus router 139
gAM Job
Extended Gerber 211
Gerber 216,229





Output 222

Section 222
CAM Processor 43,58
Aperture tolerances 226
Drill data 217
Drill plan 231
Flag options 220,223
Gerber output 225
Job 222
Messages 216
Output file name 221
Photoplot output 225
Start from a Batch 236
cam2dxf.ulp 135
cam2print.ulp 135
Can 195
Caption 134
CHANGE 39,48,57,79,161
Change package 112
Checking
Layout 117
Schematic 95
CIRCLE 41,50
CLASS 42,93
Clearance 101
Clk 162
CLOSE 43
Color settings 80
Command language 66
Command line 36,63
Command parameters 37
Command toolbar 36
Commands
ADD 40
ARC 41
CHANGE 39
CIRCLE 41
CLOSE 43
COPY 39
CuT 39
DELETE 40
DESCRIPTION 58
DISPLAY 38

DRC
ERRORS
EXPORT
GATESWAP
GROUP
INFO
INVOKE
MARK
MIRROR
MITER
MOVE
NAME
PACKAGE
PASTE
PINSWAP
POLYGON
PRINT
RECT
ROTATE
SHOW
SMASH
SPLIT
TECHNOLOGY
TEXT
UPDATE
USE
VALUE
WIRE
WRITE
Component
Design of
Insertion machine
List
Rotate
Configuration
Commands
EAGLE conf.
eagle.scr
eaglerc file
Project file
CONNECT
Connector
Consistency

51
51
75
40
39
38
a1
39
39
49
39
40
57
40
40
4
133
a1
39
38
40
4
58
4
44
37,44
40,167
a4
44

157
213

75
110

79

79

83

85

86
57,166,186
196

42,78





Context menu
Control panel
Coordinate display
Coordinates

Display

Entering

Polar

Relative
Copper plane
Copy

Elements in Lbr
COPY
Core
Creamframe
Current unit
Cursor appearance
CuT

D

Default

Directories

Settings
Delete

From library

Sheet

Wire bend
DELETE
DELETE SIGNALS
Design Rule Check
Design rules
Desktop publishing
Device

Copy

Creation
Device driver
Device set
Diameter of lands
Dimensions of pads
Directories
Directory

Default
DISPLAY
Distance

28
25
36,39,47

204
63,69
69

69

115

39

205
39,47,90
12,124
106

71

33
39,48

30
79

52,208
44

48
40,48
75
51,98
27
230
13
206
55
228
13

97

97

30

30
38,46
101

Documentation
Documentation print
Dot
DotClk
Drag&Drop
Drawing
Frames
Name
DRC
Errors
Drill
Configuration
Data
Diameter
Hole diameters
Info file
Plan
Rack file
Tolerance
Drill data export
Multilayer board
Drill table
Drillcfg.ulp
Drivers
Output
Dxf data

E

$EAGLEDIR
eagle.def
eagle.epf
eagle.scr
eaglecon.exe
eaglerc file
eaglerc, eaglerc.usr
EDIT
Edition
Light
Professional
Standard
Electrical Rule Check
Elongation
Enter key

230

159
162
162

25

198
51,198
198
13,51
118

13
212,219
217
198,231
97

219
231

220

212

218
229
218

228
76

31
228,229
86

83

236

85

85
43,52

24

22

24
13,95
104
36





Environment variable
Eps format
ERC
Error correction
Error messages
DRC
Number of e.
ERRORS
EXCELLON
excellon.cam
EXCELLON_RACK
Exit program
EXPORT

Fi

Open

Print

Save
File menu

New

Open
Film generation
Film maker
Fixing hole
Font

Changing

Checking
Forbidden areas

Forward&Back Annotation

Function keys

G

>GATE
Gate
GATESWAP
Generate data
gerb274x.cam
Gerber
Fixed aperture wheel
Information file
GERBER
gerber.cam
GERBER_RS274X

31

230
13,42,51,78,95
117

241

118

107

51,117

212
217,218
218

30
43,66,75,96

37
37
37,44

29
30
229
211
197

Y|

119

113

13,78
38,42,64,79

194
185,194
40,94
59

211

225
225
216
216
211

GERBERAUTO
GND symbol
Graphic format
Grid

Current unit
GRID
Ground layer
Group

Cut and paste

Rotate
GROUP

H

$HOME

Help function
History function
Hiz

Hole

HOLE

HOME variable

I/0

Import

In

INFO

Inner layer

Input Commands
Installation
INVOKE

Isolate

J

Job
Job file
JUNCTION

K

Keepout

L

LABEL

Labeling
>LAST_DATE_TIME
Layer

216,223,229
192
76

71
37,79
123

206
204
39,47

31
36
64
163
13
51
31

163

74

163
38,46
121

63
15,17,19
41,90
116

216,222
59
42,92

119,161

42
160
198





Available

Qty. of signal layers

Setup

Stack

Thickness
LAYER
Layout

Specify outline
Layout editor
Library

Copy a Package

Copy a Symbol

Copy elements

Create components

Editor

Editor window

List contents

Opening

QOutput script

Summary

Use

User-defined
License

Extending L.

New installation
Line

Type

Manufacturing data
MARK
Mask data
MENU
Menu bar
Micro via
Minimum clearance
MIRROR
MITER
Mixed input
Mouse click
Right click
Mouse keys
Mouse Wheel Zoom

80

100
100,124,125
13,125
100,126

43

108
45

54
55
205
56
21
51
75
43
75
26
27,44
208

18
15
14
49

120
39,47

106

43,79

35

13,131

101
39,47,64,199
41

66

68

70

44

33

MOVE

Multilayer boards
Blind, buried vias
Through vias

Multiple board creation

Must

N

>NAME
NAME
NC

Neighboring objects

Selecting
Net
Connection point
NET
Net Classes
Net script
Netlist
Network License
Next
None

(0

Object properties
Pre-setting
Show

ocC

OPEN

Optimization

OPTIMIZE

Options
CAM processor

Options menu

Orientation

Out

outlines.ulp

Output
See Also Export
Device
Drawings
Drivers
Files
Parameters

39,47
121,143
124
124
120
195

165,194
40,49,57
163

45

164
42,92
93

75

75

18
195
162

38
79
33
163
43
139
49

220

30
162
163
213
220

220
43
228
220
59





With CAM job

P

Package
Assigning
Choosing variants
Copy
Define variant
Delete variant
Editing
Radial pad arrangement
Renaming variant
Replacing
Rotated

PACKAGE

Pad
Appearance in editor
Aspect ratio
First flag
Form
Shape
Stop flag
Thermals flag

PAD

Palette

Parameter toolbar

>PART

Parts list

Pas

PASTE

Path specification

Pbm graphic

Pgm graphic

Photoplotter
Annulus aperture

Pin
Connecting point
Direction
Function
Length
List
Names
Parameter

222

13

166
186
54,205
199
201

53

204
186
48,112
203

57

13

104
104
103,172
103
172
173
105,173
53

81

36

194
75,230
163
40,48
31

76

76

226

13

92
95,163
162
163

96

165
162

Superimposed 96
PIN 54
Pin/pad connection 166,186
Pin/pad list 75
PINSWAP 40,48,94
>PLOT_DATE_TIME 198
Png graphic 76
Polygon

Invalid 117

Rank 122

Thermals 122
POLYGON 41,50,115,121
PostScript 229
Pour 116
Power

Supply 95

Supply Layer 122
Ppm graphic 76
PREFIX 57
Prepreg 13,124
PRINT 43,133
Printout time 198
Product information 34
Product registration 34
Project

Close 30

Creating 86

File (eagle.epf) 86

Management 28
Prototype manufacture 212
Pwr 95,163
&IT 43
Quotation marks 73
RRack file 14,219,220
Rank 116
Ratio 160
Ratsnest 14
RATSNEST 51,111
RECT 41,50

REDO 38





REMOVE
Rename
Device
Package
Symbol
RENAME
REPLACE
Request
Resistor
Device
Package
Symbol
Restricted area
For components
Restring width
RGB value
RIPUP
Rotate
Group
ROTATE
Roundness
ROUTE
Routing
Automatically
Manually
Pass
RS-274D
RS-274X
RUN

S

Schematic
Entry
Grid
Merge
Module
New sheet
Points to note
Symbol
Symbol, labeling
SCRIPT
Script files
Search devices

44,52,157,208

208
208
208

52
48,113
195

165
158
162

161
102
80
49,114

204
39,47
103
49,114

137
114
139
212
211

38

87
88
96
21
88
96
165
194
38
65,74
89

Section
Select objects
Serial number
SET
Shape of lands
>SHEET
Sheet
Delete
Max. number
New
SHOW
Signal
Show name
SIGNAL
Signal layers
Silkscreen
SM1000
SM3000
SMASH
SMD
Change
Cream flag
Placing
Round SMD
Stop flag
Thermals flag
Solder cream mask
Solder stop mask
Spaces
Spacing
Spin flag
SPLIT
Status display
Stopframe
Sup
Superimposed pins
Supply
Autorouting layer
Defining symbol
Hidden gates
Invisible Pin
Layer
Pin

222
45

34
44,79
97
198

88

21

88
38,46
14

114

50

121
159
212
212
40,49,90
53,158
178
178
176
177
178
105,178
106
106,216
67

116
110
41,49
152
106
95,163
96

150
183

90
190
143
190





Symbol
Supply layer

Autorouter
Swaplevel
Symbol

Copy

Editing mode

Labeling

T

Technology
Changing
Termination
Of command
Text
Font
In copper layer
Menu
Size, thickness
Spin flag
Variables
TEXT
Text Editor
Text menu
Thermals
In polygons
In supply layers
Tif graphic
Title bar
Tool tips
Track
Decompose
Width
Tree view
Update
tRestrict

U

UNDO
UPDATE

USE

User guidance
User Interface
User Language

14,192

123
164

14
55,205
54

194

184
113

38

Y|
215
79

97
11
241
41,50
61

43

117
104,123
76

35

36

114
97

30
143

38

132
37
33,114
32,79
14,77

X/ALUE 165,194
VALUE 40,49,57,167
Variant 186
Define new 199
Delete 201
Vector font 33,119
Persistent in drawing 33
Via 14
Blind, buried 125
Length 130
Stop flag 107
VIA 50,64,130
VRestrict 143
w

Wheel file 14,225
Wheel mouse 33
Window

Fetch into foreground 65
Menu 33
Number 33
Wire 14
WIRE 41,49
Wire style 49,107
Wire_bend 115
WRITE 44
XXbm graphic 76
Xpm graphic 76
%)om factor limit 33
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Chapter 1

Overview

In this tutorial, you will design a simple LED flasher PCB (Printed Circuit
Board) using the Eagle Software package. This tutorial is intended to pro-
vide a basic introduction to the Eagle PCB design package and will guide
you through the Eagle program’s features in the proper design order. A
project starts in the Eagle schematic Editor with the electrical schematic
and then leads into the Eagle PCB Layout Editor where the board is de-
signed and routed. By the end, you will have the basic tools necessary to
start on a more serious design.

1.1 Creating a Project

An Eagle project encompasses all design work required in making a PCB.
To create a project follow the instructions below.

1. Open Eagle

2. Select File > New > Project from the menu bar. Alternately,
right-clicking on a project directory will bring up a context-sensitive
menu with the same selections. If required, new or existing project
directories can be added by selecting Options > Directories and
appending a directory path to the “Projects” entry. New schematics
and board layouts can also created in this manner.

3. Name the project - LED_Flasher in the Control Panel Window.

Next a schematic document is be created within the project directory.
Follow the instructions below to create a schematic document.
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1. Select the LED_Flasher Project Folder by left clicking on the dot to

the right of the project name. The dot should light up green when
the current project is selected, see Figure 1.1.

2. Select File > New > Schematic from the menu bar. A schematic
editor window editor will open.

3. From the schematic window, save the file as led.sch. This is done by
selecting File > Save (or Save As...) from the menu bar.

Finally, you have to create a new PCB document within the project
named led.brd. This file will be the board layout. Figure 1.1 below is what
the eagle control panel window should look like when these steps are fully
completed. The project contains all necessary files and is ready to start
adding parts to create the electrical schematic.

Control Panel M=
File Options Window Help
Mame I I Description I
G- Libraries Libraries
" Design Rules Design Rules
-- Uzer Language Programs Uzer Language Programs
- Scripte Script Files
- CAM Jabs CaM Processor Jobs
E-Projects Project Folder
_J ewxamples Examples Folder
SR [ED Flasher @
Bl led brd
= @ led.zch
ChProgram Files\EAGLE-4.05:2\projects\LED_Flasher o

Figure 1.1: Successful project file creation.





Chapter 2

Schematic Editor

The first step in the design process for most electrical systems starts with a
schematic. The schematic editor within the Eagle package allows the user
to create a visual representation of the electrical system being designed.
A good schematic will allow any electronic literate person to recreate the
electrical system. This portion of the tutorial will guide you through creating
a schematic for the example LED Flasher circuit. The procedure below
provides you with the necessary tools to start on your own project schematic.

2.1 Adding Schematic Components

Components are added to the schematic diagram from part libraries. A li-
brary is composed of several components and each component within the
library has a schematic and a PCB representation. The schematic represen-
tation in the library is an electrical symbol, where as the PCB representation
of a component is known as a footprint. Figure 2.1 shows an example of a
555 timer component within the ”Linear IC” library. Note in the middle
window the schematic symbol is shown, and in the right window, the PCB
footprint is shown.

Eagle comes with many standard libraries that include a large variety
of parts. However, if a component is not listed in the standard libraries, an
Internet search might provide the library needed, or else you can create the
component representations yourself, as described in Chapter 4. An “EE401”
library has also been created, contains contains many of the common com-
ponents used in the course. To add a component in the schematic editor
follow the procedure below.
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2.1.1 Adding a Component from the Standard Libraries

1. In the schematic window select Edit > Add from the menu bar.
Alternatively, there is a tool bar to the left of the schematic window
which has several shortcuts. If the mouse is hovered over the toolbar,
a comment will appear indicating the icons command function. Either
way, a new window will pop up displaying available libraries as shown
in Figure 2.1.

2. In the search edit box, type *555* and hit Enter. The search results
are displayed in the upper left scroll box. The * serves as a wild card,
so that any component in the available libraries containing the text
7555” will show up in the search results. To start a new search simply
clear the edit box, hit Enter once and the search criteria will be reset.

3. Expand the Linear Library and then the “*555” heading. To expand
the general headings click on the ”+4” sign.

4. Find the LM555N in the upper left scroll box and select it by clicking
on it. It is important to note the details in the right windows when
a component is selected, particularly note the schematic symbol and
the PCB footprint package. There are many types of 555 timers in
the linear library with the main difference being the PCB footprint.
The "footprint” package of interest to us is an 8 pin DIP (Dual In-line
Package), which corresponds to the LM555N. See Figure 2.1.

= ADD | x|
Mame ;I

e ,0808

. B Z aaLue

: - LMB55D o o

TIMER

Package: DILOS
Dual In Line 8

<;| |;

Seaich ¥ Smds ¥ Ereview

| 5550 =l

oK I Dirop | Cancel

Figure 2.1: Edit box while adding a 555 timer.
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Whenever possible it is best to select the same component
package that you will be using on the PCB. In the situation
where you are not certain of the package type, it is possible
(and necessary) to change the package type at a later time.

5. Ensure the LM555N is selected and hit OK.

6. The program will now return to the schematic window and the com-
ponent is placed with the mouse. Click the left mouse button when
you want to add the component, and click the right mouse button to
rotate the component. Mirroring of the symbol can be performed only
after the component is placed.

7. Press ESC on the keyboard when you are done placing a single 555
timer.

8. Now you should be back in the “Add” component window. Press ESC
or click Cancel to get back to the schematic editor; however, if you
want to add more components you can do so as mention in the steps
above.

To complete the LED flasher circuit the rest of the components must be
added. For resistors and capacitors, the custom EE401 library will be used
as shown in the following section.

2.1.2 Adding a Component from the EE401 or Other Li-
braries

The first step involved in adding components from an external library is
to include or “USE” the library file. Library files have the extension *.lbr.
Follow the directions below to add resistors from the EE401 library.

1. Select Library > Use from the menu bar in the schematic editor
window.

2. Locate the directory where the desired library file (EE401.1br) is stored
in.

3. Select the EE401.1br and click OPEN. The library is now included
as part of the standard libraries for this schematic file when adding a
component. To add the component use the add command as if EE401
is part of the standard libraries using the procedure above.
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4. Add the component R3 under the EE401 library. Add 3 of these
resistors.

The parts added above are a few required to completed the LED flasher
circuit that will be constructed. Below is a list of parts that will be required
to complete the design. Ensure all the components have been added before
proceeding to the next section.

¢ 555 Timer Dip Package (Search: LM555N)

3 Resistors (Search: R3), EE401 Library

5mm LED - Light Emitting Diode (Search: LED5MM)

Capacitor (Search: CAPP1L)

A 2 Pin Power Header (Search: PINHD-1X2)

2.1.3 Adding Power Sources

Power Sources such as ground, twelve volts, and five volts are added in
the same manner as components. There are several libraries that contain
supplies, but use the EE401 library. If special voltages are required, li-
brary supplyl and library supply2 contain other supply symbols for the
schematic.

For the LED Flasher project add:

e 4 - GND supplies (Search: GND),EE401 Library
e 4 - 12V supplies (Search: 12V),EE401 Library

2.1.4 Adding a Frame

A frame is mandatory for any schematic. A frame provides the reader with
a description of important information regarding the schematic, such as:
what the schematic represents, who designed it, and how many revisions it
has gone through. Frames are added in the same manner as a component is
added, as the procedure below illustrates.

1. Select Edit > Add from the menu bar in the schematic editor window.

2. Search for LETTER P in the search edit box. There are many frames
that can be used from the “Frames” library; to view all frames do a
search for *frame?*.
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3. Select the LETTER_P click OK. Add the frame such that it en-
compasses the schematic diagram. Press ESC twice to return to the
schematic editor.

2.1.5 Adding Text

After adding the frame, it is necessary to place text to clarify the schematic
information.

1. Select Draw > Text from the menu bar in the schematic editor win-
dow.

2. Enter the desired text. For the frame, start with the text: “LED
FLASHER, BY: Your Name”.

3. Click OK. The text will now appear on the mouse cursor; place the
text in the top frame box. Similarly add the revision number.

5/EAGLE-4.09r2/projects/L ED_Flasherfled sch
ns indow Help
YN T 1

Ele Ecit Draw View Tools
2@ s/ =
=

e BTl

L4
o

l

» JEON N E X B
WBOS B #e s vD

.| | LED FLASHER BY: Group 23
TITLE: led
Document Number:jlo DE—;IUO
Date: 7/22/2003 01:36:05%a Sheet: 1/1

Figure 2.2: A very simple frame box with pertinent information.
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2.1.6 Changing Component Values

One of the final steps to completing a schematic is to add labels and values
to give each component the required information.

1.

Select Edit > Value from the menu bar in the schematic editor win-
dow.

. Select the component R3 by placing the mouse cursor on R3’s cross

hairs and Left Click. A new window will pop up requesting the value.

Enter the value for the part; for R3 enter a value of 470.

. Click OK. The value will now appear as text beside the schematic

symbol.

Label the remaining components with the appropriate values.

o LED: Red

e Cl: 10pF (10 uf)

e R1 and R2: 10k (10k)

2.1.7 Move, Rotate, and Delete Commands

Below is how the move command is used, but the procedure is similar for

other Eagle commands.

1.

2.

Select Edit > Move from the menu bar.
Place the cursor over the object’s cross hairs (hot spot).

Left click once. (For the Rotate and Delete commands, this will insti-
tute the action.)

. Move the object with the mouse to the desired location, and Left click

again to release.

By using the Move, Rotate, and Delete commands, each of the compo-
nents can be organized so that wiring the nets is efficient.
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Figure 2.3: Adding a value to a resistor.
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2.1.8 The Group Command

The Group command is a special command that can save time. It is used in
conjunction with another command such as rotate, move, or delete. Group-
ing objects will allow the additional command to be issued to several objects
at once. The procedure below is an example of using the group and move
commands together to move several objects at once.

1. Select Edit > Group from the menu bar.

2. Group the desired objects with a rectangular box or a polygon. The
objects will highlight when successfully grouped.

e Rectangle selection box: Left click and hold to start the rectangle.
Drag the mouse cursor to create a rectangular box around the
objects which are to be grouped. Release the left mouse button
to complete.

e Polygon selection box: Left click and release where the start of the
polygon begins. Draw lines by moving the mouse to each point
and left click at each bend to form the polygon shape. Click the
right mouse button when the polygon is finished.

3. Select Edit > Move from the menu bar. At this point, another
command can be substituted for the move command.

4. RIGHT CLICK once on any object in the group and this will cause
the group to be commanded. This functionality is described in the
status bar at the bottom of the application window.

5. Drag the group to the new location with the mouse and LEFT CLICK

once to release.

2.2 Adding Nets

Nets are connections that link various component pins. Below is the proce-
dure for adding a net with a label.

Do not use the WIRE command to create logical connec-
tions, use the NET command. Using NET sets internal
connection information that is required for routing a PCB.
The WIRE command does not allow as flexible control over
this feature.
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1. Select Draw > Net from the menu bar in the schematic editor win-
dow.

2. Position the mouse cursor over one of the nodes which will be con-
nected and Left Click once without holding.

3. Drag the wire to the desired positions, each time that you wish to
change direction, click the left mouse button. To toggle between or-
thogonal and diagonal draw modes click the right mouse button.
The current mode is displayed in the menubar at the top of the appli-
cation.

4. Complete the net at the final node.

5. Edit the Net Name and add a Net Label. To edit the Net name select
Edit > Name and then click on the net line. When using the PCB
layout editor later, meaningfully net names help identify connection
paths. To draw a Net Label which shows the net name in the schematic
editor, select Draw > Label and click on the appropriate net.

Make all the required nets for the schematic shown below. When adding
nets to power supplies, START AT THE POWER SUPPLY FIRST
and then connect to the other nodes. This ensures that the power supplies
net name is persevered for the ERC (Electrical Rule Check) discussed later.

When joining one net to another, Eagle will prompt for the
resulting overall net name. Ensure you select the correct
option.

2.2.1 Buses versus Nets

In this section, the difference between buses and nets is discussed. A bus
is a collection of several nets visually grouped into one line to simplify the
appearance of the schematic diagram. Buses are just drawing elements.
Logical connections can only be made with the NET command. A simple
bus will be added to the schematic to illustrate how buses are used and
created. The schematic will look as shown in Figure 2.5 after completing
the following steps. This bus serves no purpose electronically and is included
only for demonstration purposes.

1. Open Eagle and Open the schematic file for the 555 LED Flasher
Circuit designed above.
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Figure 2.5: Schematic showing a bus-oriented connection.
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2. Add two headers, (Search: PINHD-1X4). Place them as shown in
Figure 2.5.

3. Create a bus. To create a bus, select Draw > Bus, and then draw
the bus as shown in Figure 2.5.

4. Name the bus. A bus name must be the names of all net signals
that it represents. To name a Bus, select Edit > Name and click on
the bus to be named. Enter the bus name with the following syntax:

(ARRAY]|0..2],SINGLES) Arrays are created with the ArrayName[Start..End|
syntax and a single net is just the net name. Any number of nets can
be added, but Nets must be comma separated.

B Name

Mew name;

ARRAT[0.2L5IMGLES -

Caticel i

Figure 2.6: Editing bus names.

5. Label the bus. Add a label to the bus.

6. Connect the NETS to the BUS. Use the NET command and link
all the pins on each pin header to the bus. Start from the bus, which
will bring up a list of available nets; choose the appropriate net and
then connect it to the pin header. Ensure that each net connects to the
bus with a “bus entry”, or diagonal line as shown in Figure 2.7. Use
the right mouse button to alternate between orthogonal and diagonal
modes of drawing NETS.

7. Add net names to all nets entering and leaving the bus. This is
required in order to make all information about the connections visible
to the viewer of the schematic. Skipping this step has no effect on the
operation of Eagle, but makes the schematic impossible to read for
humans.

2.3 ERC - Electrical Rule Check

The ERC command is a tool that is used to test the schematic for electrical
errors. The ERC will only return possible errors and warnings, but it is up





Eagle CAD Tutorial (Eagle0) Revision 0.2

2.3 ERC - Electrical Rule Check 14
JP2
ARRAYD )
ARRAY 25
ARRAYD 35
SINGLES 45

[ corama R
SINGLES
ARRAYZ

Figure 2.7: Popup menu showing bus names.

to you to ensure there are no electrical violations. To run the ERC, select
Tools > ERC from the menu bar. When the ERC is run on the 555 Flasher
circuit, 1 error and 1 warning should result.

e The warning is due to a naming difference between VCC and V+ for
the 555 timer chip which is acceptable.

e The error is due to an unconnected input pin, which is part of the
design in this case.

As mentioned before, it is up to the user to interpret the ERC errors and
warnings correctly. The ERC can help to save debugging time.





Chapter 3

PCB (Printed Circuit
Board) Editor

Almost every piece of modern electronic equipment contains at least one
PCB (Printed Circuit Board). A printed circuit board is a fibreglass sheet
that provides support for components and connections. Copper traces that
are present on the top and bottom surfaces act as wires to create connectivity
between components. Eagle’s Board Layout Editor provides a means of
organizing components on a PCB and creating the connections by drawing
the copper traces. Complete the following steps before proceeding to the
next section.

1. Open the LED Flasher schematic file.

2. Select File > Switch to board from within the schematic editor.
This will bring up the board layout editor with the components placed
in an unorganized manner. Note the “airwires” that connect the pins of
the various components. Airwires indicate the net connections created
in the schematic editor. Later, the components will be organized in a
bid to minimize the overall length of the airwires.

It is important to always have both the board file and its
corresponding schematic open at the same time. This allows
annotation to occur wherein changes to the schematic will
automatically update the PCB (and vice-versa). Failing to
have both files open can lead to an inconsistency between
them: a difficult situation to rectify.

15
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3.1 Placing Footprints

A footprint is a collection of pads that represent how a component mounts
to a PCB.

1IC

Figure 3.1: Example footprint for an 8-pin DIP.

When organizing footprints use the MOVE and ROTATE commands.
Connection nets are shown by “airwires” which are yellow lines that indicate
a connection between component’s pins. Try to minimize the length of these
lines by placing like nodes in a common region. After moving footprints, use
the RatsNest command to redraw the airwires to make sure the footprint
placement is effective in minimizing the length travelled. Figure 3.2 is a
suggested parts layout.

JP3

Figure 3.2: Example arrangement of footprints.
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3.1.1 Part Placement Guidelines

For your design, remember the following tips and guidelines regarding the
placement of footprints.

e Try to place high pin count components in the centre of the board.
This provides more surface area to route nets.

e The light version of Eagle limits the physical board dimensions to 3
by 4 inches.

e It is important to include mounting holes as the board will be
mounted in a mechanical structure at some point.

e Use a coarse grid setting (say 100 mil or even 500 mil) for positioning
of parts. This makes it easier to line-up components. The grid can be
reduced as needed for fine-tuning.

e Place connectors to off-board equipment at the edge of the PCB.

e Traces should be at least 20 mil from the edge of the PCB.

3.2 Routing the Board

Routing a board involves drawing the locations of the resulting copper traces
between components to complete the net connections made in the schematic
editor. Below are some basic rules to keep in mind when routing a PCB.

3.2.1 Routing Tips

e Try to keep your inside trace angles greater than 90 degrees as sharp
angles tend to collect conductive debris and have other high-frequency
effects. Two consecutive 45-degree angles redirect the trace 90 de-
grees. Use “T” trace intersections if you have to. Avoid “Y” trace
intersections.

e Utilize the area under components such as ICs or resistors to route.

e Have a set of callipers or a ruler on hand for measuring package di-
mensions and lead sizes.

e Part specification sheets typically include package information that
will aid in determining pad placement.
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All polarized components (including ICs) should be placed with con-
sistent orientation.

Hole sizes should be at least 10 mil larger than the component lead.
Pads should be at least 15 mil larger than the hole size.

Place a PCB revision number and name on the top layer.
Components should be at least 200 mil from the edge of the PCB.

Octagonal pads provide more surface area to solder to.

3.2.2 EE 401 Milled PCB Routing Guidelines

In order to help ensure that your board is milled with minimal trouble, please
adhere to the following guidelines. Most of these guidelines are present due
to the nature of the PCB milling process used in the lab.

Design only single-sided boards: only the bottom layer will have cop-
per traces. Double-sided boards may be permitted for unique situa-
tions, but only at the approval of the course technician.

Milled board outlines can only be rectangular.

Milled boards do not allow traces to be placed between pads spaced
at 100 mil (this includes most DIP (DIL) packages).

Milled boards are single sided, which means only the bottom layer can
contain tracks.

With DB9 connectors and other parts where the pads are not on a
simple grid pattern, to connect to the pads use the ROUTE button
to first connect from the off-grid pad to the next point on your board.

Minimum trace width is 40 mil.

Minimum clearance for any disconnected traces or pads is 13 mil. This
clearance, however, can lead to difficult soldering tasks. The clearances
used later in this document will lead to a PCB that will be simpler to
solder.

Minimum pad size for jumpers, vias, and components is 80 mil.
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e Only three drill sizes are supported: 32 mil, 40 mil, and 125 mil.
Depending on the technician’s workload, however, these boards are
often drilled with only one of the smaller bits, meaning the larger
holes will need to be “opened up” using a drill. The following table is
a quick guide to helping you select drill sizes:

Drill Size Use

32 mil Most components.

40 mil Rectifier diodes, power transistors, and pin headers.
125 mil Mounting holes.

e You can run up to two traces easily out the end of a 0.3 inch wide DIP
package.

e Place the dimension outline 50 mil outside your desired board size.
The default PCB panel size is 4x6 inches. If no outline is provided,
you are likely to get a rough 4x6 panel with two jig holes in your circuit
layout.

3.2.3 Auto Routing

When routing a PCB it is common to combine auto routing and manual
routing. The auto router can route the majority of airwires/nets quickly,
and then special or difficult nets can be manually routed. Auto routing is a
method where the computer routes connections based on a set of rules set
by the DRC and the Auto router setup. The auto router will not always
finish the board the way you want, but it can save time. Provided setup
is correct, an auto router will route the board nets according to the design
rules and schematic connections. The following procedures will setup the
auto router and then route the connections.

Before auto routing, complete the procedure below to configure the DRC
to conform to the milled board specifications.

1. Select Tools > DRC from the menu bar within the layout editor. A
window will pop up that contains several configuration tabs.

2. Set Clearances. Click on the Clearance tab, and set the wire to
wire clearance to 40mil and the wire to pad clearance to 30 mil.
For information purposes there is a picture shown to the left of each
tab window to depict what the setting configures and at the bottom
of the window there is a description of what is being configured. See
Figure 3.3.
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i DRC (default?) x|

File | Clearance |Distance I Sizes I Festring i Shapes i Supply I Masks i helizc: l

Different Signals

Wi
‘wire | 40mil Pad
Pad 13|Jmi| IBmiI Wia
Via !Bmil ISmiI Bmil
Same Signals
Srnd Pad Wia
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Setting the values for the Same Signals checks to 0 dizables the respective check.

0K | Select l Spply J Cancel i

Figure 3.3: DRC configuration: the clearance tab.
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Set minimum track width. Click on the Sizes tab, and set the Mini-
mum Width to 40 mil and the Minimum Drill to 32 mil.

. Set the minimum PAD size by clicking on the Restring tab, and set

all the minimums to 80 mil.

Set the shape of the pads by clicking on the Shapes tab, and set the
Top and Bottom shape to octagon.

To save the DRC settings made, Click on the File tab, Click the Save
As button, and name the file.

Click OK. Clicking OK will close the DRC setup and it will also run
the DRC.

Now the auto router will follow the DRC configuration when routing the
board. To setup and run the auto router:

1.

3.

Select Tools > Auto from the menu bar within the layout editor. A
window will pop up that contains several configuration tabs.

Under the General tab, set Top to N/A and set Bottom to *. This
will make a single-sided PCB. Also set the grid size to 50 mil.

Click OK to start the auto router.

The auto router may not completely route all connections. In such a
case, the DRC configuration and auto router setup can be manipulated to
completely route the design. If manipulating settings becomes tedious, then
manual routing can be attempted as discussed below.

3.2.4 Ripping Up Tracks (Delete Tracks)

It may be necessary to delete a single track, multiple tracks, or maybe even
all tracks. The RIPUP command is useful when shifting components to
optimize boards. The RIPUP command can be accessed by selecting Edit
> Ripup from the menu bar.

1.

To rip up an individual track:

Use the RIPUP command and LEFT click on the individual track
to delete.
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Figure 3.4: Example of a completely routed board.

2. To rip up a signal:
Use the RIPUP command and type the signal name in the command
box located above the main window. For Example GND.

3. To rip up everything but a few signals:
Use the RIPUP command and type the signal name in the command
box preceded by a “!”. For example: ! GND VCC.

4. To rip up a group of tracks:

Use the GROUP command and place a box around the tracks to be
ripped up.

Use the RIPUP command and RIGHT click on one of the selected
tracks. All tracks within the group will be deleted.

5. To rip up all tracks:

Use the RIPUP command and then click the Traffic Light on the
top toolbar. Click yes to the confirmation.

If you want, RIPUP the entire design and Auto route it again.





Eagle CAD Tutorial (Eagle0) Revision 0.2
3.2 Routing the Board 23

3.2.5 Manual Routing

Manual routing involves routing nets by manually placing the copper tracks
similar to drawing lines. This involves physically drawing the track from pin
to pin and can be time consuming but necessary. The auto router is not a
perfect tool and it sometimes can make a board more complicated than is
necessary. The auto router also can get “stuck” where it may not be able to
route a board. Therefore, it will be necessary to do some, if not all, of the
routing manually. Lets try some manual routing by completing the 4-pin
headers again, but this time manually. Route the 4-Pin headers similarly to
the example shown in Figure 3.5.

Figure 3.5: Manually routed 4-pin headers.

Start by ensuring the two 4-Pin headers only have airwires, by ripping
up connections, if necessary.
To manually route:

1. Select Edit > Route from the main menu bar.

2. A toolbar will appear below the menubar that allows the track options
to be set. Select a track width of 40mil (Width: 0.04) using this
toolbar.

3. Click on the first pad where you want to start the track and draw the
track while using the airwire to guide you to the other pads until the
connection is complete. Remember when drawing lines, a right click
will switch modes between orthogonal and diagonal. A left click will
create a bend in the line.

4. After completely routing an airwire, the ROUTE command will au-
tomatically break the line indicating a successful connection. The
ROUTE command stays active and is ready to start another airwire.
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As with automatic routing, the design must be checked using the DRC
to ensure that no errors will occur in manufacturing the board, as outlined
in the next section.

3.3 DRC - Design Rule Check

The PCB layout editor adds an additional check: the design rule check.
It provides a method for ensuring that the board is designed to the spec-
ifications of a manufacturer. In the case of EE401, the routing guidelines
previously outlined are the requirements to manufacture a board using the
milling method. The DRC must be setup correctly, and at the completion
of a design the it must return no warnings or errors. To configure the DRC
consult the section on Auto Routing.

As a simple additional check, turn off all layers but “UN-
ROUTED?”. Refresh the screen and make certain there are
no unrouted traces.






Chapter 4

Building a Custom Library

If the component to be added is a specialized component and an Internet
search for the library file has not been successful, a custom library file can be
constructed (or an existing part library can be modified). Instructions below
will guide you through creating a component, footprint, and schematic sym-
bol within a custom library. The component that is created as an example
is a 2 PIN terminal block.

1.

Open Eagle and create a new library file. Select File > New > Li-
brary from the menu bar. Save the library as “mylib.lbr” in your
directory.

Add a description of your library. Select Library > Description
from the menu bar. Type in text that describes the library. For
example, “This is my custom library”.

Create a new device. Select Library > Device from the menu bar.
In the edit box labelled new type 2PINTerm. Click yes to the con-
firmation.

Create a new package. Select Library > Package from the menu
bar. In the edit box labelled new type 2PINTerm. Click yes to the
confirmation.

Create a new symbol. Select Library > Symbol from the menu
bar. In the edit box labelled new type 2PINTerm. Click yes to the
confirmation.

All of the above three creation steps bring up the same configuration
window. The window allows the user to create, but also to view all
devices, packages, and symbols within a library.

25
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A library file is composed of several other files. For instance, each
device within the library has its own file (*.dev). Similarly each
package and symbol have a file within the library (*.pac and *.sym
respectively). A device combines a package (footprint) and symbol
(schematic) to create a component. Figure 4.1 illustrates the library
file hierarchy.

A lot of work can potentially be saved by copying packages or
symbols from existing libraries. To do this, open the source
library and select the package or symbol. Turn all layers on,
select everything using the GROUP command, and CUT
the information. Use PASTE to place this information into
the destination package or symbol.

Library File

* Ibr

I
Device File Several
* dev Y Components
|

Package File Symbol File

* pac * sym

Figure 4.1: Library hierarchy.

6. Draw the schematic symbol as shown in Figure 4.3.

(a) Open the symbol file. Select Library > Symbol from the menu
bar. Highlight 2PINTerm and click OK.

(b) Create 2 PINS. Select Draw > Pin from the menu bar. Notice
the tool bar that appears below the main menu bar; the properties
of the pin can be set with this tool bar. The important property
is the direction of the pin because it is used in the ERC. For the
Power Header configure the tool bar as shown in Figure 4.2. Add
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two pins, to stop adding pins click the STOP sign on the top tool
bar.

511 Library - C:/mylib Ibr {2PINTERM sym)
Fite Edit Draw Yiew Library Options Window Help

[aaaaa--@g|?

e [f [k == Bl & piecton] Pwr ~]Swepevet[0  ~]

leda(sss o

= e e

01 inch05-03) | |l

Figure 4.2: Configuration for power pins.

(c) Name the PINS. Select Edit > Name from the menu bar, and
click on the Pin to be named. Name one of the pins POS(+) and
the other NEG(-).

(d) Draw the SYMBOL shape in Figure 4.3. This will require using
the wire and circle draw commands, but it will also require a
change in the Grid size, Select View > Grid from the menu bar
and enter a size of 0.01 inch.

(e) Add in “>NAME” and “>VALUE” using text command and
place the text strings on the Name and Value layers respectively.
These strings will allow dynamic naming of the part when it is
used in the schematic editor. One way to change the layer is to:
first place the text, Select Edit > Change > Layer from the
menu bar, select the appropriate layer, and finally click on the
text to be changed.

(f) Add a centre mark. Select View > Mark and place the cross
hair at the end of one of the pins. This will be the “hot-spot”
when the part is inserted into a schematic.

(g) Save.
7. Draw the PCB package as shown in Figure 4.5

(a) Open the package file. Select Library > Package from the menu
bar. Highlight 2PINTerm and click OK.

(b) Create 2 PADS. The Drill and Pad sizes are configured based
on the components wire leads but must also conform to manu-
facturing standards. For these two pads, configure as shown in
Figure 4.4.
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>NAME

°—QPOS(+)
°—ONEG()
>VALUE

Figure 4.3: Final 2 pin terminal block schematic symbol.

When drawing the package, it is best if you have the actual
part in front of you, along with callipers, a micrometer, or
a ruler. This will allow you to measure the size of leads (for
establishing hole size), lead pitch, and other package sizes.

51 Library - C:/mylib_Ibr (2PINTERM _pac)
File Edit Draw “iew Library Options SWindow Help

aaaaa- «(d3

AL

|led& 338 v = 5

o o |005inch005015) [F-a15015 |

Figure 4.4: Configuration for pads.

(c) Name the PADS. Name one POS and the other NEG.

(d) Draw the PACKAGE or Footprint on the Top Solder Mask Layer
(tPlace). When drawing the Solder mask layer, ensure the com-
ponent’s mechanical clearances are met so that the component
does not interfere with other components when mounted to the
PCB. These measurements, including pad spacing, are specified
by the component’s data sheet. When creating this package refer
to the 100mil grid settings shown in Figure 4.5.

(e) Add in “>NAME” and “>VALUE” using text command and
place on the tName and tValue layers respectively. This is done
for the same reason as with the device symbol.

(f) Save.
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>Name
O QO
+

>Value

Figure 4.5: Final 2 pin terminal block PCB package.

8. Form the Device. Combine the symbol and package into the device to
form the 2 Pin Power Header.

(a)
(b)

()

(f)

Open the device file. Select Library > Device from the menu
bar. Highlight 2PINTerm and click OK.

Add the Symbol. Select Edit > Add from the menu bar. High-
light 2PINTerm and click OK. Place the symbol at the location
of the cross hairs in the left window panel. Click the Stop Sign.

Add the Package. Select Edit > Package from the menu bar.
Highlight 2PINTerm and click OK. Different packages can be
associated with the schematic symbol at this juncture, if required.

Connect PINs to PADs. Select Edit > Connect from the menu
bar. Match the appropriate pins to pads, click connect, and fi-
nally click OK. A green check mark indicates successful connec-
tions.

Add a Prefiz. This adds prefix text to the component name when
the component is added to schematics and PCBs. For example
a resistor prefix is R; therefore, resistors are named R1, R2, etc.
Set this prefix to JP.

Save. Save and close the Library. The component is complete.

4.1 Update Schematic and PCB

Replace this power header with the one used in the 555 timer circuit de-
signed previously. Open the schematic file and the PCB layout file. If only
one is opened, the changes made in one of the files will not reflect in the
other Perform forward annotation: replace the schematic power header, and
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then route the design in the PCB Layout editor. If the component was con-
structed correctly, airwires will indicate the connections to be made in the
PCB layout editor.





Chapter 5

Exporting Schematic and
PCB Images

This chapter describes how to export the schematic diagram and PCB layout
to an encapsulated postscript or bitmap file for use within a document.
After completing a design, documentation usually follows. Encapsulated
postscript is the recommended export format because of one main advantage:
they are vector-based and scalable. When the schematic image is included
in a document the resulting visual is less degraded and more crisp. Below,
two procedures are outlined: one to export in encapsulated postscript, and
another to create bitmaps.

5.1 Exporting to Encapsulated Postscript

Exporting to postscript format is done through the CAM Processor within
Eagle. The following procedure will guide you through creating what is
known as a “CAM job” which will in turn allow you to easily export your
schematics and PCB layouts to postscript format.

1. Open Eagle with the file you wish to export to postscript.

2. Select File > CAM Processor from the menu bar within the files
window.

3. Configure the CAM Processor with the following attributes:

e Output Device = EPS, which stands for Encapsulated Postscript

31
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e File = filename.eps, this is where you want the output EPS file
to be placed.

e Ensure that “pos.Coord” is checked.

e Select the layers that are to be exported to the right of the win-
dow.

Figure 5.1 below is the CAM Processor configured for EPS output.

4 3 CAM Processor
File Layer ‘Window Help
—Job — Shyle
!3uectioﬂ_|x = Miror
: | [ Rotats
rompt ; 33 Pikg
™ Upsida down P 5 yrmbols
— Dutpuit M pos. Coord Ell M ames
- T | Guickalt [ alues
Devics | EFS Ll W El. o el D escript
2
S |1 pirize
I Fill pads
File | I output_file.epz
— Sheet
— Offset i Page 141 -
5 | Dinch Haight | 100inch
YIDinch Width [ 100inch
Process Job | Process Sechion I Description I Add | Drel |
C:/Program Files/EAGLE-4.08r2/projects/LED_Flasher/ed sch o

Figure 5.1: The CAM processor configured for encapsulated postscript out-
put.

4. Click on Process Job

If you will be exporting to postscript often, the CAM Processor state
can be saved. Select File > Save As within the CAM Processor window
and select an appropriate name.
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When including an encapsulated postscript image into a doc-
ument, many word processors, notably MS Word, will not
show the image contents. It is possible to add functionality
to Word to overcome this problem. Regardless, the image
will be present when printed on a postscript printer. Alter-
nately, “Alladin Ghostscript” and “Alladin Ghostview” are
MS windows-based applications that are used to view (E)PS
files.

5.2 Exporting to Bitmap

Exporting to Bitmap or Graphic format is done through the Export op-
tion within Eagle. This method of exporting is similar to many windows
programs and is thus rather straightforward. Below is the procedure.

1.

2.

Open Eagle and open the file you wish to export.

Select File > Export from the menu bar within the files window.
Another menu will pop up select Image.

Choose the appropriate output file and options.

Click OK.
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